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About this manual

Welcome!
This is the Operation Manual for Steinberg’s Cubase LE 4. 
Here you will find detailed information about all the features 
and functions in the program. 

About the program versions
The documentation covers two different operating sys-
tems or “platforms”; Windows and Mac OS X. 

Some features and settings described in the documenta-
tion are specific to one of the platforms, Windows or Mac 
OS X. This is clearly stated in the applicable cases. In 
other words:

If nothing else is said, all descriptions and procedures 
in the documentation are valid under Windows and Mac 
OS X.
The screenshots are taken from the Windows version.

Key command conventions
Many of the default key commands in Cubase LE use 
modifier keys, some of which are different depending on 
the operating system. For example, the default key com-
mand for Undo is [Ctrl]+[Z] under Windows and [Com-
mand]+[Z] under Mac OS X.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]/[Mac modifier key]+[key]

For example, [Ctrl]/[Command]+[Z] means “press [Ctrl] 
under Windows or [Command] under Mac OS X, then 
press [Z]”. 

Similarly, [Alt]/[Option]+[X] means “press [Alt] under Win-
dows or [Option] under Mac OS X, then press [X]”.

Please note that this manual often refers to right-click-
ing, e.g. to open context menus, etc. If you are using a Mac 
with a single-button mouse, hold down [Ctrl] and click.
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VST Connections: Setting up input and output busses

About this chapter
Cubase LE uses a system of input and output busses to 
transfer audio between the program and the audio hard-
ware.

• Input busses let you route audio from the inputs on your audio 
hardware into the program. This means that when you record 
audio, you will always do this through one or several input 
busses.

• Output busses let you route audio from the program to the 
outputs on your audio hardware. When you play back audio, 
you will always do this through one or several output busses.

As you can see, the input and output busses are vital 
when you work with Cubase LE. This is why you find this 
chapter at the beginning of the Operation Manual – once 
you understand the bus system and set up the busses 
properly, it will be easy to go on with recording, playing 
back and mixing.

Setting up busses

Strategies
In Cubase LE, you can create up to 8 stereo busses or up 
to 16 mono busses, respectively. 

The bus configuration is saved with the projects – 
therefore it’s a good idea to add and set up the busses 
you need and save these in a template project (see “Save 
as Template” on page 238).
When you start working on new projects, you start from this template. 
That way you get your standard bus configuration without having to make 
new bus settings for each new project. If you need to work with different 
bus configurations in different projects, you can either create several dif-
ferent templates or store your configurations as presets (see “Other bus 
operations” on page 12). The templates can of course also contain other 
settings that you regularly use – sample rate, record format, a basic track 
layout, etc.

Input busses

• Most likely you need at least one stereo input bus assigned to 
an analog input pair. This will let you record stereo material. If 
you want to be able to record in stereo from other analog input 
pairs as well, you could add stereo input busses for these, too.

• Although you can record mono tracks from one side of a ste-
reo input, it may be a good idea to add a dedicated mono in-
put bus. This could be assigned to an analog input to which 
you have connected a dedicated microphone pre-amp for ex-
ample. Again, you can have several different mono busses.

• You probably want a dedicated stereo input bus assigned to 
the digital stereo input, for digital transfers.

Output busses

• You probably want one or several stereo output busses for 
monitoring and listening to stereo mixes.

• For digital transfers, you need a stereo bus assigned to the 
digital stereo output as well.

Preparations
Before you set up busses, you should name the inputs 
and outputs on your audio hardware.

The reason for this is compatibility – it makes it easier to 
transfer projects between different computers and setups. 
For example, if you move your project to another studio, 
the audio hardware may be of a different model. But if 
both you and the other studio owner have given your in-
puts and outputs names according to the setup rather 
than names based on the audio hardware model, Cubase 
LE will automatically find the correct inputs and outputs 
for your busses and you will be able to play and record 
without having to change the settings.

Use the Device Setup dialog to assign names to the in-
puts and outputs of your audio hardware:

1. Open the Device Setup dialog from the Devices menu.

2. Make sure that the correct driver for your audio hard-
ware is selected on the VST Audio System page, so that 
the audio card is listed in the Devices list.

3. Select your audio card in the list.
The available input and output ports on your audio hardware are listed on 
the right.

4. To rename a port, click its name in the “Show as” col-
umn and enter a new name.

• If needed, you can also disable ports by deactivating 
them in the “Visible” column.
Disabled ports won’t show up in the VST Connections window when you 
are making bus settings. If you attempt to disable a port that is used by a 
bus, you will be asked whether this is really what you want – note that 
this will remove the port from the bus!
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5. Click OK to close the Device Setup dialog.

If you open a project created on another computer and 
the port names don’t match (or the port configuration isn’t 
the same – e.g. the project is created on a system with 
multi-channel i/o and you open it on a stereo in/out sys-
tem), a Pending Connections dialog will appear.
This allows you to manually re-route ports used in the project to ports 
available in your system.

The VST Connections window
You add and set up busses in the VST Connections win-
dow, opened from the Devices menu.

This window contains the Inputs and Output tabs for view-
ing input busses or output busses, respectively. 

Depending on which tab you have selected, the window 
lists the current input or output busses, with the following 
columns:

Adding a bus

1. Open the Inputs or Outputs tab depending on which 
you want to add.

2. Click the Add Bus button.
A dialog appears.

3. Select the desired (channel) configuration.
You can add stereo and mono busses.

• Alternatively you can right-click in the VST Connections 
window and add a bus in the desired format directly from 
the context menu that appears.
The new bus appears with the ports visible.

4. Click in the Device Port column to select an input/out-
put port for a channel in the bus.
The pop-up menu that appears lists the ports with the names you have 
assigned in the Device Setup dialog. Repeat this for all channels in the 
bus.

Setting the Main Mix bus (the default output bus)

The Main Mix is the output bus that each new channel in 
the mixer will be assigned to when it is created.

Any one of the output busses in the VST Connections 
window can be the default output bus. By right-clicking on 
the name of an output bus, you can set this bus as the 
Main Mix bus.

Setting the default output bus in the VST Connections window.

Column Description

Bus Name Lists the busses. You can select busses and rename 
them by clicking on them in this column.

Speakers Indicates the speaker configuration (mono, stereo) of 
each bus.

Audio Device This shows the currently selected ASIO driver.

Device Port When you have “opened” a bus (by clicking its + button 
in the Bus Name column) this column shows which phys-
ical input/output on your audio hardware is used by the 
bus.

Click You can route the click to a specific VST output bus.
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When creating new audio, group or FX channels in the 
mixer, they will automatically be routed to the default bus.

Other bus operations

• To change the port assignment for a bus, you proceed 
as when you added it – make sure the channels are visible 
(by clicking the “+” button next to the bus, or by clicking 
the “+ All” button at the top of the window) and click in the 
Device Port column to select ports.

• To remove a bus you don’t need, select it in the list, 
right-click and select “Remove Bus” from the pop-up 
menu, or press [Backspace].

• You can store and recall bus presets with the pop-up 
menu at the top of the window.
To store the current configuration as a preset, click the Store “+” button 
and enter a name for the preset. You can then select the stored configu-
ration directly from the Presets pop-up menu at any time. To remove a 
stored preset, select it and click the “-” button.

Using the busses
This section describes briefly how to use the input and out-
put busses you have created. For details refer to the chap-
ters “Recording” on page 44 and “The mixer” on page 75.

Routing
When you play back an audio track (or any other audio 
based channel in the mixer), you route it to an output bus. 
In the same way, when you record on an audio track you 
select from which input bus the audio should be sent.

• You can select input and output busses in the Inspec-
tor, using the Input and Output Routing pop-up menus.

For audio-related channel types other than audio track 
channels (i.e. Group channels and FX channels), only the 
Output Routing pop-up menu is available. Select one of 
its subtracks in the Track list to open it.

When selecting an input bus for a track you can only se-
lect busses that correspond to the track’s channel config-
uration. Here are the details for input busses:

• Mono tracks can be routed to mono input busses or individual 
channels within a stereo input bus.

• Stereo tracks can be routed to stereo or mono input busses. 

For output busses any assignment is possible.

Viewing the busses in the mixer

Note that only the output busses are available in the 
mixer – not the input busses.

The available output busses are represented as output 
channel strips in the mixer (shown in a separate pane to the 
right). You can show or hide output channels by clicking the 
corresponding button in the mixer common panel:

The output channel strips

! The default bus is indicated by an orange speaker 
icon next to its name in the VST Connections window.
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The output channels are shown to the right in the mixer. 
Here you can do the following:

• Adjust the output level for the busses with the faders.

• Open the Channel Settings window to add effects or EQ.
These will affect the whole bus. Examples of effects you may want to add 
here include compressors or limiters. See the chapter “Audio effects” in 
the separate Plug-in Reference manual.

About monitoring
The Main Mix bus (the default output bus) is used for moni-
toring (see “Setting the Main Mix bus (the default output 
bus)” on page 11).

Setting the monitoring level
You can adjust the monitoring level in the Mixer.

• When auditioning or scrubbing in the Sample Editor, 
you can also set the monitoring level using the small fader 
on the Sample editor toolbar.
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The Project window

Background
The Project window is the main window in Cubase LE. 
This provides you with an overview of the project, allowing 
you to navigate and perform large scale editing. Each 
project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a 
timeline running horizontally from left to right. The follow-
ing track types are available:

About parts and events

Events are the basic building blocks in Cubase LE. Differ-
ent event types are handled differently in the Project win-
dow:

• Video events and automation events (curve points) are always 
viewed and rearranged directly in the Project window.

• MIDI events are always gathered in MIDI parts, containers for 
one or more MIDI events. MIDI parts are rearranged and ma-
nipulated in the Project window. To edit the individual MIDI 
events in a part, you have to open the part in a MIDI editor (see 
“About editing MIDI” on page 166). 

• Audio events can be displayed and edited directly in the 
Project window, but you can also work with audio parts con-
taining several events. This is useful if you have a number of 
events which you want to treat as one unit in the project.

An audio event and an audio part.

Track type Description

Audio For recording and playing back audio events and audio 
parts. Each audio track has a corresponding audio chan-
nel in the mixer.
An audio track has an automation track for automating 
mixer channel parameters, insert effect settings etc.

FX Channel FX channel tracks are used for adding send effects. Each 
FX channel can contain up to eight effect processors – 
by routing effect sends from an audio channel to an FX 
channel, you send audio from the audio channel to the ef-
fect(s) on the FX channel. Each FX channel has a corre-
sponding channel strip in the mixer – in essence an effect 
return channel. See the chapter “Audio Effects” in the 
separate Plug-in Reference manual.
An FX channel also has an automation track for automat-
ing mixer channel parameters, effect settings etc. All FX 
channel tracks are automatically placed in a special FX 
channel folder in the Track list, for easy management.

Folder Folder tracks function as containers for other tracks, 
making it easier to organize and manage the track struc-
ture. They also allow you to edit several tracks at the 
same time. See “Folder tracks” on page 66.

Group Channel By routing several audio channels to a Group channel, 
you can submix them, apply the same effects to them, 
etc. (see “Using group channels” on page 86).
A Group channel track contains no events as such, but 
displays settings and automation curves for the corre-
sponding Group channel. Each Group channel track has 
a corresponding channel strip in the mixer. In the Project 
window, Group channels are organized as subtracks in a 
special Group Tracks folder. 

Instrument This allows you to create a track for a dedicated instru-
ment. Instrument tracks have a corresponding channel 
strip in the mixer. Each instrument track also has an auto-
mation track in the Project window. However, Volume 
and Pan are automated from within the mixer. For more 
information on instrument tracks, see “VST Instruments 
and Instrument tracks” on page 141.

MIDI For recording and playing back MIDI parts. Each MIDI 
track has a corresponding MIDI channel strip in the mixer. 
A MIDI track has an automation track for automating mixer 
channel parameters, insert and send effect settings etc. 

Marker The Marker track displays markers which can be moved 
and renamed directly in the Project window (see “Using 
the Marker track” on page 72). A project can have only 
one marker track.

Video For playing back video events. A project can only have 
one video track.

Track type Description
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Window Overview

The Track list
The Track list displays all the tracks used in a project. It 
contains name fields and settings for the tracks. Different 
track types have different controls in the Track list. To see 
all the controls you may have to resize the track in the Track 
list (see “Resizing tracks in the Track list” on page 22).

• The Track list area for an audio track:

• The Track list area for an automation track (opened by 
clicking the Show/Hide Automation button on a track):

• The Track list area for a MIDI track:

The event display, showing audio parts and events, 
MIDI parts, automation, markers, etc.

The Inspector

The rulerThe info line The toolbar

 The Track list with 
various track types

Mute & Solo
Record Enable & 
Monitor buttons

Track 
name

Lane Display TypeShow/hide automation

Indicates whether effect sends, EQ or insert effects 
are activated for the track. Click to bypass.

Automation Read/
Write buttons

Edit channel settings

Track activity 
indicator

Automation Read/
Write buttons

Automation parameter 
(click to select parameter)

Mute 
Automation

Record Enable & 
Monitor buttons

Track name

MIDI OutputBank Patch

MIDI channel

Read/Write buttons

Edit channel settingsMute & Solo

Track activity 
indicator

Lane display 
type

Drum 
Map
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The Inspector
The area to the left of the Track list is called the Inspector. 
This shows additional controls and parameters for the track 
you have selected in the Track list. If several tracks are se-
lected (see “Handling tracks” on page 25), the Inspector 
shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in 
the toolbar.

The Inspector icon.

• For most track classes, the Inspector is divided into a 
number of sections, each containing different controls for 
the track. You can hide or show sections by clicking on 
their respective names.
Clicking the name for a hidden section brings it into view and hides the 
other sections. [Ctrl]/[Command]-clicking the section name allows you 
to hide or show a section without affecting the other sections. Finally, 
[Alt]/[Option]-clicking a section name shows or hides all sections in the 
Inspector.

• You can also use key commands to show different In-
spector settings.
These are set up in the Key Commands dialog, see “Setting up key com-
mands” on page 250.

Hiding a section does not affect its functionality.
In other words, if you have set up a track parameter or activated an effect 
for example, your settings will still be active even if you hide the respec-
tive Inspector section.

Which sections are available in the Inspector depends on 
the selected track.

Please note that not all Inspector tabs are shown by 
default. You can show/hide Inspector sections by right-
clicking on an Inspector tab and activating/deactivating 
the desired option(s).
Make sure you right-click on an inspector tab and not on the empty area 
below the Inspector, as this will open the Quick context menu instead.

The Inspector Setup context menu.

Sections

The Inspector contains the controls that can be found on 
the Track list, plus some additional buttons and parame-
ters. In the table below, these additional settings and the 
available sections are listed. Which sections are available 
for which track type is described in the following sections.

Parameter Description

Edit Channel 
settings

Opens the Channel Settings window for the track, allow-
ing you to view and adjust effect and EQ settings, etc. 
See “Using Channel Settings” on page 83.

Auto Fades 
Settings button

Opens a dialog in which you can make separate Auto 
Fade settings for the track. See “Making Auto Fade set-
tings for a separate track” on page 65.

Volume Use this to adjust the level for the track. Changing this 
setting will move the track’s fader in the mixer window, 
and vice versa. See “Setting volume in the mixer” on page 
80 to learn more about setting levels.
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Audio tracks

For audio tracks, all settings and sections listed above are 
available.

MIDI tracks

When a MIDI track is selected, the Inspector contains a 
number of different sections and parameters, affecting the 
MIDI events in real time (e.g. on playback).

Marker tracks

When the marker track is selected, the Inspector shows 
the marker list. See “The Marker window” on page 71.

Video tracks

When a video track is selected, the Inspector contains a 
Mute button for interrupting video playback.

Folder tracks

When a folder track is selected, the Inspector shows the 
folder and its underlying tracks, much like a folder struc-
ture in the Windows Explorer or Mac OS X Finder.

You can click one of the tracks shown under the folder 
in the Inspector to have the Inspector show the settings 
for that track.
This way, you don’t have to “open” a folder track to make settings for 
tracks within it.

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following con-
trols and sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Channel section.

Pan Use this to adjust the panning of the track. As with the 
Volume setting, this corresponds to the Pan setting in the 
mixer.

Delay This adjusts the playback timing of the audio track. Posi-
tive values delay the playback while negative values 
cause the track to play earlier. The values are set in milli-
seconds.

Input Routing This lets you specify which Input bus or MIDI input the 
track should use (see “Setting up busses” on page 10 for 
information about Input busses).

Output Routing Here you decide to which output the track should be 
routed. For audio tracks you select an output bus (see 
“Setting up busses” on page 10) or Group channel, for 
MIDI tracks you select a MIDI output.

Inserts section Allows you to add insert effects to the track, see the 
chapter “Audio effects” in the separate Plug-in Refer-
ence manual. The Edit button at the top of the section 
opens the control panels for the added insert effects.

Equalizers 
section

Lets you adjust the EQs for the track. You can have up to 
four bands of EQ for each track, see “Making EQ set-
tings” on page 84. The Edit button at the top of the sec-
tion opens the Channel Settings window for the track. 

Sends section Allows you to route an audio track to one or several FX 
channels (up to eight), see the chapter “Audio effects” in 
the separate Plug-in Reference manual. The Edit button 
at the top of the section opens the control panel for the 
first effect in each FX channel.

Channel section Shows a duplicate of the corresponding mixer channel 
strip. The channel overview strip to the left lets you acti-
vate and deactivate insert effects, EQs and sends.

Parameter Description
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FX channel folder tracks

FX channel tracks are automatically placed in a special 
folder, for easier management. When this folder track is 
selected, the Inspector shows the folder and the FX chan-
nels it contains. You can click one of the FX channels 
shown in the folder to have the Inspector show the set-
tings for that FX channel – this way you don’t have to 
“open” a folder track to access the settings for the FX 
channels in it.

Group channel tracks

When a Group channel track is selected, the following 
controls and sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Sends section.
• Channel section.

Group channel folder tracks

Just like FX channel tracks, all Group channel tracks are 
placed in a separate folder – when this is selected, the In-
spector shows the folder and the Group channels it con-
tains. You can click one of the Group channels shown in 
the folder to have the Inspector show the settings for that 
Group channel – this way, you don’t have to “open” a folder 
track to access the settings for the Group channels in it.

The toolbar
The toolbar contains tools and shortcuts for opening other 
windows and various project settings and functions:

How to set up the toolbar and specify which tools 
should be displayed or hidden is described in the section 
“The Setup dialogs” on page 244.

The info line

The info line shows information about the currently se-
lected event or part in the Project window. You can edit al-
most all values on the info line using regular value editing. 
Length and position values are displayed in the format cur-
rently selected for the ruler (see “The ruler” on page 20).

• To hide or show the info line, click the Show Event Info-
line button on the toolbar.

The following elements can be selected for display and 
editing on the info line:

• Audio events.
• Audio parts.
• MIDI parts.
• Video events.
• Markers.
• Automation curve points.

When several elements are selected

• If you have several elements selected, the info line will 
show information about the first item in the selection. The 
values will be shown in yellow to indicate that several ele-
ments are selected.

Active project 
indicator

Show/hide 
Inspector

Show/hide 
info line

Open MixerOpen Pool

Constrain delay compensation (see “Constrain Delay 
Compensation” on page 145).

Transport controls (Previous/Next Marker, 
Cycle, Stop, Play, and Record)

Project window tools

Nudge palette

Snap on/off

Snap mode

Grid pop-up menu Quantize value

Color pop-up menuAutoscroll on/off

Snap to Zero 
Crossings



20

The Project window

• If you edit a value on the info line, the value change is 
applied to all selected elements, relatively to the current 
values. 
If you have two audio events selected and the first is one bar long and 
the other two bars long, the info line shows the length of the first event 
(one bar). If you now edit this value to 3 bars in the info line, the other 
event will be resized by the same amount – and will thus be 4 bars long.

• If you press [Ctrl]/[Command] and edit on the info line, 
the values will be absolute instead. In our example above, 
both events would be resized to 3 bars. Note that [Ctrl]/
[Command] is the default modifier key for this – you can 
change this in the Preferences (Editing–Tool Modifiers 
page, under the Info Line category).

Editing Transpose and Velocity for MIDI parts

When one or several MIDI parts are selected, the info line 
contains Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected 
parts in semitone steps.
Note that this transposition doesn’t change the actual notes in the part – 
it’s just a “play parameter”, affecting the notes on playback. The transpo-
sition you specify for a part on the info line is added to the transposition 
set for the whole track with the Transpose track parameter in the Inspec-
tor.

• Adjusting the Velocity field shifts the velocity for the se-
lected parts – the value you specify is added to the veloci-
ties of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again, 
the value you specify is added to the Vel.Shift. value set for the whole 
MIDI track in the Inspector.

Getting on-the-fly info with the Arrow tool

If the option “Select Tool: Show Extra Info” is activated in 
the Preferences dialog (Editing–Tools page), a tool tip will 
be shown for the Arrow tool, displaying information de-
pending on where you point it. For example, in the Project 
window Event display, the tool will show the current 
pointer position and the name of the track and event 
you’re pointing at.

The ruler

The ruler at the top of the event display shows the time-
line. Initially, the Project window ruler uses the display for-
mat specified in the Project Setup dialog (see “The 
Project Setup dialog” on page 21), as do all other rulers 
and position displays in the project. However, you can se-
lect an independent display format for the ruler by clicking 
the arrow button to the right of it and selecting an option 
from the pop-up menu that appears (you can also bring up 
this pop-up menu by right-clicking anywhere in the ruler).

• The selection you make here affects the ruler, the info 
line and tool tip position values (which appear when you 
drag an event in the Project window).
You can also select independent formats for other rulers and position 
displays. 

• To set the display format globally (for all windows), use 
the time display format pop-up on the Transport panel, or 
hold down [Ctrl]/[Command] and select a display format 
in any ruler.

• If you use the “Timecode” option and the option “Show 
Timecode Subframes” is activated in the Preferences 
(Transport page), the frames will also display subframes.
There are 80 subframes per frame.

! Audio events can also be transposed – see “Real-
time pitch shifting of audio events” on page 121.

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. There are 120 
ticks per sixteenth note.

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds and frames. 
The number of frames per second (fps) is set in the 
Project Setup dialog (see “The Project Setup dialog” on 
page 21). You can choose between 24, 25, 29.97 and 
30 fps or 29.97 and 30 dfps (“drop frame”).

Samples Samples.

Time Linear When this is selected, the ruler will be linear relative to 
time. This means that if there are tempo changes on the 
Tempo track, the distance between the bars will vary in 
Bars+Beats mode.

Bars+Beats 
Linear

When this is selected, the ruler will be linear relative to 
the meter position – bars and beats. This means that if 
there are tempo changes on the Tempo track, there still 
will be the same distance between bars in Bars+Beats 
mode. If the ruler is set to a time-based mode, the dis-
tance between seconds will vary depending on the 
tempo changes.
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Operations

Creating a new project
You create a new project in the following way:

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any 
custom templates you may have created (see “Save as Template” on 
page 238). 

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project 
folder. This will contain all files related to the project. 

3. Select an existing folder or type the name of a new 
one. Click OK.
A Project window appears. The new project will be based on the selected 
template, and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project 
Setup dialog. This is opened by selecting “Project 
Setup...” from the Project menu.

The following settings are available in the Project Setup 
dialog:

Setting Description

Start The start time of the project. Allows you to have the 
project start at another time than zero. Also used for set-
ting the sync start position when synchronizing Cubase 
LE to external devices (see “Setting up Cubase LE for ex-
ternal sync to timecode” on page 221). When you 
change this setting you will be asked whether you want 
to keep the project content at its timecode positions. 
“Yes” means that all events will stay at their original time-
code positions – i.e. they will be moved in relation to the 
start of the project. “No” means that all events keep their 
position relative to the project start.

Length The length of the project.

Frame Rate Used when synchronizing Cubase LE with external 
equipment. If Cubase LE is slave, this value is automati-
cally set to the frame rate of the incoming sync signal. If 
Cubase LE is the master, this determines the frame rate 
of the sent sync signal. See “Setting the Frame Rate” on 
page 219.

Display Format This is the global display format used for all rulers and 
position displays in the program. However, you can make 
independent display format selections for the individual 
rulers and displays if you like.
For descriptions of the different display format options, 
see “The ruler” on page 20.

Display Offset Offsets the time positions displayed in the ruler etc., al-
lowing you to compensate for the Start position setting. 
Typically, if you synchronize Cubase LE to an external 
source starting at a frame other than zero, you set the 
Start position to this value. However, if you still want the 
display in Cubase LE to start at zero, set the Display Off-
set to the same value too.

Sample Rate The sample rate at which Cubase LE records and plays 
audio.

Record Format/ 
File Type

When you record audio in Cubase LE, the files that are 
created will be of this resolution and file type. See “Se-
lecting a recording file format” on page 47.

Stereo Pan Law Decides whether panning should use power compensa-
tion or not (see “About the “Stereo Pan Law” Preference 
(audio channels only)” on page 82).

! While most Project Setup settings can be changed at 
any time, you should select a sample rate once and for 
all when starting with a new project! All audio files 
must be of this sample rate to play back correctly.
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Zoom and view options
Zooming in the Project window is done according to the 
standard zoom techniques, with the following special 
notes:

• When you are using the Zoom tool (magnifying glass), 
the result depends on the option “Zoom Tool Standard 
Mode: Horizontal Zooming Only” in the Preferences (Edit-
ing–Tools page).
If this is activated and you drag a selection rectangle with the Zoom tool, 
the window will only be zoomed horizontally (track height will not change). 
If the option is off, the window will be zoomed both horizontally and verti-
cally.

• When using the vertical zoom sliders, the tracks are 
scaled relatively. 
In other words, if you have made any individual track height adjustments 
(see below), the relative height differences are maintained.

You find the following options are available on the Zoom 
submenu on the Edit menu:

• If the option “Zoom while Locating in Time Scale” is ac-
tivated in the Preferences (Transport page), you can also 
zoom by clicking in the main ruler and dragging up or 
down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events verti-
cally, using the waveform zoom slider in the top right cor-
ner of the event display.
This can be useful when viewing quiet audio passages.

• If you activate the option Quick Zoom in the Prefer-
ences (Editing page), the contents of parts and events will 
not be continuously redrawn when you zoom manually.
Instead, the contents are redrawn once you have stopped changing the 
zoom – activate this if screen redraws are slow on your system.

Resizing tracks in the Track list

• You can change the height of an individual track by 
clicking on its lower border in the Track list and dragging 
up or down.
To change the height of all tracks simultaneously, hold down [Ctrl]/
[Command] and resize one of the tracks in this way. If “Snap Track 
Heights” is activated on the Track scale pop-up (see below), the track 
height will change in fixed increments when you resize it.

• You can also change the width of the Track list area, by 
dragging the border between the Track list and the event 
display.

• The controls shown for tracks in the Track list will adapt 
to the track size. This means that when resizing a track’s 
height or width the controls will be placed where they best 
“fit in”.

Option Description

Zoom In Zooms in one step, centering on the project cursor.

Zoom Out Zooms out one step, centering on the project cursor.

Zoom Full Zooms out so that the whole project is visible. “The whole 
project” means the timeline from the project start to the 
length set in the Project Setup dialog (see above).

Zoom to 
Selection

Zooms in horizontally and vertically so that the current se-
lection fills the screen.

Zoom to 
Selection 
(Horiz)

Zooms in horizontally so that the current selection fills the 
screen.

Zoom to Event This option is available only in the Sample Editor (see 
“Zooming” on page 109).

Zoom In 
Vertical

Zooms in one step vertically.

Zoom Out 
Vertical

Zooms out one step vertically.

Zoom In 
Tracks

Zooms in on the selected track(s) one step vertically.

Zoom Out 
Tracks

Zooms out the selected track(s) one step vertically.

Zoom Selected 
Tracks 

This zooms in vertically on the selected track(s) and min-
imizes the height of all other tracks.

! To get an approximate reading on the level of the au-
dio events by viewing the waveforms, make sure the 
slider is all the way down. Otherwise, zoomed wave-
forms may be mistaken for clipped audio.

! Note that this behavior is different when “Enlarge Se-
lected Track” is activated on the Edit menu (see be-
low).
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• You can use the Track scale pop-up (opened by clicking 
the arrow button above the vertical zoom control) to set 
the number of tracks to view in the current Project window.
The track height will be adjusted to show only the number of tracks spec-
ified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-
up you can manually set the number of tracks to fit in the current Project 
window.

• Tracks can also be divided vertically in lanes – see 
“Editing in Lane Display mode” on page 34.

The Enlarge Selected Track option

When this option is activated on the Edit menu (or in the 
Preferences dialog, Editing–Project & Mixer page), the se-
lected track is enlarged automatically. This is useful if you 
are stepping through the tracks in the track list, to check 
or edit the settings. The tracks will revert to the size they 
had before when they are deselected. You can adjust the 
size directly in the Track list if the default enlargement fac-
tor does not suit you. 

While this is the program behavior you will want in most 
cases, it may be a disadvantage when changing the track 
height you started out with for one or more tracks (i.e. their 
“original” height, before “Enlarge Selected Track” was ac-
tivated). As soon as you try to resize a track, it is selected 
and automatically enlarged. Instead of turning off “Enlarge 
Selected Track”, resizing the desired track(s) and the acti-
vating “Enlarge Selected Track” again, you can resize a 
track in the Track list without selecting it.

Proceed as follows:

1. Move the mouse pointer over the lower border of the 
(unselected) track you want to resize.
The mouse pointer turns into a divider symbol.

2. Hold down [Alt]/[Option] and drag the lower border of 
the track until it reaches the desired height.
Now, when you select this track, (and “Enlarge Selected Track” is acti-
vated), it will be enlarged. It will revert to the changed size, when you se-
lect a different track.

Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control 
allows you to select, create and organize zoom presets. 
These are useful if you want to toggle between different 
zoom settings (e.g. one where the whole project is dis-
played in the project window and another with a high 
zoom factor for detailed editing). With this pop-up menu, 
you can also zoom in on the area between cycle markers 
in the project.

The upper part of the menu lists the zoom presets:

• To store the current zoom setting as a preset, select 
Add from the pop-up menu.
A dialog appears, allowing you to type in a name for the preset.

• To select and apply a preset, select it from the pop-up 
menu.

• The “Zoom Full” preset is always available. Selecting 
this option zooms out so that the whole project is visible. 
“The whole project” means the timeline from the project 
start to the length set in the Project Setup dialog (see 
“The Project Setup dialog” on page 21).

Click here… … to open the context menu
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• If you want to delete a preset, select “Organize…” from 
the pop-up menu.
In the dialog that appears, select the preset in the list and click the De-
lete button. The preset is removed from the list.

• If you want to rename a preset, select “Organize…” 
from the pop-up menu.
In the dialog that appears, select the desired preset in the list and click 
the Rename button. A second dialog opens, allowing you to type in a 
new name for the preset. Click OK to close the dialogs.

The middle part of the pop-up lists any cycle markers you 
have added in the project:

• If you select a cycle marker from this menu, the event 
display is zoomed in to encompass the marker area (see 
“Zooming to cycle markers” on page 73).

• You cannot edit the cycle markers in this pop-up menu. 
For information on editing markers, see “The Marker win-
dow” on page 71.

Adjusting how parts and events are shown

The Preferences on the File menu (the Cubase LE menu, 
under Mac OS X) contains several settings for customiz-
ing the display in the Project window.

The Event Display page contains common settings for all 
track types:

The Event Display–Video page contains settings for video 
events:

The Event Display–Audio page contains settings for audio 
events:

The Event Display–MIDI page contains settings for MIDI 
parts:

! Zoom presets are global for all projects, i.e. they are 
available in all projects you open or create.

! Only the cycle markers you create in the current 
project are available on the menu.

Option Description

Colorize Event 
Background

Determines whether the backgrounds or “contents” (wave-
forms, etc.) of parts and events will be colorized. See 
“Handling tracks” on page 25.

Show Event 
Names

Determines whether the names of parts and events should 
be shown in the Project window.

Transparent 
Events

When this is activated, events and parts will be transparent, 
showing the waveforms and MIDI events only.

Show Data on 
Small Track 
Heights

If this is activated, the contents of events and parts will be 
shown, even if the height of a track is very small.

Option Description

Show Video 
Thumbnails

When this is activated, thumbnail frames of the video 
contents are shown on the Video track.

Video Cache 
Size

This determines how much memory is available for video 
thumbnails. If you have long video clips and/or work with 
a large zoom factor (so that a lot of frames are shown in 
the thumbnails), you may have to raise this value.

Option Description

Interpolate 
Audio Images

If the option is deactivated, single sample values are 
drawn as “steps”. If the option is activated they are inter-
polated to form “curves”.

Wave Image 
Style

Determines whether audio waveforms should be displayed 
as solid images, frames or “inverted” images 
(solid+frame). This selection affects all waveform images 
in the Project window, Sample Editor and Audio Part Edi-
tor.
Note that the “Framed” and “Solid and Framed” styles 
are more demanding for the computer. If the system feels 
slower in these modes, please switch back to “Solid” 
wave image style.

Show Event 
Volume Curves 
Always

If this is activated the “volume curves” created with the 
volume and fade handles are always shown – if not, the 
curves are only shown for selected events.

Show 
Waveforms

Determines whether audio waveforms should be shown 
at all.

Background 
Color 
Modulation

When this is activated, the backgrounds of audio wave-
forms are displayed in a different way, reflecting the wave-
form dynamics. This is especially useful to get an overview 
when working with small track heights.

Option Description

Default Edit 
Action

Determines which editor should be opened when you 
double-click a MIDI part or select it and press [Ctrl]/
[Command]-[E]: the Key, Drum, List or Score editor. Note 
that this setting is overridden for tracks with drum maps if 
the option “Edit as Drums when Drum Map is assigned” 
(see below) is activated.

Part Data 
Mode

Determines if and how events in MIDI parts should be 
shown in the Project window: as lines, as score notes or 
as drum notes. If “No Data” is selected, events will not be 
shown at all. Note that this setting is overridden for tracks 
with drum maps if the option “Edit as Drums when Drum 
Map is assigned” (see below) is activated.

Show 
Controllers

Governs whether non-note events (controllers, etc.) 
should be shown in MIDI parts in the Project window.
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Handling tracks
To add a track to the project, select “Add Track” from the 
Project menu and select a track type from the submenu 
that appears. The new track is added below the currently 
selected track in the Track list.

• The items on the “Add Track” submenu are also avail-
able on the Quick menu.
This is accessed by right-clicking in the Track list.

• If you select Audio, MIDI, Group Channel or Instrument 
from the Add Track submenu, a dialog opens, allowing 
you to insert several tracks in one go.
Just enter the desired number of tracks in the value field.

• For audio and group channel tracks, the channel config-
uration – mono or stereo – can be set in the Configuration 
pop-up.

• In the Preferences (Editing–Project & Mixer page, you 
can find the option “Auto Track Color Mode”.
This offers you several options for automatically assigning colors to 
tracks that are added to the project.

Once you have created tracks, you can manipulate and re-
arrange them in various ways:

• To rename a track, double-click in the name field and 
type in a new name.
If you hold down any modifier key when pressing [Return] to close the 
name field, all events on the track will get the name you entered.

• To select a track, click on it in the Track list.
A selected track is indicated by a light grey color in the Track list.

It is possible to select several tracks, by pressing [Ctrl]/[Command] and 
clicking them. To select a continuous range of tracks, use [Shift]-clicking.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and 
channel settings, right-click in the Track list and select 
“Duplicate track” from the context menu, or select “Dupli-
cate track” from the Project menu.
The duplicated track will appear below the original track.

• You can select a default color for a track by activating 
“Show Track Colors” above the Track list and selecting a 
color from the Color pop-up menu on the toolbar. This 
color will be used for all events on the track and will also 
be shown in the Mixer. You can override the default track 
color for individual events and parts by using the Color 
tool or the Color Selector pop-up menu.
The option “Colorize Event Background” in the Preferences dialog (Event 
Display page) determines whether the backgrounds or waveforms of 
events will be colorized.

• To remove a track, right-click on it in the Track list and 
select “Remove Track” from the context menu.
You can also remove multiple selected tracks, by selecting “Remove Se-
lected Tracks” either from the Project menu or from the context menu.

• To change the track height of an individual track, click 
on its lower border in the Track list and drag up or down, 
see “Resizing tracks in the Track list” on page 22.

Note that you can also automatically enlarge the se-
lected track, see “The Enlarge Selected Track option” on 
page 23.

Edit as Drums 
when Drum Map 
is assigned

If this is activated, parts on MIDI tracks with drum maps 
assigned will be shown with drum note symbols in the 
Project window. Also, the parts will automatically open in 
the Drum editor when double-clicked (overriding the De-
fault Edit Action setting above).

Note Name 
Style

Determines how MIDI note names (pitches) should be 
displayed in editors, etc.

Option Description

This track is selected.
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Disabling audio tracks

Audio tracks can be disabled by selecting “Disable Track” 
from the Track list context menu. Disabling a track is simi-
lar to muting it (see “Muting events” on page 33), since a 
disabled track will not be played back. However, disabling 
a track not only “zeroes” the output volume from the track, 
but actually shuts down all disk activity for it. See “About 
track disable/enable” on page 42 for more information.

Adding events to a track
There are a number of ways to add events to a track:

• By recording (see “Basic recording methods” on page 
45).
This is possible for audio and MIDI tracks.

• By selecting “Audio File...” or “Video File...” from the Im-
port submenu on the File menu.
This opens a file dialog, allowing you to locate the file you wish to import. 
When you import a file this way, a clip is created for the file and an event 
that plays the whole clip is inserted on the selected track, at the position 
of the project cursor.
You can also import MIDI files by using the Import submenu, but this 
works in a slightly different way (see “Exporting and importing MIDI files” 
on page 241).

• By using Copy and Paste on the Edit menu.
This allows you to copy all kinds of events between projects. You can 
also copy events within the project, from the Audio Part Editor or Sample 
Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn di-
rectly into the Project window. For audio and MIDI tracks, you can draw 
parts (see “Creating parts” on page 27).

• By dragging files and dropping them on the track at the 
desired position.
You can create events by dragging and dropping from the following lo-
cations:

• The desktop.
• The Pool.
• The “Find media” dialog.
• The Project window of another open project.
• The Audio Part Editor of any open project.

• The Sample Editor of any open project – press [Ctrl]/[Com-
mand] and drag to create an event of the current selection.

While you drag the clip in the Project window, its position will be indi-
cated by a marker line and a numerical position box. See also “By using 
drag and drop” on page 133.

Audio file import options

When you are importing audio files there are a number of 
options concerning how the files should be treated by Cu-
base LE: 

• You can choose to copy the file into the audio folder of the 
project and have the project make reference to the copied file 
rather than the original file. This helps you keep your project 
“self-contained”.

• Furthermore, you may want all files in the project to have the 
same sample rate and sample size (resolution).

The Preferences dialog (Editing–Audio page) contains a 
setting that lets you decide which options to use. Select 
the desired option on the “On Import Audio Files” pop-up:

• Open Options Dialog.
An Options dialog appears when you import, allowing you to select 
whether you want to copy the files to the Audio folder and/or convert them 
to the project settings. Note:
– When importing a single file of a format other than the project settings, 
you can specify which properties (sample rate and/or resolution) should be 
changed.
– When importing multiple files at the same time, you can select to convert 
the imported files automatically if necessary, i.e. if the sample rate is differ-
ent than the project’s or the resolution is lower than the project setting.
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• Use Settings.
No Options dialog will appear when you import. Instead, you can choose 
to make any of the options below the pop-up the standard action(s). Ac-
tivate any number of the following options to have them performed auto-
matically each time you import audio files:

Creating parts

Parts are containers for MIDI or audio events. If you record 
MIDI, a MIDI part is automatically created, containing the 
recorded events. You can also create empty audio or MIDI 
parts and later add events to them. There are two ways to 
do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow 
tool.

• Double-click with the Arrow tool on a MIDI or audio 
track, between the left and right locator.

To add events to a MIDI part, you use the tools and func-
tions in a MIDI editor (see “The Key Editor – Overview” on 
page 168). Adding events to audio parts is done in the 
Audio Part Editor (see “Window overview” on page 114) 
by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by 
using the “Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the 
same track. To remove the part and make the events appear as indepen-
dent objects on the track again, select the part and use the “Dissolve 
Part” function on the Audio menu.

Auditioning audio parts and events
Audio parts and events can be auditioned in the Project 
window with the Speaker tool:

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same tool button. If 
the tool icon on the toolbar doesn’t show a speaker symbol, first click on 
the icon to select it, then click again and select “Play” from the pop-up 
menu that appears.

2. Click where you want playback to start, and keep the 
mouse button pressed.
Only the track on which you click is played back, starting at the click po-
sition. 

3. Release the mouse button to stop playback.

Scrubbing
The Scrub tool allows you to locate positions in the audio 
by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same tool button. If 
the tool icon on the toolbar doesn’t show a “scrub symbol”, first click on 
the icon to select it, then click again and select “Scrub” from the pop-up 
menu that appears.

2. Click at the desired position and keep the mouse but-
ton pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played 
back. The speed and pitch of the playback depend on how fast you move 
the pointer.

You can adjust the responsiveness of the Scrub function 
in the Preferences (VST–Scrub page).

Option Description

Copy Files to 
Working 
Directory

If files are not already in the project’s audio folder they are 
copied there before being imported.

Convert and 
Copy to Project 
If Needed

If files are not already in the project’s audio folder they are 
copied there before being imported. Furthermore, if the 
files have a different sample rate or a lower resolution 
than the project settings, they are automatically con-
verted.

! When auditioning, the Main Mix bus is used.
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• Note that scrubbing can be quite a burden on your sys-
tem. To avoid playback problems, you will find the “CPU 
Saving Scrub Mode” option in the Preferences (VST–
Scrub page).
When you activate this option, scrubbing will be less demanding on the 
processor. This can be very useful when scrubbing in a large project, 
where the “normal” scrub behavior leads to processing overloads. When 
“CPU Saving Scrub Mode” is activated, the effects are disabled for 
scrubbing and the resampling quality is lower.

Editing parts and events
This section describes techniques for editing in the Project 
window. If not explicitly stated, all descriptions apply to both 
events and parts, even though we use the term “event” for 
convenience.

When you are using the tools for editing, you can in 
many cases get additional functions by pressing modifier 
keys (e.g. pressing [Alt]/[Option] and dragging with the 
Arrow tool creates a copy of the dragged event). 
On the following pages, the default modifier keys are described – you 
can customize these in the Preferences (Editing–Tool Modifiers page), 
see “Setting up tool modifier keys” on page 253.

Selecting events

Selecting events is done using any of the following 
methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

• Select all events on a track by right-clicking in its Track 
list and selecting “Select All Events” from the pop-up 
menu that appears.

• You can also use the arrow keys on the computer key-
board to select the closest event to the left, right, above or 
below.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several events.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all events on the 
selected track(s) that are “touched” by the project cursor 
are automatically selected.
This can be helpful when rearranging your project, since it allows you to 
select whole sections (on all tracks) by selecting all tracks and moving 
the project cursor.

• It is also possible to select ranges, regardless of the 
event and track boundaries.
This is done using the Range Selection tool (see “Range editing” on 
page 35).

• Note that in the Preferences (Editing page), you can 
find the option “Use Up/Down Navigation Commands for 
selecting Tracks only”.
By default, tracks are selected with the up/down arrow keys on the com-
puter keyboard. However, these are also used for selecting events (see 
above) which can lead to confusing results in some cases. Since track 
selection is a most vital operation in both editing and mixing, you have the 
option to use the navigation controls for track selection only. The follow-
ing applies:

• When this option is deactivated and no event/part is selected 
in the Project window, the up/down arrow keys on the com-
puter keyboard are used to step through the tracks in the 
Track list – just as you would expect this to work.

• When this option is deactivated and an event/part is selected in 
the Project window, the up/down arrow keys still step through 
the tracks in the Track list – but on the currently selected track, 
the first event/part will automatically be selected as well. If this 
is not the desired behavior, you have to activate “Use Up/Down 
Navigation Commands for selecting Tracks only”.

Option Description

All Selects all events in the Project window.

None Deselects all events.

In Loop Selects all events that are partly or wholly between 
the left and right locator.

From Start 
to Cursor

Selects all events that begin to the left of the project 
cursor.

From Cursor 
to End

Selects all events that end to the right of the project 
cursor.

Select Controllers
in Note Range

This is available in the MIDI Editors (see “Selecting 
controllers within the note range” on page 174).

All on Selected 
Tracks

Selects all events on the selected track.

Select Event This is available in the Sample Editor (see “Window 
overview” on page 107).

Left/Right Selection 
Side to Cursor

These two functions are only used for range selection 
editing (see “Creating a selection range” on page 35).

! Note that these functions work differently when the 
Range Selection tool is selected (see “Creating a 
selection range” on page 35).

Option Description
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• When this option is activated, the up/down arrow keys are 
only used to change the track selection – the current event/
part selection in the Project window will not be altered.

• Also in the Preferences (Editing–Tools page), you can 
find the Cross Hair Cursor options section.
This allows you to display a cross hair cursor when working in the Project 
window and editors, facilitating navigation and editing, especially when 
arranging in large projects. You can set up the colors for the line and the 
mask of the cross hair cursor, and define its width. The cross hair cursor 
works as follows:

• When the Selection tool (or one of its subtools) is selected, 
the cross hair cursor appears when you start moving/copying 
a part/event, or when using the event trim handles.

• When the Pencil tool, the Scissors tool or any other tool that 
makes use of this function is selected, the cross hair cursor ap-
pears as soon as you move the mouse over the event display.

• The cross hair cursor is only available for tools where such a 
function is of any use. The Mute tool for example does not use 
a cross hair cursor, as you have to click directly on an event to 
mute it.

Moving events

To move events in the Project window, use the following 
methods:

• Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. 
You can only drag events to tracks of the same type. If Snap is activated, 
this determines to which positions you can move the events (see “Snap” 
on page 37).
Note also that you can restrict movement to be either horizontal or verti-
cal only, by holding down [Ctrl]/[Command] while dragging.

• Select the event and edit the Start position in the info line.

• Use the “Move to” functions on the Edit menu.
The following functions are available:

• Use the Nudge buttons in the toolbar.
These move the selected events to the left or right. The amount of move-
ment depends on the selected display format (see “The Project Setup di-
alog” on page 21) and the value set on the Grid pop-up menu.

Here, clicking this button will move the event 2 frames to the right.

The Nudge buttons are not visible in the toolbar by de-
fault. 
You can decide which items should be visible by right-clicking in the 
toolbar and checking them in the pop-up menu that appears. See “The 
Setup dialogs” on page 244 for more information.

! You will note that there is a slightly delayed response 
when you move an event by dragging. This helps you 
avoid accidentally moving events when you click on 
them in the Project window. You can adjust this de-
lay with the Drag Delay setting in the Preferences 
(Editing page).

Function Description

Move to Cursor Moves the selected event to the project cursor position. If 
there are several selected events on the same track, the 
first event will start at the cursor, and the following will be 
lined up end-to-start after the first one.

Move to Origin Moves the selected events to their original positions, i.e. 
the positions at which they were originally recorded.

Move to Front,
Move to Back

This function doesn’t actually change the position of the 
events, but moves the selected events to the front or 
back, respectively. This is useful if you have overlapping 
events, and want to see one that is partially obscured.
For audio events, this is an extra important feature, since 
only the visible sections of events will be played back. 
Moving an obscured audio event to front (or moving the 
obscuring event to back) will allow you to hear the whole 
event on playback.

! When the Range Selection tool is used, the Nudge 
buttons move the selection range (see “Moving and 
duplicating” on page 36).

Function Description
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Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new 
position.
If Snap is activated, this determines to which positions you can copy the 
events (see “Snap” on page 37). 

• Audio and MIDI parts can also be duplicated by press-
ing [Alt]/[Option] + [Shift] and dragging.
This creates a shared copy of the part. If you edit the contents of a 
shared copy, all other shared copies of the same part are automatically 
edited in the same way.

Shared copies are indicated by an icon in the right corner of the part.

Note:

• When you duplicate audio events, the copies are al-
ways shared. This means that shared copies of audio 
events always refer to the same audio clip (see “Audio 
processing” on page 101).

• You can convert a shared copy to a real copy by select-
ing “Convert to Real Copy” from the Edit menu. This cre-
ates a new version of the clip (that can be edited 
independently) and adds this to the Pool. Note that no new 
files are created by this operation.

• Selecting “Duplicate” from the Edit menu creates a 
copy of the selected event and places it directly after the 
original.
If several events are selected, all of these are copied “as one unit”, main-
taining the relative distance between the events.

• Selecting “Repeat...” from the Edit menu opens a dia-
log, allowing you to create a number of copies (regular or 
shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the num-
ber of copies.

• You can also perform the Repeat function by dragging: 
Select the event(s) to repeat, press [Alt]/[Option], click the 
handle in the lower right corner of the last selected event 
and drag to the right.
The longer to the right you drag, the more copies are created (as shown 
by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a num-
ber of copies starting at the left locator and ending at the 
right locator.
The last copy is automatically shortened to end at the right locator.

Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in 
again, using the functions on the Edit menu.

• When you paste an event it is inserted on the selected 
track, positioned so that its snap point is aligned with the 
cursor position.
If the selected track is of the wrong type, the event will be inserted on its 
original track. See “Snap” on page 37 for information about the snap point.

• If you use the “Paste at Origin” function, the event is 
pasted at its original position (the position from which you 
cut or copied it).

Renaming events

By default, audio events show the name of their clip, but 
you can enter a separate descriptive name for separate 
events if you like. This is done by selecting the event and 
typing in a new name in the “Description” field in the info 
line.

• You can also give all events on a track the same name 
as the track by changing the track name, holding down a 
modifier key and pressing [Return].
See “Handling tracks” on page 25.

! If you hold down [Ctrl]/[Command] as well, move-
ment direction is restricted to either horizontal or ver-
tical. That means if you drag an event vertically it can 
not be moved horizontally at the same time.
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Splitting events

You can split events in the Project window in the following 
ways:

• Click with the Scissors tool on the event you want to 
split.
If Snap is activated, this determines the exact split position (see “Snap” 
on page 37). You can also split events by pressing [Alt]/[Option] and 
clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no 
events are selected, all events (on all tracks) that are intersected by the 
project cursor will be split.

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

If you split a MIDI part so that the split position inter-
sects one or several MIDI notes, the result depends on the 
option “Split MIDI Events” in the Preferences (Editing–
MIDI page). 
If the option is activated, the intersected notes will be split (creating new 
notes at the beginning of the second part). If it is deactivated, the notes 
will remain in the first part, but “stick out” after the end of the part.

Gluing events together

You can glue events together using the Glue Tube tool. 
There are three possibilities: 

• Clicking on an event with the Glue Tube tool glues it to-
gether with the next event on the track. The events do not 
have to touch one another.
The result is a part containing the two events, with one exception: If you 
first split an event and then glue the two sections together again (without 
moving or editing them first), they become a single event again.

• You can select several events on the same track and 
click on one of them with the Glue Tube tool.
A single part is created.

• When you hold down [Alt]/[Option] while clicking on an 
event with the Glue Tube tool, this event will be glued to-
gether with all following events on this track.
You can change the default key command for this in the Preferences 
(Editing–Tool Modifiers page).

Resizing events

Resizing events means to move their start or end positions 
individually. In Cubase LE, there are three types of resiz-
ing:

To select one of the resizing modes, select the Arrow tool 
and then click again on the Arrow tool icon on the toolbar. 
This opens a pop-up menu from which you can select one 
of the resizing mode options.

The icon on the toolbar will change, indicating the selected resizing mode.

The actual resizing is done by clicking and dragging the 
lower left or right corner of the event. If Snap is activated, 
the Snap value determines the resulting length (see 
“Snap” on page 37).

Normal sizing.

Resizing type Description

Normal Sizing The contents of the event stay fixed, and the start or end 
point of the event is moved to “reveal” more or less of the 
contents.

Sizing Moves 
Contents

The contents follow the moved start or end of the event 
(see the figure below).

Sizing Applies 
Time Stretch

The contents will be time stretched to fit the new event 
length (see the separate description on “Resizing events 
using time stretch” on page 32).
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Sizing moves contents.

• If several events are selected, all will be resized in the 
same way.

• You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the 
audio under the pointer is played back (scrubbed) while you drag.

• It is also possible to resize events by using the Trim but-
tons (located in the Nudge palette) on the toolbar.
This will move the start or end position of the selected Event(s) by the 
amount set on the Grid pop-up menu. The sizing type currently selected 
applies to this method too, with the exception of “Sizing Applies Time 
Stretch” which is not possible with this method. You can also use key 
commands for this (by default, press [Ctrl]/[Command] and use the left 
and right arrow key).

Note that the Nudge palette is not visible in the toolbar 
by default. See “The Setup dialogs” on page 244 for in-
structions on how to show and hide items in the toolbar.

Resizing events using time stretch

If you want to resize a part and make its contents “fit” the 
new size, you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Siz-
ing Applies Time Stretch” option from the pop-up menu.

2. Point close to the end point of the part you want to 
stretch.

3. Click and drag left or right.
When you move the mouse, a tooltip shows the current mouse position 
and length of the part. Note that the snap value applies, as with any part 
operation.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

• For MIDI parts, this means that the note events are 
stretched (moved and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved, 
and that the referenced audio files are time stretched to fit 
the new length.
A dialog box shows the progress of the time stretch operation.

Sliding the contents of an event or part

You can move the contents of an event or part without 
changing its position in the Project window. By default, this 
is done by pressing [Ctrl]/[Command]+[Alt]/[Option], click-
ing in the event or part and dragging to the left or right.

! When sliding the contents of an audio event, you 
cannot slide past the start or end of the actual audio 
clip. If the event plays the whole clip, you cannot 
slide the audio at all.
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Muting events

To mute individual events in the Project window, proceed 
as follows:

• To mute or unmute a single event, click on it with the 
Mute tool.

• To mute or unmute several events, select them – either 
by using the standard selection techniques, or by using 
one of the options on the Select submenu on the Edit 
menu – and click on one of the selected events with the 
Mute tool.
All selected events will be muted.

• You can also click in an empty area with the Mute tool 
and drag a selection rectangle around several events you 
want to mute or unmute, and then click on one of them 
with the Mute tool.

• You can mute events by selecting them and selecting 
“Mute” from the Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute” 
from the Edit menu.

• You can also change the mute status of selected events 
on the info line.

Muted events can be edited as usual (with the exception 
of adjusting fades), but are not played back.

Muted events are “greyed out”.

• You can also mute whole tracks by clicking the Mute 
(“M”) button in the Track list, the Inspector or the mixer.
Clicking the Solo (“S”) button for a track mutes all other tracks. Note that 
there are two modes for the track solo function: 
If the option “Enable Solo on Selected Track” is activated in the Prefer-
ences (Editing–Project & Mixer page) and you have soloed a track, se-
lecting another track in the track list will automatically solo that track 
instead – the solo state “moves” with the track selection.
If the option isn’t activated, the track you solo stays soloed, regardless of 
the selection.

Removing events

To remove an event from the Project window, use any of 
the following methods:

• Click on the event with the Eraser tool.
Note that if you press [Alt]/[Option] while you click, all following events 
on the same track will be deleted, but not the event you clicked and all 
events before it.

• Select the event(s) and press [Backspace], or select 
“Delete” from the Edit menu.

Creating new files from events

An audio event plays a section of an audio clip, which in 
turn refers to one or more audio files on the hard disk. 
However, in some situations you may want to create a new 
file that consists only of the section played by the event. 
This is done with the function “Bounce Selection” on the 
Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info 
line or using the volume handle) as desired.
These settings will be applied to the new file. For details on fades and 
event volume, see “Creating fades” on page 59.

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing 
only the audio in the original event. A clip for the new file is 
added to the Pool, and the original event is replaced by a 
new event playing the new clip.

• If you click “No”, a new file is created and a clip for the 
new file is added to the Pool.
The original event is not replaced.

You can also apply the Bounce Selection function to an 
audio part. In that case, the audio from all events in the 
part will be combined into a single audio file. If you choose 
“Replace” when asked, the part will be replaced with a 
single audio event playing a clip of the new file.
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Editing in Lane Display mode
You can select the lane mode manually for individual tracks, 
and use it when editing in the Project window. This makes it 
easier to view and handle overlapping events and parts.

Audio tracks

1. In the Track list or in the Inspector for the selected 
track, click the Lane Display Type button and select “Lanes 
Fixed” from the pop-up menu.
The audio track is divided vertically into two lanes. By default, all audio 
events end up in the first (top) lane.

2. Now you can move events or parts between lanes, ei-
ther by dragging or by using the “Move to Next Lane/Pre-
vious Lane” commands on the Edit menu or Quick menu.
Note that if there are overlapping audio events, the audio on the lowest 
lane has playback priority – moving events between lanes affects what 
will be heard!

If the vertical zoom factor is sufficiently high, the sections that will be 
heard on playback are indicated in green.

• Note that there will always be an extra, empty lane at the 
bottom of the track – moving an event there always will 
add another lane.
Depending on the number of lanes used, you may want to adjust the ver-
tical zoom for the track – simply drag the track edges in the track list.

3. After rearranging the overlapping events so that you 
hear what you want, you can select all events and select 
“Delete Overlaps” from the Advanced submenu on the 
Audio menu.
This puts all events in the top lane and resizes events so that overlapping 
sections are removed.

4. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.
If you do this without using the “Delete Overlaps” function, all overlap-
ping sections will be kept. However, the sections that were green will 
now be the sections visible (“on top”) and thus the sections that will be 
heard.

MIDI tracks

1. In the Track list or in the Inspector for the selected 
track, click the Lane Display Type button and select “Lanes 
Auto” or “Lanes Fixed”.

• In Lanes Auto mode, extra lanes will automatically be 
added where necessary – if two MIDI parts overlap, they 
will automatically be put on separate lanes.

• In Lanes Fixed mode, you have to move MIDI parts be-
tween lanes manually (by dragging them or by using the 
“Move to Next Lane/Previous Lane” commands on the 
Edit menu or Quick menu).
In this mode, there will always be an extra, empty lane at the bottom of 
the track – if you move a part there, another lane will be added and so on.

2. You can edit the overlapping parts as usual – by cut-
ting, deleting or muting sections in the Project window or 
by opening them in a MIDI editor.
In an editor, parts on different lanes will be treated just like parts on dif-
ferent tracks – you can use the part list pop-up menu to select an active 
part for editing, etc. 
Note that there is no playback priority between lanes on a MIDI track – all 
unmuted parts will be heard during playback.

3. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.



35

The Project window

Range editing
Editing in the Project window isn’t necessarily restricted 
to handling whole events and parts. You can also work 
with selection ranges, which are independent from the 
event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection 
tool.

When the Range Selection tool is selected, the Select 
submenu on the Edit menu has the following items for 
making selection ranges:

• Double-clicking on an event with the Range Selection 
tool creates a selection range encompassing the event.
If you hold down [Shift] you can double-click several events in a row, and 
the selection range will expand to encompass them all. Double-clicking a 
second time on an event opens it for editing in the Sample Editor.

Adjusting the size of the selection range

You can adjust the size of a selection range in the follow-
ing ways:

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an 
edge of the selection range.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which 
you clicked.

• By adjusting the selection range start or end position on 
the info line.

• By using the Trim buttons on the toolbar.
The left Trim buttons will move the start of the selection range and the 
right buttons will move the end. The edges will be moved by the amount 
specified on the Grid pop-up.

Clicking this Trim button…

…will move the start of the selection range to the right by 1 Beat.

• By using the Nudge buttons on the toolbar.
These will move the whole selection range to the left or the right. The 
amount of movement depends on the selected display format (see “The 
Project Setup dialog” on page 21) and the value specified on the Grid 
pop-up menu.

Option Description

All Makes a selection that covers all tracks, from the start of 
the project to the end (as defined by the Length setting in 
the Project Setup dialog).

None Removes the current selection range.

In Loop Makes a selection between the left and right locator, on 
all tracks.

From Start
to Cursor

Makes a selection on all tracks, from the start of the 
project to the project cursor.

From Cursor 
to End

Makes a selection on all tracks, from the project cursor to 
the end of the project.

All on Selected 
Tracks

Only used for event selection (see “Selecting events” on 
page 28).

Select Event This is available in the Sample Editor (see “Using the Se-
lect submenu” on page 111).

Left Selection 
Side to Cursor

Moves the left side of the current selection range to the 
project cursor position.

Right Selection 
Side to Cursor

Moves the right side of the current selection range to the 
project cursor position.

! Note that the contents of the selection are not 
moved – using the Nudge buttons is the same as ad-
justing the start and end of the selection range at the 
same time, by the same amount.
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The Trim buttons and the Nudge buttons are located 
in the Nudge palette, which is not visible in the toolbar by 
default. 
See “The Setup dialogs” on page 244 for instructions on how to show 
and hide items in the toolbar.

Making selection ranges for several non-contiguous 
tracks

As described above, selection ranges can cover several 
tracks. However, it is also possible to exclude tracks from 
a selection range:

1. Create a selection range from the first to the last de-
sired track.

2. Press [Ctrl]/[Command] and click in the selection range 
on the tracks you want to exclude from the selection.

3. In the same manner, you can add a track to the selec-
tion range by [Ctrl]/[Command]-clicking in the selection 
range area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new 
position.
This will move the contents of the selection range to the new position. If 
the range intersected events or parts, these will be split before moving, 
so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] 
and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as 
when duplicating events (see “Duplicating events” on page 30).

Using Cut, Copy and Paste

When working with selection ranges, you can either use 
Cut, Copy and Paste on the Edit menu, or use the func-
tions “Cut Time” and “Paste Time” on the Range submenu 
on the Edit menu. These work differently to their related 
functions on the Edit menu:

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

• If you use the Delete function on the Edit menu (or press 
[Backspace]), the data within the selection range is re-
placed by empty track space.
Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range sub-
menu, the selection range is removed and events to the 
right are moved to the left to close up the gap.

Function Description

Cut Cuts out the data in the selection range and moves it to 
the clipboard. The selection range is replaced by empty 
track space in the Project window, meaning that events 
to the right of the range keep their positions.

Copy Copies the data in the selection range to the clipboard.

Paste Pastes the clipboard data at the start position and track 
of the current selection. Existing events are not moved to 
make room for the pasted data.

Paste at Origin Pastes the clipboard data back at its original position. Ex-
isting events are not moved to make room for the pasted 
data.

Cut Time Cuts out the selection range and moves it to the clip-
board. Events to the right of the removed range are 
moved to the left to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track 
of the current selection. Existing events are moved to 
make room for the pasted data.

Paste Time at 
Origin

Pastes the clipboard data back at its original position. Ex-
isting events are moved to make room for the pasted data.
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Other functions

On the Range submenu on the Edit menu, you will find 
three more range editing functions:

Options

Snap
The Snap function helps you to find exact positions when 
editing in the Project window. It does this by restricting 
horizontal movement and positioning to certain positions. 
Operations affected by Snap include moving, copying, 
drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon in the 
toolbar.

Snap activated.

When you are moving audio events with Snap activa-
ted, it isn’t necessarily the beginning of the event that is 
used as Snap position reference. Instead, each audio event 
has a snap point, which you can set to a relevant position in 
the audio (such as a downbeat, etc.).
The snap point is set in the Sample Editor since it allows for a higher de-
gree of precision (see “Adjusting the snap point” on page 110).

Exactly how Snap works depends on which mode is se-
lected on the Snap mode pop-up menu.

The following sections describe the different Snap modes.

Grid

In this mode, the Snap positions are set with the Grid 
pop-up menu to the right. The options depend on the dis-
play format selected for the ruler. For example, if the ruler 
is set to show bars and beats, the grid can be set to bars, 
beats or the quantize value set with the next pop-up menu 
to the right. If a time or frame-based ruler format is se-
lected, the grid pop-up menu will contain time or frame-
based grid options, etc.

When Seconds is selected as ruler format, the grid pop-up menu con-
tains time-based grid options.

Grid Relative

When you move events and parts in this mode they will not 
be “magnetic” to the grid. Rather, the grid determines the 
step size for moving the events. This means that a moved 
event will keep its original position relative to the grid.

For example, if an event starts at the position 3.04.01 (one 
beat before bar 4), Snap is set to Grid Relative and the 
Grid pop-up is set to “Bar”, you can move the event in 
steps of one bar – to the positions 4.04.01, 5.04.01 and 
so on. The event will keep its relative position to the grid, 
i.e. stay one beat before the bar lines.

• This only applies when dragging existing events or parts 
– when you create new events or parts this mode works 
like the Grid mode.

Function Description

Split Splits any events or parts that are intersected by the selec-
tion range, at the positions of the selection range edges.

Crop All events or parts that are partially within the selection 
range are cropped, that is, sections outside the selection 
range are removed. Events that are fully inside or outside 
the selection range are not affected.

Insert Silence Inserts empty track space from the start of the selection 
range. The length of the silence equals the length of the 
selection range. Events to the right of the selection range 
start are moved to the right to “make room”. Events that 
are intersected by the selection range start are split, and 
the right section is moved to the right.
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Events

In this mode, the start and end positions of other events 
and parts become “magnetic”. This means that if you drag 
an event to a position near the start or end of another 
event, it is automatically aligned with the start or end of the 
other event. For audio events, the position of the snap 
point is also magnetic (see “Adjusting the snap point” on 
page 110).

• Note that this includes marker events on the marker 
track.
This allows you to snap events to marker positions, and vice versa.

Shuffle

Shuffle mode is useful when you want to change the order 
of adjacent events. If you have two adjacent events and 
drag the first one to the right, past the second event, the 
two events will change places.

The same principle works when changing the order of 
more than two events:

Magnetic Cursor

When this mode is selected, the project cursor becomes 
“magnetic”. Dragging an event near the cursor causes the 
event to be aligned with the cursor position.

Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” 
modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cur-
sor” modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Mag-
netic Cursor” modes.

Snap to Zero Crossing
When this option is activated in the Preferences (Editing–
Audio page), splitting and sizing of audio events is done at 
zero crossings (positions in the audio where the amplitude 
is zero). This helps you avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will 
scroll during playback, keeping the project cursor visible 
in the window.

• If the option “Stationary Cursor” is activated in the Pref-
erences (Transport page), the project cursor will be posi-
tioned in the middle of the screen (if possible).

1 2 3 4 5

52431

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.

! This setting affects all windows in all open projects – 
with the exception of the Sample Editor (which has 
its own Snap to Zero Crossing button).
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Background
This chapter describes the various methods available for 
controlling Playback and Transport functions in Cubase LE.

The Transport panel
Below you can find a brief description of each item on the 
Transport panel.

The pictures below show the Transport panel with all con-
trols visible and in their default position. The Transport 
panel is divided into sections, from left to right.

Note that the Output Activity and Clipping indicator as 
well as the Output Level Control refer to the Main Mix 
Output bus as defined on the Outputs tab in the VST 
Connections window.

• The main Transport functions (Cycle/Stop/Play/Record) 
can also be shown on the toolbar.

In addition, various play options are available on the Trans-
port menu.

Hiding and showing the Transport Panel

The Transport panel is shown by default when you launch 
a new project. To hide or show it, select the “Transport 
Panel” item from the Transport menu (or use a key com-
mand – by default [F2]).

About Preroll and Postroll

These items are described in the chapter “Recording”, 
see “About Preroll and Postroll” on page 55.

Changing the Transport panel setup

You can customize the appearance of the Transport panel 
by right-clicking anywhere on the panel and making selec-
tions on the pop-up menu that appears.

Activates Auto Quantize

Record mode pop-up menu

Cycle Record mode 
pop-up menu

CPU load and Disk Cache meters

Right locator: punch out 
point and end of Cycle

Activates 
punch out

Activates 
punch in

Left locator: record start point, punch 
in point and beginning of Cycle

Postroll setting 
and on/off switch

Preroll setting and 
on/off switch

Time Display and 
format pop-up

Position 
slider

Record

Play

Fast forwardRewind

Stop
Go to next 
marker or 
project end

Nudge position 
right/left

Go to previous 
marker or 
project start

Cycle on/off

Tempo track 
on/off 

Synchronization 
on/off

The tempo and time 
signature display

Metronome click on/off Show Markers (opens 
Marker window)

Jump to Marker

Precount on/off

MIDI In Activity 
(left meter)/
MIDI Out activity

Output Level 
Control

Audio output ac-
tivity and Clipping 
indicator (top)

Audio input activity and Clipping indicator (Default Input channel)
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This is explained in detail in the section “Customizing via 
the setup context menus” on page 244.

The numeric keypad
In the default Key Command settings, various Transport 
panel operations are assigned to the numeric keypad on 
the computer keyboard. The keypads are slightly different 
on PC and Macintosh computers:

Operations

Setting the project cursor position
There are several ways to move the project cursor posi-
tion:

• By using Fast Forward and Rewind.

• By dragging the project cursor in the lower part of the 
ruler. 

• By clicking in the ruler.
Double-clicking in the ruler moves the cursor and starts/stops playback. 

• If the option “Locate when Clicked in Empty Space” is 
activated in the Preferences (Transport page) you can 
click anywhere in an empty section of the Project window 
to move the cursor position.

• By changing the value in the position display.

• By using the position slider above the transport buttons 
in the Transport panel.
The range of the slider relates to the Length setting in the Project Setup 
dialog. Hence, moving the slider all the way to the right will take you to 
the end of the project. 

• By using markers (see “About markers” on page 71).

• By using playback options (see “Playback functions” on 
page 43).

• By using functions on the Transport menu.

The following functions are available:

If Snap is activated when dragging the project cursor, 
the Snap value is taken into account. This is helpful for 
finding exact positions quickly.

There are also numerous key commands available for 
moving the project cursor (in the Transport category in the 
Key Commands dialog). 
For example, you can assign key commands to the “Step Bar” and “Step 
Back Bar” functions, allowing you to move the project cursor in steps of 
one bar, backwards and forwards.

About the Transport panel display format

The time display in the transport panel

The time unit shown in the ruler can be independent from 
the time unit shown in the time display on the Transport 
panel. This means that you can display timecode in the 
transport position display and bars and beats in the ruler, 
for example.

The following rules apply:

• If you change the time format of the time display on the 
Transport panel, the time format of the ruler will be 
changed as well.
This is the same as changing the display format in the Project Setup. 
Therefore, to have different display formats in the ruler and the time dis-
play you should change the format in the ruler.

Numeric Key Function

[Enter] Play

[+] Fast Forward

[-] Rewind

[*] Record

[÷] (Win)/[/] (Mac) Cycle On/Off

[,] Return to Zero

[0] Stop

[1] Go to Left Locator

[2] Go to Right Locator

[3-9] Go to marker 3 to 9

Function Description

Locate Selection/ 
Locate Selection 
End

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must 
have selected one or more events or parts, or made a 
selection range.

Locate Next/
Previous Marker

This moves the project cursor to the closest marker to 
the right or left (see “About markers” on page 71).

Locate Next/
Previous Event

This moves the project cursor forwards or backwards 
respectively, to the closest beginning or end of any 
event on the selected track(s).
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• The time display format is set on the pop-up menu to 
the right in the position display.

• This setting also determines the time format displayed 
for the left and right locators on the Transport panel.

The left and right locators
The left and right locators are a pair of position markers 
used for specifying punch-in and punch-out positions dur-
ing recording, and as boundaries for cycle playback and 
recording. 

When cycle mode is activated on the Transport panel, 
the area between the left and right locator will be repeated 
(cycled) on playback. 
However, if the right locator is positioned before the left, this will work as 
a “jump” or “skip mode” – when the project cursor reaches the right lo-
cator it will immediately jump to the left locator position and continue 
playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click 
at the desired position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right lo-
cator. You can also drag the locator “handles” directly in the ruler.

The locators are indicated by the “flags” in the ruler. The area between 
the locators is highlighted in the ruler and in the Project window (see 
“Appearance” on page 245). Note that if the right locator is before the 
left locator, the color of the ruler between the locators will change (from 
blue to red).

• Click and drag in the upper half of the ruler to “draw” a 
locator range.
If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on 
the numeric keypad sets the left or right locator to the 
project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/
[Command]) to set the project cursor position to the left or right locator 
position. Note that these are default key commands – you can change 
these if you like.

• By creating cycle markers you can store any number of 
left and right locator positions, which can be recalled by 
simply double-clicking on the corresponding marker (see 
“About cycle markers” on page 72).

• The “Locators to Selection” item on the Transport menu 
(default key command [P]) sets the locators to encompass 
the current selection.
This is available if you have selected one or several events or made a se-
lection range.

• You can also adjust the locators numerically in the 
Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will 
move the project cursor to the respective locator. If you press [Alt]/[Op-
tion] and click the L or R button, the corresponding locator will be set to 
the current project cursor position.

Options and Settings

The “Return to Start Position on Stop” 
preference
This setting is found on the Transport page in the Prefer-
ences (found on the File menu under Windows, or on the 
Cubase LE menu under Mac OS X).

• If “Return to Start Position on Stop” is activated when 
you stop playback, the project cursor will automatically re-
turn to the position where recording or playback last 
started.

• If “Return to Start Position on Stop” is deactivated, the 
project cursor will remain at the position where you stop 
playback.
Pressing Stop again will return the project cursor to the position where 
recording or playback last started.

About track disable/enable
For audio tracks, the track context menu contains an item 
named “Disable Track”. This shuts down all disk activity 
for the track, as opposed to using Mute, which merely 
turns down the output volume for a track. For example, if 
you often record “alternative takes” you can easily build up 
a large number of takes on different tracks. Even though 
these tracks are muted, they are actually still “playing 
back” from the hard disk during playback. This puts an un-
necessary load on your disk system, so using “Disable 
Track” is recommended for such situations.
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• Select “Disable Track” for tracks that you want to keep in 
the project for later use (but don’t want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled 
tracks.

Playback functions
Apart from the standard transport controls on the Trans-
port panel, you can also find a number of functions that 
can be used to control playback on the Transport menu. 
The items have the following functionality:

About Chase
Chase is a function that makes sure your MIDI instruments 
sound as they should when you locate to a new position 
and start playback. This is accomplished by the program 
transmitting a number of MIDI messages to your instru-
ments each time you move to a new position in the 
project, making sure all MIDI devices are set up correctly 
with regard to program change, controller messages 
(such as MIDI Volume), etc.

For example, let’s say you have a MIDI track with a pro-
gram change event inserted at the beginning. This event 
makes a synth switch to a piano sound.

At the beginning of the first chorus you have another pro-
gram change event which makes the same synth switch to 
a string sound.

You now play back the song. It begins with the piano 
sound and then switches to the string sound. In the middle 
of the chorus you stop and rewind to some point between 
the beginning and the second program change. The synth 
will now still play the string sound although in this section 
it really should be a piano!

The Chase function takes care of that. If program change 
events are set to be chased, Cubase LE will track the mu-
sic back to the beginning, find the first program change 
and transmit it to your synth, setting it to the correct 
sound.

The same thing can apply to other event types as well. The 
Chase Events settings in the Preferences (MIDI page) de-
termine which event types will be chased when you locate 
to a new position and start playback.

Event types for which the checkbox is activated here 
will be chased.

• In the Chase Events section of the Preferences (MIDI 
page), you will find the option “Chase not limited to Part 
Boundaries”.
When you activate this option, MIDI controllers are also chased outside 
the part boundaries, i.e. the Chase will be performed on the part touched 
by the cursor as well as on all the parts to the left of it. Please note that 
this option should be deactivated for very large projects, as it consider-
ably slows down operations such as positioning and soloing. When you 
deactivate this option, the MIDI controllers are only chased within the 
parts under the position cursor.

Option Description

Play from Selection 
Start/End

Activates playback from the beginning or end of 
the current selection.

Play until Selection 
Start/End

Activates playback two seconds before the start or 
end of the current selection and stops at the selec-
tion start or end, respectively.

Play until Next Marker This activates playback from the project cursor and 
stops at the next marker.

Play Selection Range This activates playback from the start of the current 
selection and stops at the selection end.

Loop Selection This activates playback from the start of the current 
selection and keeps starting over again when 
reaching the selection end.

! The functions listed above (except “Play until Next 
Marker”) are only available if you have selected one 
or more events or made a selection range.
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Background
This chapter describes the various recording methods 
that you can use in Cubase LE. As it is possible to record 
both audio and MIDI tracks, both recording methods are 
covered in this chapter.

Before you start
This chapter assumes that you are reasonably familiar with 
certain basic recording concepts, and that the following 
initial preparations have been made:

• You have properly set up, connected and calibrated 
your audio hardware. 

• You have opened a project and set the project setup 
parameters to your specifications.
Project setup parameters determine the record format, sample rate, 
project length etc. that affect the audio recordings you make during the 
course of the project. See “The Project Setup dialog” on page 21.

• If you plan to record MIDI, your MIDI equipment should 
be set up and connected correctly.

Basic recording methods
This section describes the general methods used for re-
cording. However, there are additional preparations and 
procedures that are specific to audio and MIDI recording 
respectively. Make sure to read these sections before you 
start recording (see “Audio recording specifics” on page 
47 and “MIDI recording specifics” on page 50).

Record-enabling a track
Cubase LE can record on a single track or on several tracks 
(audio and/or MIDI) simultaneously. To make a track ready 
for recording, click the Record Enable button for the track in 
the Track list, in the Inspector or in the mixer. When acti-
vated, the button(s) turn red, indicating record ready mode.

Record Enable in the Inspector, Track list and mixer.

If the option “Enable Record on Selected Track” is ac-
tivated in the Preferences (Editing–Project & Mixer page), 
tracks are automatically record-enabled when you select 
them in the Track list.

The exact number of audio tracks you can record si-
multaneously depends on your computer CPU and hard 
disk performance.
In the Preferences (VST page), you can find the option “Warn on Pro-
cessing Overloads”. When this is activated, a warning message will be 
displayed as soon as the CPU clip indicator (on the Transport panel) 
lights up during recording.

Manually activating recording
You activate recording by clicking the Record button on 
the Transport panel or toolbar or by using the correspon-
ding key command (by default [*] on the numeric keypad).

Recording can be activated in Stop mode (from the current 
cursor position or from the left locator) or during playback:

• If you activate recording in Stop mode, and the option 
“Start Record at Left Locator” is activated on the Trans-
port menu, recording will start from the left locator.
The preroll setting or the metronome count-in will be applied (see “About 
Preroll and Postroll” on page 55).

• If you activate recording in Stop mode, and “Start Record 
at Left Locator” is deactivated, recording will start from the 
current project cursor position.

• If you activate recording during playback, Cubase LE 
will immediately enter Record mode and start recording 
from the current project cursor position.
This is known as “manual punch in”.
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Activating recording in Sync mode

If you are synchronizing the Cubase LE transport to exter-
nal equipment (Sync is activated on the Transport panel) 
and you activate recording, the program will go into 
“record ready” mode (the record button on the Transport 
panel will light up). Recording then starts when a valid 
timecode signal is received (or when you manually click 
the Play button). See the chapter “Synchronization” on 
page 216 for more information.

Automatically activating recording
Cubase LE can automatically switch from playback to re-
cording at a given position. This is known as “automatic 
punch in”. A typical use for this would be if you need to re-
place a section of a recording, and want to listen to what 
is already recorded, up to the recording start position.

1. Set the left locator to the position where you want re-
cording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left 
locator.
When the project cursor reaches the left locator, recording is automati-
cally activated.

Stopping recording
Again, this can be done automatically or manually:

• If you click the Stop button on the Transport panel (or 
use the corresponding key command, by default [0] on the 
numeric keypad), recording is deactivated and Cubase LE 
goes to Stop mode.

• If you click the Record button (or use the key command 
for recording, by default [*]), recording is deactivated but 
playback continues.
This is known as “manual punch out”.

• If the Punch Out button is activated on the Transport 
panel, recording will be deactivated when the project cur-
sor reaches the right locator.
This is known as “automatic punch out”. By combining this with auto-
matic punch in, you can set up a specific section to record – again very 
useful if you want to replace a certain part of a recording. See also “Stop 
after Automatic Punch Out” on page 55.

Punch In and Out activated.

Cycle recording
Cubase LE can record and play back in a cycle – a loop. 
You specify where the cycle starts and ends by setting the 
left and right locators. When the cycle is active, the se-
lected section is seamlessly repeated until you hit Stop or 
deactivate cycle mode.

• To activate cycle mode, click the cycle button on the 
Transport panel.
If you now start playback, the section between the left and right locator is 
repeated indefinitely until you stop.

Cycle activated

• To record in cycle mode, you can start recording from 
the left locator, from before the locators or from within the 
cycle, in Stop mode or during playback.
As soon as the project cursor reaches the right locator, it will jump back 
to the left locator and continue recording a new lap.

• The results of cycle recording depend on the selected 
cycle record mode and are different for audio (see “Re-
cording audio in cycle mode” on page 50) and MIDI (see 
“Recording MIDI in cycle mode” on page 53).
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Audio recording specifics

Selecting a recording file format
The format for recorded files is set in the Project Setup 
dialog on the Project menu. There are three settings: sam-
ple rate, record format (bit depth) and record file type. 
While the sample rate is set once and for all when you 
start working on a new project, the bit depth and file type 
can be changed at any time.

Record file type

The Record File Type setting determines which type of 
files will be created when you record:

Record format (bit depth)

The available options are 16 bit and 24 bit. Use the follow-
ing guidelines:

• Normally, select the record format according to the bit 
depth delivered by your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), 
you may want to record at 24 bit resolution to capture the full bit depth. 
On the other hand, if your hardware has 16 bit inputs, it’s pointless to 
record with a higher bit depth – this will only make the audio files larger, 
with no difference in audio quality.

• The higher the bit depth, the larger the files and the 
more strain is put on the disk system.
If this is an issue, you may want to lower the record format setting.

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono or stereo. This 
allows you to record or import a file containing multiple 
channels and treat it as one entity, with no need to split it 
up into several mono files etc. The signal path for an audio 

track maintains its channel configuration all the way from 
the input bus, via EQ, level and other mixer settings to the 
output bus.

You specify the channel configuration for a track when you 
create it:

1. Select “Add Audio Track” from the Track list context 
menu or the Project menu (or double-click in an empty 
area of the Track list when an audio track is selected – 
when a MIDI track is selected, double-clicking in the Track 
list creates a new MIDI track).
A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
You can choose between mono and stereo.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer, 
a corresponding channel strip appears. You cannot change the channel 
configuration for a track.

Selecting an input bus for a track

Here we assume that you have added and set up the re-
quired input busses (see “Setting up busses” on page 
10). Before you record, you need to specify from which in-
put bus the track should record. You can do this in the In-
spector:

• In the Inspector, you select an input bus on the Input 
Routing pop-up menu in the top section.
As described in the section “The Inspector” on page 17, the Inspector 
shows the settings for the selected track. You show or hide the Inspector 
clicking the “Show Inspector” button on the Project window toolbar.

File type Description

Wave File Wave files have the extension “.wav” and are a common file 
format on the PC platform.

AIFF File Audio Interchange File Format, a standard defined by Apple 
Computer Inc. AIFF files have the extension “.aif” and are used 
on most computer platforms. Like Broadcast Wave files, AIFF 
files can contain embedded text strings (see below).

! For further information on the Project Setup dialog, 
see “The Project Setup dialog” on page 21.

Click here to select an 
input bus for the track.

Click here to show/hide the Inspector.
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Setting input levels
When recording digital sound, it’s important to set the in-
put levels correctly – loud enough to ensure low noise and 
high audio quality, but not so loud that clipping (digital dis-
tortion) occurs.

Clipping typically occurs in the audio hardware when a 
too loud analog signal is converted to digital in the hard-
ware’s A/D converters. 

You need to check the level at the channel strip for the 
track on which you are recording:

1. Locate the channel strip for the track you’re about to 
record on.

2. Activate monitoring for the channel by clicking the 
speaker button next to the fader.
When monitoring is activated, the meter shows the level of the incoming 
audio signal.

3. Play the audio source that you want to record and 
check the level meter for the channel.

4. Adjust the output level of your audio source so that the 
meters go reasonably high without reaching 0.0 dB.
Check the numerical peak level indicator below the meter in the bus 
channel strip. To reset the peak level indicator, click on it.

You must adjust the output level of the audio source – 
you cannot use the faders in Cubase LE to adjust the in-
put level!

An alternative way of checking the input levels would 
be to use the control panel for your audio hardware (if it 
features input level meters). It may also be possible to ad-
just the input level in the control panel.
See the documentation of your audio hardware for details.

Monitoring
In this context, “monitoring” means listening to the input 
signal during recording. There are three fundamentally dif-
ferent ways to do this: via Cubase LE, externally (by 
listening to the signal before it reaches Cubase LE), or by 
using ASIO Direct Monitoring (which is a combination of 
both other methods – see below).

Monitoring via Cubase LE

If you monitor via Cubase LE, the input signal is mixed in 
with the audio playback. The advantage of this is that you 
can adjust the monitoring level and panning in the mixer, 
and add effects and EQ to the monitor signal just as dur-
ing playback (using the track’s channel strip – not the in-
put bus!). 

The disadvantage of monitoring via Cubase LE is that the 
monitored signal will be delayed according to the latency 
value (which depends on your audio hardware and driv-
ers). Therefore, monitoring via Cubase LE requires an au-
dio hardware configuration with a low latency value. You 
can check the latency of your hardware in the Device 
Setup dialog (VST Audio System page).

If you are using plug-in effects with large inherent de-
lays, the automatic delay compensation function in Cu-
base LE will increase the latency.
If this is a problem, you can use the Constrain Delay Compensation func-
tion while recording, see “Constrain Delay Compensation” on page 145.

When monitoring via Cubase LE, you can select one of 
four Auto Monitoring modes in the Preferences (VST 
page):

• Manual.
This option allows you to turn input monitoring on or off by clicking the 
Monitor button in the Inspector, the Track list or in the mixer.
• While Record Enabled.
With this option, you will hear the audio source connected to the channel 
input whenever the track is record enabled.
• While Record Running.
This option switches to input monitoring only during recording.
• Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in 
Stop mode and during recording, but not during playback.
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External monitoring

External monitoring (listening to the input signal before it 
goes into Cubase LE) requires some sort of external mixer 
for mixing the audio playback with the input signal. This 
can be a stand-alone physical mixer or a mixer application 
for your audio hardware, if this has a mode in which the in-
put audio is sent back out again (usually called “Thru”, 
“Direct Thru” or similar).

When using external monitoring, you cannot control the 
level of the monitor signal from within Cubase LE or add 
VST effects or EQ to the monitor signal. The latency value 
of the audio hardware configuration does not affect the 
monitor signal in this mode.

If you want to use external monitoring, you need to 
make sure that monitoring via Cubase LE isn’t activated as 
well.
Select the “Manual” monitoring mode in the Preferences (VST page) and 
don’t activate the Monitor buttons.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may sup-
port ASIO Direct Monitoring. In this mode, the actual mo-
nitoring is done in the audio hardware by sending the 
input signal back out again. However, monitoring is con-
trolled from Cubase LE. This means that the audio hard-
ware’s direct monitoring feature can be turned on or off 
automatically by Cubase LE, just as when using internal 
monitoring.

• To activate ASIO Direct Monitoring, open the Device 
Setup dialog on the Devices menu and check the Direct 
Monitoring checkbox on the VST Audio System page.
If the checkbox is greyed out, your audio hardware (or its driver) doesn’t 
support ASIO Direct Monitoring. Consult the audio hardware manufac-
turer for details.

• When ASIO Direct Monitoring is activated, you can se-
lect a monitoring mode in the Preferences (VST page), as 
when monitoring via Cubase LE (see “Monitoring via Cu-
base LE” on page 48).

• Depending on the audio hardware, it may also be possi-
ble to adjust monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor 
signal in this mode, since the monitor signal doesn’t pass 
through Cubase LE.

• Depending on the audio hardware, there may be special 
restrictions as to which audio outputs can be used for di-
rect monitoring.
For details on the routing of the audio hardware, see its documentation.

• The latency value of the audio hardware configuration 
does not affect the monitor signal when using ASIO Direct 
Monitoring.

Recording
Recording is done using any of the general recording 
methods (see “Basic recording methods” on page 45). 
When you finish recording, an audio file is created in the 
Audio folder within the project folder. In the Pool, an audio 
clip is created for the audio file, and an audio event that 
plays the whole clip appears on the recording track. Fi-
nally, a waveform image is calculated for the audio event. If 
the recording was very long, this may take a while.

If the option “Create Audio Images During Record” is 
activated in the Preferences (Record page), the waveform 
image will be calculated and displayed during the actual 
recording process.
This real-time calculation uses some processing power – if your proces-
sor is slow or you are working on a CPU-intensive project, you should 
consider turning this option off.

Undoing recording

If you decide that you don’t like what you just recorded, 
you can delete it by selecting Undo from the Edit menu. 
The following will happen:

• The event(s) you just created will be removed from the Project 
window.

• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard 

disk.

However, since their corresponding clips are moved to 
the Trash folder, you can delete the files by opening the 
Pool and selecting “Empty Trash” from the Media menu, 
see “Deleting from the hard disk” on page 133.
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Recording overlapping events
The basic rule for audio tracks is that each track can play 
back a single audio event at a time. This means that if two 
or more events are overlapping, only one of them will be 
heard at any given time.

What happens when you record overlapping events 
(record in an area where there are already events on the 
track) depends on the Linear Record Mode setting on the 
Transport panel:

• In “Normal” or “Merge” mode, recording where some-
thing has already been recorded creates a new audio 
event that overlaps the previous one(s).
When you record audio, there is no difference between “Normal” and 
“Merge” mode – the difference only applies to MIDI recording (see 
“About overlap and the Record Mode setting” on page 52).

• In “Replace” mode, existing events (or portions of 
events) that are overlapped by the new recording will be 
removed.
This means that if you record a section in the middle of a longer existing 
recording, that original event will be cut into two events with a gap for the 
new event.

Which event will be heard?

If two or more events are overlapping, you will only hear 
the events (or portions of events) that are actually visible. 
Overlapped (hidden) events or sections are not played 
back.

• The functions “Move to Front” and “Move to Back” on 
the Edit menu (see “Moving events” on page 29) are use-
ful for managing overlapping events, as is the “To Front” 
function (see below).

Recording audio in cycle mode
If you are recording audio in cycle mode, the result de-
pends on the “Cycle Record Mode” setting on the Trans-
port panel:

Cycle Record Modes on the Transport panel

There are three different modes on the Transport panel. 
For audio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the 
last completely recorded lap) is kept as an audio event.

MIDI recording specifics

Activating MIDI Thru
Normally, when working with MIDI, you will have MIDI Thru 
activated in Cubase LE, and Local Off selected in your 
MIDI Instrument(s). In this mode, everything you play dur-
ing recording will be “echoed” back out again on the MIDI 
output and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in 
the Preferences (MIDI page).

2. Record enable the track(s) on which you want to 
record.
Now, incoming MIDI is “echoed” back out again for all record-enabled 
MIDI tracks. 

If you just want to use the Thru function for a MIDI 
track without recording, activate the monitor button for the 
track instead.
This is useful e.g. if you want to try out different sounds or play a VST 
instrument in real time without recording your playing.

Record Enable button. Monitor button.
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Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the 
same time, each on a different MIDI channel. This is the 
key to playing back several sounds (bass, piano etc.) from 
the same instrument. Some devices (such as General 
MIDI compatible sound modules) always receive on all 16 
MIDI channels. If you have such an instrument, there’s no 
specific setting you need to make in the instrument. On 
other instruments, you will have to use the front panel con-
trols to set up a number of “Parts”, “Timbres” or similar so 
that they receive on one MIDI channel each. See the man-
ual that came with your instrument for more information.

Naming MIDI ports in Cubase LE

MIDI inputs and outputs are often displayed with unneces-
sarily long and complicated names. However, you can re-
name your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the MIDI Port Setup item in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which 
device to choose depends on your system.

3. To change the name of a MIDI port, click in the “Show 
As” column and type in a new name.
After closing the dialog, the new name will appear on the MIDI Input and 
Output Routing pop-up menus.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector (the area 
to the left of the Track list in the Project window):

1. If the Inspector is hidden, click the Show Inspector 
button on the toolbar.

2. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The 
Inspector shows the settings for the first selected track (for details, see 
“The Inspector” on page 17).

3. Click the track name in the Inspector to make sure the 
topmost section is shown.

4. Pull down the Input Routing pop-up menu and select 
an input.
The available MIDI inputs are shown. The items on the menu depend on 
the type of MIDI interface you are using etc. 

• If you select the “All MIDI Inputs” option, the track will receive 
MIDI data from all available MIDI inputs.

• If you hold down [Alt]/[Option] and select a MIDI input, this is 
selected for all MIDI tracks.

• If you hold down [Shift] and select a MIDI input, this is se-
lected for all selected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI input, 
this is selected for all MIDI tracks within the same folder track 
(see “Folder tracks” on page 18).

Setting the MIDI channel and output

The MIDI channel and output settings determine where 
the recorded MIDI is routed during playback, but are also 
relevant for MIDI Thru in Cubase LE. Channel and output 
can be selected in the Track list or in the Inspector. The 
procedure below describes how to make the settings in 
the Inspector, but it can be done in largely the same man-
ner in the Track list as well.

1. To select the track(s) and show the settings in the 
Inspector, proceed as when selecting a MIDI input (see 
above).
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2. Pull down the Output routing pop-up menu and select 
an output.
The available MIDI outputs are shown. The items on the menu depend on 
what type of MIDI interface you are using etc.

• If you hold down [Alt]/[Option] and select a MIDI output, this is 
selected for all MIDI tracks.

• If you hold down [Shift] and select a MIDI output, this is se-
lected for all selected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI output, 
this is selected for all MIDI tracks within the same folder track 
(see “Folder tracks” on page 18).

3. Use the channel pop-up menu to select a MIDI chan-
nel for the track.

• If you set the track to MIDI channel “Any”, each MIDI 
event on the track will be sent out on the channel stored in 
the event itself.
In other words, the MIDI material will be played back on the channel(s) 
used by the MIDI input device (the MIDI instrument you play during re-
cording).

Selecting a sound
You can select sounds from within Cubase LE by instruct-
ing the program to send Program Change and Bank Se-
lect messages to your MIDI device. This is done using the 
“Patch Selector” and “Bank Selector” fields in the Inspec-
tor or Track list.

Program Change messages give access to 128 different 
program locations. If your MIDI instruments have more 
than 128 programs, Bank Select messages (set in the 
“Bank Selector” field) allow you to select different banks, 
each containing 128 programs.

Bank Select messages are recognized differently by 
different MIDI instruments. The structure and numbering 
of banks and programs may also vary. Consult the docu-
mentation of your MIDI instruments for details.

Recording
Recording MIDI is done according to the basic recording 
methods (see “Basic recording methods” on page 45). 
When you finish recording, a part containing MIDI events 
is created in the Project window.

About overlap and the Record Mode setting

MIDI tracks are different from audio tracks when it comes 
to overlapping parts:

All events in overlapping parts are always played back.
If you record several parts at the same locations (or move parts so that 
they overlap), you will hear the events in all parts on playback, even 
though some of the parts are obscured in the Project window.

When recording overlapping parts, the result depends on 
the Linear Record Mode setting on the Transport panel:

• If Linear Record Mode is set to “Normal”, overdub recording 
works as with audio tracks, i.e. if you record again where 
something has already been recorded, you get a new part that 
overlaps the previous one(s).

• If Linear Record Mode is set to “Merge”, the overdubbed 
events are added to the existing part.

• If Linear Record Mode is set to “Replace”, the new recording 
replaces any existing events in the area on that track.
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About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch 
in/out recording for MIDI tracks is done in exactly the 
same way as for audio tracks. There is one thing to note, 
however: 

• Punching in and out on recordings with Pitch Bend or 
controller data (modulation wheel, sustain pedal, volume 
etc.) may lead to strange effects (apparently hanging 
notes, constant vibrato etc.).
If this happens, you may need to use the Reset item on the MIDI menu 
(see “The Reset function” on page 54).

About the Automatic MIDI Record Quantize function

If Auto Quantize is activated on the Transport panel (the 
“Auto Q” button), the notes you record are automatically 
quantized according to the current Quantize settings. For 
more information about quantizing, see “The Quantizing 
functions” on page 155.

Recording MIDI in cycle mode
When you record MIDI in cycle mode, the result depends 
on which Cycle Record mode is selected on the Transport 
panel:

Cycle Record mode: Mix (MIDI)

For each completed lap, everything you record is added to 
what was previously recorded in the same part. This is 
useful for building up rhythm patterns, for example. 
Record a hi-hat part on the first lap, the bass drum part on 
the second lap etc. 

Cycle Record mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI mes-
sage), all MIDI you have recorded on previous laps is over-
written from that point on in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take wasn’t good enough – you start directly 
with a new take on the next cycle lap and overwrite the 
first take.

3. After recording the second take you let the recording 
roll on and listen, without playing anything. 
You find that the take was good up until bar seven, for example.

4. On the next lap, wait until bar seven, then start playing.
This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins 
– otherwise you will overwrite the entire take.

Cycle Record mode: Keep Last

Each completed lap replaces the previously recorded lap. 
Note:

• The cycle lap must be completed – if you deactivate re-
cording or press Stop before the cursor reaches the right 
locator, the previous take will be kept.

• If you don’t play or input any MIDI during a lap, nothing 
happens (the previous take will be kept).

Recording different types of MIDI messages

Notes

When you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key 
up) message are sent out. The MIDI note message also 
contains the information which MIDI channel was used. 
Normally, this information is overridden by the MIDI chan-
nel setting for the track, but if you set the track to MIDI 
channel “Any”, the notes will be played back on their orig-
inal channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation 
wheel, sustain pedal, volume etc.) are considered as MIDI 
continuous events (as opposed to the momentary key 
down and key up messages). If you move the Pitch bend 
wheel on your synthesizer while recording, this movement 
is recorded together with the key (Note On and Note Off 
messages), just as you’d expect. But the continuous mes-
sages can also be recorded after the notes have been re-
corded (or even before). They can also be recorded on 
their own tracks, separately from the notes to which they 
belong. 

Say, for instance, that you record one or several bass 
parts on track 2. If you now set another track, like track 55, 
to the same output and MIDI channel as track 2, you can 
make a separate recording of just pitch bends for the bass 
parts on track 55. This means that you activate recording 

! You can decide exactly which event types should be 
recorded by using the MIDI filters – see “Filtering 
MIDI” on page 55.



54

Recording

as usual and only move the pitch bend wheel during the 
take. As long as the two tracks are set to the same output 
and MIDI channel, it will appear to the MIDI instrument as 
if the two recordings were made at the same time.

Program Change messages

Normally, when you switch from one program to another 
on your keyboard (or whatever you use to record), a num-
ber corresponding to that program is sent out via MIDI as 
a Program Change message. These can be recorded on 
the fly with the music, recorded afterwards on a separate 
track, or manually entered in the Key or List Editors. 

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI mes-
sage used to send data that only makes sense to a unit of 
a certain make and type. SysEx can be used to transmit a 
list of the numbers that make up the settings of one or 
more sounds in a synth. For more about viewing and edit-
ing SysEx messages, see the chapter “Working with Sys-
tem Exclusive messages” on page 201.

The Reset function
The Reset function on the MIDI menu sends out note-off 
messages and resets controllers on all MIDI channels. 
This is sometimes necessary if you experience hanging 
notes, constant vibrato, etc.

• Cubase LE can also automatically perform a MIDI reset 
on stop.
You can turn this function on or off in the Preferences (MIDI page).

• Also in the Preferences (MIDI page), you can find the 
option “Insert Reset Events after Record”.
This is a very handy function for MIDI recording. At the end of each re-
corded part, a Reset event will be inserted, resetting controller data such 
as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, etc. This 
is useful if a MIDI part is recorded and e.g. the Sustain pedal is still held 
after stopping recording. Usually, this would cause all following parts to 
be played with Sustain, as the Pedal Off command was not recorded. 
This can be prevented by activating “Insert Reset Events after Record”.

Retrospective Record
This feature allows you to capture any MIDI notes you play 
in Stop mode or during playback and turn them into a MIDI 
part “after the fact”. This is possible due to the fact that 
Cubase LE can capture MIDI input in buffer memory, even 
when not recording.

Proceed as follows:

1. Enable the Retrospective Record function in the Pref-
erences (Record page).
This activates the buffering of MIDI input, making Retrospective Record 
possible.

2. Make sure a MIDI track is record-enabled.

3. When you have played some MIDI material you want 
to capture (either in Stop mode or during playback), select 
Retrospective Record from the Transport menu (or use 
the key command, by default [Shift]+[Pad*]).

The content of the MIDI buffer (i.e. what you just played) is 
turned into a MIDI part on the record enabled track. The 
part will appear where the project cursor was when you 
started playing – this means that if you played along dur-
ing playback, the captured notes will end up exactly where 
you played them in relation to the project.

• The Retrospective Record Buffer Size setting in the 
Preferences (Record page) determines how much data 
can be captured.

MIDI Preferences
There are several other options and settings in the Prefer-
ences that affect MIDI recording and playback:

MIDI page

• Length Adjustment
Adjusts the length of notes so that there is always a short time between 
the end of one note and the start of another (of the same pitch and on the 
same MIDI channel). The time is set in ticks. By default there are 120 
ticks per 1/16 note.

Record page

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be length-
ened to start and end at whole bar positions. If you are working in a 
Bars+Beats-based context, this can make editing (moving, duplicating, 
repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track 
is automatically record-enabled. Furthermore, Record Enable is deacti-
vated for all other MIDI tracks until you close the editor again.
This makes it easier to record MIDI data when you’re editing a part – you 
will always be sure the recorded data ends up in the edited part and not 
on any other track.
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• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make 
sure the very start of the recording is included. A very annoying scenario is 
when you have recorded a perfect MIDI take, only to find out that the very 
first note wasn’t included – because you started playing a little bit too early! 
If you raise the Record Catch Range, Cubase LE will catch the events 
played just before the recording start point, eliminating this problem. 

For a description of the other options, click the Help but-
ton in the Preferences.

Filtering MIDI

The MIDI–MIDI Filter page in the Preferences allows you 
to prevent certain MIDI messages from being recorded 
and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

Options and Settings

Recording-related Transport Preferences
A couple of settings in the Preferences (Transport page) 
are relevant for recording. Set these according to your 
preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is auto-
matically deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after 
automatic punch out (when the project cursor reaches the 
right locator and punch out is activated on the Transport 
panel). If the postroll value on the Transport panel is set to 
a value other than zero, playback will continue for the set 
time before stopping (see below).

About Preroll and Postroll

The preroll and postroll value fields (below the left/right 
locator fields) on the Transport panel have the following 
functionality:

• By setting a preroll value, you instruct Cubase LE to “roll 
back” a short section whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant 
when recording from the left locator (punch in activated on the Transport 
panel) as described below.

Section Description

Record Activating any of these options prevents that type of MIDI 
message from being recorded. It will, however, be thru-
put, and if already recorded, it will play back normally.

Thru Activating any of these options prevents that type of MIDI 
message from being thruput. It will, however, be recorded 
and played back normally.

Channels If you activate a channel button, no MIDI messages on 
that MIDI channel will be recorded or thruput. Already re-
corded messages will, however, be played back normally.

Controller Allows you to prevent certain MIDI controller types from 
being recorded or thruput.
To filter out a controller type, select it from the list at the 
top of the Controller section and click “Add”. It will ap-
pear on the list below.
To remove a controller type from the list (allow it to be re-
corded and thruput), select it in the lower list and click 
“Remove”.

Section Description

Preroll value field and on/
off switch.

Postroll value field and 
on/off switch.
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• By setting a postroll value, you instruct Cubase LE to 
play back a short section after automatic punch out before 
stopping.
This is only relevant when punch out is activated on the Transport panel 
and “Stop after Automatic Punch Out” is activated in the Preferences 
(Transport page).

• To turn preroll or postroll on or off, click the correspond-
ing button on the Transport panel (next to the pre/postroll 
value) or use the “Use Preroll” and “Use Postroll” options 
on the Transport menu.

An example:

1. Set the locators to where you want to start and end re-
cording.

2. Activate Punch in and Punch out on the Transport 
panel.

3. Activate the option “Stop after Automatic Punch Out” 
in the Preferences (Transport page).

4. Set suitable preroll and postroll times by clicking in the 
corresponding fields on the Transport panel and typing in 
time values.

5. Activate preroll and postroll by clicking the buttons 
next to the preroll and postroll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field 
and playback starts. When the cursor reaches the left locator, recording 
is automatically activated. When the cursor reaches the right locator, re-
cording is deactivated, but playback continues for the time set in the 
postroll field before stopping.

Using the metronome
The metronome can output a click that can be used as a 
timing reference. The two parameters that govern the tim-
ing of the metronome are tempo and time signature, and 
these are edited in the Tempo Track window (see “Editing 
the tempo curve” on page 208).

You can use the metronome for a click during recording 
and/or playback or for a precount (count-in) that will be 
heard when you start recording from Stop mode. Click 
and precount are activated separately:

• To activate the metronome, click the Click button on the 
Transport panel.
You can also activate the “Metronome On” option on the Transport menu 
or use the corresponding key command (by default [C]).

• To activate the precount, click the Precount button on 
the Transport panel.
You can also activate the “Precount On” option on the Transport menu 
or set up a key command for this.

Metronome settings

You make settings for the metronome in the Metronome 
Setup dialog, opened from the Transport menu.

The metronome can use either an audio click played back 
via the audio hardware, send MIDI data to a connected 
device which will play back the click or do both. 

The following metronome settings are available in the dia-
log:

Metronome 
Options

Description

Metronome in 
Record / Play

Allows you to specify whether the metronome should be 
heard during playback, recording or both (when Click is 
activated on the Transport panel).

Use 
Count Base

If this option is activated, a field appears to the right 
where you specify the “rhythm” of the metronome. Nor-
mally, the metronome plays one click per beat, but setting 
this to e.g. “1/8” gives you eighth notes – two clicks per 
beat. It’s also possible to create unusual metronome 
rhythms such as triplets etc.

Click on/off Precount on/off
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Recovery of audio recordings after 
system failure
Normally, when a computer crashes, all changes made to 
your current project since you last saved it will be lost. 
Usually, there is no quick and easy way to recover your 
work.

With Cubase LE, when your system crashes while you are 
recording (because of a power cut or other mishap), you 
will find that your recording is still available, from the mo-
ment when you started recording to the time when your 
computer crashed.

When you experience a computer crash during a record-
ing, simply relaunch the system and check the project 
record folder (by default this is the Audio subfolder inside 
the project folder). It should contain the audio file you 
were recording at the time of the crash.

Precount 
Options

Description

Precount Bars Sets the number of bars the metronome will count in be-
fore it starts recording if precount is activated on the 
Transport panel.

Use Time Signa-
ture at Record 
Start Time

When this is activated, the precount will automatically 
use the time signature and tempo set at the position 
where you start recording.

Use Time 
Signature at 
Project Time

When this is activated, the precount will be in the time 
signature set in the Tempo track. Furthermore, any tempo 
changes in the Tempo track during the precount will be 
applied.

Use Signature… This lets you set a time signature for the precount. In this 
mode, tempo changes in the Tempo track won’t affect 
the precount.

MIDI Click Description

Activate MIDI 
Click

Selects whether or not the metronome will sound via 
MIDI.

MIDI Port/
Channel

This is where you select a MIDI output and channel for 
the metronome click.

Hi Note/
Velocity

Sets the MIDI note number and velocity value for the 
“high note” (the first beat in a bar). 

Lo Note/
Velocity

Sets the MIDI note number and velocity for the “low 
notes” (the other beats). 

Audio Click Description

Activate Audio 
Click

Selects whether or not the metronome will sound via the 
audio hardware. Use the Audio Click Volume slider to set 
the level of the click.

! Please note: This feature does not constitute an 
“overall” guarantee by Steinberg. While the program 
itself was improved in such a way that audio record-
ings can be recovered after a system failure, it is al-
ways possible that a computer crash, power cut, etc. 
might have damaged another component of the 
computer, making it impossible to save or recover 
any of the data.

! Warning: Please do not try to actively bring about 
this kind of situation to test this feature. Although the 
internal program processes have been improved to 
cope with such situations, Steinberg cannot guaran-
tee that other parts of the computer are not damaged 
as a consequence.
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Creating fades
There are two main types of fade-ins and fade-outs in au-
dio events in Cubase LE: fades created by using the fade 
handles (see below) and fades created by processing 
(see “Fades created by processing” on page 60).

Fades created by using the fade handles
Selected audio events have blue handles in the upper left 
and right corners. These can be dragged to create a fade-
in or fade-out respectively.

Creating a fade-in. The fade is automatically reflected in the shape of 
the event’s waveform, giving you a visual feedback of the result when 
you drag the fade handle. 

Fades created with the handles are not applied to the au-
dio clip as such but calculated in real time during play-
back. This means that several events referring to the same 
audio clip can have different fade curves. It also means 
that having a huge number of fades may demand a lot of 
processor power.

• If you select multiple events and drag the fade handles 
on one of them, the same fade will be applied to all se-
lected events.

• A fade can be edited in the Fade dialog, as described 
on the following pages. 
You open the dialog by double-clicking in the area above the fade curve, 
or by selecting the event and selecting “Open Fade Editor(s)” from the 
Audio menu (note that this will open two dialogs if the event has both 
fade-in and fade-out curves).
If you adjust the shape of the fade curve in the Fade dialog, this shape 
will be maintained when you later adjust the length of a fade.

• You can make the fade longer or shorter at any time, by 
dragging the handle.
You can actually do this even without selecting the event first, i.e. without 
visible handles. Just move the mouse pointer along the fade curve until 
the cursor turns into a bidirectional arrow, then click and drag.

• If the option “Show Event Volume Curves Always” is ac-
tivated in the Preferences (Event Display–Audio page), 
the fade curves will be shown in all events, regardless of 
whether they are selected or not.
If the option is deactivated, the fade curves are shown in selected events 
only.

Creating and adjusting fades with the Range Selection 
tool

“Handle-type” fades can also be created and adjusted 
with the Range Selection tool, in the following way:

1. Select a section of the audio event with the Range Se-
lection tool.
The result depends on your selection, in the following way:

• If you select a range from the beginning of the event, a fade-in 
will be created within the range. 

• If you select a range that reaches the end of an event, a fade-
out will be created in the range. 

• If you select a range encompassing a middle section of the 
event, but not reaching neither the start nor the end, both a 
fade-in and a fade-out will be created outside of the selected 
range. In other words, the fade-in will cover the area from the 
beginning of the event to the beginning of the selected range, 
and the fade-out will cover the area from the end of the se-
lected range to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to 
Range”.
The fade areas are adjusted according to the selection range.

! You can select multiple audio events on separate 
tracks with the Range Selection tool, and apply the 
fade to all of them simultaneously.
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About the volume handle

A selected audio event also has a blue handle in the top 
middle. This is the volume handle, and it provides a quick 
way of changing the volume of an event, directly in the 
Project window. It is linked directly to the volume setting 
on the info line, that is, dragging the volume handle also 
changes the value on the info line.

Removing fades

To remove the fades for an event, select the event and se-
lect “Remove Fades” from the Audio menu.

You can also use the Range Selection tool to remove 
fades and crossfades within the selected range:

1. Drag the Range Selection tool in the Project window, 
so that the selection encloses all of the fades and cross-
fades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

Fades created by processing
If you have selected an audio event or a section of an au-
dio event (using the Range Selection tool), you can apply 
a fade-in or fade-out to the selection by using the “Fade 
In” or “Fade Out” functions on the Process submenu on 
the Audio menu. These functions open the corresponding 
Fade dialog, allowing you to specify a fade curve.

Fades created this way are applied to the audio clip rather 
than to the event. Please note the following:

• If you later create new events that refer to the same clip, 
these will have the same fades.

If other events refer to the same audio clip, you will be 
asked whether you want the processing to be applied to 
these events or not.

• Continue will apply the processing to all events that re-
fer to the audio clip.

• New Version will create a separate, new version of the 
audio clip for the selected event.

• You can also activate “Do not show this message 
again”. 
Regardless of whether you then choose “Continue” or “New Version”, 
any further processing will conform to the option you select.

The Fade dialogs
The Fade dialogs appear when you edit an existing fade or 
use the “Fade In”/“Fade Out” functions on the Process 
submenu on the Audio menu. The picture below shows 
the Fade In dialog; the Fade Out dialog has identical set-
tings and features.

• If you open the Fade dialog(s) with several events se-
lected, you can adjust the fade curves for all these events 
at the same time.
This is useful if you want to apply the same type of fade-in to more than 
one event, etc.

! Note that the length of the fade area is determined 
by your selection. In other words, you specify the 
length of the fade before you enter the Fade dialog.

! Also note that you can select multiple events and ap-
ply the same processing to all of them simultaneously.

Drag the Volume handle 
up or down to change the 
volume of the event.

The volume change is displayed 
numerically on the info line.

The event waveform reflects the volume change.
! You can change this setting at any time in the Prefer-

ences (Editing–Audio page), under “On Processing 
Shared Clips”.
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Curve Kind

These determine whether the fade curve should consist of 
spline curve segments (left button), damped spline seg-
ments (middle button) or linear segments (right button).

Fade display

Shows the shape of the fade curve. The resulting wave-
form shape is shown in dark grey, with the current wave-
form shape in light grey.

You can click on the curve to add points, and click and 
drag existing points to change the shape. To remove a 
point from the curve, drag it outside the display.

Curve shape buttons

These buttons give you quick access to some common 
curve shapes.

Restore button

The Restore button (to the right above the fade display) is 
only available when editing fades made by dragging the 
fade handles. Click this to cancel any changes you have 
made since opening the dialog.

As Default button

The “As Default” button is only available when editing 
fades made by dragging the fade handles. Click this to 
store the current settings as the default fade. This shape 
will be used whenever you create new fades.

Fade Length Value

The Fade Length Value can be used to enter fade lengths 
numerically. The format of values displayed here are deter-
mined by the Time Display in the Transport Panel.

When you activate the “Apply Length” option, the value en-
tered in the Fade Length value field will be used when click-
ing “Apply” or “OK”. This setting is deactivated by default.

When you set the current Fade as the Default fade, the 
length value is included as part of the default settings.

Presets

If you have set up a fade-in or fade-out curve that you may 
want to apply to other events or clips, you can store it as a 
preset by clicking the Store button.

• To apply a stored preset, select it from the pop-up 
menu. 

• To rename the selected preset, double-click on the 
name and type a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Preview, Apply and Process

The buttons in the bottom row are different depending on 
whether you are editing a fade made with the fade handles 
or applying a fade using processing:

The Edit Fade dialogs have the following buttons:

The Process Fade dialogs have the following buttons:

! Stored fade-in presets will only appear in the Fade In 
dialog, and fade-out presets will only appear in the 
Fade Out dialog.

Button Function

OK Applies the set fade curve to the event, and closes the di-
alog.

Cancel Closes the dialog.

Apply Applies the set fade curve to the event, without closing 
the dialog.

Button Function

Preview Plays back the fade area. Playback will repeat until you 
click the button again (the button is labeled “Stop” during 
playback).

Process Applies the set fade curve to the clip, and closes the dia-
log.

Cancel Closes the dialog without applying any fade.

The Edit Fade dialog.

The Process Fade dialog.
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Creating crossfades
Overlapping audio material on the same track can be 
crossfaded, for smooth transitions or special effects. You 
create a crossfade by selecting two consecutive audio 
events and selecting the Crossfade command on the Au-
dio menu (or by using the corresponding key command, 
by default [X]). The result depends on whether the two 
events overlap or not:

• If the events overlap, a crossfade is created in the over-
lapping area.
The crossfade will be of the default shape – initially a linear, symmetric 
crossfade, but you can change this as described below.

• If the events don’t overlap but are directly consecutive 
(lined up end-to-start, with no gap), it’s still possible to 
crossfade them – provided that their respective audio 
clips overlap! In this case, the two events are resized so 
that they overlap, and a crossfade of the default length 
and shape is applied.
The default crossfade length and shape are set in the Crossfade dialog 
(see “Default buttons” on page 64).

An example:

The events in themselves do not overlap, but their clips do. Therefore, 
the events can be resized so that they overlap, which is required for a 
crossfade to be created.

When you select the Crossfade function, the two events are resized so that 
they overlap, and a default crossfade is created in the overlapping section.

• If the events don’t overlap, and cannot be resized 
enough to overlap, a crossfade cannot be created.

• Once you have created a crossfade, you can edit it by 
selecting one or both crossfaded events, and selecting 
“Crossfade” from the Audio menu again (or by double-
clicking in the crossfade zone). 
This opens the Crossfade dialog, see below.

Removing crossfades
To remove a crossfade, select the events and select “Re-
move Fades” from the Audio menu, or use the Range Se-
lection tool:

1. Drag the Range Selection tool in the Project window, 
so that the selection encloses all of the fades and cross-
fades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

• You can also remove a crossfade by clicking and drag-
ging it outside the track.

Overlapping section

Audio clips

Audio events
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The Crossfade dialog

The Crossfade dialog contains separate, but identical, 
sections for the fade-in and fade-out curve settings in the 
crossfade on the left, and common settings on the right.

Fade Displays
Shows the shape of the fade-out and fade-in curve, re-
spectively. You can click on the curve to add points, and 
click and drag existing points to change the shape. To re-
move a point from the curve, drag it outside the display.

Curve kind buttons
These buttons determine whether the corresponding fade 
curve should consist of spline curve segments (left but-
ton), damped spline segments (middle button) or linear 
segments (right button).

Curve shape buttons
These buttons give you quick access to some common 
curve shapes.

Equal Power and Gain
• If you activate the “Equal Gain” checkbox, the fade 
curves are adjusted so that the summed fade-in and fade-
out amplitudes will be the same all along the crossfade 
region. This is often suitable for short crossfades.

• If you activate the “Equal Power” checkbox, the fade 
curves are adjusted, so that the energy (power) of the 
crossfade will be constant all along the crossfade region.

Play buttons
• The “Play Fade Out” and “Play Fade In” buttons allow 
you to audition the fade-out or fade-in part only, without 
the crossfade.

• The “Play Crossfade” button plays back the whole 
crossfade.

You can also use the Transport play controls to play back 
the crossfaded audio events. However, that method will 
play back all unmuted audio events on other tracks as well.

Pre-roll and Post-roll
When auditioning with the Play buttons, you can choose 
to activate pre-roll and/or post-roll. Pre-roll lets you start 
playback before the fade area, and post-roll lets you stop 
playback after the fade area. This can be useful for audi-
tioning the fade in a context.

• To specify how long the pre- and post-rolls should be, 
click in the time fields and enter the desired time (in sec-
onds and milliseconds).

• To activate pre- and post-roll, click the respective but-
ton. To deactivate, click the button again.

! Equal Power curves have only one editable curve 
point. You cannot use the Curve kind buttons or the 
presets when this mode is selected.
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Length settings
You can adjust the length of the crossfade area numeri-
cally in the “Length” field. If possible, the length change 
will be applied equally to “both sides” of the crossfade 
(i.e. Cubase LE tries to “center” the crossfade).

Presets
If you have set up a crossfade shape that you may want to 
apply to other events, you can store it as a preset by click-
ing the Store button.

• To apply a stored preset, select it from the pop-up 
menu. 

• To rename the selected preset, double-click on the 
name and type in a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Default buttons
• Clicking the “As Default” button stores all of the current 
settings as the default crossfade. These settings will then 
be used whenever you create new crossfades.

• The Crossfade Length setting is included in the Default 
settings. However, it is only applied if the events to be 
crossfaded don’t overlap – otherwise the crossfade will be 
in the overlap area (see “Creating crossfades” on page 62).

• Clicking the “Recall Default” button copies the curves 
and settings of the Default crossfade to the Crossfade 
dialog.

Auto Fades and Crossfades
Cubase LE features an Auto Fade function that can be set 
both globally, i.e. for the entire project, and separately for 
each audio track. The idea behind the Auto Fade function 
is to create smoother transitions between events by ap-
plying short (1–500 ms) fade-ins and fade-outs.

Making global Auto Fade settings
1. To make Auto Fades settings globally for the project, 
select “Auto Fades Settings...” from the Project menu.
This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to acti-
vate or deactivate Auto Fade In, Auto Fade Out and Auto 
Crossfades, respectively.

3. Use the Length value field to specify the length of the 
Auto Fade or Crossfade (1-500 ms).

4. To adjust the shapes of Auto Fade In and Auto Fade 
Out, select the “Fades” tab and make settings as in the 
regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the 
“Crossfades” tab and make settings as in the regular 
Crossfade dialog.

! To be able to resize a crossfade this way, it must be 
possible to resize the corresponding event. For ex-
ample, if the left crossfaded event already plays its 
audio clip to the end, its endpoint cannot be moved 
any further to the right.

! As mentioned earlier, fades are calculated in real 
time during playback. This means that the larger the 
number of audio tracks with Auto Fades activated in 
a project, the higher the demands on the processor.
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6. If you want to use the settings you have made in future 
projects, click the “As Default” button.
The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate 
track
By default, all audio tracks will use the settings you have 
made in the project’s Auto Fades dialog. However, since 
Auto Fades use computing power, a better approach may 
be to turn Auto Fades off globally and activate them for in-
dividual tracks, as needed:

1. Right-click the track in the Track list and select “Auto 
Fades Settings...” from the context menu (or select the 
track and click the “Auto Fades Settings” button in the In-
spector).
The Auto Fades dialog for the track opens. This is identical to the project’s 
Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track to use the global Auto Fade settings, 
open the Auto Fades dialog for the track and activate the 
“Use Project Settings” checkbox.
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About folder tracks

Just as the name implies, a folder track is a folder that con-
tains other tracks. Moving tracks into a folder is a way to 
structure and organize tracks in the Project window. For 
example, grouping several tracks in a folder track makes it 
possible for you to “hide” tracks (thus giving you more 
working space on the screen). You can solo and mute 
several tracks in a quicker and easier way and perform 
editing on several tracks as one entity. Folder tracks can 
contain any type of track including other folder tracks. 

Handling folder tracks

Creating a folder track
Folder tracks are created just like any other track: Select 
“Add Track” from the Project menu and select “Folder” 
from the submenu that appears, or right-click in the Track 
list and select “Add Folder Track” from the context menu.

Moving tracks into a folder
You can move any type of track into a folder by using drag 
and drop:

1. In the Track list, click on a track that you want to move 
into a folder and drag it onto a folder track.
A green arrow pointing to a folder appears when you drag the track onto 
the folder track in the list.

2. Release the mouse button.
The track is now placed in the folder track, and all parts and events on 
the track will be represented by a corresponding folder part (see “Wor-
king with folder parts” on page 68), which is a graphical representation 
of all parts and events in the folder.

Since you can move any type of track into a folder track, it 
is possible to create sub-folders by moving one folder 
track into another. This is called “nesting”. For example, 
you could have a folder containing all the vocals in a 
project, and each vocal part could have a nested folder 
containing all the takes for easier handling etc.

Removing tracks from a folder
To remove a track from a folder, simply drag it out of the 
folder and release it in the Track list.

Hiding/showing tracks in a folder
You can hide or show the tracks located in a folder by 
clicking on the “Expand/Collapse Folder” button (the 
folder icon). Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still 
give you a graphic representation of the parts and events 
within the folder.

Muting and soloing folder tracks
One of the main advantages of using folder tracks is that 
they provide you with a way to mute and solo several tracks 
as one unit. Muting and soloing a folder track affects all 
tracks in the folder. You can also solo or mute individual 
tracks in the folder. 

A folder track

Tracks in the 
folder
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Muting a folder track

You can mute a folder track (and thereby mute all tracks 
within it) the same way you mute other tracks by clicking in 
the Mute (“M”) button in the Track list.

Soloing a folder track

You can solo a folder track (and thereby mute all tracks 
outside the folder, except those already set to Solo) the 
same way you solo other tracks, by selecting it and click-
ing the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and 
using the Mute and Solo buttons in the Track list as usual 
for any tracks inside the folder.

Working with folder parts
A folder part is a graphic representation of events and 
parts on the tracks in the folder. Folder parts indicate the 
position and length of the events and parts, as well as on 
which track they are (their vertical position). If part colors 
are used, these are also shown in the folder part.

Folder parts are created automatically when there are 
parts or events on the tracks within the folder. The follow-
ing rules apply:

• If there is a gap between parts/events on the tracks, 
there will be two separate folder parts.

• Parts or events that overlap within the folder may be 
represented by the same folder part or by two different 
folder parts – depending on how much they overlap.
If a part/event overlaps by half its length or less, it will be placed in a new 
folder part.

Handling and editing folder parts
Most of the editing you can do in the Project window ap-
plies to folder parts as well.

Any Project window editing you perform to a folder part 
affects all the events and parts it contains (those elements 
on the track within the folder that are represented by the 
folder part). You can select several folder parts if you like 
– this allows you to handle and edit them together. The 
editing you can perform includes:

• Moving a folder part. This will move its contained events and 
parts (possibly resulting in other folder parts, depending on 
how the parts overlap).

• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and 

parts.
• Splitting a folder part with the Scissors tool (see the example 

below).
• Gluing folder parts together with the Glue tube tool. This will 

only work if the adjacent folder parts contain events or parts 
on the same track.

• Resizing a folder part resizes the contained events and parts 
according to the selected resizing method. This is set by click-
ing the Arrow tool icon on the toolbar and selecting “Normal 
Sizing”, “Sizing Moves Contents” or “Sizing Applies Time 
Stretch” from the pop-up menu – see “Resizing events” on 
page 31. Note that if you select “Sizing Applies Time Stretch”, 
any automation data is not taken into account.

• Muting a folder part. This will mute its contained events and 
parts.

The “LeadGuit” event overlaps 
the “Bassline” event by more than 
half its length, which means it is 
included in the same folder part.

The “SoloGuit” event does not 
overlap with any of the other 
events. This means a new folder 
part is created.
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An example

Editing tracks within folder parts
Tracks inside a folder can be edited as one entity by per-
forming the editing directly on the folder part containing 
the tracks as explained above. You can also edit individual 
tracks within the folder by showing the contained tracks, 
selecting parts and opening editors as usual.

Double-clicking a folder part opens the editors for the cor-
responding track classes present in the folder. The follow-
ing applies:

• All MIDI parts located on the tracks within the folder are 
displayed as if they were on the same track, just like when 
opening the Key Editor with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each 
track a different color in the Project window and use the “Part Colors” 
option in the editor (see “Coloring notes and events” on page 171).

• If the folder contains tracks with audio events and/or au-
dio parts, the Sample and/or Audio Part Editors are opened 
with each audio event and audio part in a separate window.

Splitting the folder part 
with the Scissors tool...

...will split all contained parts or 
events present at that position.
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About markers
Markers are used to quickly locate certain positions. If you 
often find yourself jumping to a specific position within a 
project, you should insert a marker at this position. There 
are two types of markers:

• Cycle markers that allow you to store the start and end posi-
tions of a range. 

• Standard markers that store a specific position. 

Markers can be created and edited in several ways: 

• By using the Marker window (see below).
• By using the Marker track (see “Using the Marker track” on 

page 72).
• By using key commands (see “Marker key commands” on 

page 74).

The left and right locators are handled separately – 
see “The left and right locators” on page 42.

The Marker window

In the Marker window, you can perform most editing oper-
ations concerning markers. The markers are listed in the 
Marker window in the order in which they occur in the 
project. Most functions in the Marker window are also 
available in the Inspector when the Marker track is se-
lected.

To open the Marker window, you can:

• Select “Markers” from the Project menu
• Click the “Show” button in the Marker section on the Trans-

port panel
• Use the key command (by default [Ctrl]/[Command]-[M]).

The Marker window columns

The Marker window is divided into six columns which are 
used for performing the following operations:

• The leftmost column is the Locate column.
Clicking in this column will move the project cursor to the corresponding 
marker position. A blue arrow indicates the marker at the project cursor 
position (or the closest marker before the project cursor).

• The ID column is used to edit marker ID numbers. 
See “About marker ID numbers” on page 72.

• The Position column displays the markers’ time posi-
tions (or start positions for cycle markers).
The marker positions can be edited directly in this column.

• The End and Length columns display the end positions 
and length of cycle markers – see “About cycle markers” 
on page 72.
These values can also be edited directly in the respective column.

• The Description column lets you enter names or de-
scriptions for markers.

Click on a column heading to sort the marker list by that 
column. The Marker columns can also be reordered by 
dragging and dropping the column headers.

Adding and removing markers in the Marker window

• You add position markers (in Stop mode, during play-
back or during recording) by clicking the Add button or by 
pressing [Insert] (Windows only) on the computer key-
board. Markers are always added at the current project 
cursor position.

• To add a cycle marker, select “Cycle Markers” from the 
Show pop-up menu and click the Add button.
This adds a cycle marker between the left and right locator. You can also 
draw cycle markers on the Marker track (see “Editing markers on the 
Marker track” on page 73).

• To remove a marker, select it and click the Remove but-
ton.

Note that you can assign key commands to various 
marker commands in the Key Commands dialog (see 
“Marker key commands” on page 74).
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Moving marker positions in the Marker window

The Move button in the Marker window can be used to 
“reprogram” marker positions. Proceed as follows:

1. Set the project cursor to the position to which you 
want to move (or re-program) a marker.

2. Select the marker that you want to change in the 
Marker window.
Do not select the marker by clicking in the leftmost column, as this will 
move the project cursor to this marker.

• If a cycle marker is selected, the Move operation affects 
the cycle marker start position.
The length of the range is not affected.

3. Click the Move button.

You can also move markers by editing their position nu-
merically in the Position column.

About marker ID numbers
Each time you add a marker, it is automatically and se-
quentially assigned an ID number, starting from ID 1. ID 
numbers can be changed at any time – this allows you to 
assign specific markers to key commands (see below). 

IDs for cycle markers are shown in brackets and start from 
[1]. These may also be changed.

Assigning markers to key commands

As explained above, marker ID numbers are assigned au-
tomatically and sequentially each time you add a marker. 
The nine first markers (1 to 9) can be recalled by using key 
commands – by default these are [Shift]+[1] to [9] on the 
typewriter part of the keyboard.

If you have more than nine markers, you cannot use 
key commands to navigate to markers numbered 10 or 
higher.

If you want to keep all current markers, but want to specify 
which markers should be accessed via key commands, 
the solution is to reassign the marker ID numbers. Pro-
ceed as follows:

1. First decide which of the current markers with an ID 
between 1 and 9 you want to reassign to a new ID number, 
and thus remove its key command assignment.
Memorize the ID number.

2. Enter this ID number in the ID column of the marker you 
want to access with a key command and press [Enter].
The two marker ID numbers are switched, and the key command now 
locates to the marker selected in this step.

3. Repeat as necessary for other markers.

• You can also simply remove a marker with an ID number 
between 1 to 9 to free up a key – see “Adding and remo-
ving markers in the Marker window” on page 71.

• For more about marker key commands, see “Marker key 
commands” on page 74.

Using the Marker track

The Marker track is used for viewing and editing markers. 
Markers shown on the Marker track are exactly the same 
as shown in the Marker window, and any changes made 
on the Marker track are reflected in the Marker window 
and vice versa. Standard position markers in the Marker 
track are shown as marker events: vertical lines with the 
marker name (if assigned) and number beside it. If you se-
lect the Marker track, all markers are shown in the Inspec-
tor, much like in the Marker window.

About cycle markers
Cycle markers are shown on the Marker track as two 
markers bridged by a horizontal line. Cycle markers are 
ideal for storing sections of a project. By setting cycle 
markers for sections of a song, for example “Intro”, 
“Verse”, “Chorus” etc., this enables you to quickly navi-
gate to the song sections, and also to optionally repeat 
the section (by activating Cycle on the Transport panel). 

In addition, Cycle markers appear on the horizontal Zoom 
pop-up menu in the Project window (see below).

Adding the Marker track
To add the Marker track to the Project, select “Marker” from 
the Add Track submenu of the Project menu (or right-click 
in the Track list and select “Add Marker Track”). You can 
only have one Marker track in a project.

Markers Cycle marker Locators
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Editing markers on the Marker track
The following editing functions can be performed directly 
on the Marker track:

• Adding position markers “on the fly”.
Use the [Insert] key (Win) or the “Add Marker” button in the Track list for 
the Marker track to add position markers at the current cursor position 
during playback. 

• Adding a cycle marker at the left and right locator posi-
tions.
Clicking the “Add Cycle Marker” button in the Track list for the Marker 
track adds a cycle marker spanning the area between the left and right 
locator.

• Selecting markers.
You can use standard selection techniques like dragging to make a se-
lection rectangle, or use [Shift] to select separate markers.

• Drawing position markers.
By using the Pencil tool (or pressing [Alt]/[Option] and using the Arrow 
tool), you can create or “draw” position marker events at any position on 
the track. If snap is activated on the toolbar, this determines at which po-
sitions you can draw markers.

• Drawing cycle markers.
To draw a cycle marker range, press [Ctrl]/[Command] and use the Pen-
cil tool or the Arrow tool. Snap settings are applied if activated. 

Cycle markers can freely overlap. 

• Resizing a cycle marker.
Select a cycle marker by clicking on it. Two handles appear at the bottom 
of the start and end events. If you click and hold one of the handles you 
can drag the event left or right to resize the cycle marker. This can also 
be done numerically on the info line.

• Moving markers.
Click and drag to move the selected markers or edit marker positions on 
the info line. As usual, snap is taken into account if activated.

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting 
them and pressing [Delete], using the Erase tool etc.

• Naming markers.
A selected marker’s name can be edited on the info line.

Navigating using cycle markers
Cycle markers represent ranges rather than single posi-
tions. Therefore you don’t use them for moving the project 
cursor, but for moving the left and right locators:

• If you double-click on a cycle marker or select it from 
the Cycle pop-up menu in the Track list, the left and right 
locators are moved to encompass the cycle marker.
To move the project cursor position to the start or the end of the cycle 
marker, move it to the corresponding locator (e.g. by using the numeric 
pad keys [1] and [2]).

• You can also use key commands for this – see “Marker 
key commands” on page 74.

Zooming to cycle markers

• By selecting a cycle marker on the Zoom pop-up menu, 
the event display is zoomed in to encompass the selected 
range only (see the section “Zoom presets and Cycle mar-
kers” on page 23).
You can also do this by pressing [Alt]/[Option] and double-clicking on 
the cycle marker in the event display.

Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the 
following tools (Snap applies as usual):

The other tools cannot be used with cycle markers.

Add Marker/Add Cycle Marker buttons

Tool Use

Pencil Press [Ctrl]/[Command] and use the Pencil tool to create 
new cycle markers (as described above).

Eraser Click with the Eraser tool to delete a cycle marker. If you 
hold down [Alt]/[Option] when you click, all consecutive 
markers will also be deleted.

Selection 
Range

This is described in the following section.
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Using markers to make range selections in the 
Project window
Besides enabling you to quickly move the project cursor 
and the locators, markers can be used in conjunction with 
the Range Selection tool to make range selections in the 
Project window. This is useful if you quickly want to make 
a selection that spans all tracks in the project. 

• Double-click with the Range Selection tool between any 
two markers – this creates a selection range between the 
markers, spanning all tracks in the project (just as if you had 
used the Range Selection tool to draw a rectangle).
Any functions or processing you perform now will affect the selection only.

Moving and copying sections

This is a quick way to move or copy complete sections of 
the project (on all tracks):

1. Set markers at the start and end of the section you 
want to move or copy.

2. Select the Range Selection tool and double-click on 
the Marker track between the markers.
Everything in the project within the cycle marker boundaries is selected.

3. Click on the Marker track in the selected range and 
drag the range to a new position.
The selection in the Project window is moved to the same position.

• If you hold down [Alt]/[Option] while you drag the range, 
the selection in the Project window is copied instead.

Marker key commands
You can use key commands for the following marker oper-
ations:

If you need to check or change any key command assign-
ments, the marker commands can be found in the Trans-
port category in the Key Commands dialog.

For the [Shift]+[Pad1] to [Pad9] commands to work, 
Num Lock must be deactivated on the computer key-
board!

Operation Description Default key

Insert Marker Creates a new marker at the current 
project cursor position.

[Insert] 
(Windows only)

Locate Next 
Marker

Moves the project cursor to the right to 
the next marker position (if any).

[Shift]+[N]

Locate Previous 
Marker

Moves the project cursor to the left to 
the previous marker position (if any).

[Shift]+[B]

To Marker 1-9 Moves the project cursor to the speci-
fied marker (number 1 to 9).

[Shift]+[1] to [9]

Set Marker 1-9 Moves the specified marker (number 1 
to 9) to the current project cursor posi-
tion.

[Ctrl]+[1] to [9]

Recall Cycle 
Marker 1-9

Moves the left and right locators to 
encompass the specified cycle marker 
(1 to 9).

[Shift]+[Pad1] to 
[Pad9]
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About this chapter
This chapter contains detailed information about the ele-
ments used when mixing audio and MIDI, and the various 
ways you can configure the mixer. 

Some mixer related features are not described in this 
chapter. These are the following:

• Setting up and using audio effects.
See the chapter “Audio effects” in the separate Plug-in Reference manual.

• Automation of all mixer parameters.
See the chapter “Automation” on page 90.

• How to mix down several audio tracks (complete with 
automation and effects if you wish) to a single audio file.
See the chapter “Export Audio Mixdown” on page 211.

Overview

The mixer offers a common environment for controlling 
levels, pan, solo/mute status etc. for both audio and MIDI 
channels. 

Opening the mixer
The mixer can be opened in several ways:

• By selecting Mixer from the Devices menu.

• By clicking the Mixer icon on the toolbar

• By using a key command (by default [F3]).

• By clicking the Mixer button in the Devices panel.
You open the Devices panel by selecting Show Panel from the Devices 
menu.

What channel types can be shown in the 
mixer?
The following track-based channel types are shown in the 
mixer:

• Audio
• MIDI
• Effect return channels (referred to as FX channels in the 

Project window)
• Group channels
• Instrument tracks

The order of audio, MIDI, instrument, group and effect re-
turn channel strips (from left to right) in the mixer corre-
sponds to the Project window Track list (from the top 
down). If you reorder tracks of these types in the Track list, 
this will be mirrored in the mixer.

Folder, Marker, Video and Automation tracks are not 
shown in the mixer.

Output busses in the mixer
Output busses are represented by output channels in the 
mixer. They appear in a separate “pane” separated by a 
movable divider and with its own horizontal scrollbar, see 
“The output channels” on page 80.

Configuring the mixer
The mixer window can be configured in various ways to 
suit your needs and to save screen space. Here follows a 
run through of the various view options (the following de-
scriptions assume that you have an active project contain-
ing some tracks):

The mixer shows the channel faders for the various tracks 
of your project. On the right of the fader panel you find the 
output channel fader. On the left is the common panel 
which allows for global settings affecting all channels.
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Setting the width of channel strips

The Channel Narrow/Wide button

• Narrow channel strips contain a narrow fader and minia-
ture buttons.

Narrow and wide channel strips

• When selecting “All targets narrow” or “All targets 
wide” on the common panel, all channel strips selected as 
command targets (see “About the Command Target” on 
page 78) are affected.

Selecting what channel types to show/hide
You can specify what channel types to show or hide in the 
mixer. In the right part of the common panel you find a ver-
tical strip with different indicator buttons. Each indicator 
represents a channel type to show or hide in the mixer:

• To hide or show a channel type, click the corresponding 
indicator.
If an indicator is dark, the corresponding channel type will be shown in 
the mixer. If it is orange, the corresponding channel type will be hidden.

Showing/hiding individual channels (the “Can 
Hide” setting)
You can also show/hide individual channels of any type in 
the mixer. For this, you can assign channels a “Can Hide” 
status, which allows you to hide these channels collec-
tively. Proceed as follows:

1. [Alt]/[Option]-click the / icon (visible when moving the 
mouse pointer to the top middle of a channel strip) for the 
channel you want to hide to activate the “Can Hide” option.
If “Can Hide” is activated for a channel strip, the corresponding icon (/) 
will be visible in the top middle section of the channel strip.

2. Repeat this for all channels you want to hide.

! Each channel strip can be set to either “Wide” or 
“Narrow” mode by using the Channel Narrow/Wide 
button on the left above the fader strip.

Audio Channels

Group Channels

MIDI Channels

Instrument Channels

Effect Return Channels

Output Channels

“Can Hide” options – see below.

Reveals all channel strips

“Command Target” options – see “About 
the Command Target” on page 78.
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3. Click the top “hide button” (Hide Channels set to 
“Can Hide”) in the common panel.
This hides all channels set to “Can Hide”. To show them again, click the 
Hide button again or click the button at the bottom in the common panel 
(“Reveal All Channels”).

Below the top hide button, there are three additional “Can 
Hide” buttons.

Channel view sets
Channel view sets are saved configurations of the mixer 
windows, allowing you to quickly switch between different 
layouts for the mixer. Proceed as follows:

1. Set up the mixer the way you wish to store it as a view 
set.
The following settings will be stored:

• Settings for individual channel strips (e.g. narrow or wide mode 
and whether the channel strip is (or can be) hidden or not).

• The hide/show status for channel types.

2. Click the “Store View Set” button (the plus sign) at the 
bottom of the common panel.

3. A dialog appears, allowing you to enter a name for the 
view set.

4. Click OK to store the current mixer view set.

• You can now return to this stored configuration at any 
time, by clicking the “Select Channel View Set” button 
(the down arrow to the left of the “Store View Set” button) 
and selecting it from the pop-up menu.

• To remove a stored channel view set, select it and click 
the “Remove View Set” button (the minus sign).

About the Command Target
Command targets let you specify which channels should 
be affected by the “commands” (basically all the functions 
that can be assigned key commands) when working with 
the Mixer, e.g. the width setting of the channel strips, etc. 
You can set command targets using the Mixer common 
panel or the context menu.

The following options are available:

• All Channels
Select this if you want your commands to affect all channels.

• Selected Only
Select this if you want your commands to affect the selected channels 
only.

• Exclude Outputs
Select this if you don’t want your commands to affect the output channels.

Option Description

Set Target Channels 
to ’Can Hide’

This activates “Can Hide” for all Channels you spec-
ified as “Command Targets”. For more information, 
see “About the Command Target” on page 78.

Remove ’Can Hide’ 
from Target 
Channels

This deactivates “Can Hide” for all Channels you 
specified as “Command Targets”. For more informa-
tion, see “About the Command Target” on page 78

Remove ’Can Hide’ 
from All Channels

This deactivates “Can Hide” for all Channels in the 
Mixer.

! Some remote control devices (such as Steinberg’s 
Houston) feature this function, which means that you 
can use the remote device to switch between the 
channel view sets.

The Command Target Controls on the common panel

The Command Target submenu in the Mixer context menu
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The audio-related channel strips

The mixer showing (from left to right): the common panel, a stereo audio 
channel, a group channel, an instrument channel and an effect return 
channel plus the output channel.

All audio-related channel types (audio, instrument track, 
output channels, group, effect return) basically have the 
same channel strip layout, with the following differences:

• Only audio and instrument track channels have a Monitor and 
Record Enable button.

• Output channels do not have sends.
• Instrument tracks have an additional button for opening the in-

strument’s control panel.
• Output channels have clip indicators.

About the Insert/EQ/Send indicators and bypass 
buttons

The three indicator buttons in each audio channel strip 
have the following functionality:

• If an Insert or Send effect or an EQ module is activated 
for a channel, the corresponding button is lit. 
The effect indicators will be blue, the EQ indicator will be green.

• If you click these buttons when lit, the corresponding 
EQ or effects section will be bypassed.
Bypass is indicated by yellow buttons. Clicking the button again deacti-
vates bypass.

The common 
panel (see “The 
common panel” 
on page 80)

Channel automation 
controls

Record Enable and 
Monitor buttons

Opens the control panel 
for the VST Instrument

Level meter

Level fader

Edit button (opens the 
Channel Settings window)

Insert/EQ/Send indicators and 
bypass buttons (see below)

Channel name

The Can Hide State 
for the channel

Pan controlNarrow/Wide button



80

The mixer

The MIDI channel strips

The MIDI channel strips allow you to control volume and 
pan in your MIDI instrument (provided that they are set up to 
receive the corresponding MIDI messages). The settings 
here are also available in the Inspector for MIDI tracks.

The common panel
The common panel appears to the left in the mixer windows 
and contains settings for changing the look and behavior of 
the mixer, as well as global settings for all channels.

The output channels
The output bus you set up in the VST Connections window 
is represented by an output channel in the mixer. It is shown 
in a separate “pane” (to the right of the regular channel 
strips), with its own divider and horizontal scrollbar. The 
output channel strip is similar to other audio channels.

• For information on how to set up input and output bus-
ses, see “VST Connections: Setting up input and output 
busses” on page 9.

• How to route audio channels to busses is described in 
the section “About output busses” on page 87.

• The Main Mix (the default output) bus is used for moni-
toring. For information about Monitoring, see “About moni-
toring” on page 13.

Basic mixing procedures

Setting volume in the mixer
In the mixer, each channel strip has a fader for volume 
control. 

• For audio channels, the faders control the volume of the 
channels before they are routed directly or via a group 
channel to an output bus.

• An output channel fader determines the master output 
level of all audio channels routed to that output bus.

Level fader 
(MIDI volume)

Level (velocity) meter
Channel automation 
controls

Pan control

Monitor and Record 
Enable buttons

Edit button

Mute and Solo

Channel Narrow/
Wide button

Can Hide State 

Global automation 
Read/Write buttons

Store/Remove View set 
buttons (+/-) and Select 
View set pop-up, see 
“Channel view sets” on 
page 78.

These indicator but-
tons select what chan-
nel types are shown/
hidden in the mixer.

Command Target settings, 
see “About the Command 
Target” on page 78.

Toggles “All Wide” (left 
arrows) or “All Narrow” 
channel strips in the mixer.

Opens the VST Con-
nections window, see 
“The VST Connections 
window” on page 11.

Resets the settings 
to default (for all or 
selected channels).

Channel settings copy/
paste, see “Copying 
settings between audio 
channels” on page 85.

“Can Hide” settings, see 
“Showing/hiding individual 
channels (the “Can Hide” 
setting)” on page 77.

Global Mute and 
Solo buttons

Bus level meter

Read/Write 
Automation

Clip indicator, see 
“Setting input le-
vels” on page 48.

Edit button

Inserts and EQ 
indicators and 
Bypass buttons

Pan control

Mute and Solo 
buttons

Bus volume fader



81

The mixer

• MIDI channels handle fader volume changes in the mixer 
by sending out MIDI volume messages to the connected in-
strument(s).
Connected instruments must be set to respond to MIDI messages (such 
as MIDI volume in this case) for this to function properly.

• The fader settings are displayed numerically below the 
faders, in dB for audio channels and in the MIDI volume 0 
to 127 value range for MIDI channels.
You can also click in the fader value fields and type in the volume value.

• To make fine volume adjustments, hold down [Shift] 
when you move the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, 
it will be reset to its default value, i.e. 0.0 dB for audio 
channels, or MIDI volume 100 for MIDI channels.
This reset to default values works for most mixer parameters.

You can use the faders to set up a volume balance be-
tween the audio and MIDI channels and perform a manual 
mix by moving the faders and other controls while playing 
back. By using the Write function (see “Using Write/Read 
automation” on page 94), you can automate the levels and 
most mixer actions.

About the level meters for audio channels

When playing back audio in Cubase LE, the level meters 
in the mixer show the level of each audio channel.

• Directly below the level meter is a small level readout – 
this shows the highest registered peak level in the signal.
Click this to reset the peak levels.

If the peak level of the audio goes above 0dB, the numer-
ical level indicator will show a positive value (i.e. a value 
above 0dB).

Cubase LE uses 32 bit floating point processing internally, 
so there is virtually limitless headroom – signals can go 
way beyond 0dB without clipping. Therefore:

Having higher levels than 0dB for individual audio 
channels is not a problem in itself. The audio quality will 
not be degraded by this. 
However, when many high level signals are mixed in an output bus, this 
may require that you lower the output channel level a lot (see below). 
Therefore it’s good practice to keep the max levels for individual audio 
channels roughly around 0dB.

About the level meters for output channels

For the output channel, things are different. The output 
channel has a clip indicator.

• When you are recording, clipping can occur when the 
analog signal is converted to digital in the audio hardware. 
It’s also possible to get clipping in the signal being recorded to disk. For 
more about checking and setting input levels, see “Setting input levels” 
on page 48.

• In the output busses, the floating point audio is converted 
to the resolution of the audio hardware. In the integer audio 
domain, the maximum level is 0dB – higher levels will cause 
the clip indicator for each bus to light up.
If the clip indicators light up for a bus, this indicates actual clipping – dig-
ital distortion which should always be avoided.

About level meters for MIDI channels

The level meters for MIDI channels do not show actual vol-
ume levels. Instead, they indicate the velocity values of the 
notes played back on MIDI tracks.

About MIDI tracks set to the same MIDI channel and 
output

If you have several MIDI tracks set to the same MIDI chan-
nel (and routed to the same MIDI output), making volume 
and pan settings for one of these MIDI tracks/mixer chan-
nels will also affect all other mixer channels set to the 
same MIDI channel/output combination.

Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or 
several channels. The following applies:

! It is also possible to make static volume settings for 
an event on the info line or with the volume handle 
(see “About the volume handle” on page 60).

! If the clip indicator lights up for an output channel, 
reset the clip indicator by clicking on it, and lower the 
level until the indicator doesn’t light up.
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• The Mute button silences the selected channel.
Clicking the Mute button again un-mutes the channel. Several channels 
can be muted simultaneously. A muted channel is indicated by a lit Mute 
button and also by the lit Global Mute indicator on the common panel. 

• Clicking the Solo button for a channel mutes all other 
channels.
A soloed channel is indicated by a lit Solo button, and also by the lit Glo-
bal Solo indicator on the common panel. Click the Solo button again to 
turn off Solo.

• Several channels can be soloed at the same time.

• [Alt]/[Option]-clicking a Solo button activates “Solo De-
feat” for that channel.
In this mode the channel will not be muted if you solo another channel. To 
turn off Solo Defeat, [Alt]/[Option]-click the Solo button again. 

• You can un-mute or un-solo all channels by clicking the 
Mute or Solo indicator on the common panel.

Setting pan in the mixer

The pan control.

The pan controls in the mixer are used to position a chan-
nel between the left and right side of the stereo spectrum. 
By default for stereo audio channels, pan controls the bal-
ance between the left and right channels. You can change 
this in the Preferences. By selecting one of the other pan 
modes (see below), you can set pan independently for the 
left and right channel.

• To make fine pan adjustments, hold down [Shift] when 
you move the pan control.

• To select the (default) center pan position, hold down 
[Ctrl]/[Command] and click on the pan control.

• For MIDI channels, the pan control sends out MIDI pan 
messages.
The result depends on how your MIDI instrument is set to respond to pan 
– check your documentation for details.

About the “Stereo Pan Law” Preference (audio channels 
only)

In the Project Setup dialog there is a pop-up menu named 
“Stereo Pan Law”, on which you can select one of several 
pan modes. This is related to the fact that without power 
compensation, the power of the sum of the left and right 
side will be higher (louder) if a channel is panned center 
than if it is panned left or right. 

To remedy this, the Stereo Pan Law setting allows you to 
attenuate signals panned center, by -6, -4.5 or -3dB (de-
fault). Selecting the 0dB option effectively turns off con-
stant-power panning. Experiment with the modes to see 
which fits best in a given situation. You can also select 
“Equal Power” on this pop-up menu, which means that the 
power of the signal will remain the same regardless of the 
pan setting.

A muted chan-
nel in the mixer.

A lit Global Mute indicator on 
the common panel shows that 
one or more channels are 
muted.

[Alt]/[Option]-click a Solo button…
…to activate Solo Defeat 
for that channel.
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Audio specific procedures
This section describes the options and basic procedures 
regarding audio channels in the mixer.

Using Channel Settings 
For each audio channel strip in the mixer and in the Inspec-
tor and Track list for each audio track, there is an Edit but-
ton (“e”).

Clicking this opens the VST Audio Channel Settings win-
dow. By default, this window contains:

• A section with eight insert effect slots (see the chapter “Audio 
effects” in the separate Plug-in Reference manual).

• Four EQ modules and an associated EQ curve display (see 
“Making EQ settings” on page 84).

• A section with eight effect sends (see the chapter “Audio ef-
fects” in the separate Plug-in Reference manual).

• A duplicate of the mixer channel strip (showing the input and 
output settings).

You can customize the Channel Settings window, by 
showing/hiding the different panels and/or by changing 
their order:

• To specify, which panels should be shown/hidden, right-click 
in the Channel settings window, and activate/deactivate the 
respective options on the Customize View submenu on the 
context menu.

• To change the order of the panels, select “Setup” on the Cus-
tomize View pop-up menu and use the “Move up” and “Move 
Down” buttons.

For further information, see the chapter “Customizing” on 
page 243.

Every channel has its own channel settings (although you 
can view each in the same window if you like – see below).

The Channel Settings window is used for the following 
operations:

• Apply equalization, see “Making EQ settings” on page 84.
• Apply send effects, see the chapter “Audio effects” in the sep-

arate Plug-in Reference manual.
• Apply insert effects, see the chapter “Audio effects” in the 

separate Plug-in Reference manual.
• Copy channel settings and apply them to another channel, see 

“Copying settings between audio channels” on page 85.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single window. 

If the option “Sync Project and Mixer Selection” is acti-
vated in the Preferences (Editing–Project & Mixer page), 
this can be done “automatically”:

• Open the Channel Settings window for a track and po-
sition it so that you can see both the Project window and 
the Channel Settings window.

! All channel settings are applied to both sides of a 
stereo channel.

Click the Edit button to open the 
Channel Settings window:
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Selecting a track in the Project window automatically se-
lects the corresponding channel in the mixer (and vice 
versa). If a Channel Settings window is open, this will im-
mediately switch to show the settings for the selected 
channel. This allows you to have a single Channel Settings 
window open in a convenient position on the screen, and 
use it for all your EQ and channel effect settings.

You can also select a channel manually (thereby changing 
what is shown in the open Channel Settings window). 
Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the Choose Edit Channel pop-up menu by 
clicking the arrow button to the left of the channel number 
at the top of the Fader view.

3. Select a channel from the pop-up to show the settings 
for that channel in the open Channel Settings window.

• Alternatively, you can select a channel in the mixer by 
clicking its channel strip (make sure not to click on a con-
trol as this will change the respective parameter setting in-
stead).
This selects the channel, and the Channel Settings window is updated.

• To open several Channel Settings windows at the same 
time, press [Alt]/[Option] and click the Edit buttons for the 
respective channels.

Making EQ settings
Each audio channel in Cubase LE has a built-in paramet-
ric equalizer with up to four bands. There are several ways 
to view and adjust the EQs:

• By selecting the “Equalizers” tab in the Inspector.
Setting EQ in the Inspector is only possible for track-based audio chan-
nels.

• By using the Channel Settings window.
This offers both parameter sliders and a clickable curve display (the 
Equalizer + Curve pane) and also lets you store and recall EQ presets.

The Equalizers + Curve pane in the Channel Settings win-
dow consists of four EQ modules with parameter sliders, an 
EQ curve display and some additional functions at the top.

Using the parameter controls

1. Activate an EQ module by clicking its power button.
Although the modules have different default frequency values and differ-
ent Q names, they all have the same frequency range (20Hz to 20kHz). 
The only difference between the modules is that the “eq1” and “eq4” 
bands can act as shelving or high/low-pass filters (see below).

2. Set the amount of cut or boost with the gain control – 
the upper slider.
The range is ± 24 dB.

3. Set the desired frequency with the frequency slider.
This is the center frequency of the frequency range (20Hz to 20kHz) to 
be cut or boosted.

4. Click on the lower slider (to the left) to open the filter 
type pop-up menu and select the desired filter type.
Note that EQ 2 and EQ 3 can only act as bandpass filters.

5. Set the Q value with the lower slider (to the right).
This determines the width of the affected frequency range. Higher values 
give narrower frequency ranges.

! Below we describe how to set up EQ in the Channel 
Settings window, but the parameters are the same in 
the Inspector.
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6. If needed, you can activate and make settings for up to 
four modules.

• Note that you can edit the values numerically as well, by 
clicking in a value field and entering the desired gain, fre-
quency or Q value.

Using the curve display

When you activate EQ modules and make settings, you 
will see that your settings are automatically reflected in the 
curve display above. You can also make settings directly 
in the curve (or combine the two methods any way you 
like):

1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below is activated.

2. Make EQ settings by dragging the curve point in the 
display.
This allows you to adjust gain (drag up or down) and frequency (drag left 
or right).

3. To set the Q parameter, press [Shift] and drag the 
curve point up or down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/
[Command] (sets gain only) or [Alt]/[Option] (sets fre-
quency only) while you drag the curve point.

4. To activate another EQ module, click somewhere else 
in the display and proceed as above.

5. To turn off an EQ module, double-click its curve point 
or drag it outside the display.

EQ bypass

Whenever one or several EQ modules are activated for a 
channel, the EQ button will light up in green in the mixer 
channel strip, Inspector (Equalizer and Channel sections), 
Track list and Channel Settings window (top right corner 
of the EQ section).

You can also bypass all EQ modules. This is useful, as it 
allows you to compare the sound with and without EQ. 
Proceed as follows:

• In the mixer, the Track list and in the Channel section in 
the Inspector, click the EQs state button so that it turns 
yellow.
To deactivate EQ Bypass, click the button again, so that it turns green 
again.

• In the Inspector (Equalizers tab) and in the Channel 
Settings window, click the Bypass button (next to the EQ 
button) so that it turns yellow.
Click again to deactivate EQ Bypass mode.

EQ bypass in the mixer, the Channel Settings window and in the Inspector.

EQ in the channel overview

If the “Channel” section is selected in the Inspector, you 
will get an overview of which EQ modules, insert effects 
and effect sends are activated for the channel.

By clicking the respective indicator (1 to 4), you can turn 
the corresponding EQ module on or off.

The channel overview in the Inspector.

Copying settings between audio channels
It is possible to copy all channel settings for an audio 
channel and paste them to one or several other channels. 
This applies to all audio-based channel types. For exam-
ple, you can copy EQ settings from an audio track and ap-
ply these to a group or Instrument track, if you want them 
to have the same sound. 
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Proceed as follows:

1. In the mixer, select the channel you want to copy set-
tings from.
You can also select channels with the Channel Select pop-up menu – 
see “Changing channels in the Channel Settings window” on page 83.

2. Click the “Copy First Selected Channel’s Settings” 
button in the common panel.

3. Select the channel(s) you want to copy the settings to 
and click the “Paste Settings to Selected Channels” but-
ton (below the “Copy First Selected Channel’s Settings” 
button).
The settings are applied to the selected channel(s).

Initialize Channel and Reset Mixer
The Initialize Channel button can be found at the bottom in 
the Control Strip section of the Channel Settings window 
(if this section is not shown in the Channel Settings win-
dow, open the context menu and select “Control Strip” on 
the Customize View submenu). Initialize Channel resets 
the selected channel to the default settings. 

Similarly, the mixer common panel holds a Reset Mixer/
Reset Channels button – when you click this, you will be 
asked whether you want to reset all channels or just the 
selected channels.

The default settings are:

• All EQ, Insert and Send effect settings are deactivated and re-
set.

• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.

Using group channels
You can route the outputs from multiple audio channels to 
a group. This enables you to control the channel levels us-
ing one fader, apply the same effects and equalization to 
all of them etc. To create a group channel, proceed as fol-
lows:

1. Select Add Track from the Project menu and select 
“Group Channel” from the submenu that appears.

2. Select the desired channel configuration and click OK.
A group channel track is added to the Track list and a corresponding 
group channel strip is added to the mixer. By default the first group chan-
nel strip is labeled “Group 1”, but you can rename it just like any channel 
in the mixer.

3. Pull down the Output routing pop-up for a channel you 
want to route to the group channel, and select the group 
channel.
The output of the audio channel is now redirected to the selected group.

4. Do the same for the other channels you wish to route 
to the group.

Settings for group channels

The group channel strips are (almost) identical to audio 
channel strips in the mixer. The descriptions of the mixer 
features earlier in this chapter apply to group channels as 
well. Some things to note:

• You can route the output of a group to an output bus or 
to another group with a higher number.
You cannot route a group to itself. Routing is done with the Output Rout-
ing pop-up menu in the Inspector (select the subtrack for the Group in 
the Track list).

• There are no Input Routing pop-ups, Monitor buttons or 
Record Enable buttons for group channels.
This is because inputs are never connected directly to a group.

• Solo functionality is automatically linked for channels 
routed to a group and the group channel itself.
This means that if you solo a group channel, all channels routed to the 
group are automatically soloed as well. Similarly, soloing a channel 
routed to a group will automatically solo the group channel.

• Mute functionality depends on the setting “Group Chan-
nels: Mute Sources as well” in the Preferences (VST page). 
By default, when you mute a group channel no audio will pass through 
the group. However, other channels that are routed directly to that group 
channel will remain unmuted. If any of those channels have aux sends 
routed to other group channels, FX channels or output busses, those will 
still be heard. 

If the option “Group Channels: Mute Sources as well” is 
activated in the Preferences (VST page), muting a group 
channel will cause all other channels directly routed to it to 
be muted as well. Pressing mute again will unmute the 
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group channel and all other channels directly routed to it. 
Channels that were muted prior to the group channel be-
ing muted will not remember their mute status and will be 
unmuted when the group channel is unmuted.

One application of group channels is to use them as “ef-
fect racks” – see the chapter “Audio effects” in the sepa-
rate Plug-in Reference manual.

About output busses
Cubase LE uses a system of input and output busses 
which are set up using the VST Connections dialog. This 
is described in the chapter “VST Connections: Setting up 
input and output busses” on page 9.

Output busses let you route audio from the program to the 
outputs on your audio hardware. 

Viewing the output busses in the mixer

Output busses are shown as output channels in a sepa-
rate pane to the right in the mixer. You show or hide this 
pane by clicking the Hide Output Channels button in the 
mixer’s common panel to the left:

Each output channel resembles a regular audio channel 
strip. Here you can do the following:

• Adjust master levels for all configured output busses using the 
level faders.

• Add effects or EQ to the output channels (see the chapter 
“Audio effects” in the separate Plug-in Reference manual).

MIDI specific procedures
This section describes basic procedures for MIDI chan-
nels in the mixer.

Using Channel Settings
For each MIDI channel strip in the mixer (and MIDI track in 
the Track list or the Inspector), there is an Edit (“e”) button. 

Clicking this opens the MIDI Channel Settings window. 
By default, this window contains a duplicate of the mixer 
channel strip and the fader control strip. 

You can customize the Channel Settings window by right-
clicking the window and activating/deactivating the op-
tions on the Customize View submenu.

• To change the order of the panels, select “Setup” on 
the Customize View pop-up menu and use the “Move up” 
and “Move Down” buttons.

Every MIDI channel has its own channel settings.

The MIDI Channel Settings window.

! The option “Group Channels: Mute Sources as well” 
does not affect how mute automation is written. 
Writing mute automation on a group channel only af-
fects the group channel and not channels routed to 
it. When writing the automation, you will see the 
other channels being muted when this option is acti-
vated. However, upon playback, only the group 
channel will respond to the automation.
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Utilities

Saving mixer settings

It is possible to save complete mixer settings for selected 
or all audio channels in the mixer. These can later be 
loaded into any project. Channel settings are saved as 
mixer settings files. These have the Windows file exten-
sion “.vmx”. 

Right-clicking somewhere in the mixer panel or in the 
Channel Settings window brings up the Mixer context 
menu where the following Save options can be found:

• “Save Selected Channels” will save all channel settings 
for the selected channels.
Input/output routings are not saved.

• “Save All Mixer Settings” saves all channel settings for 
all channels.

When you select any of the above options, a standard file 
dialog opens where you can select a name and storage lo-
cation on your disk for the file.

Loading mixer settings 

Load Selected Channels

To load mixer settings saved for selected channels, pro-
ceed as follows:

1. Select the same number of channels in the new project 
to match the number of channels you saved settings for in 
the previous project.
For example, if you saved settings for six channels, select six channels in 
the mixer.

• Mixer settings will be applied in the same order as they 
were in the mixer.
Thus, if you save settings from channels 4, 6 and 8 and apply these set-
tings to channels 1, 2 and 3, the settings saved for channel 4 would be 
applied to channel 1, the settings saved for channel 6 to channel 2 and 
so on.

2. Right-click the mixer panel to open the context menu, 
and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
The channel settings are applied to the selected channels.

Load All Mixer Settings

Selecting “Load All Mixer Settings” from the context menu 
allows you to open a saved mixer settings file, and have 
the stored settings applied to all channels for which there 
is information included in the file. All channels, master set-
tings, VST Instruments, sends and master effects will be 
affected.

Please note that if the saved mixer settings were for 
24 channels, for example, and the mixer you apply it to 
currently contains 16 channels, only the settings for chan-
nels 1 to 16 will be applied – this function will not auto-
matically add channels.

! Saving/Loading mixer settings does not apply to 
MIDI channels in the mixer – only audio-related 
channels (group, audio, instrument, effect return) are 
saved with this function!

! If you choose to apply mixer settings to fewer chan-
nels than you saved, the order of the saved channels 
in the mixer applies – i.e. the saved channels that are 
“left over” and not applied will be the channels with 
the highest channel numbers (or furthest to the right 
in the mixer).
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About the VST Performance window

The VST Performance window is opened by selecting it 
from the Devices menu. It indicates the current load on the 
CPU and the hard disk transfer rate. It is recommended 
that you check this from time to time, or keep it always 
open. Even though you have been able to activate a num-
ber of audio channels in the project without getting any 
warning, you may run into performance problems when 
adding EQ or effects.

• The upper bar graph shows the CPU (processor) load.
If the red Overload indicator lights up, you need to decrease the number 
of EQ modules, active effects and/or audio channels playing back simul-
taneously.

• The lower bar graph shows the hard disk transfer load.
If the red overload indicator lights up, the hard disk is not supplying data 
fast enough to the computer. You may need to reduce the number of tracks 
playing back by using the Disable Track function (see “About track disable/
enable” on page 42). If this doesn’t help, you need a faster hard disk. 
Note that the overload indicator may occasionally blink, e.g. when you lo-
cate during playback. This does not indicate a problem, but happens be-
cause the program needs a moment for all channels to load data for the 
new playback position.

The CPU and Disk load meters can also be shown on 
the Transport panel (as “Performance”) and on the Project 
window toolbar (as “Performance Meter”).
There they are shown as two miniature vertical meters (by default at the 
left side of the panel/toolbar).
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Background
Cubase LE provides very comprehensive automation fea-
tures. Virtually every mixer and effect parameter can be 
automated.

There are two main methods you can use to automate pa-
rameter settings:

• By manually drawing curves on automation tracks in the 
Project window.
See “Editing automation events” on page 97.

• By using the Write/Read buttons and adjusting para-
meters in the mixer.
See “Using Write/Read automation” on page 94.

The methods are not different in terms of how the automa-
tion data is applied – they only differ in the way the auto-
mation events are created; manually drawing them or 
recording them. Any applied automation data will be re-
flected both in the mixer (a fader will move for example) 
and in a corresponding automation track curve (although 
this may be hidden).

About automation tracks
Audio tracks, group channel tracks and FX channel tracks 
all have automation tracks. These allow you to view and 
edit the automation of all mixer settings for the track, in-
cluding settings for the track’s insert effects. There is one 
automation “subtrack” for each track, on which the differ-
ent automation parameters can be displayed.

Similarly, MIDI tracks have an automation track for auto-
mating mixer settings and MIDI Modifiers.

For Instrument tracks, as a combination of a MIDI track 
and a VST Instrument, the automation track provides auto-
mation parameters for the VST Instrument itself, for the 
VST Instrument channel and the respective MIDI automa-
tion parameters.

Finally, for output channels, automation tracks are auto-
matically added as soon as you activate automation (the 
Write button) in the corresponding mixer channel strip or 
in the Channel Settings window.

What can be automated?
Mixing in Cubase LE can be completely automated. The 
following parameter settings can be recorded automati-
cally – or manually drawn in – on automation tracks:

For each audio or group track

• Volume
• Mute
• Pan
• 8 x insert effect parameters (if inserts are used)
• 8 x effect send settings (on/off, level, pan)
• Settings for 4 EQ modules (Master Bypass, on/off, Type, 

Gain, Freq., Quality)
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For each FX channel track and output bus

• Volume
• Mute
• Pan
• 8 x insert effect parameters (if inserts are used)
• Settings for 4 EQ modules (Master Bypass, on/off, Type, 

Gain, Freq., Quality)

For each MIDI track

• Volume
• Pan
• Mute
• MIDI Modifiers on/off switch
• Transpose
• Vel. shift
• Random 1-2 min/max/target
• Range 1-2 min/max/target

For each Instrument track

The automation track for instrument tracks features all pa-
rameters that are available for MIDI tracks (see the re-
spective sections above) except MIDI Volume, Pan and 
Mute, because the parameters Volume, Pan and Mute are 
controlled directly via the Instrument Return channel in the 
Mixer. Additionally it features the following parameters for 
VST instruments:

• VST Instrument plug-in parameters plus:

• Volume
• Mute
• Pan
• 8 x insert effect parameters (if inserts are used)
• 8 x effect send settings (on/off, level, pan)
• Settings for 4 EQ modules (Master Bypass, on/off, Type, 

Gain, Freq., Quality)

Automation track operations

Opening automation tracks 
Every track/channel has an automation track.

For audio, Instrument, group channel, MIDI and FX chan-
nel tracks, there are two ways you can open the automa-
tion track:

• By right-clicking the track in the Track list and selecting 
“Show Automation” from the context menu.

• By clicking on the left border of the track in the Track 
list. (When you position the mouse pointer over the lower 
left corner of the track, the respective arrow icon (“Show/
Hide Automation”) appears.)

An automation track opens in the Track list, and a straight 
black horizontal line is shown as well as a greyed out mir-
ror image of the audio events’ waveform (or MIDI events 
for MIDI tracks) in the event display. By default, the volume 
parameter is assigned to the automation track.

Click here to open the automation track.

For output busses, automation tracks are automatically cre-
ated when the Write automation button (see “Using Write/
Read automation” on page 94) is activated in either:

• The corresponding channel strip in the mixer.
• The corresponding Channel Settings window.
• The mixer common panel (“All Automation to Write Status”).
• The area above the Track list (“All Automation to Write Status”).
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Assigning a parameter to an automation track
To make settings for an automation parameter, you have to 
select it from the pop-up menu.

1. Open the automation track for the desired track in the 
Track list, as described above.

2. Click in the parameter display for the automation track.
A pop-up menu opens, containing some of the automation parameters 
plus the item “More...” at the bottom of the list. The contents of the list 
depend on the track type (audio, MIDI, etc.).

• If the parameter you wish to automate is on the pop-up 
menu, you can select it directly.
The parameter will replace the current parameter in the automation track. 

• If you wish to add a parameter not available on the pop-
up menu or want to view all parameters that can be auto-
mated, go on to the next step.

3. Select “More...”.
The Add Parameter dialog appears. This dialog shows a list with all pa-
rameters that can be automated for the selected channel (sorted into dif-
ferent categories), including the parameters for any assigned insert 
effects. See “What can be automated?” on page 91 for a list of the avail-
able parameters according to channel type. To view the parameters in 
each category click the “+” sign for the category folder.

The Add Parameter dialog for an audio track.

4. Select a parameter from the list and click OK.
The parameter will replace the current parameter in the automation track.

Note that the “replacing” of the parameter displayed in 
the automation track is completely non-destructive. 
If the track contained any automation data for the parameter you just re-
placed, this data will still be there, although it will not be visible after you 
replaced the parameter. If you click in the parameter display you can 
switch back to the replaced parameter. All automated parameters are in-
dicated by an asterisk (*) after the parameter name on the pop-up menu.

Volume and Mute are automated.
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Removing automation
To remove all automation for the selected parameter, click 
the parameter name and select “Remove Parameter” from 
the pop-up menu. This will delete any automation events 
on the track, and the automation track will be closed.

Hiding automation tracks
To hide a single automation track, you have two possibili-
ties:

• Position the pointer over the top left border of the automation 
track in the Track list and click the “Hide Automation Track” 
button (the minus sign).

• Right-click the track for which you wish to hide the automation 
track, and select “Hide Automation” from the context menu.

To hide the automation tracks for all tracks in the Track list, 
right-click any track and select “Hide All Automation” from 
the context menu.

Hiding unused automation tracks

To hide all empty automation tracks (i.e. automation tracks 
that were opened but do not contain any automation 
data), proceed as follows:

• Right-click any track in the Track list and select “Show 
All Used Automation” from the pop-up menu.
This will close all automation tracks not containing any automation 
events. For tracks that have automated parameters, the automation track 
is shown for the first (topmost) parameter in the Parameter list.

Muting automation

You can mute individual automation parameters by click-
ing the Mute button on the automation track. Clicking the 
Read (R) button (see “Using Write/Read automation” on 
page 94) for an automation track will activate or deacti-

vate Read mode for all automated parameters of the track. 
Using the Mute button allows you to turn off automation 
for a single parameter.

The “Automation follows Events” setting
If you activate “Automation follows Events” on the Edit 
menu (or in the Preferences dialog–Editing page), auto-
mation events will automatically follow when you move an 
event or part on the track. 

This makes it easy to set up automation related to a spe-
cific event or part, rather than to a specific position in the 
project. For example, you can automate the panning of a 
sound effect event (having the sound pan from left to right, 
etc.) – if you need to move the event, the automation will 
automatically follow! The rules are:

• All automation events for the track between the start 
and end of the event or part will be moved.
If there are automation events in the new position (to which you move the 
part or event), these will be overwritten.

• If you copy an event or part (using Copy/Paste, or [Alt]/
[Option]-dragging, or using the Duplicate or Repeat func-
tions), the automation events will be duplicated as well.

Using Write/Read automation
All track types except folder, marker and video tracks fea-
ture Write (W) and Read (R) buttons in the mixer, in the 
Track list and in the Channel Settings window. Further-
more, the control panels for all plug-in effects and VST In-
struments also feature Write and Read buttons.

The Write and Read buttons for a channel in the mixer and for an auto-
mation track in the Track list.

• If you activate Write for a channel, all mixer parameters 
you adjust during playback for that specific channel will be 
recorded as automation events.

• If you activate Read for a channel, all your recorded 
mixer actions for that channel will be performed during 
playback, just like you performed them in Write mode.
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• The W and R buttons for a track in the Track list are mir-
rors of the W and R buttons in the corresponding channel 
strip in the mixer.

There are also global Read and Write buttons in the com-
mon panel of the mixer and at the top of the Track list:

The global Write and Read buttons in the mixer, and in the Track list.

• When global Read (“All Automation to Read Status”) is 
activated, all your recorded mixer actions for all channels 
will be performed during playback.

• When global Write (“All Automation to Write Status”) is 
activated, all mixer actions you perform during playback 
(for all channels) will be recorded as automation events.

MIDI Controller Input to Automation Tracks

If you have set up a remote device to control parameters 
and settings in the program, you can record automation 
with that remote device – just activate Write as usual. 
However, if you are recording a MIDI track and want to 
record automation at the same time, the controller data 
sent by the remote device will be recorded “twice” – as 
automation and as MIDI controller data on the MIDI track.

To avoid this, activate “MIDI Controller Input to Automa-
tion Tracks” in the Preferences dialog (MIDI page). When 
this is activated, the controllers will be recorded as auto-
mation only, not as MIDI controller data on the recorded 
MIDI track.

Recording your actions – an example
If the settings in your current project are crucial, you may 
not want to “experiment” with automation until you know 
more about it. If so, create a new project for the following 
example. It doesn’t even have to contain audio events, just 
a few audio tracks. Proceed as follows:

1. Open the Mixer window.

2. Click the global Write button (“All Automation to Write 
Status”) in the mixer common panel.
Cubase LE is now in global Write mode. 

3. Start playback and adjust some volume faders and/or 
other parameter settings in the mixer or perhaps in a 
Channel Settings window.
Stop playback when you are done, and return to the position where you 
started playback.

4. Deactivate Write mode and click the global Read but-
ton (“All Automation to Read Status”) in the mixer com-
mon panel.
Cubase LE is now in global Read mode.

5. Start playback, and watch the Mixer window.
All your actions performed during the previous playback will be repro-
duced exactly.

6. If you wish to redo anything that was recorded, acti-
vate Write mode again and start playback from the same 
position.

• You can have Write and Read activated simultaneously, 
if you want to watch and listen to your recorded mixer ac-
tions while you’re recording fader movements for another 
mixer channel, etc.

Recording plug-in automation
Every parameter for every assigned effect or VST Instru-
ment can be automated in much the same manner as de-
scribed above.

The following example assumes that you have assigned an 
insert effect to an FX channel track (see the chapter “Au-
dio effects” in the separate pdf document “Plug-in Refer-
ence”), and describes how to record automation for the 
effect:

1. Select the FX channel track in the Track list and open 
its Inserts section in the Inspector.
If the Inspector is hidden, click the “Show Inspector” button in the 
Project window toolbar.

Please note that not all Inspector tabs are shown by 
default. You can show/hide Inspector sections by right-
clicking on an Inspector tab and activating/deactivating 
the desired option(s).
Make sure to click on an Inspector tab and not on the empty area below 
the Inspector, as this will open the Quick context menu instead.

2. Open the control panel for the effect by clicking the Edit 
button (“e”) above the insert effect slot in the Inspector.
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3. Click the Write button in the control panel to activate 
Write mode.
All effects and VST Instruments have Write/Read buttons on their control 
panels. These work exactly like the corresponding buttons in the mixer or 
in the Track list. In the previous example, we used global Write mode, in 
which mixer and parameter changes are recorded on all tracks, but in this 
example we’ll use Write mode for one track only.

4. Start playback and adjust some effect parameters in 
the control panel.
When you are finished, stop playback and return to the position where 
you started playback.

5. Deactivate Write and instead click the Read button on 
the control panel.

6. Start playback and watch the control panel.
All actions you performed during the previous playback will be repro-
duced exactly.

Assigning an automated parameter to an automation 
track

To select which parameter is currently shown in the auto-
mation track for the FX channel, proceed as follows:

1. Click on the parameter name for the FX channel auto-
mation track.
The parameter name pop-up list is shown containing the automation pa-
rameters for the plug-in. The parameter(s) you previously automated are 
indicated by an asterisk after the parameter name in the list.

The parameters for the WahWah effect.

2. Select the parameter you wish to view from the para-
meter pop-up.
The automation curve for the parameter you selected is displayed on the 
automation track.

Working with automation curves

About automation curves 
There are two kinds of automation curves, “ramp” and 
“jump”:

• Jump curves are created for any parameter that only has 
on/off values, like a Mute button, for example.

• Ramp curves are created for any parameter that gener-
ates continuous multiple values, such as fader or dial 
movements etc. 

About the static value line
When you first open an automation track for a parameter, 
it doesn’t contain any automation events (unless you have 
previously adjusted that parameter with write automation 
activated), and this is reflected in the event display as a 
straight horizontal black line, the “static value” line. This 
line represents the current parameter setting.

• If you have manually added any automation events or 
used write automation for the corresponding parameter, 
and then deactivate Read mode, the automation curve will 
be greyed-out in the automation track event display and 
the static value will be used instead.
As soon as Read mode is activated, the automation curve will become 
available.

A ramp automation curve

A jump automation curve
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Editing automation events

Drawing automation events

By using write automation in the mixer, you generate auto-
mation events by moving parameter dials and faders in the 
mixer. You can also add them manually by drawing automa-
tion curves on an automation track. Proceed as follows:

1. Open the automation track by clicking on the left edge 
of the track in the Track list.
The static value line is shown in the event display for the automation track.

2. Select the Pencil tool.
You can also use the various modes of the Line tool for drawing curves, 
see below.

3. If you click on the static value line, an automation event 
is added, Read automation mode is automatically acti-
vated, and the static value line changes to a blue automa-
tion curve.

4. If you click and hold, you can draw a curve by adding a 
multitude of single automation events.

5. When you release the mouse button, the number of 
automation events is reduced to a few events, but the ba-
sic shape of the curve still remains the same.
This “thinning out” of events is governed by the Automation Reduction 
Level setting in the Preferences, see “About the Automation Reduction 
Level preference” on page 99.

6. If you now activate playback, the volume will change 
with the automation curve.
In the mixer, the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the 
result.
If you draw over existing events, a new curve is created.

• If the automation track is in Read mode already, you can 
also add automation events by clicking with the Arrow tool.
If you are trying to add a point between two existing points and the new 
point doesn’t deviate from the existing curve, it will be removed by reduc-
tion as soon as you release the mouse button (see “About the Automa-
tion Reduction Level preference” on page 99).

Using the various modes of the Line tool to draw 
automation curves

The Line tool can be very useful for drawing automation 
curves. The various modes are accessed by selecting the 
Line tool on the toolbar, clicking on it a second time and 
selecting from the pop-up menu that appears.

• Clicking and dragging with the Line tool in Line mode 
shows a line in the automation track and creates automa-
tion events aligned with this line.
This is a quick way to create linear fades, etc.

• The Line tool in Parabola mode works in the same way, 
but aligns the automation events with a parabolic curve in-
stead, resulting in more “natural” curves and fades.
Note that the result depends on the direction in which you draw the par-
abolic curve.

• The Sine, Triangle and Square Line tool modes create 
automation events aligned with continuous curves.
If Snap is activated and set to Grid, the period of the curve (the length of 
one curve “cycle”) is determined by the grid setting. If you press [Shift] 
and drag, you can set the period length manually, in multiples of the grid 
value.
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Selecting automation events

• To select a single automation curve point, click on it 
with the Arrow tool.
The point turns red, and you can drag it in any horizontal or vertical direc-
tion between two points.

• To select multiple curve points, you can either [Shift]-
click or drag a selection rectangle with the Arrow tool.
All events inside the selection rectangle will become selected.

Drawing a selection rectangle around some points to select them.

When selected, the points can be moved in all directions 
as “one”, i.e. the curve shape formed by the selected 
events remains intact.

• To select all automation events on an automation track, 
right-click the automation track in the Track list and 
choose “Select All Events” from the context menu.

Removing automation events

There are several ways to remove automation events:

• By selecting points and pressing [Backspace] or [De-
lete] or selecting Delete from the Edit menu.

• By clicking on an event with the Eraser tool.

• By selecting a range (with the Range Selection tool), 
and pressing [Backspace] or [Delete] or selecting Delete 
from the Edit menu.

• By opening the parameter pop-up menu for an automa-
tion track and selecting “Remove Parameter”.
This will remove all automation events from the track, and the track will be 
closed.

Editing automation events

Automation events can be edited much like other events. 
You can use cut, copy and paste, you can nudge events 
etc. There are, however, four items on the Edit menu that 
are not applicable to automation events. These are:

• Split at Cursor
• Split Loop
• Move to Front
• Move to Back

Tips and common methods
There are no hard and fast rules when it comes to describ-
ing which automation method you should use. You can for 
example never even open an automation track, and stick 
with write automation throughout a project. Or you can 
stick to drawing automation curves to automate settings in 
a project. Both methods have their advantages, but it is of 
course up to you to decide what to use and when.

• Editing curves on automation tracks offers a graphical 
overview in relation to the track contents and the time po-
sition.
This makes it easy to quickly change parameter values at specific points, 
without having to activate playback. For example, this method gives you a 
good overview if you have a voice-over or a dialog on one track and a 
music bed on another track, the level of which needs to be lowered with 
a specific amount every time the dialog occurs.

• By using write automation in the mixer you don’t have to 
manually select parameters from the Add Parameter list.
You can work much like you would using a “real” physical mixer. Every ac-
tion you perform is automatically recorded on automation tracks which you 
can later open for viewing and editing of the parameters you changed.

These are just two examples of advantages for each 
method. Generally, editing curves and using write automa-
tion are two methods that complement each other, and 
depending on the nature of your projects you will probably 
work out what method works best for a given situation.
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Options and Settings

About the Automation Reduction Level 
preference
This item can be found on the Editing page in the Prefer-
ences dialog. Automation reduction reduces the number 
of automation events after you have used write automation 
or added automation events manually. When you write au-
tomation events or draw them in with the Pencil tool, these 
are added as a continuous stream of densely packed 
events. This is necessary because the program cannot 
“guess” what you will be doing next. However, when you 
are done, the reduction function will remove all superflu-
ous automation curve points and the automation curve 
now contains only the events necessary to reproduce your 
actions.

For example, all events that lie between two other points, 
but do not deviate from the curve, will be automatically re-
moved by reduction.

If you try to add an event that doesn’t deviate from the existing curve 
between two existing points...

...it will be removed when the mouse is released. If you move the se-
lected event by any amount so that the resulting curve isn’t a straight 
line, the event will be added.

• If you feel you need a lower (or higher) reduction level of 
events than the default setting, you can change it, but nor-
mally the default setting works well. 

• A minimum reduction level setting is not recommended 
as this will retain a lot of unnecessary events.
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Background
Audio processing in Cubase LE can be called “non-de-
structive”, in the sense that you can always undo your last 
operation using the Undo command on the Edit menu. 
This is possible because processing affects audio clips 
rather than the actual audio files, and because audio clips 
can refer to more than one audio file. This is how it works:

1. If you process an event or a selection range, a new au-
dio file is created in the Edits folder, within your project 
folder. 
This new file contains the processed audio, while the original file is unaf-
fected. 

2. The processed section of the audio clip (the section 
corresponding to the event or selection range) then refers 
to the new, processed audio file.
The other sections of the clip will still refer to the original file.

• Furthermore, the original, unprocessed audio file can 
still be used by other clips in the project, by other projects 
or by other applications.

Audio processing
Basically, you apply processing by making a selection and 
selecting a function from the Process submenu on the Au-
dio menu. Processing is applied according to the follow-
ing rules:

• Selecting events in the Project window or the Audio 
Part Editor will apply processing to the selected events 
only.
Processing will only affect the clip sections that are referenced by the 
events.

• Selecting an audio clip in the Pool will apply processing 
to the whole clip.

• Making a selection range will apply processing to the 
selected range only.
Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy 
(i.e. the event refers to a clip that is used by other events in 
the project), you are asked whether you want to create a 
new version of the clip or not.

Select “New Version” if you want the processing to affect the selected 
event only. Select “Continue” if you want the processing to affect all 
shared copies. 

If you activate the “Do not show this message again” 
option, any and all further processing you do will conform 
to the selected method (“Continue” or ”New Version”). 
You can change this setting at any time by using the “On Processing 
Shared Clips” pop-up in the Preferences (Editing–Audio page).

...the clip will refer both 
to the original file and a 
new file, containing the 
processed section only.

After processing the event...

This event plays a section of this clip...

...which refers to this audio file.
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Common settings and features
If there are any settings for the selected Audio processing 
function, these will appear when you select the function 
from the Process submenu. While most settings are spe-
cific for the function, some features and settings work in 
the same way for several functions:

The “More...” button

If the dialog has a lot of settings, some options may be 
hidden when the dialog appears. To reveal these, click the 
“More...” button.

To hide the settings, click the button again (now labeled 
“Less...”).

The Preview, Process and Cancel buttons

These buttons have the following functionality:

Pre/Post-CrossFade

Some processing functions allow you to gradually mix the 
effect in or out. This is done with the Pre/Post-CrossFade 
parameters. If you activate Pre-CrossFade and specify a 
value of e.g. 1000 ms, the processing will be applied 
gradually from the start of selection, reaching full effect 
1000 ms after the start. Similarly, if you activate Post-
CrossFade, the processing will gradually be removed, 
starting at the specified interval before the end of the se-
lection.

Envelope

The Envelope function allows you to apply a volume enve-
lope to the selected audio. The dialog contains the follow-
ing settings:

Curve Kind buttons

These determine whether the envelope curve should con-
sist of spline curve segments (left button), damped spline 
segments (middle button) or linear segments (right button).

Fade display

Shows the shape of the envelope curve. The resulting 
waveform shape is shown in dark grey, with the current 
waveform shape in light grey. You can click on the curve 
to add points, and click and drag existing points to change 
the shape. To remove a point from the curve, drag it out-
side the display.

Presets

If you have set up an envelope curve that you may want to 
apply to other events or clips, you can store it as a preset 
by clicking the Store button. 

• To apply a stored preset, select it from the pop-up 
menu. 

• To rename the selected preset, double-click on the 
name and enter a new one in the dialog that appears. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Fade In and Fade Out
For a description of these functions, see the chapter “Fa-
des and crossfades” on page 58.

Button Description

Preview Allows you to listen to the result of the processing with 
the current settings. Playback will continue repeatedly 
until you click the button again (the button is labeled 
“Stop” during Preview playback). You can make adjust-
ments during Preview playback, but the changes are not 
applied until the start of the next “lap”. Some changes 
may automatically restart the Preview playback from the 
beginning.

Process Performs the processing and closes the dialog.

Cancel Closes the dialog without processing.

! The sum of the Pre- and Post-CrossFade times can-
not be larger than the length of the selection.
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Gain

Allows you to change the gain (level) of the selected audio. 
The dialog contains the following settings:

Gain

This is where you set the desired gain, between -50 and 
+20dB. The setting is also indicated below the Gain dis-
play as a percentage.

Clipping detection text

If you use the Preview function before applying the pro-
cessing, the text below the slider indicates whether the 
current settings result in clipping (audio levels above 
0dB). If that is the case, lower the Gain value and use the 
Preview function again.

• If you want to increase the level of the audio as much as 
possible without causing clipping, you should use the Nor-
malize function instead (see “Normalize” on page 104).

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 102.

Merge Clipboard

This functions mixes the audio from the clipboard into the 
audio selected for processing, starting at the beginning of 
the selection.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the original (the 
audio selected for processing) and the copy (the audio on 
the clipboard).

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 102.

! For this function to be available, you need to have cut 
or copied a range of audio in the Sample Editor first.
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Noise Gate

Scans the audio for sections weaker than a specified 
threshold level and replaces them with silence. The dialog 
contains the following settings:

Threshold

The level below which you want audio to be silenced. 
Levels below this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio 
level has exceeded the threshold level.

Min. Opening Time

This is the shortest time the gate will remain open. If you 
find that the gate opens and closes too often when pro-
cessing material that varies rapidly in level, you should try 
raising this value.

Release Time

The time it takes for the gate to close fully after the audio 
level has dropped below the threshold level.

Linked Channels

This is available for stereo audio only. When it is activated, 
the Noise Gate is opened for both channels as soon as 
one or both channels exceed the Threshold level. When 
Linked Channels is deactivated, the Noise Gate works in-
dependently for the left and right channel.

Dry/Wet mix

Allows you to specify a mix ratio between “dry” and pro-
cessed sound.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 102.

Normalize

The Normalize function allows you to specify the desired 
maximum level of the audio. It then analyzes the selected 
audio and finds the current maximum level. Finally it sub-
tracts the current maximum level from the specified level 
and raises the gain of the audio by the resulting amount (if 
the specified maximum level is lower than the current max-
imum, the gain will be lowered instead). A common use for 
Normalizing is to raise the level of audio that was recorded 
at too low an input level. The dialog contains the following 
settings:

Maximum

The desired maximum level for the audio, between -50 and 
0dB. The setting is also indicated below the Gain display as 
a percentage.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 102.

Phase Reverse
Reverses the phase of the selected audio, turning the 
waveform “upside down”. The dialog contains the follow-
ing settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows 
you to specify which channel(s) should be phase-reversed.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 102.
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Remove DC Offset
This function will remove any DC offset in the audio selec-
tion. A DC offset is when there is too large a DC (direct 
current) component in the signal, sometimes visible as the 
signal not being visually centered around the “zero level 
axis”. DC offsets do not affect what you actually hear, but 
they affect zero crossing detection and certain process-
ing, and it is recommended that you remove them.

There are no parameters for this function.

Reverse
Reverses the audio selection, as when playing a tape 
backwards. There are no parameters for this function.

Silence
Replaces the selection with silence. There are no parame-
ters for this function.

Stereo Flip

This function works with stereo audio selections only. It al-
lows you to manipulate the left and right channel in various 
ways. The dialog contains the following parameters:

Mode

 

This pop-up menu determines what the function does:

Freeze Edits
The Freeze Edits function on the Audio menu allows you 
to make all processing permanent for a clip:

1. Select the clip in the Pool or one of its events in the 
Project window.

2. Select “Freeze Edits…” from the Audio menu.

• If there is only one edit version of the clip (no other clips 
refer to the same audio file), the following dialog will appear:

If you select “Replace”, all edits will be applied to the original audio file 
(the one listed in the clip’s Path column in the Pool). If you select “New 
File”, the Freeze Edits operation will create a new file in the Audio folder 
within the project folder (leaving the original audio file unaffected).

• If the selected clip (or the clip played by the selected 
event) has several edit versions (i.e. there are other clips re-
ferring to the same audio file), the following alert will appear:

As you can see, you don’t have the option to Replace the original audio 
file in this case. This is because that audio file is used by other clips. Se-
lect “New File” to have a new file created in the Audio folder within the 
project folder.

! It is recommended that this function is applied to 
complete audio clips, since the DC offset (if any) is 
normally present throughout the entire recording.

Option Description

Flip Left-Right Swaps the left and right channel.

Left to Stereo Copies the left channel sound to the right channel.

Right to Stereo Copies the right channel sound to the left channel.

Merge Merges both channels on each side for mono sound.

Subtract Subtracts the left channel information from the right and 
vice versa. This is typically used as a “Karaoke effect”, for 
removing centered mono material from a stereo signal.

! After a Freeze Edits, the clip refers to a new, single 
audio file.

Option Description
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Background
The Sample Editor allows you to view and manipulate au-
dio at the audio clip level, by cutting and pasting, removing 
or drawing audio data or applying processing.

The Sample Editor also contains Audio Warp related fea-
tures. These are described in the chapter “Audio warp re-
altime processing” on page 118.

Opening the Sample Editor
You open the Sample Editor by double-clicking an audio 
event in the Project window or the Audio Part Editor, or by 
double-clicking an audio clip in the Pool. You can have 
more than one Sample Editor open at the same time.

• Note that double-clicking an audio part in the Project 
window will open the Audio Part Editor, even if the part 
only contains a single audio event.
This is described in the chapter “The Audio Part Editor” on page 113.

Window overview

The Elements menu

If you right-click in the Sample Editor to bring up the 
Quick menu, you will find a sub menu called “Elements”. 
By activating or deactivating options on this submenu, you 
specify what is shown in the editor window. Some of 
these options are also available as icons on the toolbar.

The toolbar
The toolbar contains tools and various settings:

• You can customize the toolbar by right-clicking it and 
using the pop-up menu to hide or show items.

• Selecting Setup from the pop-up menu allows you to 
reorder sections on the toolbar, store presets, etc. See 
“The Setup dialogs” on page 244.

The thumbnail display

The thumbnail display provides an overview of the whole 
clip. The section currently shown in the main waveform 
display of the Sample Editor is indicated by a blue rectan-
gle in the thumbnail, while the current selection range is 
shown in blue.

The Sample Editor tools

Audition, Loop & Volume controls

AutoscrollShow info

Show Audio Event

Snap to Zero Crossing

Start and end of the current selection range

Length of the current selection range

Musical controls

The warp settings pop-up menu, 
see “Warp settings” on page 120.

Musical ModeThe “Use” pop-up menu, see “The “Use” 
pop-up menu” on page 125.

Hitpoint mode and 
sensitivity slider
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• You can move the blue rectangle in the thumbnail to 
view other sections of the clip.
Click in the lower half of the rectangle and drag to the left or right to 
move it.

• You can resize the blue rectangle (by dragging its left or 
right edge) to zoom in or out, horizontally.

• You can define a new viewing area by clicking in the up-
per half of the overview and dragging a rectangle with the 
pointer.

The ruler
The Sample Editor ruler is located between the thumbnail 
and the waveform display. It shows the timeline in the dis-
play format specified in the Project Setup dialog (see “The 
Project Setup dialog” on page 21). If you like, you can se-
lect an independent display format for the ruler by clicking 
on the arrow button to the right of it and selecting an op-
tion from the pop-up menu that appears (this affects the 
values in the info line, too). For a list of the display format 
options, see “The ruler” on page 20.

The waveform display and the level scale

The waveform display shows the waveform image of the 
edited audio clip – in the style selected in the Preferences 
(Event Display–Audio page), see “Adjusting how parts 
and events are shown” on page 24. To the left of the 
waveform display, a level scale can be shown, indicating 
the amplitude of the audio.

• When the level scale is shown, you can select whether 
the level should be shown as a percentage or in dB.
This is done by right-clicking the level scale and selecting an option from 
the pop-up menu that appears. This also allows you to hide the level scale.

• To display the level scale after hiding it, right-click to 
bring up the Quick menu and activate “Level Scale” on the 
Elements submenu.

• This submenu also allows you to select whether you 
want the zero axis and/or the half level axis indicated in the 
waveform display.

The info line

The info line at the bottom of the window shows informa-
tion about the edited audio clip. You cannot edit the val-
ues on the info line.

• To hide or show the info line, click the Show Info button 
on the toolbar.

Half 
level 
axis

Zero axis

Audio format and length Current selection range

Selected display format 
(for info line and ruler)

Number of edits 
made to clip

Zoom factor
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• Initially, length and position values are displayed in the 
format specified in the Project Setup dialog (see “The 
Project Setup dialog” on page 21), but you can change 
this by clicking in the middle field of the info line and se-
lecting another display format from a pop-up menu.
This selection affects the Sample Editor ruler as well.

Operations

Zooming
Zooming in the Sample Editor is done according to the 
standard zoom procedures, with the following special 
notes:

• The vertical zoom slider changes the vertical scale rela-
tive to the height of the editor window, in a way similar to 
the waveform zooming in the Project window (see “Zoom 
and view options” on page 22).
The vertical zoom will also be affected if the option “Zoom Tool Standard 
Mode” (Preferences on the Editing–Tools page) is deactivated and you 
drag a rectangle with the Zoom tool.

• The following options relevant to the Sample Editor are 
available on the Zoom submenu (on the Edit menu and the 
Quick context menu):

• You can also zoom by resizing the rectangle in the 
thumbnail display.
See “The thumbnail display” on page 107.

• The current zoom setting is shown in the info line, as a 
“samples per screen pixel” value.

• Note that you can zoom in horizontally to a scale with 
less than one sample per pixel! 
This is required for drawing with the Pencil tool (see “Drawing in the 
Sample Editor” on page 112).

• If you have zoomed in to one sample per pixel or less, 
the appearance of the samples depend on the option 
“Interpolate Audio Images” in the Preferences (Event Dis-
play–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If 
the option is activated, they are interpolated to “curves” form.

Auditioning
While you can use the regular play commands to play 
back audio when the Sample Editor is open, it is often 
useful to listen to the edited material only. Below are two 
ways to do this.

You can adjust the auditioning level with the miniature 
level fader on the toolbar.

By using the Speaker tool

If you click somewhere in the waveform display with the 
Speaker (“Play”) tool and keep the mouse button pressed, 
the clip will be played back from the position at which you 
clicked. Playback will continue until you release the mouse 
button.

By using the Audition icon

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have made a selection, this selection will be played 
back.

• If there is no selection, but the option “Show Event” is acti-
vated (see “Show audio event” on page 112), the section of 
the clip corresponding to the event will be played back.

• If there is no selection, and “Show Event” is deactivated, play-
back will start at the cursor position (if the cursor is outside 
the display, the whole clip will be played back).

• If the Loop icon is activated, playback will continue repeatedly 
until you deactivate the Audition icon. Otherwise, the section 
will be played back once.

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to 
Selection

Zooms in so that the current selection fills the screen.

Zoom to Event Zooms in so that the editor shows the section of the clip 
corresponding to the edited audio event. This is not 
available if you opened the Sample Editor from the Pool 
(in which case the whole clip is opened for editing, not 
an event).

Zoom In/Out 
Vertical

This is the same as using the vertical zoom slider (see 
above).
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Scrubbing

The Scrub tool allows you to locate positions in the audio 
by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse 
button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played 
back. The speed and pitch of the playback depends on how fast you 
move the pointer.

• You can adjust the response of the Scrub tool with the 
Scrub Response (Speed) setting in the Preferences (VST–
Scrub page).
There you will also find a separate Scrub Volume setting.

Adjusting the snap point
The snap point is a marker within an audio event (or clip, 
see below). This is used as a reference position when you 
are moving events with snap activated, so that the snap 
point is “magnetic” to whatever snap positions you have 
selected. 

By default, the snap point is set at the beginning of the au-
dio event, but often it is useful to move the snap point to a 
“relevant” position in the event, such as a downbeat, etc.

1. Activate the “Audio Event” option so that the event is 
displayed in the editor.

2. Scroll so that the event is visible, and locate the “S” 
flag in the event.
If you haven’t adjusted this previously, it will be located at the beginning 
of the event.

3. Click on the “S” flag and drag it to the desired posi-
tion.
When you drag the snap point, a tool tip shows its current position (in 
the format selected on the Sample Editor ruler).

• It is also possible to define a snap point for a clip (for 
which there is no event yet).
To open a clip in the Sample Editor, double-click it in the Pool (or drag it 
from the Pool to the Sample Editor). After having set the snap point using 
the procedure described above, you can insert the clip into the project 
from the Pool or the Sample Editor, taking the snap point position into 
account.

Making selections
To select an audio section in the Sample Editor, you click 
and drag with the Range Selection tool.

• If Snap to Zero Crossing is activated on the toolbar, the 
start and end of the selection will always be at zero cross-
ings (see “Snap to Zero Crossing” on page 112).

• You can resize the selection by dragging its left and 
right edge or by [Shift]-clicking.

• The current selection is indicated by the selection con-
trols on the toolbar.
You can fine-tune the selection by changing these values numerically. 
Note that the values are relative to the start of the clip, rather than to the 
project timeline.

A selected range
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Using the Select submenu

The following options on the Select submenu of the Edit 
menu can be used in the Sample Editor:

Editing selection ranges
Selections in the Sample Editor can be manipulated in 
several ways. Please note:

• If you attempt to edit an event that is a shared copy (i.e. 
the event refers to a clip that is used by other events in the 
project), you are asked whether you want to create a new 
version of the clip or not (if you haven’t made a “perma-
nent” choice already – see below).
Select “New Version” if you want the editing to affect the selected event 
only. Select “Continue” if you want the editing to affect all shared copies. 
Note: If you activate the option “Do not show this message again” in the 
dialog, any further editing you do will conform to the selected method 
(“Continue” or “New Version”). You can change this setting at any time 
with the “On Processing Shared Clips” pop-up menu in the Preferences 
(Editing–Audio page).

Cut, Copy and Paste

The Cut, Copy and Paste commands on the Edit menu 
work according to the following rules:

• Selecting Copy copies the selection to the clipboard.

• Selecting Cut removes the selection from the clip and 
moves it to the clipboard.
The section to the right of the selection is moved to the left to fill out the 
gap.

• Selecting Paste copies the data on the clipboard into 
the clip.
If there is a selection in the editor, this will be replaced by the pasted 
data. If there is no selection (if the selection length is “0”), the pasted 
data will be inserted starting at the selection line. The section to the right 
of the line will be moved to make room for the pasted material.

The pasted data will be inserted at the selection line.

Insert Silence

Selecting “Insert Silence” from the Range submenu on the 
Edit menu will insert a silent section with the same length 
as the current selection, at the selection start. 

• The selection will not be replaced, but moved to the 
right to make room. 
If you want to replace the selection, use the “Silence” function instead 
(see “Silence” on page 105).

Delete

Selecting Delete from the Edit menu (or pressing [Back-
space]) removes the selection from the clip. The section to 
the right of the selection is moved to the left to fill out the 
gap.

Processing

The functions on the Process submenu on the Audio menu 
can be applied to selections in the Sample Editor, see the 
chapter “Audio processing and functions” on page 100.

Function Description

All Selects the whole clip.

None Selects no audio (the selection length is set to “0”).

In Loop Selects all audio between the left and right locator.

From Start to 
Cursor

Selects all audio between the clip start and the project 
cursor.

From Cursor to 
End

Selects all audio between the project cursor and the end 
of the clip. For this to work, the project cursor must be 
within the clip boundaries.

Select Event Selects the audio that is included in the edited event only. 
This is not available if you opened the Sample Editor from 
the Pool (in which case the whole clip is opened for edit-
ing, not an event).

Left Selection 
Side to Cursor

Moves the left side of the current selection range to the 
project cursor position. For this to work, the cursor must 
be within the clip boundaries.

Right Selection 
Side to Cursor

Moves the right side of the current selection range to the 
project cursor position (or the end of the clip, if the cursor 
is to the right of the clip).
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Creating a new event from the selection

You can create a new event that plays only the selected 
range, using the following method:

1. Make a selection range.

2. Press [Ctrl]/[Command] and drag the selection range 
to the desired audio track in the Project window.

Creating a new clip or audio file from the selection

You can extract a selection from an event and either cre-
ate a new clip or a new audio file, in the following way:

1. Make a selection range.

2. Select “Bounce Selection” from the Audio menu.

A new clip is created and added to the Pool, and another 
Sample Editor window will open with the new clip. The 
new clip will refer to the same audio file as the original clip, 
but will only contain the audio corresponding to the selec-
tion range.

Drawing in the Sample Editor
It is possible to edit the audio clip at sample level by draw-
ing with the Pencil tool. This can be useful if you need to 
manually edit out a spike or click, etc.

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform 
display.
When you release the mouse button, the edited section is automatically 
selected.

Options and settings

Show audio event

When the option “Audio Event” is activated on the Ele-
ments submenu on the Quick menu (or the Show Audio 
Event button is activated on the toolbar), the section corre-
sponding to the edited event is highlighted in the waveform 
display and Thumbnail. The sections of the audio clip not 
belonging to the event are shown with a grey background.

• In this mode, you can adjust the start and end of the 
event in the clip by dragging the event handles in the 
waveform display.
When you move the pointer over the event handles (no matter what tool 
may be selected), it takes on the shape of an arrow, to indicate that you 
can click and drag.

Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at 
zero crossings (positions in the audio where the amplitude 
is zero). This helps you avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

• This setting affects the Sample Editor only. In the 
Project window and other editors, the Snap to Zero 
Crossing setting on the Project menu toolbar or in the 
Preferences (Editing–Audio page) is used.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will 
scroll during playback, keeping the project cursor visible 
in the editor.

! This is only available if you opened the Sample Editor 
by double-clicking an audio event in the Project win-
dow or the Audio Part Editor.
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Background
The Audio Part Editor allows you to view and edit the 
events inside audio parts. Essentially, this is the same type 
of editing that you do in the Project window, which means 
that this chapter contains a lot of references to the chap-
ter “The Project window” on page 14.

Audio parts are created in the Project window, in one of 
the following ways:

• By selecting one or several audio events on the same 
track, and selecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the 
same track with the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double-clicking between the left and right locator on 
an audio track.
With the last two methods, an empty part is created. You can then add 
events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor
You open the Audio Part Editor by selecting one or more 
audio part(s) in the Project window and double-clicking 
on any one of them (or using the Edit-Open key command, 
by default [Ctrl]/[Command]+[E]). The Audio Part Editor 
can display several parts at once, and you can also have 
more than one Audio Part Editor open at the same time.

• Note that double-clicking on an audio event in the 
Project window will open the Sample Editor (see “Ope-
ning the Sample Editor” on page 107).

Window overview

The toolbar
The tools, settings and icons on the toolbar have the same 
functionality as in the Project window, with the following 
differences:

• A Solo button (see “Auditioning” on page 116).
• Separate tools for auditioning (Speaker) and scrubbing (see 

“Scrubbing” on page 116).
• No Line, Glue Tube or Color tool.
• Play and Loop icons and an Audition Volume control (see 

“Auditioning” on page 116).
• Part List controls for handling several parts: Activating parts 

for editing, restricting editing to active parts only and showing 
part borders (see “Handling several parts” on page 116).

You can customize the toolbar, hiding or reordering its 
items.
See “The Setup dialogs” on page 244.

The ruler and info line
These have the same functionality and appearance as 
their counterparts in the Project window.

• Note that you can select a separate display format for 
the Audio Part Editor ruler by clicking on the arrow button 
on the right and selecting an option from the pop-up menu 
that appears.
For a list of the available formats, see “The ruler” on page 20.
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About lanes
If you make the editor window larger, this will reveal addi-
tional space below the edited events. This is because an 
audio part is divided vertically in lanes. 

Lanes can make it easier to work with several audio events 
in a part:

In the top figure it is unnecessarily hard to discern, select 
and edit the separate events. In the bottom figure, some of 
the events have been moved to a lower lane, making se-
lection and editing much easier.

• To move an event to another lane without accidentally 
moving it horizontally, press [Ctrl]/[Command] and drag it 
up or down.
This is the default modifier key for this – you can adjust this in the Prefer-
ences if you like.

Overlapping events

Only one event per track can be played back at the same 
time! This means that if you have overlapping events (on 
the same lane or different lanes) these will cut each other 
off, according to the following rules:

• For events on the same lane, the ones that are on top 
(visible) will be played.
To move overlapping events to the front or back, use the Move to Front 
and Move to Back functions on the Edit menu.

• For events on different lanes, the event on the lowest 
lane gets playback priority.

The overlapping sections of the upper event will not be played since the 
event on the lower lane has playback priority!

Lanes
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Operations

• Note that if a part is a shared copy (i.e. you have previ-
ously copied the part by [Alt]/[Option]+[Shift]-dragging), 
any editing you perform will affect all shared copies of this 
part.
To indicate that it is a shared copy, its name is displayed in italics and a 
symbol is displayed in the lower right corner of the part in the Project 
window (see “Duplicating events” on page 30).

Auditioning
There are three ways to listen to the events in the Audio 
Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the 
Speaker tool and keep the mouse button pressed, the part 
will be played back from the position where you clicked. 
Playback will continue until you release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons.

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have selected events in the part, only the section bet-
ween the first and last selected event will be played back.

• If you have made a range selection, only this section will be 
played back.

• If there is no selection, the whole part will be played back. If 
the project cursor is within the part, playback starts from the 
current cursor position. If the cursor is outside the part, play-
back starts from the beginning of the part.

• If the Audition Loop icon is activated, playback will continue 
until you deactivate the Audition icon. Otherwise, the section 
will be played back once.

By using regular playback

You can of course use the regular playback controls while 
in the Audio Part Editor. Furthermore, if you activate the 
Solo Editor button on the toolbar, only the events in the 
edited part will be played back.

Scrubbing
In the Audio Part Editor, the Scrub tool has a separate icon 
on the toolbar. Apart from that, scrubbing works exactly as 
in the Project window (see “Scrubbing” on page 27).

Handling several parts
When you open the Audio Part Editor with several parts se-
lected – all on the same track or on different tracks – they 
might not all “fit” in the editor window, which can make it 
hard to get an overview of the different parts when editing.

Therefore, the toolbar features a few functions to make 
working with multiple parts easier and more comprehen-
sive:

• The Part List menu lists all parts that were selected 
when you opened the editor, and lets you select which 
part should be active for editing.
When you select a part from the list, it is automatically made active and 
centered in the display.

Note that it is also possible to activate a part by click-
ing on it with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
If you for example select “All” from the Select submenu on the Edit menu 
with this option activated, all events in the active part will be selected but 
not the events in other parts.

“Edit Active Part Only” activated on the toolbar.

! Zooming, selecting and editing in the Audio Part Ed-
itor is done just as in the Project window (see “Ope-
rations” on page 21).
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• You can zoom in on an active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu on the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, 
making the borders easily discernible. There are also two “markers” in 
the ruler with the name of the active part, marking its beginning and end. 
These can be moved freely to change the part borders.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them ac-
tive, with key commands.
In the Key Commands dialog – Edit category, there are two functions: 
“Activate Next Part” and “Activate Previous Part”. If you assign key com-
mands to these, you can use them to cycle between parts. Please refer 
to “Setting up key commands” on page 250 for instructions on how to 
set up key commands.

Common methods

Assembling a “perfect take”
When you record audio in Cycle mode, the events created 
during each lap are named “Take X”, where “X” is the 
number of the take. You can create a perfect take by put-
ting together sections of the different takes in the Audio 
Part Editor.

The procedure below will not work if you recorded 
with “Keep Last” mode selected on the Transport panel.
In that case, only the last take will be kept on the track.

First, you have to create an audio part from the takes.

Creating an audio part from events

1. In the Project window, use the Object Selection tool to 
draw a rectangle around the recorded events.
This is necessary, since clicking on the event may just select the event on 
top (the last take). If in doubt, check the info line – the info text should be 
yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

Assembling a take

1. Double-click the part to open the Audio Part Editor.
Now the different takes will be placed on different lanes, with the last 
take at the bottom.

2. Use the tools to cut out pieces of the takes and as-
semble the final result.
This can include splitting with the Scissors tool, resizing events with the 
Arrow tool or deleting with the Eraser tool. 

• Remember that the events on the lowest lane have play-
back priority. 
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!

Options and Settings
The following options and settings are available in the 
Audio Part Editor:

• Snap
You can specify an independent Snap mode (and snap value for the Grid 
mode) in the editor. The functionality is exactly the same as in the Project 
window.

• Autoscroll
When Autoscroll is activated on the toolbar, the window will scroll during 
playback, keeping the project cursor visible in the editor. This setting can 
be activated or deactivated individually for each window.

• Snap to Zero Crossing
When this option is activated, all audio edits are done at zero crossings 
(positions in the audio where the amplitude is zero). This helps you avoid 
pops and clicks which might otherwise be caused by sudden amplitude 
changes.
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Background
Audio warp is the generic name for the realtime time 
stretching and pitch shifting functions in Cubase LE. The 
main audio warp features are as follows:

• Tempo match any audio loop to the project tempo – see “De-
termining the tempo of an audio loop and activating Musical 
mode” on page 119.

• Pitch shift any number of audio clips in realtime – see “Real-
time pitch shifting of audio events” on page 121. 

• Freeze the realtime processing to optimize the audio sound 
quality and lessen the CPU load – see “Freezing the realtime 
processing” on page 121.

About Musical mode
Musical mode is the key audio warp feature. It allows you 
to lock audio clips to the project tempo by using realtime 
time stretching.

When you activate Musical mode, you have to specify the 
tempo for the audio file or loop. In Musical mode, audio 
events will adapt to any tempo changes in Cubase LE, just 
like MIDI events.

The Musical Mode button is activated on the Sample Editor toolbar.

About ACID® loops

Cubase LE supports ACID® loops. These loops are stan-
dard audio files but with embedded tempo/length informa-
tion. When ACID® files are imported into Cubase LE, 
Musical mode is automatically activated and the loops will 
adapt to the tempo set in the project.

Determining the tempo of an audio 
loop and activating Musical mode

You can adapt the tempo of an audio loop, i.e. an audio 
clip of a given musical length, to the project tempo in Cu-
base LE. Once Musical mode has been set, the loop will 
follow any tempo variations in realtime.

The first step is to import a loop. This could be any loop, 
just as long as it meets the basic criteria, e.g. a loop that is 
exactly 2 or 4 bars long at a given tempo (it doesn’t matter 
if you don’t know the tempo).

1. Import a suitable loop, for example a drum loop.

2. Double-click the loop to open it in the Sample Editor.

3. Click the Musical mode button (the note button) so 
that it lights up.

By default, the warp controls are situated on the far right in the Sample 
Editor toolbar.

4. In the dialog that appears, enter the original tempo of 
the loop (this is often part of the loop name, e.g. 
“SloGroove_105bpm”).

• On the toolbar, you can find three fields displaying the 
time signature, audio tempo and bars & beats, allowing 
you to inspect your settings. If the bar count is wrong for 
example, you should correct the tempo. This is done in the 
Tempo column in the Pool window (provided that Musical 
mode is deactivated in the Sample Editor).
If you have not specified the tempo in the Pool or (by activating Musical 
mode) in the Sample Editor, these fields will display the default setting of 
“0”.

The signature, audio tempo and tempo fields in the Sample Editor.

! ACID® loops, other commercial loops, and loops 
you created yourself containing tempo/length infor-
mation will automatically have Musical mode acti-
vated when they are imported, and the steps below 
are not necessary.
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When the Musical mode is activated and the tempo is set, 
the loop is automatically stretched. On the Sample Editor 
toolbar, you can find a warp setting pop-up menu and a 
warp icon. The warp icon lights up if the audio clip is 
stretched or pitch-shifted/transposed. 

On the “warp setting” pop-up, you can find various warp 
options that govern the audio quality of the realtime time 
stretching. There are presets for common types of audio 
material and an Advanced option where you can manually 
set warp parameters. See “Warp settings” on page 120 
for a description of these parameters.

5. Select the warp setting preset that best corresponds 
to the audio loop material and close the Sample Editor.

6. Activate playback.

Now the loop will automatically adjust to the project 
tempo, and follow any further tempo changes you make! In 
the Project window, the audio event will have a note sym-
bol and two arrows in the lower right corner. The note 
symbol indicates Musical mode and the arrow indicates 
that the file is stretched.

Activating Musical mode from within the Pool
It is also possible to activate/deactivate Musical mode 
from within the Pool by clicking the respective checkbox in 
the Musical column. 

When you have correctly set a tempo or length for an au-
dio clip, this information is saved with the project. This al-
lows you to import files into the project with Musical mode 
already activated. The tempo (if set) is also saved when 
exporting files.

If you import a new file into the Pool, or if a clip in the pool 
has not had tempo or length set, the tempo is unknown. If 
you try to activate Musical mode in the Pool for such files, 
a dialog appears where you have to enter the tempo be-
fore Musical mode is activated. The default value is the 
current project tempo.

Warp settings
The “warp setting” pop-up menu, which is located on the 
Sample Editor toolbar, contains various presets affecting 
the realtime time stretching sound quality. These presets 
have self-explanatory names like “Drums” and “Mix”, 
where the parameters involved have been optimized for 
the corresponding type of audio material.

The following warp settings are available:

Advanced settings

If you select the Advanced menu item, a dialog opens 
where you can manually change the three parameters that 
govern the sound quality of the time stretching:

Option Description

Drums This mode will best preserve the rhythmic accuracy of unpitched 
audio that contains many transients (e.g. drum loops).
Using this option for pitched audio will lead to noticeable arte-
facts.

Plucked This should be used for audio with transients and a relatively sta-
ble spectral sound character (e.g. plucked instruments).

Pads Use this mode for pitched audio with slower rhythmics and a 
stable spectral sound character. This will minimize sound arte-
facts, but the rhythmic accuracy will not be preserved.

Vocals This mode was optimized for slower signals with transients and 
a prominent tonal character (e.g. vocals).

Mix This mode will preserve the rhythm and minimize the artefacts 
for pitched material which does not meet the above criteria (i.e. 
with a less homogenous sound character). 
This will be selected by default for audio that is not categorized.

Advanced This allows for a manual tweaking of the time stretching parame-
ters. By default, the settings that are shown when you open the 
dialog are those of the last used preset (except if the Solo mode 
was selected, see below). The Advanced settings are described 
in more detail below this table.

Parameter Description

Grainsize The realtime time stretching algorithm splits the audio into 
small pieces called “grains”. This parameter determines the 
size of the grains. For material with many transients you 
should use low Grainsize values for best results. 

Overlap Overlap is the percentage of the whole grain that will over-
lap with other grains. Use higher values for material with a 
stable sound character.
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Realtime pitch shifting of audio 
events
Audio events can be pitch-shifted in real time just like MIDI 
events. 

The process is very simple:

1. Select one or several audio events in the Project win-
dow.
Audio parts cannot be transposed.

2. Open the event info line.

3. Set a value in the Transpose field to the far right on the 
info line.
The value range is up/down two octaves in semitone steps. 

4. Press [Enter].
All selected audio events are now transposed to the set value using pitch 
shift. The same general rules apply as for other event editing on the info 
line, see “The info line” on page 19.

• You can also fine-tune selected audio events in cent 
steps (100ths of a semitone) by entering a value in the 
Finetune field to the right.

Freezing the realtime processing
You can “freeze” any realtime processing at any time. This 
can be done to serve two purposes; to conserve CPU 
power and to optimize the sound quality of the processing. 

• Select the audio event(s) you wish to process and se-
lect “Freeze Timestretch and Transpose” from the Real-
time Processing submenu of the Audio menu.
When the freeze processing is applied, a copy of the original file is auto-
matically created in the Pool so that the original audio clip remains intact.

After freezing, the audio clip is like any standard audio clip 
before applying realtime processing, i.e. it will not follow 
tempo changes. The freeze processing function is best 
used when you have determined the tempo or key of a 
project, but you can of course always adapt the audio to a 
new key or tempo. In this case, it is better to revert back to 
the original audio clip rather than to process the already 
processed file again.

Variance Variance is also a percentage of the whole length of the 
grains and sets a variation in positioning so that the overlap-
ping area will sound smooth. A Variance setting of 0 will 
produce a sound akin to time stretching used in early sam-
plers, whereas higher settings will produce more (rhythmic) 
“smearing” effects but less audio artefacts.

! Audio and MIDI events cannot be transposed simul-
taneously.

Parameter Description
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Background
Hitpoint detection is a special feature of the Sample Edi-
tor. It detects attack transients in an audio file and then 
adds a type of marker, a “hitpoint”, at each transient. 
These hitpoints allow you to create “slices”, where each 
slice ideally represents each individual sound or “beat” in 
a loop (drum or other rhythmic loops work best with this 
feature). When you have successfully sliced the audio file, 
you can do a number of useful things with it:

• Change the tempo without affecting the pitch.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the 

basic feel.
• Extract sounds from loops.

The term “loop” is used throughout this chapter. Loop 
in this context means an audio file with a musical time 
base, i.e. the length of the loop represents a certain num-
ber of bars and/or beats at a certain tempo. Playing the 
loop back at the right tempo in a cycle set to the correct 
length will produce a continuous loop without gaps.

Using hitpoints
The basic functionality of using hitpoints to slice up a loop 
is to make a loop fit the tempo of a song, or alternatively to 
create a situation that allows the song tempo to be 
changed while retaining the timing of a rhythmic audio 
loop, just like when using MIDI files. 

Which audio files can be used?
Here are some guidelines as to what type of audio files are 
suited for slicing using hitpoints:

• Each individual sound in the loop should have some no-
ticeable attack. 
Slow attacks, legato playing etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice cor-
rectly.
In these cases, try to normalize the files or to remove DC Offset.

• There may be problems with sounds drowned in smear-
ing effects, like short delays.

Calculating hitpoints and slicing a loop – a 
quick tutorial
Before proceeding, find a suitable loop using the criteria 
above. Proceed as follows:

1. Open the event or clip for editing in the Sample Editor.
You can do this by double-clicking an event on an audio track in the 
Project window or a clip in the Pool. In this example, we assume you 
work with an event on a track.

2. Click the Hitpoint Mode button on the toolbar.
Now the Sensitivity slider is added, and the Use menu is activated. The 
items on this pop-up don’t affect the actual detection but rather which 
hitpoints will be shown afterwards. If you e.g. know that your loop is 
based on 1/16th notes, select “1/16”. If you’re uncertain, set this to “All” 
– you can change this setting afterwards if needed.

The Hitpoint Mode button

3. Select the Hitpoint Edit tool on the Sample Editor tool-
bar or open the Audio menu and select “Calculate Hit-
points” on the Hitpoints submenu.
The hitpoints are detected.

The Hitpoint Edit tool

Now, as you can see, hitpoints have been set at the begin-
ning of each sound in the loop.
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4. If you now move the hitpoint sensitivity slider to the 
left, this gradually hides the hitpoints. Moving the slider to 
the right increases the sensitivity to reveal additional hit-
points detected during the calculate process.
The basic aim is to add, remove or in various other ways edit the hitpoints 
so that one individual sound is played between each hitpoint. For details, 
see “Editing hitpoints” on page 124.

In the next step, the loop will adapt to the project tempo 
set in Cubase LE.

5. Pull down the Audio menu and select “Create Audio 
Slices from Hitpoints” from the Hitpoints submenu.
The following happens:

• If the original tempo of the audio file is unknown, a dialog 
opens in which you are asked to enter it.

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for 

each hitpoint. 
• The audio event is replaced by an audio part, containing the 

slices (double-click the part to view the slices in the Audio 
Part Editor).

• The loop is automatically adapted to the project tempo.

The slices in the Audio Part Editor. Here, the project tempo was higher 
than the loop’s original tempo – the slice events overlap slightly.

• If you opened the Sample Editor for a clip in the Pool, 
you will find that the icon for the clip changes in the Pool 
(to indicate that it is sliced).
Dragging the sliced clip from the Pool to an audio track will create an au-
dio part with the slices adapted to the project tempo, just as above.

6. If you activate cycle playback on the Transport panel, 
the loop should now play back seamlessly at the tempo 
set in the program!

• Note that if the project tempo is lower than the original 
tempo of the loop, there may be audible gaps between 
each slice event in the part.
This can be remedied by using the Close Gaps function on the Ad-
vanced submenu of the Audio menu, see “Close Gaps” on page 128. 
You should also consider activating auto fades for the respective audio 
track – fade-outs set to about 10 ms will help eliminate any clicks be-
tween the slices when you play back the part. See “Auto Fades and 
Crossfades” on page 64.

• If the project tempo is higher than the loop’s original 
tempo, you may want to activate auto crossfades for the 
track.
You can use the Close Gaps functions in this case as well, see “Close 
Gaps” on page 128.

Editing hitpoints
In this section, we go back a bit and look at what can be 
done with hitpoints in the Sample Editor. There are two 
ways to invoke the hitpoint calculation:

• Select Calculate Hitpoints from the Hitpoints submenu 
on the Audio menu.

• Select the Hitpoint Edit tool from the toolbar or Quick 
menu.
The last method will calculate hitpoints if they haven’t already been cal-
culated.

As outlined in the previous section, this makes the pro-
gram calculate hitpoints in the audio event, and you can 
use the Sensitivity slider to change how many hitpoints 
are shown. 

For some loops, this may be all that is needed to set the 
hitpoints so that each slice to be created will contain a 
single “hit” or sound. However, there will almost certainly 
be cases when the automatic calculation may add a hit-
point where there shouldn’t be one, and fail to add a hit-
point where one is needed, even if the Sensitivity slider is 
set to maximum. If there are too many or too few hitpoints 
in a loop, it will not play back properly.

When this occurs, you have to edit the hitpoints manually 
in the Sample Editor.
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Auditioning slices
A slice is a section of the waveform, from one hitpoint to 
the next. 

The first thing you should do before editing hitpoints is to 
listen to each slice in the Sample Editor to determine what 
they contain. The aim is to avoid “double hits”, like a snare 
hit being followed by a hi-hat hit within the same slice. You 
also want to determine whether any hitpoints have been 
added that should be removed: 

1. Open a loop in the Sample Editor.
If you have already created slices, you can open them in the Sample Ed-
itor by double-clicking any event in the Audio Part Editor. If it is a new 
loop, follow the instructions in the tutorial.

2. Select the Hitpoint Edit tool.
When you point in the waveform display, the pointer changes to a 
speaker icon.

3. Now you can simply point and click in any slice area 
and the corresponding slice will be played back from the 
beginning to the end.
Listen for “double hits” and slices that contain parts of a single sound. 

If you find hitpoints that need to be removed or instances 
where a hitpoint needs to be added, the first thing to try is 
to change the sensitivity setting – see the following section.

Setting the sensitivity
The loop is first analyzed to determine where hitpoints 
should appear (where the individual “beats” in the loop are), 
then you manually set the sensitivity with the Sensitivity 
slider to determine how many hitpoints there should be.

• Try raising the sensitivity to add “missing” hitpoints and 
lowering it to remove unwanted hitpoints.
This may or may not work, depending on the situation, but as a general 
rule you should try this first.

• Audition the slices again to determine if changing the 
sensitivity has improved matters.

The “Use” pop-up menu

The “Use” pop-up menu on the toolbar affects which hit-
points are shown and is a useful tool for removing un-
wanted hitpoints. The options on the pop-up menu are:

How many slices do I need?

If your main reason for slicing the loop is to change the 
tempo, you generally need as many slices as you can get, 
but never more than one per individual “hit” in the loop.

Option Description

All All hitpoints are shown (taking the Sensitivity slider into 
account).

1/4, 1/8, 
1/16, 1/32

Only hitpoints that are close to the selected note value 
positions within the loop will be shown (e.g. close to ex-
act sixteenth note positions, if the 1/16 option is se-
lected). Again, the Sensitivity slider is taken into account.

Metric Bias This is like the “All” mode, but all hitpoints that are close 
to even meter divisions (1/4 notes, 1/8 notes, 1/16 
notes, etc.) get a “sensitivity boost” – they are visible at 
lower Sensitivity slider settings. This is useful if you are 
working with dense or cluttered material with a lot of hit-
points, but you know that the material is based on a strict 
meter. By selecting Metric Bias it will be easier to find the 
hitpoints close to the meter position (although most other 
hitpoints are also available, at higher sensitivity settings).



126

Working with hitpoints and slices

Disabling slices
You might run into situations where there are too many 
slices – a single sound may have been split into two 
slices, for example. You could of course reduce the sensi-
tivity to get rid of the hitpoints you don’t want, but then 
other hitpoints could disappear too, which may be unde-
sirable. What you need to do in a situation like this is to 
disable an individual slice using the Hitpoint Edit tool:

1. Select the Hitpoint Edit tool.

2. Press [Alt]/[Option] and move the pointer to the han-
dle (the triangle).
The pointer turns into a cross in the Sample Editor window. 

3. Click on the handle of the hitpoint you wish to disable.
The hitpoint handle is diminished and its line disappears to indicate that 
it is disabled.

4. Now, the hitpoint won’t be taken into account when 
you create slices.

5. To reactivate a disabled hitpoint, [Alt]/[Option]-click 
on the hitpoint handle with the Hitpoint Edit tool.

Locking slices
If you lock a hitpoint by clicking on its handle with the Hit-
point Edit tool, it will stay even if you drag the Sensitivity 
slider all the way to zero. This can be used in situations 
where one or several slices contain double hits, but raising 
the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when audi-
tioning.

2. Remember the current slider setting.

3. Raise the Sensitivity slider to a higher value so that a 
hitpoint appears, separating the two sounds.
Most likely this will add a lot of other unwanted hitpoints as well.

4. Audition to make sure you got what you wanted.

5. Select the Hitpoint Edit tool and point at the handle.
The speaker icon changes to a normal arrow pointer.

6. Lock the new slice by clicking on its handle.
Locked hitpoints are displayed in a darker color.

7. Drag the Sensitivity slider to the original setting.
The locked hitpoint will remain shown.

• You can unlock a locked hitpoint by clicking it again 
with the Hitpoint Edit tool with [Alt]/[Option] pressed.

Setting hitpoints manually
If you cannot get the desired result by adjusting sensitivity, 
disabling or locking, you can add, move and delete hit-
points manually.

Adding hitpoints

Manually adding hitpoints can be done in situations where 
a hitpoint is missing at a specific point, but doesn’t appear 
even if the sensitivity is set to full.

1. Zoom in on the waveform at the point where you wish 
to add a hitpoint.

2. Audition the area with the Hitpoint Edit tool to make 
sure that the start of the sound is in view.

3. Activate Snap to Zero Crossing on the Sample Editor 
toolbar.
By finding zero crossings in the waveform (positions where the amplitude 
is close to zero), manually added slices won’t introduce any clicks or 
pops. All hitpoints found by the Calculate function are automatically 
placed at zero crossings.

4. Press [Alt]/[Option] with the Hitpoint Edit tool selected 
so that the mouse pointer changes to a pencil tool and 
click just before the start of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

! Snap to Zero Crossing may alter the timing. In some 
cases it might be better to deactivate it, however, if 
you create slices afterwards, auto fades will be ne-
cessary.
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• If you click and keep the mouse button pressed, you can 
adjust the position of the new hitpoint by dragging.
Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Play tool to make sure 
you got what you wanted.

Moving hitpoints

If you manually added a hitpoint, and it was either placed 
too far away from the start of the sound or too far into the 
sound, you can manually move the hitpoint. It is also pos-
sible to move calculated hitpoints this way.

1. Make sure Snap to Zero Crossing is activated on the 
Sample Editor toolbar.

2. Select the Hitpoint Edit tool.

3. Click on the hitpoint handle and drag it to the new po-
sition.

Deleting hitpoints

To delete a hitpoint, select the Hitpoint Edit tool and drag 
the hitpoint out of the Sample Editor window. Hitpoints 
that you have created manually can also be deleted by 
clicking their handle with the Hitpoint Edit tool.

About Q-points

Optionally, hitpoints can have individual Q-points. Their 
function is to define the point to which the quantizing will 
apply. Sometimes a slice might have a slow attack, and a 
peak further into the slice which you wish to use as the Q-
point. This defines the point which will be stretched to a 
grid position when quantizing.

• To activate Q-points, open the Preferences dialog (Edit-
ing–Audio page) and activate the option “Hitpoints have Q-
Points”.
Next time you use the Calculate Hitpoints function, the hitpoints will have 
Q-points. Manually added hitpoints do not have Q-points.

• To offset the position of a Q-point in relation to the hit-
point, simply click on the “Q” icon and drag it to the right 
to the desired position.

Creating slices
After you have specified the correct loop length and time 
signature and worked on the hitpoints in the Sample Edi-
tor so that one sound per slice is heard, it is time to actu-
ally slice the file (if that is what you want to do – there are 
other uses for hitpoints as well, as described below). This 
is done by selecting “Create Audio Slices from Hitpoints” 
from the Hitpoints submenu on the Audio menu.

The following happens:

• If you edited an event on an audio track, the Sample Ed-
itor closes.

• The audio event is “sliced” so that there is a separate 
event for each hitpoint.
In other words, the sections between the hitpoints become separate 
events, all referring to the same original file.

• On the audio track, the former audio event is replaced 
by an audio part that contains the slices. 
If you edited a clip from the Pool, you need to drag it to an audio track to 
get a part with the slices. 

• The loop is automatically adapted to the tempo set in 
Cubase LE.
This takes the loop length you specified into account: e.g., if the loop 
was one bar long, the part is resized to fit exactly one bar in the Cubase 
LE tempo, and the slices are moved accordingly, keeping their relative 
positions within the part.

You can change the tempo and have the loop automati-
cally follow. Furthermore, you can double-click the part to 
edit the slices in the Audio Part Editor to: 

• Remove or mute slices.
• Change the loop by reordering, replacing or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce Se-

lection” function on the Audio menu.
• Realtime transpose and stretch slices.
• Edit slice envelopes.

! When you create slices, all events containing the ed-
ited clip will also be replaced.
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Other hitpoint functions
On the various submenus on the Audio menu, you will also 
find the following functions:

Create Markers from Hitpoints
This is located on the Hitpoints submenu. If an audio event 
contains calculated hitpoints, this function can be used to 
add markers – one for each hitpoint – to an existing or auto-
matically created marker track (see “Using the Marker track” 
on page 72). This can be useful for locating to hitpoints.

Divide Audio Events at Hitpoints
This Hitpoints submenu item can be used when you simply 
wish to create separate events according to the hitpoints 
for a file. This means that you do not have to make the same 
considerations as when slicing for tempo changes. You can 
use any method you like to set hitpoints, i.e. use sensitivity, 
note values, manually or any combination.

• The slices created will appear in the Project window as 
separate events.

Set Audio Event from Loop
This Advanced submenu function will resize the event ac-
cording to the loop range in the Sample Editor.

Set Tempo from Event
This Advanced submenu function sets the project tempo 
according to the original tempo of the loop (as specified in 
the Sample Editor or in the Pool). The result depends on 
whether you are using a fixed tempo or the Tempo track.

• If you are using fixed tempo, you will be asked to confirm 
that you want to change this – click Yes to set the fixed 
tempo to the event’s original tempo.

• If you are using the Tempo track, but there are no tempo 
changes, you will be asked whether the global tempo 
should be changed.
Click Yes to change the global tempo (the first tempo event on the 
Tempo track) or No to insert tempo events at the beginning and end of 
the audio event (i.e. the project tempo will be adapted to the loop tempo 
but only during the course of the event).

• If you are using the Tempo track with tempo changes, 
new tempo events will be inserted at the beginning and 
end of the audio event.
The project tempo will be adapted to the loop tempo during the course 
of the event.

Stretch to Project Tempo
This Advanced submenu function makes use of the origi-
nal tempo and applies time stretch to the selected event, 
so that it fits the current project tempo.

This can be used for stretching a whole loop (not sliced) 
to the project tempo.

Close Gaps
If you have sliced a loop for tempo changes, lowering the 
tempo below the loop’s original tempo will create gaps 
between the slices. The lower the tempo is in relation to 
the original tempo, the wider the gaps will be. This can be 
fixed using the “Close Gaps” function on the Advanced 
submenu:

1. Set the desired tempo.

2. Select the part in the Project window.

3. Select “Close Gaps” from the Advanced submenu.
Now time stretch is applied on each slice to close the gaps. Depending 
on the length of the part, this can take a little while.

4. The waveform is redrawn and the gaps are closed!

• Note that this feature creates new clips in the Pool, one 
for each slice.

• Close Gaps can also be used when the project tempo 
is higher than the original loop tempo.
This will use the time stretch function to shrink the slices to fit.

• If you decide to change the tempo again after using the 
Close Gaps function, you should undo the Close Gaps 
operation or start over again, using the original un-
stretched file.

• You can also use this function on individual events (in 
the Audio Part Editor or Project window).
The events don’t have to be slices – you can use Close Gaps simply to 
stretch an audio event to the start position of the next event.
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Background

What is the Pool?
Every time you record on an audio track, a file is created 
on your hard disk. A reference to this file – a clip – is also 
added to the Pool. Two general rules apply to the Pool:

• All audio and video clips that belong to a project are 
listed in the Pool.

• There is a separate Pool for every project.

The way the Pool displays folders and their contents is 
similar to the way the Mac OS X Finder and the Windows 
Explorer display folders and lists of files.

What can you do in the Pool?
In the Pool you can, among other things, perform the fol-
lowing operations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or 
converted).

• Convert file formats.
• Rename clips (this will also rename the referred files on disk).
• Delete clips (if you select the “Move to Trash” option and 

empty the Trash folder – see “Deleting clips” on page 133).
• Prepare File Archives for backup.
• Minimize files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.

Opening the Pool
You open the Pool in any of the following ways:

• By clicking the Pool icon in the Project window.

• By selecting “Pool” on the Project menu or “Open Pool Win-
dow” on the Media menu.

• By using a key command (by default [Ctrl]/[Command]+[P] – 
note that using this key command a second time will close the 
Pool again).

The content of the Pool is divided into three main folders: 

• The Audio folder
This contains all audio clips currently in the project.

• The Video folder
This contains all video clips currently in the project.

• The Trash folder 
Unused clips can be moved to the Trash folder for later permanent re-
moval from the hard disk.

These folders cannot be renamed or deleted from the 
Pool, but any number of subfolders can be added (see 
“Organizing clips and folders” on page 138).

Window Overview

Audio folder

Trash folder Video folder

Audio clip name

Waveform image

Column Headings

Toolbar
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Toolbar overview

The info line
Click the “Show Info” button on the toolbar to show or 
hide the info line at the bottom of the Pool window. It 
shows the following information:

How clips are displayed in the Pool
• Audio clips are represented by a waveform icon followed by 

the clip name.

• Video clips are represented by a camera icon followed by the 
clip name.

The Pool window columns
Various information about the clips can be viewed in the 
Pool window columns. The columns contain the following 
information:

About the Status column symbols

The Status column can display various symbols that relate 
to the clips status. The following symbols can be shown:

Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This 
is done by clicking on the corresponding column heading. 
Clicking again on the same heading switches between as-
cending and descending sort order.

Column Description

Media This column contains the Audio, Video and Trash folders. 
If the folders are opened, the clip names are shown and 
can be edited. This column is always shown.

Used This column displays the number of times a clip is used in 
the project. If a column row is empty, the corresponding 
clip is not used.

Open/Close all 
FoldersView / Attributes

Pop-up

Hide/show 
info line

Import Button

Project Folder Path

Pool Record Folder Path
Play and Loop buttons, 
audition volume control

Search Button

Number of audio 
files in the Pool

Number of files in the Pool that are not 
in the project folder (e.g. video files)

Total size of all audio 
files in the Pool

Number of audio 
files in use

Status This column displays various icons that relate to the cur-
rent Pool and clip status. See “About the Status column 
symbols” on page 131 for a description of the icons.

Musical The checkbox in this column allows you to activate or de-
activate Musical Mode. If the Tempo column (see below) 
displays “???”, you have to enter the correct tempo be-
fore you can activate Musical Mode.

Tempo This shows the tempo of audio files for which a tempo 
has been set using the Audio Tempo Definition tool. If no 
tempo has been specified, the column displays “???”. 

Sign. This is the time signature, e.g. “4/4”.

Info This column shows the following information for audio 
clips: The sample rate, bit resolution, number of channels 
and the length in seconds. For video clips the frame rate, 
number of frames, and length in seconds are shown.

Type This column shows the file format of the clip.

Date This column shows the date when the clip was created.

Origin Time This column shows the original start position where a clip 
was recorded in the project. As this value can be used as 
a basis for the option “Insert into Project” in the Media or 
context menu (and other functions), you can change it if 
the Origin Time value is independent.

Image This column displays waveform images of audio clips. 

Path This column shows the path to the location of a clip on 
the hard disk.

Symbol Description

This indicates the current Pool Record folder (see 
“Changing the Pool Record folder” on page 138).

This symbol is shown if a clip has been processed.

The question mark indicates that a clip is referenced to 
the project but is missing from the Pool (see “About mis-
sing files” on page 135).

This indicates that the clip file is external, i.e. located out-
side the current Audio folder for the project.

This indicates that the clip has been recorded in the cur-
rently open version of the project. This is useful for finding 
recently recorded clips quickly.

Column Description
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Customizing the view

• You can specify which of the columns should be shown 
or hidden by selecting the View/Attributes pop-up on the 
toolbar and selecting/deselecting items.

• You can rearrange the order of the columns by clicking 
on a column heading and dragging the column to the left 
or right.
The mouse pointer changes to a hand when you place it on the column 
heading.

• The width of a column can also be adjusted by placing 
the pointer between two column headers and dragging 
left or right.
The pointer changes to a divider when you place it between two column 
headers.

Operations

Renaming clips in the Pool
To rename a clip in the Pool, select it and click on the ex-
isting name, type in a new name and press [Return].

This will also rename the referred files on disk!

Copying clips in the Pool
To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.

2. Select “New Version” on the Media or context menu.
A new version of the clip appears in the same Pool folder, with the same 
name but with a “version number” after it, to indicate that the new clip is 
a duplicate. The first copy made of a clip will logically get the version 
number “2” and so on. 

Inserting clips into a project

By using menus

1. Select the clip(s) you want to insert into the project.

2. Pull down the Media or context menu and select an 
“Insert into Project” option.
The “At Cursor” option will insert the clip(s) at the current project cursor 
position. 
The “At Origin” option will insert the clip(s) at their Origin Time position(s).

• Note that the clip will be positioned so that its snap 
point is aligned with the selected insert position.
You can also open the Sample Editor for a clip by double-clicking it, and 
perform the insert operation from there. This way you can set the snap 
point before inserting a clip.

The arrow indicates the sort 
column and sort order.

! Renaming a clip in the Pool is much preferred to re-
naming it outside Cubase LE (for example on the 
computer desktop). This way Cubase LE already 
“knows” about the change, and won’t lose track of 
the clip the next time you open the project. See 
“About missing files” on page 135 for details about 
lost files.

! Copying a clip does not create a new file on disk, but 
just a new edit version of the clip (referring to the 
same original file).
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3. The clip is inserted on the selected track or on a new 
audio track.
If several tracks are selected, the clip will be inserted on the first selected 
track.

By using drag and drop

You can use drag and drop to insert clips into the Project 
window. You can also use drag and drop from the Sample 
Editor for a clip by making a selection range and pressing 
[Ctrl]/[Command] while dragging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its posi-
tion will be indicated by a marker line and a numerical po-
sition box.
Note that these indicate the position of the snap point in the clip. For ex-
ample, if you drop the clip at the position 10.00, this will be where the 
snap point ends up. See “Adjusting the snap point” on page 110 for in-
formation on how to set the snap point.

• If you position the clip in an empty area in the event dis-
play (i.e. below existing tracks), a new track is created for 
the inserted event.

Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the 
hard disk, proceed as follows:

1. Select the clip(s) and select “Delete” from the Edit 
menu (or press [Backspace] or [Delete]).

If you try to delete a clip that is used by one or more 
events, the program will ask you if you want to remove 
these events from the project.

If you cancel, neither the clip nor the associated events are deleted.

2. Click Remove.
A new prompt asks whether you want to move the clip to the Trash or re-
move it from the Pool.

3. Select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the 
hard disk and can be used in other projects etc. This operation can be 
undone.

Deleting from the hard disk

To delete a file permanently from the hard disk, it must first 
be moved to the Trash folder:

1. Follow the instructions for deleting clips above and se-
lect “Trash”.
Alternatively, you can drag and drop clips into the Trash folder.

2. Select “Empty Trash” on the Media or context menu. 
Choose one of the two options in the alert: 

• Click “Erase” to delete the file on the hard disk perma-
nently.
Remember that this operation cannot be undone!

• Click “Remove from Pool” to remove the clip from the 
Pool but to keep the file.

Snap point

! Before you permanently delete audio files from the 
hard disk, make sure that they are not used by an-
other project!
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To retrieve a clip from the Trash Folder, drag and drop 
it back into an Audio or Video folder.

Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in 
the project. You can then decide whether to move them to 
the Pool Trash folder (where they can be permanently de-
leted) or to remove them from the Pool:

1. Select “Remove Unused Media” on the Media or con-
text menu.
A prompt appears with the text “Move to Trash or Remove From Pool?”

2. Make your selection.

Locating events and clips

Locating events via clips in the Pool

If you want to find out which events in the project refer to a 
particular clip in the Pool, proceed as follows:

1. Select one or more clips in the Pool.

2. Select “Select in Project” on the Media or context 
menu.
All events that refer to the selected clip are now selected in the Project 
window.

Locating clips via events in the Project window

If you want to find the clip for an event in the Project win-
dow, proceed as follows:

1. Select one or more events in the Project window.

2. Pull down the Audio menu and select “Find Selected 
in Pool”.
The corresponding clip(s) will be located and highlighted in the Pool. If 
the Pool window isn’t already open it will be opened.

Searching for audio files
The Pool can help you locate audio files in your Pool, on 
your hard disk or other media. This works much like the 
regular file search, but with a couple of extra features:

1. Click the Search button in the toolbar.
A search pane appears at the bottom of the window, displaying the 
search functions.

The search pane in the Pool.

By default, the search parameter in the search pane is “Name”. For us-
ing other filter criteria, see “Extended search functionality” on page 135 
below.

2. Specify the name of the file(s) to search for in the 
Name field.
You can use partial names or wildcards (*). Note that only audio files of 
the supported formats will be found.

3. Use the Location pop-up menu to specify where to 
search.
The pop-up menu will list all your local drives and removable media. 

• If you want to limit the search to certain folders, choose 
“Select Search Path” and select the desired folder in the 
dialog that appears.
The search will include the selected folder and all subfolders. Note also 
that folders you have recently selected using the “Select Search Path” 
function will appear on the pop-up menu, allowing you to quickly select 
any of them.

4. Click the Search button.
The search is started and the Search button is labeled Stop – click this 
to cancel the search if needed.

When the search is finished, the found files are listed to 
the right.

• To audition a file, select it in the list and use the play-
back controls to the left (Play, Stop, Pause and Loop).
If Auto Play is activated, selected files will automatically be played back.

• To import a found file into the Pool, select it in the list 
and double-click it or click the Import button.

5. To close the search pane, click the Search button in 
the toolbar again.
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The Find Media window

Alternatively to the search pane in the Pool, you can open 
a stand-along Find Media window by selecting the 
“Search Media…” option from the Media or context menu 
(also available from the Project window). This offers the 
same functionality as the search pane. 

• To insert a found clip directly into the project from the 
Find Media window, select it in the list in the dialog and 
select one of the “Insert into Project” options from the Me-
dia or context menu.
The options are described in “Inserting clips into a project” on page 132.

Extended search functionality

Apart from the search criterion Name, additional search fil-
ters are available. To use them, proceed as follows:

1. Click the Search button on the toolbar.
The Search pane is displayed in the lower part of the Pool window.

2. Move the mouse pointer over the “Name” text to the 
right of the name field, until an arrow is displayed, and 
click it.

3. The Extended Search pop-up menu opens.
This contains six options determining which search criteria will be dis-
played above the Location (Name, Size, Bitsize, Channels, Sample Rate 
or Date) and the Add Filter and Presets submenus.

The search criteria have the following parameters:

• Name: partial names or wildcards (*)
• Size: Less than, more than, equal, between (two values), in 

seconds, minutes, hours and bytes
• Bitsize (resolution): 8, 16, 24, 32
• Channels: mono, stereo and from 3 to 16
• Sample Rate: various values, choose “Other” for free setting
• Date: various search ranges

4. Select one of the topmost 6 options in the pop-up 
menu to change the search option above the Location 
pop-up menu.
This way, you can choose e.g. to display the Size or Sample Rate para-
meter instead of the Name field.

5. If you want to display more search options, select the 
desired element from the Add filter submenu.
This allows you e.g. to add the Size or the Sample Rate parameters to 
the already displayed Name and Location parameters.

This allows for a very detailed search, helping you to mas-
ter even the largest sound database.

• You can store presets of your search filter settings. For 
this, click Store Presets in the Presets submenu and enter 
a name for the preset.

Existing presets will be offered at the bottom of the list. To remove a 
preset, click on the preset to activate it, then choose Remove Preset.

About missing files
When you open a project, the Resolve Missing Files dialog 
(see below) may open, warning you that one or more files 
are “missing”. If you click Close in the warning dialog, the 
project will open anyway, without the missing files. In the 
Pool you can check which files are considered missing. 
This is indicated by a question mark in the Status column.

Move the mouse pointer over the “Name” text to 
the right of the name field and click…

… to show the Extended Search pop-up menu.
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A file is considered missing under one of the following 
conditions:

• The file has been moved or renamed outside the pro-
gram since the last time you worked with the project, and 
you ignored the Resolve Missing Files dialog when you 
opened the project for the current session.

• You have moved or renamed the file outside the pro-
gram during the current session.

• You have moved or renamed the folder in which the 
missing files are located.

Locate missing files

1. Select “Find Missing Files” from the Media or context 
menu.
The Resolve Missing Files dialog opens. 

2. Decide if you want the program to try to find the file for 
you (Search), if you want to do it yourself (Locate) or if you 
want to specify in which directory the program should 
search for the file (Folder).

• If you select Locate, a file dialog opens, allowing you to 
locate the file manually.
Select the file and click “Open”.

• If you select Folder, a dialog opens to let you specify the 
directory in which the missing file can be found.
This might be the preferred method if you have renamed or moved the 
folder containing the missing file, but the file still has the same name. 
Once you select the correct folder, the program finds the file and you can 
close the dialog.

• If you select Search, a dialog opens to let you specify 
which folder or disk should be scanned by the program. 
Click the Search Folder button, select a directory or a disk and click the 
Start button. If found, select the file from the list and click “Accept”. 
Afterwards Cubase LE tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have acciden-
tally deleted it from the hard disk), it will normally be indi-
cated with a question mark in the Status column in the 
Pool. However, if the missing file is an edit file (a file cre-
ated when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the pro-
gram to reconstruct it by recreating the editing to the orig-
inal audio file:

1. Open the Pool and locate the clip(s) for which files are 
missing.

2. Check the Status column – if it says “Reconstruct-
ible”, the file can be reconstructed by Cubase LE.

3. Select the reconstructible clips and select “Recon-
struct” from the Media or context menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or re-
constructed, you may want to remove these. For this, select 
“Remove Missing Files” from the Media or context menu. 
This will remove all missing files from the Pool as well as 
their corresponding events from the Project window.

Auditioning clips in the Pool
There are two methods you can use to audition clips in the 
Pool:

• By selecting a clip and activating the Play button.
The whole clip will play back, unless you stop playback by clicking the 
Play button again.

The Play button.
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• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end 
of the clip, unless you stop playback by clicking the Play button, or by 
clicking anywhere else in the pool window.

Click in the waveform image to audition a clip.

You can adjust the auditioning level with the miniature 
level fader on the toolbar. This does not affect the regular 
playback level.

If you have activated the Loop button before you audition, 
the following will happen:

The Loop button.

• If you click the Play button to audition a clip, it will repeat 
indefinitely until you stop playback by clicking the Play or 
Loop button again.

• If you click in the waveform image to audition, the sec-
tion from the point you clicked to the end of the clip will re-
peat indefinitely until you stop playback.

Opening clips in the Sample Editor
The Sample Editor allows you to perform detailed editing 
on the clip (see “The Sample Editor” on page 106). 

If you double-click on a clip waveform icon or a clip name 
in the Media column, the clip will open in the Sample 
Editor.

One practical use for this is to set a snap point for a clip 
(see “Adjusting the snap point” on page 110). When you 
later insert the clip from the Pool into the project, you can 
have it properly aligned according to the set snap point.

Import Medium...
The Import Medium dialog lets you import files directly into 
the Pool. It is opened from the Media or context menu or 
with the Import button in the Pool window.

This is a standard file dialog, where you can navigate to 
other folders, audition files etc. The following audio file for-
mats can be imported:

• Wave
• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see “Importing ReCycle files” on page 240)
• SD2 (Sound Designer II) 
• MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see “Impor-

ting compressed audio files” on page 241)
• Windows Media Audio (Windows – see “Importing com-

pressed audio files” on page 241)

They may have the following characteristics:

• Stereo or mono
• Any sample rate (although files with another sample rate than 

the one used in the project will play back at the wrong speed 
and pitch – see below).

• 8, 16, 24 bit or 32 bit float resolution

The following videos formats can also be imported:

• AVI (Audio Video Interleave)
• MOV and QT (QuickTime)
• DV (Mac OS X only)
• MPEG 1 and 2 video files

! For video files to be played back correctly, the right 
codecs have to be installed.

Clicking the Import button opens the Import dialog:
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It is also possible to use the commands on the Import 
submenu on the File menu to import audio or video files 
into the Pool.

When you select a file in the Import Medium dialog and 
click Open, the Import Options dialog opens:

It contains the following options:

• Copy File to Working Directory.
Activate this if you want a copy of the file to be made in the Audio folder 
of the project, and have the clip refer to this copy. If the option is off, the 
clip will refer to the original file in the original location (and will thus be 
marked as “external” in the Pool – see “About the Status column sym-
bols” on page 131).

• Convert to Project section:
Here you can choose to convert:
• the sample rate (if the sample rate is different than the one set for 

the project)
• the sample size, i.e. resolution (if the sample size is lower than the 

record format used in the project)
The options are only available if necessary. Note that if you are importing 
several audio files at once, the Import Options dialog will instead contain 
a “Convert if needed” checkbox. When this is activated, the imported 
files will be converted only if the sample rate is different or the sample 
size is lower than the project’s.

• Do not Ask again.
If this is activated, files will always be imported according to the settings 
you have made, without this dialog appearing. This can be reset in the 
Preferences (Editing–Audio page). 

You can always convert files later by using the Convert 
Files (see “Convert Files” on page 140) or Conform Files 
(see “Conform Files” on page 140) options.

Changing the Pool Record folder

The Pool Record folder.

In the Pool Record folder, all audio clips that you record in 
the project will end up. The Pool Record folder is indi-
cated by the text “Record” in the Status column and by a 
red dot on the folder itself, as shown in the picture above. 
By default, this is the main Audio folder. You can, how-
ever, at any time create a new Audio subfolder and desig-
nate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or a subfolder in it) as the Pool 
Record folder.

2. Select “Create Folder” on the Media or context menu.
A new empty audio subfolder appears in the Pool.

3. Select the new folder.

4. Select “Set Pool Record Folder” on the Media or con-
text menu, or click in the Status column of the new folder.
The new folder now becomes the Pool Record folder, and any audio re-
corded in the project will be saved in this folder.

Organizing clips and folders
If you accumulate a large number of clips in the Pool, it 
may sometimes be difficult to quickly find specific items. In 
such cases, organizing clips in new subfolders with suit-
able names that reflect the content can be a solution. For 
example, you could put all sound effects in one folder, all 
lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, for which you 
want to create a subfolder.
You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Media on context menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Click on the name and enter an appropriate name for 
the folder.

4. Drag and drop the clips you wish to move to the new 
folder.

5. Repeat steps 1-4 as necessary.
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Applying processing to clips in the Pool
You can apply audio processing to clips from within the 
Pool in the same way as to events in the Project window. 
Simply select the clip(s) and choose a processing method 
from the Audio menu. To find out more about audio pro-
cessing, see “Audio processing and functions” on page 
100.

Undo processing
If you have applied processing to a clip, either in the 
Project window or in the Pool, this is indicated by the red 
and grey waveform symbol in the Status column.

Freeze Edits
You can use the Freeze Edits function to create a new file 
with processing applied or to replace the original with a 
processed version, see “Freeze Edits” on page 105.

Minimize File
The option “Minimize File” on the Media or context menu 
allows you to change the size of audio files according to 
the audio clips referenced in a project. The files produced 
using this option will only contain the audio file portions 
actually used in the project. This can significantly reduce 
the size of the project, if large portions of the audio files 
are unused. Therefore, the option is useful for archiving 
purposes after you have completed a project.

This operation will permanently alter the selected au-
dio files in the Pool. This cannot be undone!
If this is not what you want, you can use the option “Save Project to New 
Folder” in the File menu instead, see “Save Project to New Folder” on 
page 238. This function also has the option of minimizing files, but cop-
ies all files into a new folder, leaving the original project untouched.

Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” on the Media or context menu.
An alert appears, informing you that the entire Edit History will be 
cleared. Click Minimize to proceed or Cancel to stop the process. 

3. After the minimizing is finished, another alert appears, 
because the file references in the stored project have be-
come invalid. 
Click Save Now to save the updated project or click Later to proceed 
with the unsaved project. 

Only the audio portions actually used in the project remain 
in the corresponding audio file(s) in the Pool Record folder.

Prepare Archive
The option “Prepare Archive” on the Media or context 
menu is useful if you want to archive a project. It checks 
that every clip referenced in the project is located in the 
same folder, and takes actions if that is not the case: 

• Any files that are located outside the current project 
folder will be copied to it.
Please note that audio files that reside within the project folder will not be 
copied to the audio folder. You will therefore have to copy them there 
manually before backing up the audio folder or save them separately dur-
ing backup, see below.

• If any processing has been applied, you will be asked 
whether you want to Freeze Edits.
If you do this, you don’t have to archive the Edits folder. Everything belong-
ing to the project will be contained in the project file and the Audio folder.

Once you have performed a Prepare Archive, you can copy 
the project file, the Audio folder and any other audio mate-
rial you saved in the project folder to backup disks, etc.

It is not necessary to archive the Images folder, since 
these Images can be recreated by Cubase LE. You may 
also find a file with the extension “.csh” in the project 
folder. This contains image information for edited clips and 
other data that can be recreated, so it can safely be de-
leted.

! Video clips are always referenced and not stored in 
the project folder.
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Convert Files

Selecting the option “Convert Files” on the Media or con-
text menu opens the Convert Options dialog which oper-
ates on selected files. Use the pop-up menus to specify 
which audio file attributes you want to keep and which you 
want to convert. The available settings are:

• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

• Sample Width
Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or 
32 Bit float.

• Channels
Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave or AIFF format.

Options

When you convert a file, you can use the Options pop-up 
to set one of the following options regarding what to do 
with the new file:

Conform Files
By using this Media or context menu command, you will 
change all selected files that have different file attributes 
than what is specified for the project, to conform to this 
standard.

Proceed as follows:

1. Select the clips in the Pool.

2. Select “Conform Files” on the Media or context menu.
A dialog opens allowing you to choose between keeping or replacing the 
original unconverted files in the Pool. The following applies:

• Clip/event references in the pool are always redirected to the 
conformed files.

• If any 'keep' option is selected, original files remain in the 
Project’s Audio folder and new files are created.

• If you select the “Replace” option, files in the Pool and in the 
Project’s Audio folder are replaced.

Option Description

New Files Creates a copy of the file in the audio folder and converts 
this new file according to the chosen attributes. The new 
file is added to the Pool, but all clip references will still 
point to the original, unconverted file.

Replace Files Converts the original file without changing clip refer-
ences. The references are however saved with the next 
save action.

New + Replace 
in Pool

Creates a new copy with the chosen attributes, replaces 
the original file with the new one in the Pool and redirects 
the current clip references from the original file to the 
new file. This is the option to select if you want your audio 
clips to refer to the converted file, but still want to keep 
the original file on disk (e.g. if the file is used in other 
projects).



17
VST Instruments and Instrument tracks



142

VST Instruments and Instrument tracks

Introduction
VST Instruments are software synthesizers (or other 
sound sources) that are associated with Cubase LE. They 
are played internally via MIDI, and their audio outputs ap-
pear on separate channels in the mixer, allowing you to 
add effects or EQ, just as with audio tracks.

The VST Instrument HALionOne is included with Cubase 
LE, others can be purchased separately from Steinberg 
and other manufacturers. 

This chapter describes the general procedures for 
setting up and using VST Instruments.
For a description of HALionOne and its parameters, see the chapter 
“HALionOne” in the Plug-in Reference.

Activating and using VST 
Instruments
VST Instruments can be activated by creating Instrument 
tracks. Instrument tracks are a combination of a VST In-
strument, an Instrument channel and a MIDI track. You 
play and record MIDI note data directly for this track.

Instrument tracks feature a single MIDI input and a single 
stereo output. 

An instrument track corresponds to one channel in the 
mixer, which corresponds to one VST Instrument that is set 
up automatically with the instrument track. All automation 
parameters are available directly in the instrument track. 
This way, you can move VST Instrument automation curves 
together with the MIDI data.

• Instrument tracks provide a very convenient way of 
quickly browsing for and auditioning preset sounds before 
you actually create the track! 

• Instrument tracks have Inserts, Sends, EQ, etc.

There are certain limitations that apply to Instrument tracks:

• As there is only one stereo output available, you cannot 
use multiple outputs for VST Instruments loaded in an In-
strument track.
Thus, you can only use the first output channel pair of a multitimbral in-
strument.

• The MIDI volume and pan are not visible. Instead, the 
VST Instrument volume and pan are displayed.

• The output device of an Instrument track always has to 
be a VST Instrument.

Creating an instrument track
1. To add a track, either open the Project menu, select 
the “Add Track” option and choose “Instrument” or right-
click in the track list to open the context menu and select 
“Add Instrument Track”.

2. In both cases, the Add Instrument Track dialog opens, 
providing a list of available VST Instruments.

• You can either select a VST Instrument from the list or 
proceed without specifying an instrument.

• If you want to add more than one instrument track, set 
the corresponding number in the count field. 

3. Click OK to create the instrument track(s).
The instrument track appears in the Track list and as an Instrument channel 
in the mixer.

The instrument channel in the mixer…

…and the instrument track 
in the track list.
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The instrument panel does not open automatically (re-
gardless of whether an instrument was selected in the 
“Add Instrument Track” dialog or not). If a device was se-
lected, the track will have the same name as the instru-
ment, otherwise it will be named “Instrument Track”. 

• In the Inspector, you can select a VST Instrument from 
the Instrument pop-up.
Only VST Instruments are available on the pop-up. When you select an 
instrument on this pop-up menu, its control panel is opened.

• On the Input Routing pop-up you can select a MIDI input.
Instrument tracks only have one MIDI input.

• To open the control panel for the VST Instrument, click 
the “Edit Instrument” button in the Inspector.

• Recording/playing the instrument is done just like for 
MIDI tracks.

Editing an instrument track/channel
According to the “mixed” nature of the instrument track, 
the features and parameters of VST Instruments as well as 
of MIDI tracks are available for editing:

• You can solo and mute tracks or add, modify or bypass 
audio inserts and EQs etc. 

• You can perform the usual MIDI editing procedures on 
the instrument track.

• You can adjust track delay, choose the MIDI input, select 
drum maps, etc.

Using VST presets

About VST presets
VST presets store all panel settings for an instrument, but 
no track/channel settings.

There are two types of VST presets that can be used; the 
VST 2 standard “.fxb/.fxp” files and the new VST 3 preset 
standard with the extension “.vstpreset”.

All VST 2 instruments can import “.fxb/.fxp” files and also 
convert them to the VST 3 standard. Once converted you 
can use all the Preset browser features.

Selecting VST presets
VST Instruments come with a large number of VST pre-
sets for instant selection. Presets can either be accessed 
from the control panel for the instrument or from the In-
spector. 

To select a VST Instrument preset, proceed as follows:

1. Load a VST Instrument by creating an Instrument track.

2. If necessary, click on the track name at the top of the 
Inspector to open the basic track settings.

3. Click in the Programs field in the Inspector.
This opens the Presets Browser. Selecting a new preset overwrites the 
settings of the current preset so any unsaved changes will be lost.

4. To exit the browser, double-click the desired preset or 
click somewhere outside the window to close it.

• You can also open the preset list from the VST Instru-
ment’s control panel. Simply click in the Preset name field.

• If you click the SoundFrame button (the cube symbol), 
the “Load Preset…” dialog opens.
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This dialog is much like the Preset list, but there is a differ-
ence:

• If you use the “Load Preset” dialog, this allows you to 
preview the settings of other presets without actually load-
ing them. If you chose to cancel the operation, the preset 
that was selected before opening the dialog will be re-
loaded exactly as it was, including any unsaved changes. If 
you activate “Auto Preview” below the Viewer section, you 
can step through the presets and play them via MIDI.

• When you use the Preset list, selecting another preset 
will load it directly, replacing the previous preset.

• The Viewer section of the Load Preset dialog and the 
Preset list automatically display all the available presets for 
the instrument.

5. When you have selected an instrument preset, click 
OK to close the Load Preset dialog or – if you used the 
Preset browser – double-click the preset or click outside 
the browser window to close it.

Saving VST Instrument presets
You can save your edited settings for further use (e.g. in 
other projects):

1. In the VST Instrument panel, click the SoundFrame but-
ton to the right of the name field.
This opens a pop-up menu.

2. Select “Save Preset” from the pop-up menu.
This opens a dialog where you can save the current settings as a preset.

Presets are saved into a default folder named VST3 Pre-
sets. Within this folder, there is a folder named “Steinberg 
Media Technologies” where the included presets are ar-
ranged in sub-folders named after each instrument.

You cannot change the default folder, but you can add fur-
ther subfolders inside the instrument’s preset folder.

• Under Windows, the default preset folder is in the fol-
lowing location:
Boot drive/Documents and Settings/User name/Application data/VST3 
Presets.

• Under Mac OS, the default preset folder is in the follow-
ing location:
Users/Username/Library/Audio/Plug-Ins/Presets/

3. In the File name field in the lower part of the dialog you 
can enter a name for the new preset.

4. Click OK to store the preset and exit the dialog.

About earlier VST Instrument presets
You can use any VST 2.x Instrument plug-ins in Cubase 
LE. Adding VST Instrument plug-ins works the same way 
as for audio effects.

When you add a VST 2 plug-in, any previously stored pre-
sets for it will be of the old FX program/bank (.fxp/.fxb) 
standard. You can import such files, but the preset han-
dling will be slightly different. You will not be able to use 
the new features like the Preview function until you have 
converted the old “.fxp/.fxb” presets to VST 3 presets. If 
you save new presets for a VST 2 plug-in these will auto-
matically be saved in the new “.vstpreset” format in the 
default location.

Importing and converting FXB/FXP files

To import .fxp/.fxb files, proceed as follows:

1. Load any VST 2 instrument you may have installed, and 
click on the SoundFrame button to open the Preset Man-
agement pop-up menu.

2. Select “Import FXB/FXP” from the pop-up.
This menu item is only available for VST 2 instrument plug-ins.

3. In the file dialog that opens, locate the file and click 
Open.
If you loaded a Bank, it will replace the current set of all programs. If you 
loaded a single preset, it will replace the currently selected preset pro-
gram only.

4. After importing, you can convert the current program 
list to VST Presets by selecting “Convert Program List to 
VST Presets” from the Preset Management pop-up.
After converting, the presets will be available. The new converted pre-
sets will be stored in the VST3 Preset folder.
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Exporting Instrument tracks
You can export instrument tracks as standard MIDI files, 
see “Exporting MIDI files” on page 241.

Please note: 

• As there is no MIDI patch information in an instrument 
track, this information is missing in the resulting MIDI file.

• If you activate “Export Inspector Volume/Pan”, the volume 
and pan of the VST Instrument channel are converted and 
written into the MIDI file as volume and pan controllers.

About latency
Depending on your audio hardware and its ASIO driver, 
the latency (the time it takes for the Instrument to produce 
a sound when you press a key on your MIDI controller) 
may simply be too high to allow comfortable real-time VST 
Instrument playback from a keyboard. 

If this is the case, a workaround is to play and record your 
parts with another MIDI Sound Source selected, and then 
switch to the VST Instrument for playback.

You can check the latency for your audio hardware in 
the Device Setup dialog (VST Audio System page).
The input and output latency values are shown below the ASIO Driver 
pop-up menu. For live VST Instruments playing, these values should ide-
ally be a few milliseconds (although the limit for “comfortable” live playing 
is a matter of personal taste).

Constrain Delay Compensation
Cubase LE features full delay compensation throughout 
the entire audio path. This means that any delay inherent in 
the VST plug-ins you use will automatically be compen-
sated for during playback, so that all channels are kept in 
perfect sync (see the chapter “Audio effects” in the Plug-
in Reference).

However, when you play a VST Instrument in real time or 
record live audio (with monitoring through Cubase LE ac-
tivated), this delay compensation may sometimes result in 
added latency. To avoid this, activate the Constrain Delay 

Compensation button on the Project window toolbar. This 
function tries to minimize the latency effects of the delay 
compensation, while maintaining the sound of the mix as 
far as possible.

• In the Preferences dialog (VST page) you will find a set-
ting called Delay Compensation Threshold. Only plug-ins 
with a delay higher than the value entered here will be af-
fected by the Constrain Delay Compensation function.

• VST plug-ins (with higher delay than the threshold 
value) which are activated for audio track channels that 
are record enabled, group channels and output channels 
will be turned off when you activate Constrain Delay Com-
pensation.

• VST plug-ins activated for FX channels are not turned 
off but their delay is disregarded by the program (delay 
compensation is turned off).

After recording or using a VST Instrument with Constrain 
Delay Compensation, you should turn off the function to 
restore full delay compensation.

Automating a VST Instrument
• Automation of the VST Instrument channel settings is 
done in the same way as automating regular channels.

• Automation of the specific parameters for a VST Instru-
ment is done in the same way as automating VST effect 
parameters.

See the chapter “Automation” on page 90.



18
MIDI realtime parameters and effects



147

MIDI realtime parameters and effects

Introduction
For each MIDI track, you can set up a number of track pa-
rameters, or modifiers. These affect how the MIDI data is 
played back, “transforming” MIDI events in real time be-
fore they are sent to the MIDI outputs.

On the following pages, the available parameters and ef-
fects are described. Keep in mind:

• The actual MIDI events will not be affected – the changes 
happen “on the fly”.

• Since the modifier settings don’t actually change the MIDI 
data on the track, they will not be reflected in the MIDI editors. 
To convert the track settings to “real” MIDI events, use the 
Freeze MIDI Modifiers function (see “Permanent settings with 
Freeze MIDI Modifiers” on page 160).

The Inspector – General handling
The MIDI modifiers are set up in the Inspector. Here’s a 
brief rundown on how to handle the Inspector:

• To show or hide the Inspector, click the Inspector icon 
on the Project window’s toolbar.

• For a MIDI track, up to three sections are available, and 
all three sections are displayed by default.
For information about setting up the Inspector, see “The Setup dialogs” 
on page 244.

• You can fold or unfold the sections individually by click-
ing on the section name.
Clicking the name for a hidden section brings it to view and hides the 
other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or 
show a section without affecting other sections. Finally, [Alt]/[Option]-
clicking a tab shows or hides all sections in the Inspector.

The Inspector for a MIDI track.

Folding in or hiding (via the Setup dialog) a section 
does not affect the functionality but merely hides the sec-
tion from view. 
This means your settings will still be active even if you fold in or hide the 
Inspector settings.

Basic track settings
The topmost Inspector section contains the basic settings 
for the selected MIDI track.

These are settings that either affect the basic functionality 
for the track (mute, solo, enable record, etc.) or send out 
additional MIDI data to the connected devices (program 
change, volume, etc.). The section contains all settings in 
the Track list (see “The Track list” on page 16), with a few 
additional parameters:  

Parameter Description

Track name
field

Click once to show/hide the topmost Inspector section. 
Double-click to rename the track.
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Note that the functionality of the Bank and Patch se-
lector settings (used for selecting sounds in the con-
nected MIDI instrument) depends on to which instrument 
the MIDI output is routed, and how you have set it up in 
the MIDI Device Manager.
The MIDI Device Manager allows you to specify which MIDI instruments 
and other devices are connected to the various MIDI outputs, thus mak-
ing it possible to select patches by name, see “The MIDI Device Mana-
ger” on page 150.

Many of the basic track settings are duplicated in 
“mixer channel strip form” in the fader section of the In-
spector (see below).

Other Inspector sections
Apart from the basic track settings (see above) and the 
MIDI Modifiers (see “MIDI Modifiers” on page 148), the In-
spector for a MIDI track also contains the following:

The MIDI Fader section

This contains a single channel strip, allowing you to set 
volume, pan, mute/solo and other parameters for the track. 
This is a “mirror” of the track’s channel strip in the mixer – 
see “The MIDI channel strips” on page 80.

MIDI Modifiers 

The following settings will affect the MIDI events on the 
track in real time during playback. They will also be in ef-
fect if you play “live” with the track selected and record 
enabled (provided that “MIDI Thru Active” is activated on 
the Preferences–MIDI page). This makes it possible to 
transpose or adjust the velocity of your live playing.

If you want to compare the result of your modifier set-
tings with the “unprocessed” MIDI, you can use the By-
pass button in the MIDI Modifiers section.
When this is activated, the MIDI Modifiers settings will be temporarily 
disabled. A bypassed section is indicated by a yellow Bypass button.

Transpose
This allows you to transpose all notes on the track in semi-
tones. The available range is -127 to +127 semitones, but 
remember that the total range of MIDI note numbers is 0 
to 127. Furthermore, not all instruments can play back 
notes over the whole range. Therefore, extreme transposi-
tions can give rather strange and unwanted results.

Edit button This opens the channel settings window for the track (a 
window showing a channel strip with volume fader and 
other controls – see “Using Channel Settings” on page 
83).

Mute/Solo 
buttons

Mutes or solos the MIDI track.

Read/Write 
buttons

Used for automating the track settings – see “Using 
Write/Read automation” on page 94.

Record enable 
button

Activate this to make the track ready for recording.

Monitor button When this is activated (and the option “MIDI Thru Active” 
is on in the Preferences–MIDI page), incoming MIDI will 
be routed to the selected MIDI output.

Lane Display 
Type button

Allows you to divide the tracks in lanes.

Volume Use this to adjust the level for the track. Changing this 
setting will move the track’s fader in the Mixer window, 
and vice versa. See “Setting volume in the mixer” on page 
80 for more about setting levels.

Pan Use this to adjust the panning of the track. 

Delay This adjusts the playback timing of the MIDI track. Posi-
tive values delay the playback while negative values 
cause the track to play earlier. The values are set in milli-
seconds.

Input/Output 
Routing/Channel

This is where you select MIDI input, MIDI output and MIDI 
channel for the track.

Bank and Patch 
Selector pop-up

Allows you to select a sound, see below. (If no bank is 
available, only the Patch selector is shown.)

Drum Map Allows you to select a drum map for the track – see “Ma-
naging drum maps” on page 187.

Parameter Description
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You can also transpose individual MIDI parts using the 
Transpose field in the info line.
The transposition in the info line (for the individual part) is added to the 
transpose value you have set up for the whole track in the Inspector.

Velocity Shift
This setting lets you change the dynamics of all notes on 
the track. The value in this field is added to the velocity of 
each note message that is sent out (use negative values to 
lower the velocities). The range is -127 to +127 with 0 
representing no change in velocity.

Note that the effect of changing the velocity depends on 
the sound and instrument.

You can also adjust the velocity of events in individual 
MIDI parts using the Velocity field in the info line.
The velocity shift in the info line (for the individual part) is added to the 
velocity shift you have set up for the whole track in the Inspector.

Velocity Compression
This function multiplies the velocity values with the factor 
you specify. This factor is set using a numerator (left value) 
and a denominator (right value), resulting in a fractional 
number (1/2, 3/4, 3/2 etc.). For example, if you set the 
factor to 3/4, the velocities will be three quarters of their 
original values. This will also affect the difference in veloc-
ity between the notes, thus compressing or expanding the 
velocity scale. Typically, you would combine this setting 
with the Velocity Shift parameter. An example:

Let’s say you have three notes with the velocity values 60, 
90 and 120, and wish to “even out” the velocity differ-
ences somewhat. If you set the Velocity Compression 
value to 1/2, the notes will play back with the velocities 
30, 45 and 60. By adding 60 in the Velocity Shift field, the 
notes will play back with the velocities 90, 105 and 120, 
meaning you have compressed the velocity range. 

In a similar way, you can use Velocity Compression values 
greater than 1/1 together with negative values in the Ve-
locity Shift field, to expand the velocity range.

Length Compression
This value adjusts the lengths of all notes on the track. As 
with Velocity Compression, the value is set with a numer-
ator and denominator. For example, the value 2/1 means 
that all note lengths will be doubled, while 1/4 means all 
note lengths will be a quarter of the actual lengths.

Random
The Random settings let you introduce random variations 
to various properties of MIDI notes. Anything from very 
subtle variations to dramatic changes can be applied. 
There are two separate “random generators”, set up in the 
following way:

1. Pull down the Random pop-up menu and select which 
note property should be randomized.
The options are position, pitch, velocity and length. 

Keep in mind that depending on the content of the 
track, certain parameter changes might not be immedi-
ately noticeable or have any effect at all (as would be the 
case if applying random length to a percussion track play-
ing “one-shot” samples for example). 
To best audition the random changes choose a track with clearly defined 
rhythm and note content (as opposed to a string pad).

2. Set the desired range of random deviation by entering 
values in the two number fields.
The two values govern the limits of the randomization, so that the values 
will vary between the left value and the right value (you cannot set the left 
value higher than the right value). The maximum random range for each 
property is listed in the table below: 

Note that you can make independent settings for the 
two random generators.

• To deactivate the Random function, pull down the Ran-
dom pop-up menu(s) and select “OFF”.! Remember that the maximum velocity is always 127 

no matter how much you try to expand.

Property Range

Position -500 to +500 ticks

Pitch -120 to +120 semitones

Velocity -120 to +120 

Length -500 to +500 ticks
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Range
The Range function lets you specify a note (pitch) or ve-
locity range and either force all notes to fit within this 
range, or exclude all notes outside this range from play-
back. As with the Random function, there are two sepa-
rate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of 
the following four modes:

2. Use the two fields to the right to set the min and max 
values.
These values will be shown as numbers (0-127) for the velocity modes 
and as note numbers (C-2 to G8) for the pitch modes.

Note that you can make independent settings for the 
two Range functions.

• To deactivate the Range function, pull down the Range 
pop-up menu(s) and select “OFF”.

The MIDI Device Manager
The MIDI Device Manager allows you to specify and set 
up your MIDI devices, making global control and patch se-
lection easy.

Opening the MIDI Device Manager
Select MIDI Device Manager from the Devices menu to 
bring up the following window:

When you open the MIDI Device Manager for the first 
time, it will be empty (because you haven’t installed any 
devices yet). On the following pages we describe how to 
add a pre-configured MIDI device to the list, how to edit 
the settings and how to define a device from scratch.

Note that there is an important difference between in-
stalling a preset MIDI device (“Install Device”) and import-
ing a MIDI device setup (“Import Setup”):

• The presets do not include any device mapping of pa-
rameters and controls.
They are simply patch name scripts. When you install a preset MIDI de-
vice, it is added to the Installed Devices list.

• A device setup can include device mapping and/or 
patch information. 

Mode Description

Vel. Limit This function affects all velocity values outside the speci-
fied range. Velocity values below the Min setting (the 
lower limit of the range) are set to the Min value, and ve-
locity values above the Max setting are set to the Max 
value. Notes with velocity values within the set range are 
not affected. Use this if you want to force all velocity val-
ues to fit within a certain range.

Vel. Filter Velocity Filter works by excluding all notes with velocity 
values outside the specified range. Notes with velocity 
values below the Min setting or above the Max setting will 
not be played back. Use this to “isolate” notes with cer-
tain velocity values.

Note Limit This function allows you to specify a pitch range, and 
forces all notes to fit within this range. Notes outside the 
specified range are transposed up or down in octave 
steps until they fit within the range.
Note: If the range is too “narrow”, so that some notes 
cannot be fit within the range by octave-transposing, 
these notes will get a pitch in the middle of the range. For 
example, if you have a note with a pitch of F3, and the 
range is C4-E4, that note will be transposed to D4.

Note Filter Note Filter works by excluding all notes with pitches out-
side the specified range. Notes lower than the Min set-
ting or higher than the Max setting will not be played 
back. Use this to “isolate” notes with certain pitches.

This is the list of MIDI devices you 
have connected. The first time you 
open the MIDI Device Manager, 
this list will be empty.

These buttons let you manage 
the list of installed devices.

This pop-up menu lets you edit 
the selected device (provided that 
“Enable Edit” is activated).

Here, the patch structure is 
shown for the device selected 
above.

This area shows exactly which 
MIDI messages should be sent 
out to select the patch high-
lighted in the list to the left.

Here you specify to which 
MIDI output the selected 
device is connected.
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Installing a MIDI device
To install a MIDI device, proceed as follows:

1. Click the Install Device button.
A dialog appears listing all pre-configured MIDI devices. For now we as-
sume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.

• If your MIDI device isn’t included in the list but is com-
patible with the GM (General MIDI) or XG standards, you 
can select the generic GM or XG Device options.
When you select one of these options, a name dialog will appear. Enter a 
name for the instrument and click OK.

The device appears in the Installed Devices list to the left.

3. Select the new device in the list and pull down the 
Output pop-up menu.

4. Select the MIDI output that is connected to the device.

• You can rename a device in the Installed Devices list by 
double-clicking and typing – this is useful if you have sev-
eral devices of the same model, and want to separate 
them by name instead of by number.

• To remove a device from the Installed Devices list, se-
lect it and click Remove Device. The device will be deleted 
immediately. 

About Patch Banks
Depending on the selected device, you may find that the 
Patch Banks list is divided in two or more main banks. 
Typically, these are called Patches, Performances, Drums 
etc. The reason for having several patch banks is that dif-
ferent “types” of patches are handled differently in the in-
struments. For example, while “patches” typically are 
“regular” programs that you play one at the time, “perfor-
mances” may be combinations of patches, which could 
e.g. be split across the keyboard, layered or used for mul-
titimbral playback.

For devices with several banks, you will find an additional 
button labeled “Bank Assignment” at the top of the win-
dow. Selecting this opens a window in which you can 
specify for each MIDI channel which bank it should use. 
The selection here will affect which bank is displayed 
when you select programs by name for the device in the 
track list or Inspector. For example, many instruments use 
MIDI channel 10 as an exclusive drum channel, in which 
case you would want to select the “Drums” (or “Rhythm 

Set”, “Percussion”, etc.) bank for channel 10 in this list. 
This would then let you select between different drum kits 
in the track list or Inspector.

Selecting a patch for an installed device
If you return to the Project window at this point, you will 
find that the installed device has been added to the MIDI 
Output menus (in the track list and the Inspector). Now 
you can select patches by name, in the following way:

1. Pull down the Output menu (in the track list or Inspec-
tor) for a track that you want to play the installed device, 
and select the device.
This directs the track to the MIDI output specified for the device in the MIDI 
Device Manager. The bank and program fields in the track list and Inspec-
tor are replaced by a single Programs field that currently reads “Off”.

2. Click the Programs field to display a pop-up menu, hi-
erarchically listing all the patches in the device.
The list is similar to the one displayed in the MIDI Device Manager. You 
can scroll the list up and down (if required), click the plus/minus signs to 
show or hide subgroups, etc.

You can also use a filter function here. For this, enter the 
search term in the Filter field, e.g. “drum”, and press [Re-
turn] to display all sounds with “drum” in the name.

3. Click a patch in the list to select it.
This sends the appropriate MIDI message to the device. You can also 
scroll the program selection up or down, as with any value.

Renaming patches in a device
The pre-configured devices list is based on the factory-
preset patches, i.e. the patches included in the device 
when you first bought it. If you have replaced some of the 
presets with your own patches, you need to modify the de-
vice so that the patch name list matches the actual device:

1. In the MIDI Device Manager, select the device in the In-
stalled Devices list.

2. Activate the Enable Edit checkbox.
When this is turned off, you cannot edit the pre-configured devices.

3. Use the Patch Banks display to locate and select the 
patch you want to rename.
In many instruments, the user-editable patches are located in a separate 
group or bank.

4. Click on the selected patch in the Patch Banks list to 
edit its name.

5. Type in the new name and click OK.
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6. Rename the desired patches in this way, and finish by 
deactivating Enable Edit again (to avoid modifying the de-
vice by accident).

You can also make more radical changes to the patch 
structure in a device (adding or deleting patches, groups 
or banks), see below.
For example, this would be useful if you expanded your MIDI device by 
adding extra storage media such as RAM cards, etc.

Patch Structure
Patches are structured as follows:

• Banks are the main categories of sounds – typically patches, 
performances and drums, as described above.

• Each bank can contain any number of groups, represented by 
folders in the list.

• The individual patches, performances or drum kits are repre-
sented by presets in the list.

The Commands pop-up menu contains the following items:

Create Bank

Creates a new bank at the highest hierarchical level of the 
Patch Banks list. You can rename this by clicking on it and 
typing a new name.

New Folder

Creates a new subfolder in the selected bank or folder. 
This could correspond to a group of patches in the MIDI 
device, or just be a way for you to categorize sounds, etc. 
When you select this item, a name dialog will appear, al-
lowing you to name the folder. You can also rename the 
folder afterwards by clicking it and typing in the list.

New Preset

This adds a new preset in the selected bank or folder. You 
can rename the preset by clicking it and typing a new name.

When the preset is selected, its corresponding MIDI 
events (Program Change, Bank Select, etc.) are shown in 
the event display to the right. The default setting for a new 
preset is Program Change 0 – to change this, use the fol-
lowing procedures:

• To change which Program Change value should be 
sent out to select the patch, adjust the number in the 
Value column for the Program Change event.

• To add another MIDI event (e.g. Bank Select) click di-
rectly below the last event in the list and select a new 
event from the pop-up menu that appears.
After adding a new event, you need to set its value in the Value column, 
as with Program Change.

• To replace an event, click on it and select another event 
from the pop-up menu.
For example, a MIDI device may require that a Bank Select message is 
sent first, followed by a Program Change message, in which case you 
would need to replace the default Program Change message with a 
Bank Select message and add a new Program Change after that.

• To remove an event, select it and press [Delete] or 
[Backspace].

Add Multiple Presets

This opens a dialog, allowing you to set up a range of pre-
sets to be added in the selected bank or folder. Proceed 
as follows:

1. Add the event types required for selecting a patch in 
the MIDI device.
This is done just as when editing the settings for a single event: clicking 
in the event display brings up a pop-up menu from which you can select 
an event type.

2. Use the Range column to set up either a fixed value or 
a range of values for each event type in the list.
This requires some explanation: 
If you specify a single value in the Range column (e.g. 3, 15 or 127), all 
added presets will have an event of this type set to the same value. 
If you instead specify a value range (a start value and an end value, sep-
arated by a dash, e.g. 0-63), the first added preset will have an event set 
to the start value, the next value will be incrementally raised by one and 
so on, up to and including the end value.

The number of added presets depends on the Range 
setting.

! For details on which MIDI events are used for select-
ing patches in the MIDI device, consult its documen-
tation.

! Different devices use different schemes for Bank Se-
lect. When you insert a Bank Select event, you 
should check the device’s documentation to find 
whether to choose “CC: BankSelect MSB”, “Bank 
Select 14 Bit”, “Bank Select 14 Bit MSB-LSB 
Swapped” or possibly some other option.
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3. Specify a Default Name below the event display.
The added events will get this name, followed by a number. You can re-
name presets manually in the Patch Banks list later.

4. Click OK.
A number of new presets are now added in the selected bank or folder, 
according to your settings.

Other editing functions

• You can move presets between banks and folders by drag-
ging them in the Patch Banks list.

• You can remove a bank, folder or preset by selecting it in the 
Patch Banks list and pressing [Backspace].

• If you specify more than one bank, a Bank Assignment item 
will be added to the pop-up menu at the top of the window. 
Use this to assign banks to the different MIDI channels (see 
“About Patch Banks” on page 151).

Defining a new MIDI device
This section describes how to define a new MIDI device. 

If your MIDI device is not included in the list of pre-config-
ured devices (and is not a “plain” GM or XG device), you 
need to define it manually to make it possible to select 
patches by name.

1. In the MIDI Device Manager, click the Install Device 
button.
The Add MIDI Device dialog appears.

2. Select “Define New...” and click OK.
A dialog appears.

3. Enter the name of the device and the MIDI channels 
you would like the device to use and click OK.
The device appears in the Installed Devices list.

4. Select the device in the list.
As you can see, it currently contains only an Empty Bank item.

5. Make sure the Enable Edit checkbox is activated.
Now you can use the functions on the Commands pop-up menu to the 
left to organize the patch structure of the new device.
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Introduction
This chapter describes the various MIDI processing func-
tions available on the MIDI menu (see highlighted entries 
below). They offer various ways to edit MIDI notes and 
other events, either in the Project window or from within a 
MIDI editor.

MIDI functions vs. MIDI modifiers

There are MIDI functions that have no MIDI modifiers 
counterpart, and vice versa.

In some cases, however, the result of a MIDI function can 
also be obtained by using MIDI modifiers. For example, the 
operations “Transpose” and “Quantize” are available as 
MIDI modifiers as well as MIDI functions. The main differ-
ence is that MIDI modifiers don’t affect the actual MIDI 
events on the track in any way, while MIDI functions 
change the events “permanently” (although recent 
changes can be undone). 

Use the following guidelines to decide which path to 
choose for operations that are available both as modifiers 
and as functions:

• If you want to adjust a few parts or events only, use MIDI func-
tions. The MIDI modifiers affect the output of the whole track.

• If you want to experiment with different settings, use MIDI 
modifiers.

• MIDI modifiers settings are not reflected in the MIDI editors, 
since the actual MIDI events aren’t affected. This can be po-
tentially confusing; if you’ve e.g. transposed notes using mod-
ifiers, the MIDI editors will still show the notes with their 
original pitch (but they will play back at their transposed pitch). 
Therefore MIDI functions are a better solution if you want to 
see the effects in the MIDI editors.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function 
depends on the function, the active window and the cur-
rent selection:

• A MIDI function may only apply to MIDI events of a cer-
tain type.
For example, quantization affects notes only, while the Delete Controllers 
function obviously applies to MIDI controller events.

• In the Project window, the MIDI functions apply to all 
selected parts, affecting all events (of the relevant types) 
in them.

• In the MIDI editors, the MIDI functions apply to all se-
lected events. If no events are selected, all events in the 
edited part(s) will be affected.

The Quantizing functions

What is quantizing?
Quantizing in its fundamental form is a function that auto-
matically moves recorded notes, positioning them on ex-
act note values:

For example, if you record a series of eighth notes, some of them 
may end up slightly beside the exact eighth note positions.

Quantizing the notes with the quantize grid set to eighth notes will 
move the “misplaced” notes to exact positions.
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However, quantizing is not only a method of correcting er-
rors, it can also be used creatively in various ways. For 
example, the “quantize grid” does not have to consist of 
perfectly straight notes, some notes can automatically be 
excluded from quantizing, etc.

When quantizing MIDI, only MIDI notes are affected 
(no other event types).
However, you can choose to move the controllers together with their re-
spective notes by activating the “Move Controller” option in the Quantize 
Setup dialog, see “The Move Controller setting” on page 158.

Setting up quantize on the toolbar
At its most basic, setting up quantizing consists of select-
ing a note value from the Quantize pop-up menu on the 
toolbar (in the Project window or a MIDI editor).

By default, this allows you to quantize to exact note values 
(straight, triplet or dotted notes) only. 

Setting up quantize in the Quantize Setup 
dialog
If you want more options than those available on the pop-
up menu, select “Quantize Setup...” from the MIDI menu 
(or “Setup...” from the Quantize pop-up menu) to open the 
Quantize Setup dialog.

The grid display in the middle of the dialog shows one bar 
(four beats), with blue lines indicating the quantize grid 
(the positions that notes will be moved to). Value changes 
in the grid, presets and quantize options will be graphically 
reflected here, see below. 

The Quantize Setup dialog contains the following settings:

Straight note values

Triplet note values

Dotted note values

! Any settings you make in the dialog are immediately 
reflected in the Quantize pop-up menus. However, if 
you want your settings permanently available on the 
Quantize pop-up menus, you have to use the presets 
functions (see “Presets” on page 157).



157

MIDI processing and quantizing

The Grid and Type pop-ups

These are used to determine the basic note value for the 
quantizing grid. In other words, these have the same func-
tionality as the Quantize pop-up menu on the toolbar.

Swing

The Swing slider is only available when a straight note 
value is selected for the grid and Tuplet is off (see below). 
It lets you offset every second position in the grid, creating 
a swing or shuffle feel. When you adjust the Swing slider, 
the result is shown in the grid display.

A straight eighth note grid compared with a grid with 60% swing.

Tuplet

Allows you to create more rhythmically complex grids by 
dividing the grid into smaller steps.

Magnetic Area

This allows you to specify that only notes within a certain 
distance from the grid lines should be affected by quantiz-
ing. 

• When the slider is set to 0%, the Magnetic Area func-
tion is deactivated, i.e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the mag-
netic areas are shown around the blue lines in the grid display.

Presets

The controls in the lower left corner of the dialog allow you 
to store the current settings as a preset, available on the 
Quantize menus in the toolbars. The usual preset proce-
dures apply:

• To store the settings as a preset, click the Store button. 

• To “load” a stored preset, showing the stored settings 
in the dialog, just select it from the pop-up menu. 
This is useful if you want to modify an existing preset.

• To rename the selected preset, double-click on the 
name and type in a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Apply and Auto

These functions allow you to apply quantizing directly from 
the dialog, as described below.

! If you don’t want to apply the quantizing you have set 
up in the dialog, you can close the window by click-
ing its standard close box. You can also leave the di-
alog open while you continue working.

Only notes within the indicated zones will be affected by quantizing.
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The Non Quantize setting

This is an additional setting that affects the result of the 
quantizing. It allows you to set a “distance” in ticks 
(120ths of sixteenth notes).

Events that already are within the specified distance from 
the quantize grid will not be quantized. This allows you to 
keep slight variations when you quantize, but still correct 
notes that are too far from the grid.

The Random Quantize setting

This is an additional setting that affects the result of the 
quantizing. It allows you to set a “distance” in ticks 
(120ths of sixteenth notes).

Events will be quantized to random positions within the 
specified “distance” from the quantize grid, thus creating 
a more “loose” quantizing. Much like the Non Quantize 
setting, this allows for slight variations, while at the same 
time keeping notes from ending up too far from the grid.

The Iterative Strength setting

Here you specify how much the notes should be moved 
towards the grid when using the Iterative Quantize func-
tion, see below.

The Move Controller setting

When this is activated, controllers related to notes (pitch 
bend, etc.) are automatically moved with the notes when 
these are quantized.

Applying quantize
There are several ways to apply the quantize:

• The standard method is to select “Over Quantize” from 
the MIDI menu (or using a key command, [Q] by default).
This quantizes the selected MIDI parts or notes according to the current 
Quantize pop-up menu setting.

• You can also apply quantizing directly from the Quantize 
Setup dialog, by clicking the “Apply Quantize” button.

• If you activate the “Auto” checkbox in the Quantize 
Setup dialog, any change you make in the dialog is imme-
diately applied to the selected MIDI parts or notes.
A great way of using this feature is to set up a playback loop, and adjust 
the settings in the dialog until you get the desired result. 

The Auto Quantize function

If you activate the Auto Q button on the Transport panel, 
all MIDI recordings you make are automatically quantized 
according to the settings you have made in the Quantize 
Setup dialog.

Iterative Quantize
Another way to apply “loose” quantization is to use the It-
erative Quantize function on the MIDI menu. It works like 
this:

Instead of moving a note to the closest quantize grid posi-
tion, Iterative Quantize moves it only part of the way. You 
specify how much the notes should be moved towards the 
grid with the “Iterative Strength” setting in the Quantize 
Setup dialog.

Iterative Quantize also differs from “regular” quantization 
in that the operation is not based on the notes’ original po-
sitions but on their current, quantized position. This makes 
it possible to repeatedly use Iterative Quantize, gradually 
moving the notes closer to the quantize grid until you’ve 
found the desired timing.

! When you apply quantize, the result is based on the 
original position of the notes. Therefore, you can 
freely try different quantize settings with no risk of 
“destroying” anything. See also “Undo Quantize” on 
page 159.
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Advanced Quantize functions

Quantize Lengths

This function (on the Advanced Quantize submenu on the 
MIDI menu) will quantize the length of the notes, without 
changing their start positions. At its most basic level, this 
function will set the length of the notes to the Length 
Quantize value on the MIDI editors’ toolbar. However, if 
you have selected the “Quantize Link” option on the 
Length Quantize pop-up menu, the function will resize the 
note according to the quantize grid, taking the Swing, Tu-
plet and Magnetic Area settings into account. An example:

1. Length Quantize set to “Quantize Link”.

2. Some 1/16th notes.

3. Here, the quantize value has been set to straight 1/16th notes with 
Swing at 100%. Since Snap is activated (see “Snap” on page 171), the 
quantize grid is reflected in the note display’s grid.

4. Selecting Quantize Lengths will adjust the note lengths according to 
the grid. If you compare the result to the first figure above, you will find 
that notes that started within the odd sixteenth note “zones” show the 
longer grid length, and notes in the even zones have the shorter length.

Quantize Ends

The Quantize Ends function on the Advanced Quantize 
submenu will only affect the end positions of notes. Apart 
from that, it works just like regular quantizing, taking the 
Quantize pop-up menu setting into account.

Undo Quantize

As mentioned above, the original position of each quan-
tized note is stored. Therefore, you can make the selected 
MIDI notes revert to their original, unquantized state at any 
time by selecting Undo Quantize from the Advanced 
Quantize submenu. This is independent from the regular 
Undo History.

Freeze Quantize

There may be situations when you want to make the quan-
tized positions “permanent”. For example, you may want to 
quantize notes a second time, having the results based on 
the current quantized positions rather than the original po-
sitions. To make this possible, select the notes in question 
and select “Freeze Quantize” from the Advanced Quantize 
submenu. This makes the quantized positions permanent.

Transpose
The Transpose item on the MIDI menu opens a dialog with 
settings for transposing the selected notes:

Semitones

This is where you set the amount of transposition.

! This function is only available from within the MIDI 
editors.

! After you have performed a Freeze Quantize for a 
note, you cannot undo its quantization.
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Scale Correction

Scale Correction transposes the selected notes by for-
cing them to the closest note of the selected scale type. 
This can be used for creating interesting key and tonal 
changes, either by itself or in conjunction with the other 
settings in the Transpose dialog.

• To activate Scale Correction, click the checkbox.

• Select a root note and scale type for the current scale 
from the upper pop-up menus.

• Select a root note and scale type for the new scale from 
the lower pop-up menus.
Make sure to select the correct root note if you want to keep the result in 
the same key as the original notes, or select an entirely different key if you 
want to experiment.

Keep Notes in Range

When this checkbox is activated, transposed notes will re-
main within the Upper and Lower Barrier values.

• If a note ends up outside the barriers after transposition, 
it will be shifted to another octave, keeping the correct 
transposed pitch if possible.
If this isn’t possible (if you have set a very narrow range between the Up-
per and Lower Barrier), the note will be transposed “as far as possible”, 
i.e. to the Upper or Lower Barrier note. If you set the Upper and Lower 
Barriers to the same value, all notes will be transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel 
closes the dialog without transposing.

Permanent settings with Freeze MIDI 
Modifiers
The MIDI Modifier settings in the Inspector do not change 
the MIDI events themselves, but work like a “filter”, affect-
ing the music on playback. Therefore, you may want to 
make them permanent, i.e. convert them to “real” MIDI 
events, for example to transpose a track and then edit the 
transposed notes in a MIDI editor. For this, you can use 
the “Freeze MIDI Modifiers” command from the MIDI 
menu. This applies all filter settings permanently to the re-
spective track.

The “Freeze MIDI Modifiers” function affects the following 
settings for MIDI tracks:

• Several settings on the main tab of the Inspector (program 
and bank selection and the Delay parameter).

• The settings on the MIDI Modifiers tab (i.e. Transpose, Veloc-
ity Shift, Velocity Compression and Length Compression).

The following settings for MIDI parts are taken into ac-
count as well:

• The Transpose and Velocity settings for parts displayed on the 
info line – please note that the Volume setting is not taken into 
account. 

To use the “Freeze MIDI Modifiers” function, proceed as 
follows:

1. Select the desired MIDI track.

2. Pull down the MIDI menu and select “Freeze MIDI 
Modifiers”.
The Inspector settings will be converted to MIDI events and inserted at 
the beginning of the part(s). All notes of the part(s) will be modified ac-
cordingly and the Inspector settings will be reset.

Dissolve Part
The Dissolve Part function on the MIDI menu has two sep-
arate uses:

• When you work with MIDI parts (on MIDI channel “Any”) 
containing events on different MIDI channels.
Dissolve Part separates the events according to MIDI channel.

• When you want to separate MIDI events according to 
pitch.
A typical example would be drum and percussion tracks, where each 
pitch usually corresponds to a separate drum sound.

When dissolving a part into either separate channels 
or separate pitches, you can automatically remove the si-
lent (empty) areas of the resulting parts by activating the 
“Optimized Display” checkbox in the Dissolve Part dialog.

Dissolving parts into separate channels
Setting a track to MIDI channel “Any” will cause each MIDI 
event to play back on its original MIDI channel, rather than 
a channel set for the whole track. There are two main situ-
ations when “Any” channel tracks are useful:
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• When you record several MIDI channels at the same 
time.
You may for example have a MIDI keyboard with several keyboard zones, 
where each zone sends MIDI on a separate channel. Recording on an 
“Any” channel track allows you to play back the recording with different 
sounds for each zone (since the different MIDI notes play back on sepa-
rate MIDI channels).

• When you have imported a MIDI file of Type 0.
MIDI files of Type 0 contain only one track, with notes on up to 16 different 
MIDI channels. If you were to set this track to a specific MIDI channel, all 
notes in the MIDI file would be played back with the same sound; setting 
the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on 
different MIDI channels and distributes the events into new 
parts on new tracks, one for each MIDI channel found. This 
allows you to work with each musical part individually. Pro-
ceed as follows:

1. Select the part(s) containing MIDI data on different 
channels.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate Chan-
nels” option.

Now, for each MIDI channel used in the selected part(s), a 
new MIDI track is created and set to the corresponding 
MIDI channel. Each event is then copied into the part on 
the track with the corresponding MIDI channel. Finally, the 
original part(s) are muted.

An example:

Dissolving parts into separate pitches
The Dissolve Part function can also scan MIDI parts for 
events of different pitches, and distribute the events into 
new parts on new tracks, one for each pitch. This is useful 
when the different pitches are not used in a regular me-
lodic context, but rather for separating different sounds 
(e.g. MIDI drum tracks or sampler sound FX tracks). By 
dissolving such parts, you can work with each sound indi-
vidually, on a separate track. Proceed as follows:

1. Select the part(s) containing MIDI data.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate 
Pitches” option.
A new MIDI track is created for each used pitch in the selected part(s). 
The events are then copied into the parts on the track for the corres-
ponding pitch. Finally, the original part(s) are muted.

Other MIDI functions
The following items can be found in the Functions sub-
menu of the MIDI menu:

Legato
Extends each selected note so that it reaches the next note.

This part contains events on 
MIDI channel 1, 2 and 3.

Selecting “Dissolve Part” creates new parts on new tracks, set 
to channel 1, 2 and 3. Each new part contains only the events 
on the respective MIDI channel.

The original MIDI 
part is muted.
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You can specify the desired gap or overlap with the “Legato 
Overlap” setting in the Preferences (Editing–MIDI page).

When using Legato with this setting, each note will be extended to end 
5 ticks before the next note.

When you activate the “Legato Mode: Selected Only” op-
tion, the length of the note will be adjusted so that it 
reaches the next selected note, allowing you e.g. to only 
apply Legato to your bass line (when playing on a key-
board).

Fixed Lengths

This function resizes all selected notes to the length set 
with the Length Quantize pop-up menu on the MIDI editor 
toolbar.

Delete Doubles
This function removes double notes, i.e. notes of the same 
pitch on the exact same position. Double notes can occur 
when recording in Cycle mode, after Quantizing, etc.

Delete Controllers
This function removes all MIDI controllers from the se-
lected MIDI parts.

Delete Continuous Controllers
This function removes all “continuous” MIDI controller 
events from the selected MIDI parts. Therefore, “on/off” 
events such as sustain pedal events are not removed.

Delete Notes
Allows you to delete very short or weak notes. This is use-
ful for automatically removing unwanted “ghost notes” af-
ter recording. Selecting “Delete Notes...” opens a dialog 
in which you set up the criteria for the function:

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the 
note length is taken into account, allowing you to remove 
short notes. You can either specify the minimum length 
(for notes to be kept) in the value display or by dragging 
the blue line in the graphical length display below.

• The graphical length display can correspond to 1/4 bar, 
one bar, two bars or four bars.
You change this setting by clicking in the bar field to the right of the dis-
play.

In this case, the whole length display corresponds to two bars, and the 
Minimum Length is set to 1/32nd notes (60 ticks).

Minimum Velocity

When the Minimum Velocity checkbox is activated, the ve-
locity of notes is taken into account, allowing you to re-
move weak notes. You specify the minimum velocity (for 
notes to be kept) in the value display.

! This function is only available from within the MIDI 
editors.

! This function always affects whole MIDI parts.

! This function always affects whole MIDI parts.

! This function always affects whole MIDI parts.



163

MIDI processing and quantizing

Remove when under

This setting is only available when both Minimum Length 
and Minimum Velocity is activated. By clicking the value 
display, you select whether both length and velocity crite-
ria must be met for notes to be deleted, or whether one of 
the criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to 
the rules set up. Clicking Cancel closes the dialog without 
deleting notes.

Restrict Polyphony
Selecting this item opens a dialog in which you can spec-
ify how many “voices” should be used (for the selected 
notes or parts). Restricting the polyphony this way is use-
ful when you have an instrument with limited polyphony 
and want to make sure all notes will be played. The effect 
is achieved by shortening notes as required, so that they 
end before the next note starts.

Pedals to Note Length
This function scans for Sustain pedal on/off events, length-
ens the affected notes to match the Sustain pedal off posi-
tion, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)
This function allows you to make sure that no notes of the 
same pitch overlap (i.e. that one starts before the other 
ends). Overlapping notes of the same pitch can confuse 
some MIDI instruments (a new Note On is transmitted be-
fore the Note Off is transmitted). This command can then 
be used to automatically solve the problem.

Delete Overlaps (poly)
This function shortens notes when required, so that no 
note begins before another ends. This happens regard-
less of which pitch the notes have.

Velocity
This function opens a dialog that allows you to manipulate 
the velocity of notes in various ways.

The following types of velocity processing are available:

Add/Subtract

This simply adds a fixed number to the existing velocity 
values. You set the value (positive or negative) with the 
Amount parameter.

Compress/Expand

Compresses or expands the “dynamic range” of MIDI 
notes by scaling the velocity values according to the Ratio 
setting (0 – 300%). The principle behind this is that multi-
plying different velocity values with a factor higher than 1 
(over 100%) will also make the differences between ve-
locity values greater, while using a factor lower than 1 (un-
der 100%) will make the differences smaller. In short:

• To compress (“even out” velocity differences), use ratio 
values below 100%.
After compression, you would probably want to add a velocity amount 
(with the Add/Subtract function) to maintain the average velocity level. 

• To expand (create greater difference in velocity), use ra-
tio values above 100%.
Before you expand, you may want to adjust the velocity with the Add/
Subtract function, so that the average velocity is somewhere in the mid-
dle of the range. If the average velocity is high (near 127) or low (near 0), 
expansion will not work properly, simply because velocity values can only 
be between 0 and 127!

Limit

This function allows you to make sure that no velocity val-
ues fall outside a given range (the Lower and Upper val-
ues). Any velocity values outside this range are raised/
lowered to exactly the Lower/Upper values.
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Fixed Velocity
This function sets the velocity of all selected notes to the 
Insert Velocity value on the toolbar in the MIDI editors.

Thin Out Data
Thins out MIDI data. Use this to ease the load on your ex-
ternal MIDI devices if you have recorded very dense con-
troller curves etc. 

You can also manually thin out the controller data by using 
the quantize function in the Key Editor.

Extract MIDI Automation
This option allows you to automatically convert continuous 
controller data of a MIDI part into MIDI track automation 
data. Proceed as follows:

1. Select the desired MIDI part containing the continuous 
controller data.

2. Select “Extract MIDI Automation”. (This command is 
also available on the Key Editor context menu.)
The controller data will automatically be removed from the controller lane 
in the editor.

3. In the Project window, open the automation track(s) 
for the respective MIDI track (by clicking on the left edge 
of the track list or by selecting “Show All Used Automa-
tion” from the context menu). You will find that an automa-
tion track has been created for each of the continuous 
controllers in the part.

Please note that this function can only be used for 
continuous controllers. Data such as Aftertouch, Pitch-
bend or SysEx cannot be converted to MIDI track automa-
tion data.

Remember that to be able to hear the automation data, 
you have to activate the Read button for the respective au-
tomation track(s).

Reverse
This function inverts the order of the selected events (or of 
all events in the selected parts), causing the MIDI music to 
play backwards. Note that the effect is different from re-
versing an audio recording. With MIDI, the individual notes 
will still play as usual in the MIDI instrument – it’s only the 
order of playback that is changed.

! This is an extremely useful function as it allows you to 
quickly and easily convert the continuous controllers 
of your recorded MIDI parts into MIDI track automa-
tion data, making them available for editing in the 
Project window.
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About editing MIDI
There are several ways to edit MIDI in Cubase LE. You 
can use the tools and functions in the Project window for 
large-scale editing, or use the functions on the MIDI menu 
to process MIDI parts in various ways (see “What is affec-
ted by the MIDI functions?” on page 155). For hands-on 
graphical editing of the contents of MIDI parts, you use the 
MIDI editors:

• The Key Editor is the default MIDI editor, presenting 
notes graphically in an intuitive piano roll-style grid.
The Key Editor also allows for detailed editing of non-note events such 
as MIDI controllers. For more information, see “The Key Editor – Over-
view” on page 168.

• The Drum Editor is similar to the Key Editor, but takes 
advantage of the fact that with drum parts, each key corre-
sponds to a separate drum sound. 
This is the editor to use when you’re editing drum or percussion parts. 
For more information, see “The Drum Editor – Overview” on page 182.

• The List Editor shows all events in the selected MIDI 
parts as a list, allowing you to view and edit their proper-
ties numerically.
For more information, see “The List Editor – Overview” on page 189.

• The Score Editor shows MIDI notes as a musical score .
This offers basic score editing and printing – see “The Score Editor – 
Overview” on page 193 for details).

You can define each of the four editors mentioned 
above as your default MIDI editor, see below. 

Opening a MIDI editor
There are two ways to open a MIDI editor:

• Select one or several parts (or a MIDI track, with no 
parts selected) and select Open Key Editor, Open Drum 
Editor, Open List Editor from the MIDI menu or Open 
Score Editor from the Scores submenu (or use the corre-
sponding key command).
The selected parts (or all parts on the track, if no part was selected) will 
open in the chosen editor.

• Double-click a part to open it in the default editor.
Which editor opens depends on the settings in the Preferences (Event 
Display–MIDI page):

Double-clicking will open the editor selected on the Default 
Edit Action pop-up menu. However, if the option “Edit as 
Drums when Drum Map is assigned” is activated and a 
drum map is selected for the edited track (see “Selecting a 
drum map for a track” on page 187), the Drum Editor will 
open. This way you can double-click to open the Key Editor 
(or the Score Editor or List Editor, depending on your pref-
erences) but drum tracks will automatically open in the 
Drum Editor.

If the part you open for editing is a shared copy, any ed-
iting you perform will affect all shared copies of this part.
Shared copies are created by pressing [Alt]/[Option]+[Shift] and drag-
ging, or by using the Repeat function with the “Shared copies” option 
activated. In the Project window, shared copies are indicated by the part 
name in italics and an icon in the bottom right corner of the part (see 
“Duplicating events” on page 30).
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Handling several parts
When you open a MIDI editor with several parts (or a MIDI 
track containing several parts) selected, you might find it 
somewhat hard to get an overview of the different parts 
when editing.

For such cases the editor toolbar features a few functions 
to make working with multiple parts easier and more com-
prehensive:

• The Part List menu lists all parts that were selected 
when you opened the editor (or all parts on the track, if no 
parts were selected), and lets you select which part 
should be active for editing.
When you select a part from the list, it is automatically made active and 
centered in the note display.

Note that it is also possible to activate a part by select-
ing an event within this part with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
For example, if you select “All” from the Select submenu on the Edit menu 
with this option activated, only events in the active part will be selected. 
Similarly, if you select notes by dragging with the Arrow tool (making a se-
lection rectangle), only the notes in the active part will be selected.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on the active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu on the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, 
making the borders easily discernible. In the Key Editor, there are also 
two “markers” in the ruler with the name of the active part, marking its be-
ginning and end. These can be moved freely to change the size of the 
part.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts (making them ac-
tive) using key commands.
In the Key Commands dialog – Edit category, you will find two functions for 
this: “Activate Next Part” and “Activate Previous Part”. If you assign key 
commands to these, you can use them to cycle between parts in the edi-
tors. For further information, see “Setting up key commands” on page 250.
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The Key Editor – Overview 

The toolbar
As in other windows, the toolbar contains tools and vari-
ous settings. You can specify which toolbar items should 
be shown and store/recall different toolbar configurations 
– see “The Setup dialogs” on page 244. 

The info line

The info line shows information about selected MIDI 
notes. You can edit all values on the info line using regular 
value editing (see “Editing on the info line” on page 176 
for details). Length and position values are displayed in 
the format currently selected for the ruler (see below).

• To hide or show the info line, click the icon in the tool-
bar.

The ruler
The ruler shows the time line, by default in the display for-
mat selected on the Transport panel. You can select a 
separate format for a MIDI editor ruler on the Ruler pop-up 
menu, opened by clicking the arrow button to the right of 
it. For a list of the available formats, see “The ruler” on 
page 20.

Ruler

Info line

Toolbar

Note 
display

Controller 
display

Show/Hide Info line

Solo Editor button
Key Editor tools

Autoscroll 
on/off

Audition on/off

Part list

Show/Hide Part 
borders

Edit active 
part only

Auto Select 
Controllers

Nudge Tools Snap on/off

Velocity for inserted notes Grid modes

Quantize settings Step Input MIDI Input Step/MIDI 
input controls

Color pop-up 
menu

Chord recogni-
tion display

Mouse pointer display: Current 
pitch and meter position
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At the bottom of the pop-up menu, there are two addi-
tional items:

• If “Time Linear” is selected, the ruler, note display and 
controller display will be linear in relation to time.
This means that if the ruler shows bars and beats, the distance between 
the bar lines will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, note display 
and controller display will be linear in relation to tempo.
This means that if the ruler shows bars and beats, the distance between 
beats will be constant.

In most cases, you would probably set the display format 
to “Bars+Beats” in “Bars+Beats Linear” mode when edit-
ing MIDI.

The note display

The note display is the main area in the Key Editor. It con-
tains a grid in which MIDI notes are shown as boxes. The 
width of a box corresponds to the note length, and the 
vertical position of a box corresponds to the note number 
(pitch), with higher notes higher up in the grid. The piano 
keyboard to the left serves as a guide for finding the right 
note number. 

For a description on how to display colors in the note dis-
play, see “Coloring notes and events” on page 171.

The chord recognition function

Cubase LE features a handy chord recognition function 
that helps you identify chords in the Key Editor note dis-
play. To find out which chord is formed by simultaneously 
played notes, place the project cursor over the notes. All 
MIDI notes currently “touched” by the project cursor are 
analyzed and the chord recognition display in the toolbar 
shows you which chord the notes form.

In the picture above, the project cursor touches the notes C, Eb and G. 
As shown in the chord recognition display, this results in a C minor chord.

The controller display

The area at the bottom of the Key Editor window is the 
controller display. This consists of one or several control-
ler lanes, each showing one of the following properties or 
event types:

• Velocity values of the notes.
• Pitch Bend events.
• Aftertouch events.
• Poly Pressure events.
• Program Change events.
• Any type of continuous controller event.

To change the size of the controller display, drag the di-
vider between the controller display and the note display. 
This will make the controller display larger and the note 
display smaller, or vice versa.
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Velocity values are shown as vertical bars in the controller 
display, with higher bars corresponding to higher velocity 
values:

Each velocity bar corresponds to a note in the note display.

Events in the controller display (that is, anything other than 
velocity values) are shown as “blocks”, the heights of which 
correspond to the “values” of the events. However, events 
that have been recorded (or drawn with a low quantize 
value) may appear more like “filled curves”, simply because 
they are positioned very closely:

If you zoom in on the upper “curve”, you will find that it consists of sep-
arate events.

Unlike notes, events in the controller display have no 
length. The value of an event in the display is “valid” until 
the start of the next event:

For a description of editing in the controller display, see 
“Editing in the controller display” on page 177.

Key Editor operations

Zooming
Zooming in the Key Editor is done according to the stan-
dard zoom procedures, using the zoom sliders, the Zoom 
tool or the Zoom submenu on the Edit menu.

• When you drag a rectangle with the Zoom tool, the result 
depends on the option “Zoom Tool Standard Mode: Hori-
zontal Zooming Only” in the Preferences (Editing–Tools 
page).
If this is activated, the window will only be zoomed horizontally; if not, the 
window will be zoomed both horizontally and vertically.

Using the Trim tool
The Trim tool allows you to change the length of note 
events by cutting off the end or the beginning of notes. It 
is available in the Key Editor and in the List Editor.

Using the Trim tool means moving the note-on or the note-
off event for one or several notes to a position defined with 
the mouse. Proceed as follows:

1. Select the Trim tool in the Key Editor or the List Editor 
toolbar.
The mouse pointer changes to a knife symbol.

2. Locate the note(s) that you wish to edit.

• To edit a single note, click on it with the Trim tool. The 
range between the mouse cursor and the end of the note 
will be removed.
You can use the mouse position display in the toolbar to find the exact 
position for the trim operation.

• To edit several notes, click and drag with the mouse 
across the notes.
A line is displayed. The notes will be trimmed along this line.

Trimming the end of three note events.

If you delete the second event…
…the first event will be “valid” 
until the start of the third event.
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• By default, the Trim tool will cut off the end of notes. To 
trim the beginning of the note(s), press [Alt]/[Option] while 
dragging.

• If you press [Ctrl]/[Command] while dragging, you will 
get a vertical trim line, allowing you to set the same start or 
end time for all edited notes.

You can change the Trim tool key commands in the Pref-
erences (Editing–Tool Modifiers page).

Note that when you trim the beginning of a note in the 
List Editor, the note may move to a different position in the 
list (since other events may now begin before the edited 
event).

Note that the trimmed note ends don’t snap to the grid.

Playing back
You can play back your music as usual when working in a 
MIDI editor. There are several features designed to make 
editing easier during playback:

Solo button

If you activate the Solo button, only the edited MIDI parts 
will be heard during regular playback.

Autoscroll

 

As described in the section “Autoscroll” on page 38, the 
Autoscroll function makes the window “follow” the project 
cursor during playback, so that the current play position is 
visible at all times. However, when you are working in a 
MIDI editor, you may want to deactivate Autoscroll – this 
way, the events you are working with will stay visible.

The Autoscroll buttons in each of the MIDI editors are inde-
pendent of the Project window Autoscroll setting, which 
means that Autoscroll can be activated in the Project win-
dow and deactivated in the MIDI editor you are working in.

Auditioning

If the speaker icon on the toolbar is activated, individual 
notes will automatically be played back (auditioned) when 
you move or transpose them, or when you create new notes 
by drawing. This makes it easier to hear what you’re doing.

Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when ed-
iting in a MIDI editor. It does this by restricting horizontal 
movement and positioning to certain positions. Operations 
affected by snap include moving, duplicating, drawing, siz-
ing, etc.

• How Snap works depends on the Snap mode pop-up 
menu next to the Snap button.
See “Snap” on page 37.

• When the “Bars+Beats” display format is selected in 
the ruler, the snap grid is set by the quantize value on the 
toolbar.
This makes it possible to snap not only to straight note values but also to 
swing grids set up in the Quantize Setup dialog (see “The Quantizing 
functions” on page 155).

When any of the other display formats is selected in the 
ruler, positioning is restricted to the displayed grid, i.e. you 
can snap in finer increments by zooming in, and in coarser 
increments by zooming out the display.

Coloring notes and events
By using the Colors pop-up menu on the toolbar, you can 
select a color scheme for the events in the editor. The fol-
lowing options are available:

Option Description

Velocity The notes get different colors depending on their velocity 
values.

Pitch The notes get different colors depending on their pitch.

Channel The notes get different colors depending on their MIDI 
channel value.
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When any of the options (apart from “Part”) is selected, 
you can select “Setup” from the Colors pop-up menu. 
This opens a dialog in which you can specify which colors 
should be associated with which velocities, pitches or 
channels, respectively.

Creating and editing notes
To draw new notes in the Key Editor, you use the Pencil 
tool or the Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you insert single notes by clicking at 
the desired time (horizontal) and pitch position (vertical).

• When you move the pointer in the note display, its bar 
position is indicated in the toolbar, and its pitch is indicated 
both in the toolbar and on the piano keyboard to the left.
This makes it easy to find the right note and insert position.

• If Snap is activated, this determines the start position of 
the created note.

• If you click once, the created note will have the length 
set on the Length Quantize pop-up menu on the toolbar.
You can create a longer note by clicking and dragging. The length of the 
created note will be a multiple of the Length Quantize value.

Drawing notes with the Line tool

The Line tool can be used for creating series of contigu-
ous notes. To do so, click and drag to draw a line and then 
release the mouse button.

The Line tool has several different modes.
To select one of the modes, click on the Line tool icon on the toolbar 
when the tool is already selected. This opens a pop-up menu from which 
you can select one of the Line tool modes.

The tool icon will change appearance according to the se-
lected mode.

Setting velocity values

When you draw notes in the Key Editor, the notes will get 
the velocity value set in the insert velocity field on the tool-
bar.

You can use one of four different methods for determining 
the velocity:

Part The notes get the same color as their respective part in 
the Project window. Use this option when you are work-
ing with two or more tracks in an editor, to make it easier 
to see which notes belong to which track.

GridMatch The notes get different colors depending on their time 
position. This mode makes it easy to see e.g. if the notes 
in a chord start at the exact same beat.

Option Description

Mode Description

Line This is the default mode for the Line tool. When this 
mode is selected, you click and drag to create a straight 
line, in any angle. When you release the mouse button, a 
series of notes will be created, aligned with the line. If 
Snap is activated, the notes will be spaced and sized ac-
cording to the Quantize value.

Parabola, Sine, 
Triangle, Square

These modes insert events along different curve shapes. 
While they can be used for creating notes, they’re proba-
bly best suited for controller editing (see “Adding and 
editing events in the controller display” on page 179).

Paint Allows you to insert multiple notes by dragging with the 
mouse button pressed. If Snap is activated, the notes will 
be positioned and sized according to the Quantize and 
Length Quantize values. If you press [Ctrl]/[Command] 
while painting, movement will be restricted to horizontal 
only (i.e. the painted notes will have the same pitch).
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• When a key command is assigned for the Select tool–
Edit Velocity action (in the Editing–Tool Modifiers page of 
the Preferences dialog), you can select one or more notes, 
press [Ctrl]/[Command]+[Shift] and click on one of the 
selected notes to change the velocity. 
The cursor changes into a speaker and, next to the note, a field with the 
velocity value appears – the Note Velocity Slider. Move the mouse 
pointer up or down to change the value. Value changes will be applied to 
all selected notes, as you can see in the controller lane. 

• Selecting a predefined velocity value from the insert ve-
locity pop-up menu.
The menu contains five different predefined velocity values. The “Setup...” 
item opens a dialog that allows you to specify which five velocity values 
should be available on the pop-up menu. (This dialog can also be opened 
by selecting “Insert Velocities...” from the MIDI menu.)

• Manually entering the desired velocity value by clicking 
in the insert velocity field and typing in the desired value.

• Using a key command.
You can assign a key command to each of the five available velocity val-
ues in the Key Commands dialog (MIDI category – the items Insert Ve-
locity 1-5). This allows for quick switching between different velocity 
values when entering notes. See “Setting up key commands” on page 
250 for instructions on how to set up key commands.

Selecting notes

Selecting notes is done using any of the following me-
thods:

• Use the Arrow tool.
The standard selection techniques apply, like selecting by clicking on the 
note or using a selection rectangle. Note that when you press [Shift] and 
click on notes or draw a selection rectangle, these notes will be added to 
the overall selection. When you press [Ctrl]/[Command] and click on 
notes or draw a selection rectangle, these notes will be removed from 
the overall selection (standard Windows behavior).

• Use the Select submenu on the Edit menu or Quick 
menu.
The Select menu options are:

• You can also use the left and right arrow keys on the 
computer keyboard to step from one note to another.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several notes.

• To select all notes of a certain pitch, press [Ctrl]/[Com-
mand] and click on the desired key in the keyboard display 
to the left.

You can also press [Shift] and double-click on a note to select all the fol-
lowing notes of the same pitch.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all notes currently 
“touched” by the project cursor are automatically selected.

Toggle selections

If you want to toggle the selected elements within a selec-
tion rectangle, press [Ctrl]/[Command] and enclose the 
same elements within a new selection rectangle. Once 
you release the mouse button, the previous selection is 
deselected and vice versa.

Option Description

All Selects all notes in the edited part.

None Deselects all events.

In Loop Selects all notes that are partially or completely inside the 
boundaries of the left and right locators (only visible if lo-
cators are set).

From Start to 
Cursor

Selects all notes that begin to the left of the project cur-
sor.

From Cursor to 
End

Selects all notes that end to the right of the project cur-
sor.

All notes of the correspond-
ing pitch are selected.
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Selecting controllers within the note range

You can select the controllers within the range of the se-
lected notes. The following applies:

• When the Auto Select Controllers button is activated in 
the toolbar, the controllers will always be selected when 
the respective notes are selected.

• A note range lasts until the start of the next note or the 
end of the part. 

• Selected controllers for notes are moved when the cor-
responding notes are moved.

Moving and transposing notes

To move notes in the editor, use any of the following me-
thods:

• Click and drag to a new position.
All selected notes will be moved, maintaining their relative positions. If 
Snap is activated, this determines to which positions you can move the 
notes, see “Snap” on page 171.

• Use the up and down arrow keys on the computer key-
board.
This method allows you to transpose the selected notes, without risking 
to move them horizontally. You can also use the Transpose function (see 
“Transpose” on page 159) or the info line (see “The info line” on page 
168) for this. Note that pressing [Shift] and using the up and down arrow 
keys will transpose notes in steps of one octave.

• Use the Move to Cursor function on the Edit menu.
This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info 
line.
See “Editing on the info line” on page 176.

• Use the Move buttons in the Nudge palette on the tool-
bar.
This moves the selected note(s) by the amount set on the Quantize pop-
up menu. 
By default, the Nudge palette isn’t shown on the toolbar – see “The Se-
tup dialogs” on page 244 for more information.

Note that when you move selected notes to a different 
position, any selected controllers for these notes will move 
accordingly.
See also “Moving and copying events” on page 180.

You can also adjust the position of notes by quantizing 
(see “The Quantizing functions” on page 155).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in 
the Project window:

• Hold down [Alt]/[Option] and drag the note(s) to a new 
position.
If Snap is activated, this determines to which positions you can copy 
notes (see “Snap” on page 171).

• Selecting Duplicate from the Edit menu creates a copy 
of the selected note and places it directly after the original.
If several notes are selected, all of these are copied “as one unit”, main-
taining the relative distance between the notes.

• Selecting Repeat from the Edit menu opens a dialog, al-
lowing you to create a number of copies of the selected 
note(s).
This works like the Duplicate function, but you can specify the number of 
copies.

• You can also perform the Repeat function by dragging: 
Select the note(s) to repeat, press [Alt]/[Option], click the 
right edge of the last selected note and drag to the right.
The longer to the right you drag, the more copies are created (as indi-
cated by the tool tip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit 
menu to move or copy material within a part or between 
different parts. When you paste copied notes, you can ei-
ther use the regular Paste function or the function “Paste 
Time” from the Range submenu of the Edit menu.

• “Paste” inserts the copied notes at the project cursor position 
without affecting existing notes.

! Note also that you can restrict movement to horizon-
tal or vertical only by holding down [Ctrl]/[Command] 
while dragging.
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• “Paste Time” inserts at the project cursor position, but moves 
(and if necessary, splits) existing notes to make room for the 
pasted notes.

Resizing notes

To resize a note, use one of the following methods:

• Position the arrow tool at the start or end of the note, so 
that the pointer takes on the shape of a small double ar-
row. Click and drag to the left or right to resize the note.
This method allows you to resize the note from either direction.

• Click with the Pencil tool within the note box and drag 
to the left or the right (to make the note shorter or longer, 
respectively).

With both these methods, the resulting length will be a 
multiple of the Length Quantize value on the toolbar.

• Use the Trim Start/End buttons on the Nudge palette on 
the toolbar.
This resizes the selected note(s) by moving their start or end positions, in 
steps according to the Length Quantize value on the toolbar. By default, 
the Nudge palette isn’t shown on the toolbar – see “The Setup dialogs” on 
page 244 for more information.

• Select the note and adjust its length on the info line.
See “Editing on the info line” on page 176 for details on info line editing.

• Use the Trim tool, see “Using the Trim tool” on page 170.

Splitting notes

There are three ways to split notes:

• Clicking on a note with the Scissors tool splits the note 
at the position you pointed (taking the Snap setting into 
account if activated).
If several notes are selected, they are all split at the same position.

• If you select “Split at Cursor” in the Edit menu, all notes 
that are intersected by the project cursor are split at the 
cursor position.

• If you select “Split Loop” in the Edit menu, all notes that 
are intersected by the left or right locator are split at the 
locator positions.

Gluing notes

Clicking on a note with the Glue Tube tool will “glue it to-
gether” with the next note of the same pitch. The result will 
be one long note spanning from the start of the first note 
to the end of the second note and with the properties (ve-
locity, etc.) of the first note.

Muting notes

Individual notes can be muted in the Key Editor, as op-
posed to muting an entire MIDI part in the Project window. 
This allows you to exclude notes from playback, but keep 
the option to bring them back again at any time. To mute a 
note, use one of the following methods:

• Click on it with the Mute tool.
• Drag a rectangle with the Mute tool, enclosing all notes you 

want to mute.
• Select the note(s) and choose Mute from the Edit menu. 
The default key command for this is [Shift]+[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute 
tool, or select it and choose Unmute from the Edit menu. 
The default key command for this is [Shift]+[U].

Selecting “Paste Time” with this data 
on the clipboard and the project cur-
sor here…

…will give you this.
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Deleting notes

To delete notes, either click on them with the Eraser tool 
or select them and press [Backspace].

Editing on the info line
The info line shows the values and properties of the se-
lected event(s). If a single event is selected, its values are 
displayed on the info line. If several events are selected, 
the info line shows the values of the first of these events in 
yellow.

Several events selected.

You can edit the values on the info line using regular value 
editing. This allows you to move, resize, transpose or 
change velocity of events in a very precise manner. It’s 
also possible to click the Pitch or Velocity field in the info 
line and play a note on your MIDI keyboard – the pitch or 
velocity will be adjusted according to the note you played.

If you have several events selected and change a value, 
all selected events will be changed by the set amount.

If you have several events selected, hold down [Ctrl]/
[Command] and change a value, the change will be abso-
lute.
In other words, the value setting will be the same for all selected events.

Editing notes via MIDI
You can change the properties of notes via MIDI. For ex-
ample, this can be a fast way to get the right velocity value, 
since you will hear the result even as you edit:

1. Select the note you want to edit.

2. Click on the MIDI connector symbol on the toolbar.

Click this button to enable editing via MIDI.

3. Use the note buttons on the toolbar to decide which 
properties should be changed by the MIDI input.
You can enable editing of pitch, note-on and/or note-off velocity.

With this setting, the edited notes will get the pitch and velocity values of 
the notes input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will get the pitch, velocity and/or note-off 
velocity of the played note.

The next note in the edited part is automatically selected, 
making it easy to quickly edit a series of notes.

• If you want another try, select the note again (e.g. by 
pressing the left arrow key on the computer keyboard) and 
again play a note on your MIDI instrument.

Step input
Step input, or step recording, is when you enter notes one 
at a time (or one chord at a time) without worrying about 
the exact timing. This is useful e.g. when you know the part 
you want to record but are not able to play it exactly as you 
want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate 
Step Input mode.

2. Use the note buttons to the right to decide which 
properties should be included when you input the notes.
For example, you may not want to include the velocity and/or note-off ve-
locity of the played notes. It’s also possible to turn off the pitch property, 
in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start po-
sition (the desired position of the first note or chord).
The step input position is shown as a blue line in the note display, and in 
the lower mouse pointer display in the toolbar.
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4. Specify the desired note spacing and length with the 
Quantize and Length Quantize pop-up menus.
The notes you input will be positioned according to the Quantize value 
and have the length set with the Length Quantize value. For instance, if 
you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the 
notes will be sixteenth notes, appearing on each eighth note position.

5. Play the first note or chord on your MIDI instrument.
The note or chord appears in the editor and the step input position ad-
vances one quantize value step.

If Insert mode is activated, all notes to the right of the 
step input position will be moved to “make room” for the 
inserted note or chord.

Insert mode activated.

6. Continue in the same way with the rest of the notes or 
chords.
You can adjust the Quantize or Length Quantize value as you go along, 
to change the timing or note lengths. You can also move the step input 
position manually by clicking anywhere in the note display.

• To insert a “rest”, press the right arrow key on the com-
puter keyboard.
This advances the step input position one step.

7. When you’re done, click the Step Input button again 
to deactivate step input.

Editing in the controller display

About controller lanes

By default, the controller display has a single lane, show-
ing one event type at a time. However, you can add lanes 
by right-clicking in the display and selecting “Create new 
controller lane” from the Quick menu. This allows you to 
view and edit different controllers at the same time.

The controller display with two lanes set up.

• To remove a lane, right-click in it and select “Remove this 
Lane” from the Quick menu, or click on the minus button.
This hides the lane from view – it doesn’t affect the events in any way.

• If you remove all lanes, the controller display will be 
completely hidden.
To bring it back again, select “Create new controller lane” from the Quick 
menu.

Selecting the event type

Each controller lane shows one event type at a time. To 
select which type should be displayed, use the pop-up 
menu to the left of the lane.

• Selecting “Setup...” opens a dialog in which you can 
specify which continuous controller event types should be 
available on the pop-up menu.

Controller types in this 
list are already listed on 
the pop-up menu.

Controller types in this 
list are not listed on the 
pop-up menu.

Click this button to add 
the selected controller 
type to the pop-up menu.

Click this button to remove the 
controller type selected in the 
left list from the pop-up menu.
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• Each MIDI track has its own controller lane setup (num-
ber of lanes and selected event types). 
When you create new tracks, they get the controller lane setup used last.

Controller lane presets

Once you have added the required number of controller 
lanes and selected the event types you need, you can 
store this combination as a controller lane preset. You 
could for example have a preset with one velocity lane 
only, another with a combination of velocity, pitch bend 
and modulation, and so on. This can make working with 
controllers much quicker.

• To add the current controller lane setup as a preset, pull 
down the pop-up menu to the left of the horizontal scroll-
bar and select “Add”.
Enter a name for the preset in the dialog that appears and click OK.

• To apply a stored preset, select it from the pop-up 
menu.
This immediately brings up the controller lanes and event types in the 
preset.

• To remove or rename presets, select “Organize” from 
the pop-up.

Editing velocity values

When “Velocity” is selected for viewing, the lane shows 
the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. 
The different tools and Line tool modes offer several pos-
sibilities, as listed below.

If the option “Controller Lane Editing: Select Tool de-
faults to Pen” is activated in the Preferences (Editing–MIDI 
page), the Arrow tool automatically switches to the Pencil 
tool when you move the pointer into the controller display.
If you want to use the Arrow tool to select events in the controller display, 
press [Ctrl]/[Command].

If the Speaker icon (Acoustic Feedback) is activated 
on the toolbar, the notes will be played back when you ad-
just the velocity, allowing you to audition your changes.

• You can use the Pencil tool to change the velocity of a 
single note: click on its velocity bar and drag the bar up or 
down.
While you drag, the current velocity value is shown in the display to the 
left.

• You can use the Pencil tool or the Line tool in Paint 
mode to change the velocity values of several notes by 
painting a “freehand curve”.
When editing velocity, these two methods have the same functionality.

• Use the Line tool in Line mode for creating linear veloc-
ity ramps.
Click where you want the ramp to start and drag the cursor to where you 
want the ramp to end. When you release the mouse button, the velocity 
values are aligned with the line between the two points.
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• Parabola mode works in the same way, but aligns the 
velocity values to a Parabola curve instead.
Use this for smooth, “natural” velocity fades, etc.

• The remaining three Line tool modes (Sine, Triangle and 
Square) align the velocity values to continuous curve 
shapes (see below).

Note:

• If there is more than one note at the same position (e.g. a 
chord), their velocity bars will overlap in the controller lane. 
If none of the notes are selected, all notes at the same position will be set 
to the same velocity value when you draw. To edit the velocity of only one 
of the notes at the same position, first select the note in the note display. 
Now, editing will only affect the velocity of the selected note.

You can also adjust the velocity of a single note by select-
ing it and changing its velocity value on the info line.

Adding and editing events in the controller display

When any option other than “Velocity” is selected for a 
controller lane, you can create new events or edit the val-
ues of existing events using the Pencil tool or the Line tool 
in its various modes: 

• Clicking with the Pencil tool or the Line tool in Paint 
mode creates a new event.
Note the “Select Tool defaults to Pen” option – see “Editing velocity va-
lues” on page 178. 

• Press [Alt]/[Option] and use the Pencil tool or the Line 
tool in Paint mode to modify the value of an event (without 
creating a new one).
Note that you can click and drag to change or add multiple events, draw 
controller curves, etc. You can press or release [Alt]/[Option] while draw-
ing, switching dynamically between “edit mode” and “create mode”.

With the Pencil tool and the Line tool in Paint mode, the 
quantize value determines the “density” of created control-
ler curves (if Snap is activated, see “Snap” on page 171).
For very smooth curves, you should use a small quantize value or turn off 
Snap. However, this will create a very large number of MIDI events, which 
can cause MIDI playback to “stutter” in some situations. A medium-low 
density is often sufficient.

• Clicking and dragging with the Line tool in Line mode 
shows a line in the controller lane, and creates events with 
values aligned to this line.
This is the best way to draw linear controller ramps. If you press [Alt]/
[Option], no new events are created – use this mode for modifying exist-
ing controller curves.

If you want to enter or adjust a single event, click once with the Pencil 
tool or the Line tool in Paint mode.

If you want to “paint a curve”, drag the tool (with the mouse button 
pressed):

When you move the pointer in the controller lane, the 
corresponding value is displayed in this field.

Converting a controller curve to a ramp 
using the Line tool.
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• The Parabola mode works in the same way, but aligns 
the values to a parabola curve instead, giving more “natu-
ral” curves and fades.
Note that the result depends on the direction from which you draw the 
parabola.

• In Parabola mode, you can use modifier keys to deter-
mine the shape of the parabola curve.
If you press [Ctrl]/[Command], the parabola curve will be reversed. If you 
press [Alt]/[Option]+[Ctrl]/[Command] while Snap is activated, you can 
change the position of the whole curve (in both cases the snap value for 
the positioning will be a quarter of the quantize value). If you press [Shift], 
the exponent will be increased or decreased.

In Line and Parabola modes, the length quantize value 
determines the “density” of created controller curves (if 
Snap is activated).
For very smooth curves, you should use a small length quantize value or 
turn off Snap. To avoid over-dense controller curves (which may cause 
MIDI playback to “stutter”), use a medium-low density.

• The Sine, Triangle and Square modes create events 
with values aligned to continuous curves.
In these modes, the quantize value determines the period of the curve 
(the length of one curve “cycle”) and the length quantize value deter-
mines the density of the events (the lower the length quantize note value, 
the smoother the curve).

• In Sine, Triangle and Square mode you can also use 
modifier keys to determine the shape of the curve.
If you press [Ctrl]/[Command] you can change the phase of the beginning 
of the curve, if you press [Alt]/[Option]+[Ctrl]/[Command] while snap is 
activated you can change the position of the whole curve (in both cases 
the snap value for the positioning will be a quarter of the quantize value).

You can also set the curve period freely by holding 
down [Shift] when you insert events in Sine, Triangle or 
Square mode.
Activate Snap, [Shift]-click and drag to set the length of one period. The 
period length will be a multiple of the quantize value.

• In Triangle and Square mode, you can press 
[Shift]+[Ctrl]/[Command] to change the maximum position 
of the triangle curve (to create sawtooth curves) or the 
pulse of the square curve. As in other modes, you can 
press [Alt]/[Option] if you want to change the existing 
events rather than creating new ones. Again, the snap 
value for the positioning will be a quarter of the quantize 
value.

Moving and copying events

You can move or duplicate events in a controller lane, 
much like you can with notes:

1. Click with the Arrow tool to select the events you want 
to cut or copy.
If the option “Controller Lane Editing: Select Tool defaults to Pen” is ac-
tivated in the Preferences (Editing–MIDI page), you need to press [Ctrl]/
[Command] to get the Arrow tool.

2. Click and drag the events to move them.
If Snap is activated, this determines to which positions you can move the 
events (see “Snap” on page 171).

• If you hold down [Alt]/[Option] and drag, the events will 
be copied rather than moved. 

! If there is an event of the same type at the exact 
same position already, this will be replaced by the 
moved event.
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Using cut, copy and paste

You can use the standard Cut, Copy and Paste options on 
the Edit menu to move or copy events in the controller dis-
play:

1. Select the events you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, 
open that part in another Key Editor window.

4. Position the project cursor where you want to paste 
the events.

5. Select Paste from the Edit menu.
The events on the clipboard are added, starting at the project cursor po-
sition, maintaining their relative distances. If a pasted event ends up at 
the same position as an existing event of the same type, the old event is 
replaced. 

Deleting events in the controller display

You delete events by clicking on them with the Eraser tool 
or by selecting them and pressing [Backspace]. Please 
note:

• Deleting a controller event makes the last event before 
this valid up until the next event. It does not “zero” any 
controller changes.

• You can delete notes by deleting their velocity bars in 
the controller display.
Please be aware that if there is more than one note on the same position, 
there may still only be one velocity bar visible – make sure you delete only 
the desired notes!

Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a 
specific note number (key). That is, each Poly Pressure 
event has two editable values: the note number and the 
amount of pressure. Therefore, when Poly Pressure is se-
lected on the event type pop-up menu, there are two value 
fields to the left of the controller display, one for the note 
number and one for the amount:

To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard dis-
play.
The selected note number is displayed in the upper value field to the left 
of the controller display. Note that this only works for the topmost lane. If 
you have selected “Poly Pressure” for several controller lanes, you have 
to type in the desired note number directly in the lower value field to the 
left of each lane. 

3. Use the Pencil tool to add a new event, just as when 
adding regular controller events.

To view and edit existing Poly Pressure events, proceed 
as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field 
to the left of the controller lane.
A pop-up menu appears, listing all note numbers for which there already 
are Poly Pressure events.

3. Select a note number from the pop-up menu.
The Poly Pressure events for the selected note number are shown in the 
controller lane.

4. Use the Pencil tool to edit the events as usual.
Press [Alt]/[Option] to edit existing events without adding any new ones.

• Poly Pressure events can also be added and edited in 
the List Editor.

! Remember that a non-note event doesn’t have a 
length – it’s “valid” until the next event (see “The 
controller display” on page 169.

! When the Auto Select Controllers button is activated 
in the Key Editor toolbar, selecting controller events 
will also select the corresponding notes. Moving 
events (either using cut/copy/paste or drag & drop) 
in the note display will also move the corresponding 
controller events and vice versa. See also “Selecting 
controllers within the note range” on page 174.
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The Drum Editor – Overview

The toolbar and info line
These are much the same as the toolbar and info line in 
the Key Editor (see “The Key Editor – Overview” on page 
168), with the following differences:

• The Drum Editor has no Pencil tool – instead there is a 
Drumstick tool (for entering and removing notes) and a 
Line tool with various line and curve modes (for drawing 
several notes in one go or editing controller events).

• There are no Scissors and Glue Tube tools in the Drum 
Editor.

• As in the Key Editor, the mouse pointer display in the 
toolbar shows the pitch and position of the pointer, but the 
pitch is shown as a drum sound name rather than a note 
number.

• The Use Global Quantize button allows you to select 
which value should be used when Snap is activated – the 
global quantize value on the toolbar or the individual quan-
tize values for the drum sounds.

• Instead of a Length Quantize pop-up, there is an Insert 
Length pop-up menu.
It is used in much the same way, as described on the following pages.

The drum sound list

A drum sound list for GM Drum Map.

The purpose of the Drum Editor is to edit MIDI tracks where 
each note (pitch) plays a separate sound, as is typically the 
case with a MIDI drum kit. The drum sound list to the left 
lists all drum sounds by name (according to the selected 
drum map or name list – see below), and lets you adjust 
and manipulate the drum sound setup in various ways.

Note:

• The number of columns in the list depends on whether a 
drum map is selected for the track or not.
See “Working with drum maps” on page 185.

Toolbar Ruler

Note 
display

Controller 
display

Drum sound listDrum Maps
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• You can reorder the columns by dragging the column 
headings, and resize them by dragging the dividers be-
tween the column headings.

The note display

The note display of the Drum Editor displays notes as dia-
mond symbols. The vertical position of the notes corre-
sponds to the drum sound list to the left, while the horizontal 
position corresponds to the note’s position in time, just as in 
the Key Editor. Note however, that the diamond symbols 
don’t indicate the length of the notes. This makes sense, 
since drum sounds most often are “one-shot” samples that 
play to their end regardless of the note lengths.

Drum map and name pop-up menus

Below the drum sound list you will find two pop-up menus, 
used for selecting a drum map for the edited track or (if no 
drum map is selected) a list of drum sound names. For an 
explanation of drum maps, see “Working with drum maps” 
on page 185.

Controller display
The controller display in the Drum Editor is exactly the 
same as in the Key Editor. You can add or remove control-
ler lanes via the Quick menu, and create and edit events 
as described in the section “Editing in the controller dis-
play” on page 177.

Drum Editor operations
The basic handling (zooming, playback, auditioning, etc.) 
is the same as in the Key Editor (see “Key Editor opera-
tions” on page 170). The following sections describe the 
procedures and features specific to the Drum Editor.

Creating and editing notes
The standard way of entering notes in the Drum Editor is 
to click with the Drumstick tool.

When you move the pointer in the note display, its bar position and 
drum sound is indicated in the toolbar, making it easy to find the right 
sound and position.

The position of the created note depends on the following 
factors:

• If Snap is deactivated on the toolbar, the note will ap-
pear exactly where you clicked.
In this mode, notes can be positioned freely.

• If Snap is activated and Use Global Quantize is deacti-
vated on the toolbar, the note will snap to positions ac-
cording to the quantize value set for the sound in the drum 
sound list.
You can set up different quantize values for different drum sounds. You 
may for example want hi-hat notes snap to sixteenth notes, but snare and 
bass drum snap to eighth notes.

• If both Snap and Use Global Quantize are activated, the 
note will snap to positions according to the Quantize set-
ting on the toolbar (next to the Use Global Quantize but-
ton).

The length of the inserted note is determined by the Insert 
Length setting on the toolbar. However, if this is set to 
“Drum-Map Link”, the note will get the length of the quan-
tize value for the drum sound.

You can quickly audition the drum sounds by clicking 
in the leftmost column in the drum sound list.
This plays the corresponding note.
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Clicking with the Drumstick tool on an existing note 
will remove it.
This makes drum pattern editing very quick and intuitive.

Setting velocity values

The notes you enter will get the insert velocity value set in 
the insert velocity field on the toolbar – to speed up things 
you may want to assign key commands to the insert velo-
city options. See “Setting velocity values” on page 172.

Selecting notes

Selecting notes is done by any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Quick menu (see “Se-
lecting notes” on page 173).

• Use the left and right arrow keys on the computer key-
board to step from one note to the next or previous note.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several notes.

• You can also press [Shift] and double-click on a note to 
select all the following notes for the same drum sound.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all notes currently 
“touched” by the project cursor are automatically selected.

Moving, duplicating or repeating notes

To move or copy notes in the editor (to other positions or 
other drum sounds), you use the same methods as in the 
Key Editor: click and drag, use the arrow keys or Edit 
menu functions, etc. – see “Moving and transposing no-
tes” on page 174. There is one thing to note:

When you are moving or copying several selected notes 
by dragging them and Snap is activated but Use Global 
Quantize is deactivated, the notes will snap to positions 
according to the quantize values for the drum sounds. If 
the moved/copied notes have different quantize values, 
the largest value will determine snapping. For example, if 
you are moving two notes, with the quantize values 1/16 
and 1/4 respectively, the notes will snap to quarter notes 
(1/4).

You can also adjust the position of notes by quantizing 
(see “The Quantizing functions” on page 155).
Again, which quantize value is used depends on whether Global Quan-
tize is used.

Muting notes and drum sounds

You can mute individual notes by clicking or enclosing 
them with the Mute tool or by using the Mute function on 
the Edit menu (see “Muting notes” on page 175).

Furthermore, if a drum map is selected (see “Selecting a 
drum map for a track” on page 187), the drum sound list 
will have a Mute column. Click in the Mute column for a 
drum sound to mute that sound. Finally, clicking the Drum 
Solo button will mute all drum sounds other than the se-
lected one.

Muted drum sounds

Deleting notes

To delete notes, click on them with the Drumstick or 
Eraser tool or select them and press [Backspace].

Other editing methods
As in the Key Editor, you can edit notes on the info line or 
via MIDI, and enter notes using step input, see “Editing on 
the info line” on page 176.

! Please note that the mute state for drum sounds is 
part of the drum map, so any other tracks using the 
same map will also be affected. 



185

The MIDI editors

Working with drum maps

Background
A drum kit in a MIDI instrument is most often a set of dif-
ferent drum sounds with each sound placed on a separate 
key (i.e. the different sounds are assigned to different MIDI 
note numbers). One key plays a bass drum sound, another 
a snare and so on.

Unfortunately, different MIDI instruments often use differ-
ent key assignments. This can be troublesome if you have 
made a drum pattern using one MIDI device, and then 
want to try it on another. When you switch device, it is very 
likely that your snare drum becomes a ride cymbal, or your 
hi-hat becomes a tom, etc. – just because the drum 
sounds are distributed differently in the two instruments.

To solve this problem, and simplify several aspects of MIDI 
drum kits (like using drum sounds from different instru-
ments in the same “drum kit”), Cubase LE features so-
called drum maps. A drum map is a list of drum sounds, 
with a number of settings for each sound. When you play 
back a MIDI track for which you have selected a drum 
map, the MIDI notes are “filtered” through the drum map 
before being sent to the MIDI instrument. Among other 
things, the map determines which MIDI note number is 
sent out for each drum sound, and so which sound is 
played in the receiving MIDI device.

A solution to the problem above would therefore be to set 
up drum maps for all your instruments. When you want to 
try your drum pattern on another instrument, you simply 
switch to the corresponding drum map and your snare 
drum sound will remain a snare drum sound.

Drum map settings
A drum map consists of settings for 128 drum sounds 
(one for each MIDI note number). To get an overview of 
these settings, open the Drum Editor and use the Map 
pop-up menu below the drum sound list to select the “GM 
Map” drum map.

This drum map is set up according to the General MIDI standard. For in-
formation on how to load, create and select other drum maps, see 
“Managing drum maps” on page 187.

Now, take a look at the drum sound list (you may have to 
drag the divider between the list and the note display to 
the right to see all columns). The columns show the set-
tings of the drum map for each sound.

Here’s a brief description (details follow below):

Column Description

Pitch The actual note number of the drum sound. This is what 
links notes on a MIDI track to drum sounds. For example, 
with the above drum map, all MIDI notes with the pitch 
C1 would be mapped to the Bass Drum sound.

Instrument The name of the drum sound.

Quantize This value is used when entering and editing notes as de-
scribed in the sections “Creating and editing notes” on 
page 183 and “Moving, duplicating or repeating notes” 
on page 184.

Mute Allows you to mute a drum sound, excluding it from play-
back. See “Muting notes and drum sounds” on page 184.
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All settings in a drum map (except the Pitch) can be 
changed directly in the drum sound list or in the Drum 
Map Setup dialog (see “The Drum Map Setup dialog” on 
page 187).
Note that the changes you make will affect all tracks that use the drum 
map.

About Pitch, I-note and O-note
This can be a somewhat confusing area, but once you’ve 
grasped how it all works it’s not very complicated. Going 
through the following “theory” will help you make the most 
out of the drum map concept – especially if you want to 
create your own drum maps.

As mentioned earlier, a drum map is a kind of “filter”, 
transforming notes according to the settings in the map. It 
does this transformation twice; once when it receives an 
incoming note (i.e. when you play a note on your MIDI 
controller) and once when a note is sent from the program 
to the MIDI sound device.

In the following example, we have modified the drum map, 
so that the Bass Drum sound has different Pitch, I-note 
and O-note values.

I-notes (input notes)

Let’s look at what happens on input: When you play a note 
on your MIDI instrument, the program will look for this note 
number among the I-notes in the drum map. In our case, if 
you play the note A1, the program will find that this is the I-
note of the Bass Drum sound.

This is where the first transformation happens: the note 
will get a new note number according to the Pitch setting 
for the drum sound. In our case, the note will be trans-
formed to a C1 note, because that is the pitch of the Bass 
Drum sound. If you record the note, it will be recorded as a 
C1 note.

O-notes (output notes)

The next step is the output. This is what happens when 
you play back the recorded note, or when the note you 
play is sent back out to a MIDI instrument in real time 
(MIDI Thru):

The program checks the drum map and finds the drum 
sound with the pitch of the note. In our case, this is a C1 
note and the drum sound is the Bass Drum. Before the 
note is sent to the MIDI output, the second transformation 
takes place: the note number is changed to that of the O-
note for the sound. In our example, the note sent to the 
MIDI instrument will be a B0 note.

Usage

So, what’s the point of all this? Again, the purposes are 
different for I-notes and O-notes:

Changing the I-note settings allows you to choose 
which keys will play which drum sounds, when playing or 
recording from a MIDI instrument.
For example, you may want to place some drum sounds near each other 
on the keyboard so that they can be easily played together, move sounds 
so that the most important sounds can be played from a short keyboard, 
play a sound from a black key instead of a white, and so on.
If you never play your drum parts from a MIDI controller (but draw them in 
the editor) you don’t need to care about the I-note setting.

The O-note settings let you set things up so that the 
“Bass Drum” sound really plays a bass drum.
If you’re using a MIDI instrument in which the bass drum sound is on the 
C2 key, you set the O-note for the Bass Drum sound to C2. When you 
switch to another instrument (in which the bass drum is on C1) you want 
the Bass Drum O-note set to C1. Once you have set up drum maps for 
all your MIDI instruments, you don’t have to care about this anymore – 
you just select another drum map when you want to use another MIDI in-
strument for drum sounds.

I-note This is the “input note” for the drum sound. When this 
MIDI note is sent into Cubase LE, (i.e. played by you), the 
note will be mapped to the corresponding drum sound 
(and automatically transposed according to the Pitch set-
ting for the sound).

O-note This is the “output note”, i.e. the MIDI note number that is 
sent out every time the drum sound is played back. 

Channel The drum sound will be played back on this MIDI channel.

Output The drum sound will be played back on this MIDI output. 
If you set this to “Default”, the MIDI output selected for 
the track will be used.

Column Description
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The channel and output settings
You can set separate MIDI channels and/or MIDI outputs 
for each sound in a drum map. The following rules apply:

• When a drum map is selected for a track, the MIDI 
channel settings in the drum map override the MIDI chan-
nel setting for the track.
In other words, the MIDI channel setting you make in the Track list or In-
spector for the track is normally disregarded. If you want a drum sound to 
use the channel of the track, set it to channel “Any” in the drum map.

• If the MIDI output is set to “default” for a sound in a 
drum map, the sound will use the MIDI output selected for 
the track.
Selecting any other option allows you to direct the sound to a specific 
MIDI output.

By making specific MIDI channel and output settings for 
all sounds in a drum map, you can direct your drum tracks 
directly to another MIDI instrument simply by selecting an-
other drum map – you don’t need to make any channel or 
output changes for the actual track.

To select the same MIDI channel for all sounds in a 
drum map, click the Channel column, press [Ctrl]/[Com-
mand] and select the desired channel.
All drum sounds will be set to this MIDI channel. The same procedure 
can be used for selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or out-
puts for different sounds. This allows you to construct drum 
kits with sounds from several different MIDI devices, etc.

Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-
up menu in the Inspector or in the Drum Editor:

Selecting “No Drum Map” turns off the drum map func-
tionality in the Drum Editor. Even if you don’t use a drum 
map, you can still separate sounds by name using a name 
list (see “Using drum name lists” on page 188).

The Drum Map Setup dialog

To set up and manage your drum maps, select Drum Map 
Setup from the Map pop-up menus or the MIDI menu. This 
opens the following dialog:

The Drum Map setup dialog.

This is where you load, create, modify and save drum 
maps. The list to the left shows the currently loaded drum 
maps; selecting a drum map in the list displays its sounds 
and settings to the right.

The settings for the drum sounds are exactly the same 
as in the Drum Editor (see “Drum map settings” on page 
185).
As in the Drum Editor, you can click the leftmost column to audition a 
drum sound. Note: if you audition a sound in the Drum Map Setup dialog, 
and the sound is set to MIDI output “Default”, the output selected on the 
Output pop-up menu in the lower left corner will be used. When audi-
tioning a Default output sound in the Drum Editor, the MIDI output se-
lected for the track will be used, as described in section “The channel 
and output settings” on page 187.

! Initially, the Map pop-up menu will only contain one 
map: “GM Map”. However, you will find a number of 
drum maps included on the program DVD – how to 
load these is described below.
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Open the Functions pop-up menu in the top left corner to 
open a list of available functionalities:

Drum maps are saved with the project files. If you have 
created or modified a drum map, you should use the Save 
function to store it as a separate XML file, available for 
loading into other projects.
If you always want to have the same drum map(s) included in your 
projects, you may want to load these into the template – see “Save as 
Template” on page 238.

Using drum name lists
Even if no drum map is selected for the edited MIDI track, 
you can still use the Drum Editor if needed. As previously 
mentioned, the drum sound list will then only have four col-
umns: Audition, Pitch, Instrument (drum sound name) and 
Quantize. There will be no I-note and O-note functionality.

In this mode, the names shown in the Instrument column 
depend on the selection on the Names pop-up menu, just 
below the Map pop-up in the Drum Editor.

The options on this pop-up menu are the currently loaded 
drum maps plus a “GM Default” item which is always avail-
able. This means you can use the drum sound names in any 
loaded drum map without using I-notes and O-notes, if you 
want to.

Button Description

New Map Click this to add a new drum map to the project. The 
drum sounds will be named “Sound 1, Sound 2” and so 
on, and have all parameters set to default values. The 
map will be named “Empty Map”, but you can rename it 
by clicking and typing in the list.

New Copy Adds a copy of the currently selected drum map. This is 
probably the quickest way to create a new drum map: se-
lect the map that is similar to what you want, create a 
copy, change the desired drum sound settings and re-
name the map in the list.

Remove Removes the selected drum map from the project.

Load Opens a file dialog, allowing you to load drum maps from 
disk. On the Cubase LE DVD you will find a number of 
drum maps for different MIDI instruments – use this func-
tion to load the desired maps into your project.

Save Opens a file dialog for saving the drum map selected in 
the list. If you have created or modified a drum map, you 
should use this function to save it as a file on disk – this 
allows you to load it into other projects. Drum map files 
have the extension “.drm”.

Init Display 
Notes

Allows you to reset the Display Notes entry to the original 
setting, i.e. the Pitch entry.

Close Closes the dialog.
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The List Editor – Overview

The toolbar
The toolbar contains several items that are the same as in 
the Key Editor (edit solo, snap, quantize settings, etc.). 
These are described earlier in this chapter. The following 
toolbar items are unique to the List Editor:

• The Insert pop-up menu is used when creating new 
events.
This is where you determine what type of event to add (see “Inserting 
events” on page 190).

• The Mask pop-up menu and Filter view (Show Filter 
View button) allow you to hide events from view, based on 
their type and other properties.
See “Filtering” on page 191.

• The Value View button can be used for hiding and 
showing the Value display (see below).

The List Editor has no info line (numerical editing is avail-
able in the list instead).

If you see an empty or incomplete list of items although 
the items are visible in the Key Editor, check if you have ac-
tivated any filters (see “Filtering” on page 191).

The list
This lists all events in the selected MIDI part(s), in the or-
der (from top to bottom) in which they are played back. 
You can edit the event properties by using regular value 
editing, see “Editing in the list” on page 190.

The event display
This shows the events graphically. The vertical position of 
an event in the display corresponds to its entry in the list 
(i.e. to the playback order), while the horizontal position cor-
responds to its actual position in the project. This is where 
you add new parts or events, drag to move them, etc.

The value display
This display shows the “value” of each event, allowing for 
easy viewing and graphical editing. Typically, the value 
shown is the “Data 2” or “Value 2” property (amounts to 
MIDI controller events, velocity for notes, etc.). You can 
show or hide this display by clicking the “Show List Value 
View” button on the toolbar.

Event displayEvent list 

Value 
display

RulerToolbar Filter view
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List Editor operations

Customizing the view
You can click and drag the divider between the list and 
the event display to make one area wider and the other 
narrower. Furthermore, the list can be customized in the 
following ways:

• You can change the order of the columns by dragging 
the column headings.

• You can resize columns by dragging the dividers be-
tween the column headings.

Setting the display format

Just like in the Project window, you set the display format 
(bars+beats, seconds, etc.) by right-clicking in the ruler 
and selecting an option from the pop-up menu. This set-
ting affects both the ruler and all start, end and length val-
ues shown in the list.

Zooming

You can change the horizontal magnification in the event 
display by using the zoom slider below the display or the 
Zoom tool (the magnification glass).

Inserting events
To add a new event to the edited part, proceed as follows:

1. Use the Insert pop-up menu on the toolbar to select 
the event type.

2. Select the Pencil tool and click in the event display at 
the desired position (relative to the ruler).
If you are creating note events, you can click and drag to set the length of 
the note.

The new event appears in the list and in the display. Its 
properties will be set to default values, but can be ad-
justed in the list.

• Notes will get the insert velocity value set in the insert 
velocity field on the toolbar. See “Setting velocity values” 
on page 172.

Editing in the list
The list allows you to perform detailed numerical editing of 
the events’ properties. The columns have the following 
functionality:

• You can edit several events at once. If several events 
are selected and you edit a value for one event, the other 
selected events’ values will be changed as well.
Normally, any initial value differences between the events will be main-
tained – i.e. the values will change by the same amount. If you press [Ctrl]/
[Command] when you edit, however, all events will get the same value.

Column Description

L Locate column. An arrow in this column indicates the 
event that starts closest before the project cursor posi-
tion. If you click in this column for an event, the project 
cursor is moved to the start of that event. Double-clicking 
moves the cursor position and starts/stops playback – 
useful for auditioning when editing in the list.

Type The event type. This cannot be changed.

Start The start position of the event, shown in the format se-
lected for the ruler. Changing this is the same as moving 
the event. Note that moving the event past any other 
event in the list will re-sort the list (the list always shows 
the events in the order they are played back).

End This is only used for note events, allowing you to view and 
edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of 
the note – changing this resizes the note and automati-
cally changes the End value as well.

Data 1 This is the “data 1” or “value 1” property of the event. The 
content of this depends on the event type – for notes, 
this is the pitch, for example. Where applicable, the val-
ues are shown in the most relevant form. For instance, the 
Data 1 value for notes is shown as a note number in the 
format selected in the Preferences (Event Display–MIDI 
page). See also the table in the section “Editing in the va-
lue display” on page 192.

Data 2 This is the “data 2” or “value 2” property of the event. The 
content of this depends on the event type – for notes, 
this is the velocity value, for example. See the table in the 
section “Editing in the value display” on page 192.

Channel The MIDI channel of the event. Note that this setting is 
normally overridden by the channel setting for the track. 
To make a MIDI event play back on “its own” channel, set 
its track to channel “Any” in the Project window.

Comment This column is used for some event types only, providing 
an additional comment about the event.
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For SysEx (system exclusive) events, you can only edit 
the position (Start) in the list.
However, when you click the Comment column, the MIDI SysEx Editor 
opens, in which you can perform detailed editing of system exclusive 
events (see “Working with System Exclusive messages” on page 201).

Editing in the event display
The event display allows you to edit the events graphically 
using the tools on the toolbar. You can edit single events 
as well as several selected events simultaneously.

• To move an event, click and drag it to a new position.
Note that moving the event past any other event in the display will re-sort 
the list (the list always shows the events in the order they are played 
back). As a result, the vertical position of the event in the display will 
change as well.

• To make a copy of an event, press [Alt]/[Option] and 
drag it to a new position.

• To resize a note, select it and drag its end point with the 
Arrow tool as in the Project window.
This only works with notes.

• To mute or unmute an event, click on it with the Mute 
tool.
You can mute or unmute several events in one go by enclosing them in a 
selection rectangle with the Mute tool.

• You can select a color scheme for the events with the 
Colors pop-up menu on the toolbar.
This affects how all MIDI events are shown in the List, Key and Drum 
editors – see “Coloring notes and events” on page 171.

• To delete an event, select it and press [Backspace] or 
[Delete], or click on it with the Eraser tool in the event dis-
play.

Filtering

Clicking the “Show Filter View” button on the toolbar 
opens an additional filter bar that allows you to hide spe-
cific event types from view. For example, it may be hard to 
find note events if the part contains a lot of controllers. By 
hiding these, the list becomes more manageable.

• To hide an event type, activate its checkbox on the filter 
view.

• To see one event type only (hide all other event types), 
press [Ctrl]/[Command] and click its checkbox. If you 
[Ctrl]/[Command]-click again, all checkboxes are cleared 
(all events will be visible).

The event types remain hidden even if you close the fil-
ter view.
To make sure you see all events, open the filter view and check that all 
checkboxes are deactivated.

The filter view does not remove, mute or change the 
events in any way.

Masking

The Mask function is similar to the filter view but allows 
you to hide events based on other criteria as well. Pro-
ceed as follows:

1. Select an event (or several events) of the type you want 
to view.

2. Pull down the Mask pop-up menu on the toolbar and 
select one of the options.
The results are as follows:

Option Description

Event Types Only events with the type of the selected event will be 
shown. This does the same as the filter view but is 
quicker if you only want to view a single event type.

Event Types
and Data 1

Only events of the same type and with the same “Data 1” 
value will be shown. For example, if a note event is se-
lected, only notes with the same pitch will be shown. If a 
controller event is selected, only controllers of the same 
type will be shown.

Event Channels Only events with the same MIDI channel value as the se-
lected event will be shown.
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In addition to the above options, the menu also gives you 
access to the Logical Editor presets.

When you apply any of the Logical Editor presets to cre-
ate masking settings yourself, only the events that meet 
the criteria specified will be visible.

• To deactivate the Mask function, select “Nothing” from 
the Mask pop-up menu.

The most typical usage of the Mask function is to view a 
certain type of controller only (e.g. Modulation, Breath 
Control, etc.). Since these are all the same event types 
(controller), this would not be possible using the filter 
view. With the “Event Types and Data 1” option on the 
Mask pop-up menu, it is!

Editing in the value display
The value display to the right of the event display is a tool 
for quick viewing and editing of multiple values, e.g. veloci-
ties or controller amounts. The values are shown as hori-
zontal bars, with the bar length corresponding to the value.

A velocity ramp in the value display.

You edit the values by clicking and dragging. Note that the 
pointer automatically takes on the shape of the Pencil tool 
when you move it into the value display – you don’t have to 
select the Pencil tool for this.

Exactly which value is shown for an event depends on the 
event type. The following table shows what is displayed 
and edited in the Data columns and the value display:

• The value display can be hidden from view by clicking 
the “Show List Value View” button on the toolbar, so that it 
is not lit.

Event type Data 1 Data 2 Value display

Note Pitch
(note number)

Velocity Velocity

Controller Controller type Controller 
amount

Controller 
amount

Program 
Change

Program 
number

Not used Program 
number

Aftertouch Aftertouch 
amount

Not used Aftertouch 
amount

Pitch Bend Bend amount Not used Bend amount

SysEx Not used Not used Not used
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The Score Editor – Overview

The Score Editor shows the MIDI notes as a musical 
score. The window contains the following sections and 
items:

The toolbar
The Score Editor toolbar is similar to the toolbar in the Key 
Editor, with the following differences:

• The Score Editor toolbar has a button for showing or hiding 
the extended toolbar (see below).

• There are no active part settings – in the Score Editor, parts 
on different tracks are shown on different staves.

• There are no chord recognition functions.

The info line
The info line shows information about selected MIDI 
notes, just like in the Key and Drum Editors. You can edit 
all values on the info line using regular value editing (see 
“Editing on the info line” on page 176 for details).

• To hide or show the info line, click the “Show Info” but-
ton in the toolbar.

The extended toolbar

The extended toolbar (shown or hidden by clicking the 
“Show Tool Strip” button on the main toolbar) contains 
the following items:

Note value buttons

Click one of these to select a note value for input. The “T” 
and “.” options are for triplet and dotted note values. You 
can also press [Ctrl]/[Command] and click one of the note 
value buttons – this will resize all selected notes to the 
note value you choose.

Enharmonic shift

Allows you to manually select whether a note should be 
shown with flat or sharp accidentals. See “Enharmonic 
Shift” on page 199.

The score display

The main area of the Score Editor window shows the 
notes in the edited parts on one or several staves. 

• If you are editing one or several parts on the same track, 
as much of them as possible is shown on several staves – 
one above the other – just as with a score on paper.

Extended 
toolbar

Info line

Toolbar
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• If you are editing parts on several tracks, they are put on 
a grand staff (multiple staves, tied together by bar lines).

• The number of measures across the screen depends on 
the size of the window and the number of notes in each 
measure.
The maximum number of bars across the page is four.

• The end of the last part is indicated by a double bar line.

• Unlike the other MIDI editors, the Score Editor does not 
have a ruler.
A conventional ruler would not make sense, since there is no exact rela-
tionship between a note’s horizontal position in the score and its musical 
position in the Project.

Score Editor operations 

Opening the Score Editor
To open one or several parts in the Score editor you pro-
ceed as with the other editors: select one or several tracks 
or any number of parts (on the same or different tracks), 
and select “Open Score Editor” from the Scores submenu 
on the MIDI menu. The default key command for this is 
[Ctrl]/[Command]+[R].

• You can also select the Score editor as your default ed-
itor, allowing you to open it by double-clicking parts.
This is done with the Default Edit Action pop-up menu in the Preferences 
dialog (Event Display–MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open 
the Score editor, you will get one staff for each track (al-
though you can split a staff in two, e.g. when scoring for 
piano). The staves are tied together by bar lines and 
placed in the order of the tracks in the Project window.

• If you need to rearrange the staves: close the editor, go 
back into the Project window, drag the tracks to the order 
you want them, and open the Score Editor again.

The Active Staff

Just as in the other editors, all MIDI input (as when record-
ing from your instrument) is directed to one of the tracks, 
here called the Active staff. The Active staff is indicated by 
a rectangle in the left part of the first visible bar.

To change the active staff, click in the staff you want to ac-
tivate.

Getting the score displayed correctly
When you open the Score Editor for a part recorded in 
real time, the score may not look as legible as you expect. 
The Score Editor can ignore the minor time variances in 
performance and make a neater score almost instantly. To 
achieve this, there are a number of Staff Settings that de-
termine how the program displays the music.

Note that the time signature follows the time signa-
ture(s) on the Tempo track and are common to all tracks/
staves in the score.

There are two ways to open the Staff Settings dialog:

• Double-click in the area to the left of the staff.

• Activate a staff by clicking in it, and select “Staff Set-
tings…” from the Scores submenu on the MIDI menu.
The Staff Settings dialog appears.

! The settings you make in this dialog are independent 
for each staff (track), but common for a piano staff 
which you have created by choosing the “Split” Staff 
Mode option (see below).

The Active staff
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Staff Mode

This pop-up determines how the staff should be shown: 

• When set to “Single”, all notes in the part are shown in 
the same staff.

• When set to “Split”, the part is split on the screen into a 
bass and treble clef, as in a piano score. 
You use the Split-Point value field to set the note where you want the 
split to occur. Notes above and including the split note will appear on the 
upper staff, and notes below the split note will appear on the lower staff.

Before and after setting a split at C3.

Display Quantize

Notes are not an absolute language, and you must give 
the program a few hints on how the score should be dis-
played. This is done using the Display Quantize section of 
the Staff Settings dialog.

Here is a description of the functions:

Key and Clef

The correct Key and Clef are set using the two scroll bars 
in the Key & Clef section.

If you activate the “Auto Clef” checkbox, the program attempts to guess 
the correct clef, judging from the pitch of the music.

! These are only display values used for the graphics 
in the Score Editor. They do not affect the actual 
playback in any way.

Parameter Description

Notes Determines the smallest note value to be displayed and 
the “smallest position” to be recognized and properly dis-
played. Set this to the smallest significant note position 
used in your music. 
For example, if you have notes on odd sixteenth note po-
sitions, you should set this value to 16.
The “T” values are for triplet note values.
This setting is partly overridden by Auto Quantize (see 
below).

Rests This value is used as a “recommendation” – the program 
will not display rests smaller than this value, except where 
necessary. In effect, this setting also determines how the 
length of notes should be displayed. Set this value ac-
cording to the smallest note value (length) you want to be 
displayed for a single note, positioned on a beat.

Auto Quantize Generally, if your music contains mixed triplets and 
straight notes, try activating this checkbox. Otherwise, 
make sure it is deactivated.
Auto Quantize uses involved methods to make your score 
look as legible as possible. Auto Quantize allows you to 
mix straight notes with tuplets (triplets) in a part. But, 
Auto Quantize also uses the (display) Quantize value. If it 
can't find an appropriate note value for a certain note or 
group of notes, it will use the set Quantize value to dis-
play it.
If the part is imprecisely played and/or complex, Auto 
Quantize may have a problem “figuring out” exactly what 
you “mean”.

Dev This option is only available if Auto Quantize is on. When 
Dev (Deviation) is activated, triplets/straight notes will be 
detected even if they are not exactly “on the beat”. How-
ever, if you know your triplets/straight notes are perfectly 
recorded (quantized or entered by hand), turn this off.

Adapt This option is only available if Auto Quantize is on. When 
Adapt is activated, the program “guesses” that when one 
triplet is found, there are probably more triplets surround-
ing it. Turn this on if not all of your triplets are detected.
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• To set the clef and key for the lower staff, activate the 
“Lower Staff” checkbox in the Key/Clef section.

Display Transpose

Some instruments, for example a lot of brass instruments, 
are scored transposed. For this purpose, the Staff Set-
tings dialog allows you to specify a separate Display 
Transpose setting for each staff (track). This transposes 
the notes in the score (i.e. how they are displayed) without 
affecting how the notes play back. This allows you to 
record and play back a multi staff arrangement, and still 
score each instrument according to its own transposition.

• Use the pop-up menu to select the instrument for which 
you are scoring.
You can also manually set a display transpose value with the Semitones 
box above.

Interpret. Flags

These provide additional options for how the score should 
be displayed:

Applying your settings

After you’ve made your settings, click Apply to apply them 
to the active staff. You can select another staff in the 
score and make settings for that, without having to close 
the Staff Settings dialog first – just remember to click Ap-
ply before you change staff, otherwise your changes will 
be lost.

Entering notes with the mouse
To enter notes into a part in the Score Editor, you use the 
Note tool. However, first you need to set the note value 
(length) and spacing:

Selecting a note value for input

This can be done in two ways:

• By clicking the note symbols on the extended toolbar.
You can select any note value from 1/1 to 1/64th and turn on and off the 
dotted and triplet options by clicking the two buttons to the right. The se-
lected note value is displayed in the Length value field on the toolbar and 
in the Note tool cursor shape.

• By selecting an option from the Length Q pop-up on the 
toolbar.

Selecting a Quantize Value

When you move the mouse pointer over the score, you will 
see that the position box on the toolbar tracks your move-
ment and shows the current position in bars, beats, six-
teenth notes and ticks.

Parameter Description

Clean Lengths When this is activated, notes that are considered to be 
chords will be shown with identical lengths. This is done 
by showing the longer notes as shorter than they are. 
When Clean Lengths is turned on, notes with very short 
overlaps are also cut off; a bit as with No Overlap (see 
below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as 
overlapping another, lengthwise. This allows long and 
short notes starting at the same point to be displayed 
without ties; the long notes are cut off in the display. This 
will make the music more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.

Syncopation When this function is activated, syncopated notes are 
shown in a more legible way.

This is a dotted quarter at the end of a bar when Syn-
copation is Off...

...and when it is On.

Shuffle Activate this function when you have played a shuffle 
beat and want it displayed as straight notes (not triplets). 
This is very common in jazz notation.

Parameter Description
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Positioning on screen is controlled by the current Quan-
tize value. If you for example set this to “1/8 Note” you can 
only insert and move notes to eighth note positions, at 
quarter notes, at half bars or at bar positions. It is a good 
strategy to set the Quantize value to the smallest note 
value in the piece. This doesn’t stop you from inputting 
notes at “coarser” positions. However, if you set the 
Quantize value to too small a note value, it is easier to 
make mistakes.

The Quantize value is set with the Quantize pop-up on the 
toolbar.

• You can also assign key commands to the different 
Quantize values.
This is done in the Key Commands dialog on the File menu, under the 
heading “MIDI Quantize”.

• Just like in the other MIDI editors, you can use the 
Quantize Setup dialog to create other quantize values, ir-
regular grids, etc.
However, this is not often used when entering score notes.

Entering a note

To add a note to the score, proceed as follows:

1. Make the staff active.
Notes are always put in on the active staff.

2. Select the type of note by selecting a note value.
This is described in detail above.

3. If you selected the note value by clicking on a symbol 
on the extended toolbar, the Note tool was automatically 
selected – otherwise select the Note tool from the toolbar 
or Quick menu.

4. Select a Quantize value.
As described above, the Quantize value will determine the spacing be-
tween notes. If you have Quantize set to “1/1 Note” you will only be able 
to add notes at downbeats. If you set Quantize to “1/8 Note” you will be 
able to add notes at all eighth note positions etc.

5. Click in the staff and keep the mouse button pressed.
A note appears under the mouse pointer.

6. Move the mouse horizontally to find the correct posi-
tion.
Check the lower mouse position box on the toolbar – the position is 
“magnetically” attracted to the grid defined by the current Quantize 
value. This allows you to easily find the correct position.

7. Move the mouse vertically to find the correct pitch.
The upper mouse position box shows the pitch at the pointer position, 
making it easy to find the right pitch.

8. Release the mouse button.
The note appears in the score.

The notes you enter will get the insert velocity value set in 
the insert velocity field on the toolbar. See “Setting velo-
city values” on page 172.

Selecting notes
There are several ways to select notes in the Score Editor:

By clicking

To select a note, click on its note head with the Arrow tool. 
The note head gets red to indicate that it is selected.

• To select more notes, hold down [Shift] and click on 
them.

• To deselect notes, hold [Shift] down and click on them 
again.

• If you hold down [Shift] and double-click on a note, this 
note and all the following notes in the same staff are se-
lected.

Using a selection rectangle

1. Press the mouse button with the Arrow tool in some 
free (white) space in the score.

2. Drag the mouse pointer.
A rectangle appears. You can drag to select voices on several voices or 
staves if you wish.

3. Release the mouse button.
All notes with their note heads inside the rectangle get selected.

If you want to deselect one or more of the notes, hold 
down [Shift] and click as described above.

Using the keyboard

By default, you can step through the notes in the staff us-
ing the left and right arrow keys. If you press [Shift], you 
will select the notes as you step through them.

With the quantize value set to “1/8 Note”, you can only 
input notes at eighth note positions.



198

The MIDI editors

• If you want to use other keys for selecting notes, you 
can customize the settings in the Key Commands dialog 
on the File menu (in the Navigate category).

Deselecting everything

To deselect everything, simply click with the Arrow tool in 
some “free” (white) space in the score.

Deleting notes
Notes can be deleted in two ways:

Using the Eraser tool

1. Select the Eraser tool from the toolbar or Quick menu.

2. Click on the Note(s) you want to erase, one at a time 
or drag over them with the mouse button pressed.

Using the keyboard or delete menu item

1. Select the notes you want to delete.

2. Select Delete from the Edit menu, or press [Delete] or 
[Backspace] on the computer keyboard.

Moving notes
To move or transpose notes, proceed as follows:

1. Set the Quantize value.
The Quantize value will restrict your movement in time. You can not place 
the notes on positions smaller than the Quantize value. If Quantize for ex-
ample is set to “1/8 Note”, you will not be able to move the notes to a six-
teenth note position. However, you will be able to put them on any eighth 
note, quarter note, half note or whole note position.

2. If you want to hear the pitch of the note while moving, 
activate the speaker icon on the toolbar. 
When it is on, you will hear the current pitch of the “dragged” note.

3. Select the note(s) you plan to move.

4. Click one of the selected notes and drag it to a new 
position and/or pitch.
The horizontal movement of the note is “magnetically attracted” to the 
current Quantize value. The position boxes on the toolbar show what the 
new position and pitch for the dragged note will be.

5. Release the mouse.
The notes appear at their new position.

• If you press [Ctrl]/[Command] and drag, movement is 
restricted to vertical or horizontal only (depending on in 
which direction you drag).

• You can also move selected notes by using key com-
mands, as assigned in the Nudge category in the Key 
Commands dialog.
When moving notes to the left or right using key commands, the notes 
will be moved in steps according to the current Quantize value. The keys 
assigned for up/down nudging will transpose notes in semitones steps.

Duplicating notes
1. Set the Quantize value and select the notes, as for 
moving.

2. Press [Alt]/[Option] and drag the notes to their new 
position.

• If you want to restrict movements to one direction only, 
press [Ctrl]/[Command].
This works just as for moving, as described above.

• [Alt]/[Option] is the default modifier key for copying/du-
plicating. If you like, you can change this in the Prefer-
ences dialog (Editing–Tool Modifiers page).
The entry for this is found in the Drag & Drop category (“Copy”).

Changing the length of notes
As described earlier (see “Getting the score displayed 
correctly” on page 194), the displayed length of a note 
isn’t necessarily the actual note length, but also depends 
on the Note and Rest Display Quantize settings in the 
Staff Settings dialog. This is important to remember when 
you change the length of a note, since it can give rise to 
confusing results.

There are several ways to change the length of a note in 
the Score Editor:

By using the Note tool

1. Select a Note value that you wish to apply to the Note.
This can be done by clicking a note value icon in the extended toolbar or 
by selecting a new Length value.

2. Select the Note tool if it isn’t already selected.

3. Hold down [Alt]/[Option] and click on the notes you 
wish to set to this length.
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By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a 
number of notes to the same length:

1. Select the notes you want to change.

2. Hold down [Ctrl]/[Command] and click on one of the 
note icons on the extended toolbar.
All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info 
line, just like in the Key and Drum Editors (see “Editing on 
the info line” on page 176).

Splitting and Gluing notes
• If you have two notes strung together by a tie, and click 
on the “tied” note head with the Scissors tool, the note will 
be divided into two, with the respective length of the 
“main” and the tied note.

• Conversely, if you click on a note with the Glue Tube 
tool it will be joined to the next note with the same pitch.

Enharmonic Shift
The buttons to the right on the extended toolbar allow you 
to shift the display of selected notes so that for example 
an F# (F sharp) is instead shown as a Gb (G flat) and vice 
versa:

1. Select the note(s) you want to affect.

2. Click on one of the buttons to display the selected 
note(s) a certain way.

The “off” button resets the notes to original display. The other five op-
tions are double flats, flats, No (no accidentals shown, regardless of 
pitch), sharps and double sharps.

Flip Stems
Normally the direction of the note stems is automatically 
selected according to the note pitches, but you can 
change this manually if you like:

1. Select the notes for which you want to change (flip) the 
stem direction.

2. Pull down the MIDI menu and select Flip Stems from 
the Scores submenu.

Working with text
You can use the Text tool to add comments, articulation or 
instrumentation advice and other text strings anywhere in 
the score:

Adding a text string

1. Select the Text tool from the toolbar or Quick menu.

2. Click anywhere in the score.
A text input line dialog box appears.

3. Enter the text and press [Return].

Editing text

To edit an already added text string, double-click it with 
the Arrow tool. This opens the text for editing, and you can 
use the arrow keys to move the cursor, delete characters 
with the [Delete] or [Backspace] keys and type new text as 
usual. Finish by pressing [Return].

• To delete a text block, select it with the Arrow tool and 
press [Backspace] or [Delete].

• You can move or duplicate text blocks by dragging (or 
[Alt]/[Option]-dragging) them, just as with notes.

Changing the text font, size and style

To change the font settings for the text you have added, 
proceed as follows:

1. Select the text block by clicking it with the Arrow tool.

2. Pull down the MIDI menu and select “Set Font” from 
the Scores submenu.
A Font Settings dialog appears, containing the following settings:

Item Description

Font This is where you specify the font for the text. Which 
fonts are available on the pop-up menu depends on 
which fonts you have installed on you computer. You 
probably don’t want to use the “Steinberg” fonts – these 
are special fonts used by the program (e.g. for score 
symbols) and not suited for common text.

Size Sets the size of the text.

Frame Allows you to encase the text in a rectangular (box) or 
oval frame.

Text style op-
tions

These checkboxes determine whether the text should be 
bold, italic, and/or underlined.
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3. When you’ve made your settings, click Apply.
If you like, you can leave the Font Settings dialog open, select another 
text block and adjust the settings for that – just remember to click Apply 
before you select a new text block.

• If you make settings in the Font Settings dialog with no 
text block selected, the settings will be used as default for 
all new text.
In other words, all text you enter from then on will get the settings you 
have specified (although you can of course change this manually for 
each text block as usual).

Printing
To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor.
Printing is only available from within the Score Editor.

2. Select Page Setup from the File menu and make sure 
all your printer settings are correct. Close the dialog.

3. Select Print from the File menu.

4. The standard Print dialog appears. Fill out the options 
as desired.

5. Click Print.

! If you change your setting for paper size, scale and 
margins now, the score may change its look. 
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Introduction
SysEx (System Exclusive) messages are model-specific 
messages for setting various parameters of a MIDI device. 
This makes it possible to address device parameters that 
would not be available via normal MIDI syntax.

Every major MIDI manufacturer has its own SysEx identity 
code. SysEx messages are typically used for transmitting 
patch data, i.e. the numbers that make up the settings of 
one or more sounds in a MIDI instrument.

Cubase LE allows you to record and manipulate SysEx 
data in various ways. This chapter points to various fea-
tures that help you manage and create SysEx data.

Bulk dumps

Recording a bulk dump in Cubase LE
In any programmable device, the settings are stored as 
numbers in computer memory. Change those numbers, 
and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or 
some settings in the device's memory in the form of MIDI 
SysEx messages. A dump is therefore (among other 
things) a way of making backup copies of the settings of 
your instrument: sending such a dump back to the MIDI 
device will restore the settings. 

If your instrument allows the dumping of a few or all of its 
settings via MIDI by activating some function on the front 
panel, this dump will probably be recordable in Cubase LE.

1. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Cubase LE menu) and se-
lect the MIDI–MIDI Filter page.
This allows you to govern which MIDI event types should be recorded 
and/or thru-put.

2. Make sure that recording of Sysex data is not filtered, 
by unchecking the the Sysex checkbox in the Record sec-
tion. The Sysex checkbox in the Thru section can be left as 
it is (by default activated).

This way, SysEx messages will be recorded but not echoed back out to 
the instrument (which may lead to unpredictable results).

3. Activate recording on a MIDI track and initiate the 
dump from the front panel of the instrument.

4. When done recording, select the new part and open 
the List Editor from the MIDI menu.
This allows you to check that the SysEx dump was recorded – there 
should be one or several SysEx events in the part/event list.

! If your MIDI instrument doesn’t offer a way to initiate a 
dump “by itself”, you have to send a Dump Request 
message from Cubase LE to start the dump. In that 
case, use the MIDI SysEx Editor (see “Editing System 
Exclusive messages” on page 203) to insert the spe-
cific Dump Request message (see the instrument’s 
documentation) at the beginning of a MIDI track. 
When you activate recording, the Dump Request 
message will be played back (sent to the instrument), 
the dump will start and be recorded as above.
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Transmitting a bulk dump back to a device
1. Make sure the MIDI track with the System Exclusive 
data is routed to the device.
You may want to check your device’s documentation to find details about 
which MIDI channel should be used, etc.

2. Solo the track.
This might not be necessary, but it is a good safety measure.

3. Make sure the device is set up to receive SysEx mes-
sages (often, receiving SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive 
System Exclusive” mode.

5. Play back the data.

Some advice
• Don't transmit more data than you need. If all you want is a sin-

gle program, don't send them all, it will only make it harder to 
find the one you want. Usually, you can specify exactly what 
you want to send.

• If you want the sequencer to dump the pertinent sounds to 
your instrument each time you load a project, put the SysEx 
data in a silent “count-in” before the project itself starts.

• If the dump is very short (for instance, a single sound) you can 
put it in the middle of the project to re-program a device on 
the fly. However, you can achieve the same effect by using 
Program Change. This is definitely preferable, since less MIDI 
data is sent and recorded. Some devices may be set up to 
dump the settings for a sound as soon as you select it on the 
front panel.

• If you create parts with useful “SysEx dumps”, you can put 
these on a special muted track. When you want to use one of 
them, drag it to an empty unmuted track and play it back from 
there.

• Do not transmit several SysEx dumps to several instruments at 
the same time.

• Make a note of the current device ID setting of the instrument. 
If you change this, the instrument may refuse to load the dump 
later.

Recording System Exclusive 
parameter changes
Often you can use SysEx to remotely change individual 
settings in a device, e.g. open a filter, select a waveform, 
change the decay of the reverb etc. Many devices are also 
capable of transmitting changes made on the front panel 
as SysEx messages. These can be recorded in Cubase 
LE, and thus incorporated into a regular MIDI recording.

Here's how it works: let's say you open up a filter while play-
ing some notes. In that case, you will record both the notes 
and the SysEx messages generated when you opened of 
the filter. When you play it back, the sound changes exactly 
like it did when you recorded it.

1. Open the Preferences dialog from the File menu, se-
lect the MIDI–MIDI Filter page and make sure that SysEx is 
recorded, i.e. the Sysex checkbox in the Record section is 
deactivated.

2. Make sure the instrument is actually set to transmit 
changes of front panel controls as SysEx messages.

3. Record normally.
When you’re done, you can check that the events were recorded pro-
perly in the List Editor.

Editing System Exclusive messages
While SysEx events are shown in the List Editor, their en-
tire content is not (only the beginning of the message is 
displayed in the Comment column for the event). Also, you 
cannot edit the event (other than moving it) as you can 
with other event types in the List Editor.

Instead, you have to use the MIDI SysEx Editor for this.
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• To open the MIDI SysEx Editor for an event, click in the 
Comments column for the event in the List Editor.

The display shows the entire message on one or several 
lines. SysEx messages always begin with F0 and end with 
F7 with a number of arbitrary bytes in between. If the mes-
sage contains more bytes than fit on one line, it continues 
on the next. The Address indication to the left helps you 
find out on which position in the message a certain value 
resides.

You can edit all values except for the first (F0) and last one 
(F7).

Selecting and viewing values

To select a value, either click on it or use the cursor keys. 
The selected byte is displayed in various formats:

• In the main display, values are shown in hexadecimal format.
• To the right of this, values are shown in ASCII format.
• At the bottom of the dialog, the selected value is shown in 

binary and decimal formats.

Editing a value

The selected value can be edited directly in the main dis-
play or in the decimal and binary displays. Just click on it 
and type in the desired value as usual.

Adding and deleting bytes

Using the Insert and Delete buttons or their corresponding 
computer keyboard keys, you can add and delete bytes 
from the message. Inserted data will appear before the se-
lection.

To delete the complete SysEx message, select it in the 
List Editor and press [Delete] or [Backspace].

Importing and exporting data

The Import and Export buttons allow you to get SysEx data 
from disk and to export the edited data to a file. The file 
has to be in “MIDI SysEx” (.SYX) binary format. Only the 
first dump in a .SYX file will be loaded.

This format should not be confused with MIDI files, which 
have the extension .MID.
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Background
The tempo can either be fixed through the whole project 
(this is called “Fixed tempo mode”) or follow the Tempo 
track (this is called “Tempo track mode”), which may con-
tain tempo changes.

• To switch between Fixed tempo mode and Tempo track 
mode, use the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is shown), the tempo 
follows the Tempo track; when it is deactivated (and the text “Fixed” is 
shown), the Fixed tempo is used (see “Setting the Fixed tempo” on 
page 209). You can also switch tempo mode in the Tempo Track Editor 
(see below).

In Tempo track mode, the tempo cannot be changed on 
the Transport panel, i.e. the tempo information here is for 
display purposes only.

The Tempo track also contains time signature events. 
These are always active, regardless of whether Fixed 
tempo mode or Tempo track mode is selected.

A note about audio tracks in a tempo-based project

The start time position of audio events depends on the 
current tempo setting. However, it is important to realize 
that the actual audio (“within” the events) will play back as 
recorded, regardless of any tempo changes you make. 
Therefore, it’s good practice to make the proper tempo 
and time signature settings before you start recording 
tempo-based audio.

To make an already recorded audio track follow the 
tempo changes, you can use the Hitpoints and Slicing fea-
tures, see “Working with hitpoints and slices” on page 122.
How well this works depends on the character of the audio recordings, 
since the Hitpoint detection feature works best with fairly rhythmical ma-
terial.

The Tempo Track Editor – Overview
To make changes to the actual Tempo track, you need to 
open the Tempo Track Editor by selecting “Tempo Track” 
on the Project menu.

The toolbar
The toolbar contains various tools and settings. The tempo 
and time signature displays to the right allow you to view 
and edit the value of the selected tempo curve point or time 
signature event, much like the info line in other editors.

Tools

Tempo track on/off Autoscroll

Snap on/off Snap pop-up

Curve type selector

Curve type for new tempo events

Time signature

The selected tempo
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The ruler
The ruler in the Tempo Track Editor shows the timeline. As 
in other windows, you can select a display format by click-
ing on the arrow button to the right of the ruler and select-
ing an option from the pop-up menu that appears.

The two additional items at the bottom of the menu have 
the following functionality:

• If “Time Linear” is selected, the ruler, time signature area 
and tempo curve display will be linear in relation to the 
timeline.
This means that if the ruler shows bars and beats, the distance between 
the bar lines will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, time signa-
ture area and tempo curve display will be linear in relation 
to beats.
If the ruler shows bars and beats, the distance between beats will be 
constant.

The time signature area
The area below the ruler contains time signature events. 

The tempo curve display

The main display shows the tempo curve (or, if Fixed tempo 
mode is selected, the Fixed tempo – see “Setting the Fixed 
tempo” on page 209). To the left of the display is a tempo 
scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the dis-
play format selected for the ruler.

Operations

Zooming
Changing the magnification is done using any of the fol-
lowing methods:

• By using the zoom sliders in the lower right corner of the 
window.

• By using the Magnifying Glass tool.
This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
The options on the menu work as in other windows.
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Editing the tempo curve

Adding tempo curve points

1. Use the “insert curve” pop-up menu in the toolbar to 
select whether you want the tempo to change gradually 
from the previous curve point to the new one (“Ramp”) or 
change instantly to the new value (“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve 
display, and keep the mouse button pressed.
If Snap is activated on the toolbar, this determines at which time posi-
tions you can insert tempo curve points, see “Snap” on page 210.

When you click, the tempo display in the toolbar shows the tempo 
value.

4. Drag the curve point to the desired tempo value (indi-
cated in the tempo display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you 
selected “Ramp” or “Jump” in step 1 above.

• You can also just click and draw a tempo curve with the 
Pencil tool, so that curve points are inserted while you draw.
For this, the “Ramp” Insert Curve mode is useful.

• Instead of using the Pencil tool, you can press [Alt]/[Op-
tion] and use the Arrow tool. 
This will only insert a single point (i.e. you cannot draw a curve with the 
Arrow tool).

Selecting tempo curve points

Selecting curve points is done using any of the following 
methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

• You can also use the left and right arrow keys on the 
computer keyboard to go from one curve point to the next.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several points.

Editing tempo curve points

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically.
If several points are selected, all of them are moved. If Snap is activated 
on the toolbar, this determines to which time positions you can move 
curve points, see “Snap” on page 210.

! This section assumes that you are working in Tempo 
track mode, i.e. the Tempo button must be activated 
on the Transport panel.

Insert curve set to “Ramp”

Insert curve set to “Jump”

Option Description

All Selects all curve points on the Tempo track.

None Deselects all curve points.

In Loop Selects all curve points between the left and right locator.

From Start
to Cursor

Selects all points to the left of the project cursor.

From Cursor
to End

Selects all points to the right of the project cursor.
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• By adjusting the tempo value in the tempo display on 
the toolbar.
For this to work, a single tempo curve point must be selected.

Adjusting the curve type

You can change the curve type of a tempo curve segment 
at any time, using the following method:

1. Select all curve points within the segment you want to 
edit.

2. Pull down the Curve pop-up menu on the toolbar and 
select “Jump” or “Ramp”.
The curve sections between the selected points are adjusted.

Removing tempo curve points

To remove a curve point, either click on it with the Eraser 
tool or select it and press [Backspace]. The first tempo 
curve point cannot be removed.

Setting the Fixed tempo
When the Tempo track button is deactivated, the Tempo 
track curve is greyed out (but still visible). Since the Fixed 
tempo is constant throughout the whole project, there are 
no tempo curve points. Instead, the Fixed tempo is dis-
played as a horizontal black line in the tempo curve display.

There are three ways to set the tempo in Fixed mode:

• Drag the tempo line up or down with the Arrow tool.

• Adjust the value numerically in the tempo display on the 
toolbar.

• On the Transport panel, in Fixed tempo mode, click on 
the Tempo value to select it, enter a new value and press 
the [Enter] key.

Adding and editing time signature events
• To add a time signature event, click in the time signature 
area with the Pencil tool. 
This adds a default 4/4 time signature event at the closest bar position. 
You can also do this by pressing [Alt]/[Option] and clicking with the Ar-
row tool.

• To edit the value of a time signature event, select it and 
adjust the value in the signature display on the toolbar.
Note that there are two thumbwheel controls for the signature display; 
the left one adjusts the numerator and the right one adjusts the denomi-
nator.

! Dragging tempo curve points with a time-based dis-
play format (any other format than “Bars+Beats”) may 
lead to confusing results. This is because moving a 
point will change the relationship between tempo and 
time. For example, let’s say you move a tempo point to 
the right and drop it on a certain time position. When 
you release the mouse button, the mapping between 
tempo and time will be adjusted (since you have 
changed the tempo curve). As a result, the moved 
point will appear at another position. For this reason, 
we recommend that you use the Bars+Beats display 
format when editing tempo curves.
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• You can move a time signature event by clicking and 
dragging it with the Arrow tool.
Again, note that time signature events can only be positioned at the start 
of bars.

• To remove a time signature, either click on it with the 
Eraser tool or select it and press [Backspace].
The first time signature event cannot be removed.

Options and settings

Snap
You activate or deactivate Snap by clicking the Snap icon 
on the toolbar. The behavior of the function depends on 
the display format selected for the ruler:

• If “Bars+Beats” is selected, tempo curve points will 
snap to the set resolution on the Snap pop-up.
If this is set to 1/1, curve points will snap to the start of bars.

• If any other display format is selected, tempo curve 
points will snap to the vertical grid lines in the tempo curve 
display.
The spacing of the grid lines depends on the horizontal magnification.

• Time signature events can only be positioned at the start 
of bars, regardless of whether Snap is activated or not.

Autoscroll
When this option is activated, the tempo curve display will 
scroll during playback, keeping the project cursor visible.
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Introduction
The Export Audio Mixdown function in Cubase LE allows 
you to mix down audio from the program to a file on your 
hard disk, in a number of formats. 

You always mix down an output bus. For example, if you 
have set up a stereo mix with tracks routed to a stereo 
output bus, mixing down that output bus would give you a 
mixdown file containing the whole mix.

Notes

• The Export Audio Mixdown function mixes down the 
area between the left and right locator.

• When you mix down, you get what you hear – mutes, 
mixer settings and insert effects are taken into account.
Note though that you will only include the sound of the bus you select for 
mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first 
need to record all your MIDI music to audio tracks (by connecting the 
outputs of your MIDI instruments to your audio inputs and recording, as 
with any other sound source).

• A single instrument track can be directly exported as 
Audio Mixdown.

Mixing down to an audio file
1. Set up the left and right locator to encompass the area 
that you want to mix down.

2. Set up your tracks so that they play back the way you 
want.
This includes muting unwanted tracks or parts, making manual mixer set-
tings and/or activating the R (Read) automation buttons for some or all 
mixer channels.

3. Pull down the File menu and select “Audio Mixdown…” 
from the Export submenu.
The Export Audio Mixdown dialog appears.

The available settings and options differ depending on the 
selected file format (see “The available file formats” on 
page 213).

4. Enter a name for the mixdown file in the File name field 
and specify a path where you want the mixdown to be 
saved. Alternatively, you can activate the option “Use 
Project Audio Folder”.
This saves the mixdown file in the Project Audio folder.

5. Select the bus you want to mix down with the Outputs 
pop-up menu.
This lists all output busses in the active project.

6. Activate the Split Channels option, if you want to ex-
port all channels as mono files.

7. Select a file format with the File Format pop-up menu.

8. Make additional settings for the file to be created.
This includes selecting sample rate, bit depth, etc. The available options 
depend on the selected file format – see “The available file formats” on 
page 213.

9. If you want to automatically import the resulting audio 
file back into Cubase LE, activate the checkboxes in the 
“Import into project” section.
If you activate the “Pool” checkbox, a clip referring to the file will appear 
in the Pool. Activating the “Audio Track” checkbox as well will create an 
audio event that plays the clip, and place it on a new audio track, starting 
at the left locator.



213

Export Audio Mixdown

The Import options are only available if you have se-
lected an uncompressed file format.

10. If you activate Update Display, the meters will be up-
dated during the export process.
This allows you to check for clipping, for example.

11. Click Export.

A dialog with a progress bar is displayed while the audio file 
is created. If you change your mind during the file creation, 
you can click the Abort button to abort the operation.

• If the option “Close dialog after export” is activated, the 
dialog will be closed, otherwise it will be left open.

• If you have activated any of the “Import to” options, the 
file will be imported back into the project.
When playing back the re-imported file in Cubase LE, remember to mute 
the original tracks so that you really hear the correct file.

About the Import options dialog

When you activate any of the options in the Import sec-
tion, the Import Options dialog will open. For a detailed 
description of the options in this dialog see “Import Me-
dium...” on page 137. 

The available file formats
The following pages describe the different export file for-
mats, and their options and settings.

• AIFF files (see “AIFF files” on page 213).
• AIFC files (see “AIFC files” on page 214).
• Wave files (see “Wave files” on page 214).
• Windows Media Audio files (Windows only, see “Windows 

Media Audio files (Windows only)” on page 214).

MP3 export is available upon upgrade of Cubase LE. 
Please contact your vendor for details.

AIFF files
AIFF stands for Audio Interchange File Format, a standard 
defined by Apple Computer Inc. AIFF files have the exten-
sion “.aif” and are used on most computer platforms.

For AIFF files the following options are available:

Option Description

File name
(File Location 
section)

In this field you can enter a name for the mixdown file.

Path
(File Location 
section)

Here you can specify a path where you want the mix-
down to be saved. 

Use Project 
Audio Folder
(File Location 
section)

If you activate this option the mixdown file is saved in 
the Project Audio folder, as opposed to the specified 
path.

File Format pop-
up menu (File 
Format section)

From this pop-up menu you can select the file format 
for the export.

Insert Broadcast 
Wave Chunk 
(File Format
section)

This allows you to include information about the date 
and time of creation, a timecode position (allowing you 
to insert exported audio at the correct position in other 
projects, etc.) along with author, description and refer-
ence text strings in the exported file. 
Some applications may not be able to handle files with 
embedded info – if you get problems using the file in 
another application, turn off the option and re-export.

Edit button (File 
Format section)

By clicking this button the “Broadcast Wave Chunk” 
dialog opens where you can enter additional informa-
tion that will be embedded in the exported files.

Outputs pop-up 
menu (Audio 
Engine Output 
section)

This menu lists all output busses in the active project. 
Simply select the bus you want to mix down.

Mono Export 
(Audio Engine 
Output section)

If you activate this option, the exported audio is mixed 
down to mono.

Split Channels 
(Audio Engine 
Output section)

Activate this option, if you want to export all channels 
as mono files.

Update Display
(Audio Engine 
Output section)

If you activate this option, the meters will be updated 
during the export process. This allows you to check for 
clipping, for example. 

Sample Rate 
(Audio Engine 
Output section)

This setting determines the frequency range of the ex-
ported audio – the lower the sample rate, the lower the 
highest audible frequency in the audio. In most cases, 
you should select the sample rate set for the project, 
since a lower sample rate will degrade the audio qual-
ity (mainly reducing the high frequency content) and a 
higher sample rate will only increase the file size, with-
out adding to audio quality. Also consider the future 
usage of the file – if you e.g. plan to import the file into 
another application, you should select a sample rate 
supported by that application.
If you are making a mixdown for CD burning, you 
should select 44.100 kHz, since this is the sample rate 
used on audio CDs.

Option Description
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AIFC files
AIFC stands for Audio Interchange File Format Com-
pressed, a standard defined by Apple Computer Inc. 
These files support compression ratios as high as 6:1 and 
contain tags in the header. AIFC files have the extension 
“.aifc” and are used on most computer platforms. 

AIFC files support the same options as AIFF files.

Wave files
Wave files have the extension “.wav” and are the most 
common file format on the PC platform. 

Wave files support the same options as AIFF files.

Windows Media Audio files (Windows only)
This is a format developed by Microsoft Inc. Due to the ad-
vanced audio codecs and lossless compression used, 
WMA files can be decreased in size with no loss of audio 
quality. The files have the extension “.wma”.

Exporting a WMA mixdown

The following options are available:

Input Stream

Here you set the sample rate (44.1, 48 or 96 kHz) and the 
bit resolution (16 bit or 24 bit) of the encoded file. These 
should be set to match the sample rate and bit resolution 
of the source material. If no value matches that of your 
source material, use the closest highest available value. 
E.g. if you’re using 20 bit source material, set the bit reso-
lution to 24 bit rather than 16 bit.

Bit Depth (Au-
dio Engine Out-
put section)

Allows you to select 8, 16, 24 bit or 32 bit (float) files.
If the file is an “intermediate mixdown” that you plan to 
re-import and continue working on in Cubase LE, we 
recommend that you select the 32 bit (float) option.
32 bit (float) is a very high resolution (the same resolu-
tion as used internally for audio processing in Cubase 
LE), and the audio files will be twice the size of 16 bit 
files.
If you are making a mixdown for CD burning, you should 
use the 16 bit option, as CD audio is always 16 bit.
8 bit resolution should only be used if required, since it 
will result in limited audio quality. 8 bit audio may be 
suitable in some multimedia applications, etc.

Pool (Import 
section)

Activate this option if you want to import the resulting 
audio file automatically back into the Pool. A clip refer-
ring to the file will appear in the Pool. 
If this option is activated, the Import Options dialog ap-
pears on export. For a description of the available set-
tings, see “Import Medium...” on page 137.

Audio Track 
(Import section)

If you activate this option, an audio event that plays the 
clip will be created and placed on a new audio track, 
starting at the left locator.
If this option is activated, the Import Options dialog ap-
pears on export. For a description of the available set-
tings, see “Import Medium...” on page 137.

Close dialog 
after export

If this option is activated, the dialog will be closed after 
the export, otherwise it will be left open.

Option Description
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Encoding Scheme

These settings are used for defining the desired output 
from the encoder. Make settings appropriate for the in-
tended use of the file. If the file will be downloaded or 
streamed on the Internet, you might not want too high bit 
rates for example.

• Mode
The WMA encoder can use either an encoding with constant or variable 
bit rate or a lossless encoding. The options on this menu are as follows:

• Bit Rate/Channels
This menu allows you to set the desired bit rate – from 128 kbps to 768 
kbps, depending on the selected Mode (see above). If the Mode “Vari-
able Bitrate with Quality” is used (see above), the menu allows you to se-
lect from six levels of desired quality, with 10 being the lowest and 100 
the highest. Generally, the higher the bitrate or quality you select, the 
larger the final file will be.

Dynamic Range Control

These controls allow you to define the dynamic range of 
the encoded file. The dynamic range is the difference in 
dB between the average loudness and the peak audio 
level (the loudest sounds) of the audio. These settings af-
fect how the audio is reproduced if the file is played on a 
Windows XP computer with a player in the Windows Me-
dia 9 series, and the user activates the special “Quiet 
Mode” feature of the player to control the dynamic range.

The dynamic range is automatically calculated during the 
encoding process, but you can specify it manually as well.

If you want to manually specify the dynamic range, first put 
a checkmark in the box to the left by clicking in it and then 
enter the desired dB values in the Peak and Average 
fields. You can enter any value between 0 and -90dB. 

Note however that it is usually not recommended to 
change the Average value, since it affects the overall vol-
ume level of the audio and therefore can affect the audio 
quality adversely.

The Quiet Mode in a Windows Media 9 player can be set 
to one of three settings. Below, these settings are listed 
together with an explanation of how the Dynamic Range 
settings affect them:

• Off: If Quiet Mode is off, the dynamic range settings that were 
automatically calculated during the encoding will be used.

• Little Difference: If this is selected and you have not manually 
changed the dynamic range settings, the peak level will be 
limited to 6dB above the average level during playback. If you 
have manually specified the dynamic range, the peak level will 
be limited to the mean value between the peak and average 
values you specified.

• Medium Difference: If this is selected and you have not manu-
ally changed the dynamic range settings, the peak level will be 
limited to 12dB above the average level. If you have changed 
the dynamic range, the peak level will be limited to the peak 
value you specified.

Output Media Description

In these fields you can enter a number of text strings with 
information about the file – title, author, copyright informa-
tion and a description of its contents. This information will 
then be embedded in the file header and can be displayed 
by some Windows Media Audio playback applications.

Mode Description

Constant Bitrate 
(CBR)

This will encode to a file with a constant bit rate (set in 
the Bit Rate/Channels menu, see below). Constant bit 
rate is preferably used if you want to limit the size of the 
final file. The size of a file encoded with constant bit 
rate is always the bit rate times the duration of the file.

Variable Bitrate 
with Quality

Encodes to a file with a variable bit rate, according to a 
quality scale (the desired quality is set in the Bit Rate/
Channels menu, see below). When you encode with 
variable bit rates, the bit rate fluctuates depending on 
the character and intricacy of the material being en-
coded.s The more complex passages in the source 
material, the higher the bit rate – and the larger the final 
file – will be.

Lossless Encodes to a file with lossless compression.
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Background

What is synchronization?
Synchronization is said to exist when you make two pieces 
of equipment agree on time or tempo and position info. 
You can establish synchronization between Cubase LE 
and a number of other types of devices, including tape re-
corders and video decks, but also MIDI devices that “play 
back”, such as other sequencers, drum machines, “work-
station sequencers” etc.

When you set up a synchronization system, you must de-
cide which unit is the master. All other devices are then 
slaved to this unit, which means they will adjust their play-
back speed to the master’s.

Cubase LE as a slave

When a synchronization signal is coming in to Cubase LE, 
from another device (such as a tape recorder, video re-
corder, etc.), this device is the master and Cubase LE is 
the slave. Cubase LE will adjust its playback to the other 
device.

Cubase LE as a master

When you set up Cubase LE to transmit synchronization 
information to other devices, Cubase LE is the master and 
the other devices are the slaves; they will adjust their play-
back to Cubase LE.

Cubase LE – both master and slave

Cubase LE is a very capable synchronization device. It can 
operate as both a master and a slave at the same time. For 
example, Cubase LE might be slaved to a tape recorder 
transmitting timecode, while at the same time transmitting 
MIDI Clock to a drum machine, acting as a master for that.

Synchronization signals
Basically there are three types of synchronization signals 
for audio: timecode, MIDI clock and word clock.

Timecode (SMPTE, EBU, MTC, VITC etc.)
Timecode appears in a number of guises. No matter which 
“format” it has, it always supplies a “clock on the wall” 
type of synchronization, that is, a synchronization related 
to hours, minutes, seconds and two smaller units called 
“frames” and “subframes”.

• LTC (SMPTE, EBU) is the audio version of timecode. This 
means that it can be recorded on the audio track of an audio 
or video recorder.

• VITC is the video format timecode, i.e. it is stored in the actual 
video image.

• MTC is the MIDI version of timecode, transmitted via MIDI ca-
bles.

• ADAT sync (Alesis) is only used with the ASIO Positioning 
Protocol, see “About the ASIO Positioning Protocol (APP)” on 
page 222.

For the ASIO Positioning Protocol other high precision 
timecode formats may also be supported.

Format recommendations for timecode – without ASIO 
Positioning Protocol

• When synchronizing your system to external timecode, via a 
synchronizer, the most common timecode format is MTC. 
Contrary to some reports you might have heard, MTC delivers 
good precision for external sync. This is due to the fact that 
the operating system can “time stamp” incoming MIDI mes-
sages, which increases precision.

Format recommendations for timecode – with ASIO 
Positioning Protocol

• LTC and VITC are the formats with the highest precision and 
are recommended when available.

• MTC is the next best option and probably the most common 
choice, since few audio hardware solutions have built-in LTC 
or VITC readers. However, LTC and VITC offer even higher 
precision when available.

! For a description of the VST System Link feature 
(with which you can synchronize separate computers 
running Cubase LE or Nuendo for example), see 
“VST System Link” on page 223.
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MIDI Clock
MIDI Clock is a tempo-based type of synchronization sig-
nals, i.e. it is related to the number of “beats per minute”. 
MIDI Clock signals are suitable for synchronizing two de-
vices that agree on tempo, such as for example Cubase 
LE and a drum machine.

Word Clock
Word clock is basically a replacement for the sample rate 
clock in for example an audio card. Word clock hence 
runs at the same rate as the sample rate in the audio, 
44.1kHz, 48kHz etc.

Word clock does not contain any position information, it is 
only a “simple” signal for clocking the audio at its sample 
rate.

Word clock comes in many formats, analog on coaxial ca-
ble, digital as part of an S/PDIF, AES/EBU or ADAT audio 
signal, etc.

Synchronizing the transport vs. 
synchronizing audio

How timing is handled in a non-synchronized 
system
Let’s first look at the situation where Cubase LE is not 
synchronized to any external source:

Any digital playback system has an internal clock that ulti-
mately affects the playback speed and stability, and PC 
audio hardware is no exception. This clock is extremely 
stable.

When Cubase LE is playing back with no external syn-
chronization, all playback is internally synchronized to the 
internal digital audio clock.

Synchronizing Cubase LE’s playback
Let’s assume now that we use external timecode synchro-
nization with Cubase LE. For example, we might synchro-
nize playback to a tape recorder.

Timecode coming from an analog tape recorder will al-
ways vary slightly in speed. Different timecode generators 
and different tape recorders will also supply timecode with 
slight differences in speed. In addition, the shuttling of 
tape mechanisms due to overdubs and re-recordings can 
cause the physical tape to wear and stretch, which affects 
the speed of the timecode.

If you use a synchronizer that generates wordclock and set 
up Cubase LE to sync to incoming timecode, it will vary its 
overall playback speed to compensate for such fluctuations 
in the speed of the timecode – that’s the whole purpose of 
synchronization.

What happens with the digital audio?
The fact that Cubase LE’s playback is synchronized to the 
timecode does not affect the playback of the digital audio. 
It still relies on the perfectly stable, built-in clock in the au-
dio hardware.

As might be expected, problems will appear when the per-
fectly stable digital audio gets related to the slightly vary-
ing speed of a system synchronized to timecode.

The playback timing of each event will not be in total ac-
cordance with the tape or the MIDI playback, since the 
playback speed of the audio is determined by the digital 
audio hardware’s built-in clock.

Resolving to word clock
The solution to this problem is to use one external clock 
for all components in the system. One master clock is 
used to derive whatever type of clock signal each compo-
nent in the system needs. For example, something called a 
house clock can be used to generate sample rate clocks 
for the digital audio hardware and timecode for Cubase 
LE. This ensures that all components in the system use 
the same reference source for their timing.

Synchronizing digital audio to external clocks running at 
sample rate is often called “resolving” or “synchronizing to 
word clock”. 

! MIDI Clock is not suitable as a master sync source 
for an application like Cubase LE. Therefore Cubase 
LE will transmit MIDI Clock signals to other devices, 
but it will not receive MIDI Clock.
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If you aim to perform synchronization to external signals, 
we strongly recommend that you obtain proper synchroni-
zation equipment. This encompasses:

• An audio card that can be slaved to external word clock.
• A synchronizer that can read timecode (and possibly house 

clock) and generate the required sync signals from that, such 
as the Steinberg TimeLock Pro.

or...

• An audio system with complete built-in synchronization possi-
bilities, preferably supporting the ASIO Positioning Protocol 
(see “About the ASIO Positioning Protocol (APP)” on page 
222).

Using timecode without word clock
Of course, it is possible to set up a synchronization system 
where you lock Cubase LE to timecode without using word 
clock. However, please note that the timing of audio vs. 
MIDI cannot be guaranteed and that fluctuations in speed 
in the incoming timecode will not affect the playback of au-
dio events. This means that synchronizing to timecode may 
work in the following situations:

• When the timecode was originally generated by the au-
dio card itself.

• When the source providing the timecode is extremely 
stable (such as a digital video system, a digital tape re-
corder or another computer).

• When you remain synchronized to that same stable 
source throughout the entire process, both while record-
ing and playing back audio.

Making basic settings and 
connections

Setting the Frame Rate
The frame rate is the number of frames per second in a film 
or on a video tape. Just as there is always sixty seconds to a 
minute, there is always a certain number of frames to each 
second. However, the frame rate used varies with the type 
of media (film or video), which country the video tape has 
been produced in, and other circumstances.

In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up is automatically adjusted to the 
frame rate of the incoming timecode.
There is an exception to this when you are synchronizing Cubase LE to 
MIDI Timecode: If you have selected 29.97 fps or 30 dfps as Frame Rate 
in Cubase LE, this selection will be kept, since these frame rates can not 
be distinguished in the MTC format.

The Project Setup dialog contains six frame rates to 
choose from:

• The Display Format pop-up contains a number of for-
mats that when selected work as the “master” setting for 
the display format used in the various windows’ rulers and 
position displays.

Making connections
The following connections are required for external sync 
via a synchronizer, including resolving of the audio card. 
For details on audio card and synchronizer settings and 
connections, see the manuals for these devices.

• Route the master clock signal (LTC, VITC, etc.) to an in-
put on the synchronizer.

• Connect the word clock output on the synchronizer to a 
word clock input on the audio card.

• Connect the MIDI Timecode (MTC) output on the syn-
chronizer to the corresponding input on the computer.

Frame Rate Description

24 fps The traditional frame rate of 35mm film.

25 fps The frame rate used for all video and audio in Europe 
(EBU).

29.97 fps Straight 29.97 frames per second.

29.97 dfps “Drop frame” code running at 29.97 frames per second, 
most often used in the United States of America for work 
with color video.

30 fps Straight 30 frames per second. This is often used in the 
United States for audio only work.

30 dfps Very rarely used.
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• Set up the synchronizer and make sure the frame rate 
settings are in accordance with the master clock.

A typical synchronization setup.

Synchronization settings
In the following sections you will find a description of how 
to set up your system for the different timecode sources:

Internal Timecode
In this mode, Cubase LE is the master.

Use the “MIDI Timecode Destinations” and “MIDI Clock 
Destinations” sections to specify which devices should be 
slaved to Cubase LE.

Synchronizing other Equipment to Cubase LE

You may have other MIDI devices that you want to syn-
chronize to Cubase LE. There are two types of synchroni-
zation signals that Cubase LE can transmit: MIDI Clock 
and MIDI Timecode.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type 
of synchronization signal, the other device will follow Cu-
base LE’s tempo. The tempo setting in the other device is of 
no relevance. If the device also reacts to Song Position 
Pointers (which Cubase LE transmits), it will follow when 
you wind, rewind and locate using the Cubase LE Trans-
port panel.

MIDI Clock transport commands include “Start”, “Stop” 
and “Continue”. However, some MIDI equipment (e.g. 
some drum machines) do not recognize the “Continue” 
command. If this is the case with your equipment, activate 
the option “Always Send Start Message” in the Synchroni-
zation Setup dialog (MIDI Clock Destinations section).
When this is activated, only the Start command is used.

• Activate “MIDI Clock Follows Project Position” if you 
want the other device to follow when you loop, jump and 
locate during playback.
When this is activated, the sent MIDI Clock signals will follow the se-
quencer time and tempo position at all times.

Transmitting MIDI Timecode

If you transmit MIDI Timecode to a device supporting this 
type of synchronization signal, the device will synchronize 
time-wise to Cubase LE, that is, the time display on Cubase 
LE’s Transport panel and on the other device will agree. 
When you wind and locate Cubase LE and then activate 
playback, the other device will follow from the same posi-
tion (if it has this capability and is set up for it!).

Setting Up

1. Connect the desired MIDI Outputs from Cubase LE to 
the device(s) that you plan to synchronize.

2. Open the Synchronization Setup dialog from the 
Transport menu.

! Please note that some external devices may not react 
smoothly to these repositioning messages. Espe-
cially when working with some older devices, it may 
take some time for them to synchronize accurately to 
the project time.

Settings for sync to internal timecode.
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3. Specify the sync destinations by using the checkboxes 
in the corresponding sections in the lower right part of the 
dialog.
You can output any combination of MIDI Timecode and MIDI Clock to 
any combination of outputs (however, you probably don’t want to send 
MTC and MIDI Clock to the same output).

4. Set the other device(s) to their “external synchroniza-
tion” mode (or some other mode with a similar name) and 
activate playback on them if necessary.

5. Activate playback in Cubase LE, and the other de-
vice(s) will follow.

MIDI Timecode
In this mode, Cubase LE is the slave and the timecode is 
sent by the MIDI Timecode Source specified in the corre-
sponding section. 

Setting up Cubase LE for external sync to timecode

1. In the Synchronization dialog, set Timecode Source to 
MIDI Timecode.

2. Use the pop-up menu in the MIDI Timecode Source 
section to select an input for the timecode.

3. Close the Synchronization Setup dialog and open the 
Project Setup dialog from the Project menu.

4. Use the Start value to set which frame on the external 
device (e.g. a video tape) should correspond to the begin-
ning of the project.

5. In the dialog that appears, you are asked if you want to 
keep the project content at its timecode positions. Select 
“No”.
This will make all events and parts keep their positions relative to the 
project start. 

6. Close the Project Setup dialog.

7. On the Transport panel, activate the Sync button (or 
select Sync Online from the Transport menu).

8. Start the tape (or video, or other master device) that 
contains the timecode. Cubase LE starts playing when it 
receives timecode with a position “higher” than, or equal 
to, the project Start frame.

You can wind the device that sends the timecode to any 
position and start from there.

You should also take a look at the options in the Applica-
tion section, see “Application options” on page 223.

The Sync indicator

On the Transport panel you can check the status of in-
coming timecode by observing the sync indicator. It 
switches between “Offline” (not waiting for sync), “Idle” 
(ready for sync but no signal is coming in), and “Lock xx” 
(where xx indicates the frame rate of the incoming signal).

! Some MIDI interfaces will automatically send MIDI 
Clock to all MIDI outputs, regardless of the MIDI 
Clock port selection you make in Cubase LE. If this is 
the case, you should only select one MIDI Clock port 
(consult the documentation of the MIDI interface if in 
doubt).

Sync to timecode activated

Options for in-
coming timecode

Outputs for 
MIDI Clock

Outputs for 
MIDI Timecode

Input port for 
MIDI Timecode

! When the master device with the timecode is 
stopped, you can use the Cubase LE transport con-
trols as you normally do, when it is not synchronized. 

Set this to the time-
code position 
where you want the 
project to start.

The Sync indicator
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ASIO Audio Device

In this mode, Cubase LE is the slave and the synchroniza-
tion signal can be received from another device con-
nected to a digital interface of the audio hardware.

About the ASIO Positioning Protocol (APP)

The ASIO Positioning Protocol is a technology that ex-
pands on the type of sync described above and makes 
sample-accurate positioning possible.

When transferring audio digitally between devices, it is im-
portant that synchronization using word clock and timecode 
is completely correlated. If not, the audio will not be re-
corded at the exact intended (sample-accurate) position, 
which can cause various types of problems, such as inac-
curately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a di-
gital multi-track tape recorder to Cubase LE (for editing) 
and then back again. If you do not have sample-accurate 
synchronization set up, you cannot be sure that the mate-
rial will appear in its exact original position, when trans-
ferred back to the tape recorder.

In order to take advantage of the ASIO Positioning Proto-
col, your audio hardware must be suitably equipped and 
the functionality must be included in the ASIO driver for 
the hardware.

An example of a system for sample-accurate transfers 
would be transferring audio tracks from an Alesis ADAT to 
Cubase LE. Here the ADAT will be the sync master 
(though it doesn’t necessarily have to be). It provides both 
the digital audio (with an inherent word clock) and position 
information (timecode) via its ADAT sync protocol. The 
master clock is generated by the ADAT itself.

Hardware and software requirements for APP

• Your computer audio hardware (in the example above this 
would be an ADAT card in your computer) must support all 
the functionality required for the ASIO Positioning Protocol. 
That is, it must be able to read the digital audio and the corre-
sponding position information from the external device.

• There must be an ASIO 2.0 driver for the audio hardware.
• For resolving to external timecode, the audio hardware must 

have an integrated timecode reader/generator on-board.
• For information about which audio hardware models currently 

support APP, see the Steinberg web site (www.steinberg.net).

Setting up the audio card for external synchronization

1. Open the Device Setup dialog from the Devices menu 
and, on the VST Audio System page, select your audio in-
terface from the “ASIO Driver” pop-up menu.
In the Devices List, the name of the audio interface is displayed below 
the VST Audio System entry. 

2. Select your audio interface in the Devices list to the 
left.

3. Click the Control Panel button to open the card’s pro-
prietary setup dialog.
If this card is accessed via a special ASIO driver, this dialog is provided 
by the card, not by Cubase LE. Hence the settings vary with the card 
brand and model.

4. Adjust the settings as recommended by the card man-
ufacturer, then close the dialog.
The dialog may also contain various diagnostic tools that allow you to 
verify for example whether word clock is arriving correctly.

5. From the Clock Source pop-up, select the input to 
which you routed the word clock signal.
This pop-up may not be used if you selected an input in the Control 
Panel dialog instead.

6. Click OK to close the Device Setup dialog.

! This option is only available if your hardware is com-
patible with the ASIO Positioning Protocol.

! The ASIO Positioning Protocol requires audio hard-
ware with specific ASIO drivers.

! The ASIO Positioning Protocol exploits the specific 
advantage of having an audio card that has an inte-
grated timecode reader. With such a card and the 
ASIO Positioning Protocol, you can achieve constant 
sample-accurate synchronization between the audio 
source and Cubase LE.
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You can now set up the synchronization:

1. Open the Synchronization Setup dialog and set the 
Timecode Source to ASIO Audio Device.

2. Make the desired settings in the dialog.
For information on the different sections, click the Help button in the dia-
log.

3. Close the Synchronization Setup dialog.

4. Open the Project Setup dialog from the Project menu 
and use the Start value to set which frame on the external 
device (e.g. a video tape) should correspond to the begin-
ning of the project.

5. A message appears, asking you whether you want to 
keep the project content at its timecode positions. Select 
“No”.
This will make all events and parts keep their positions relative to the 
project start. 

6. Close the Project Setup dialog.

7. On the Transport panel, activate the Sync button (or 
select Sync Online from the Transport menu).

8. Start the tape (or video, or other master device) that 
contains the timecode. Cubase LE starts playing when it 
receives timecode with a position “higher” than, or equal 
to, the project Start frame.

You can wind the device that sends the timecode to any 
position and start from there.

You should also take a look at the options in the Applica-
tion section, see “Application options” on page 223.

The Sync indicator

On the Transport panel you can check the status of in-
coming timecode by observing the sync indicator. It 
switches between “Offline” (not waiting for sync), “Idle” 
(ready for sync but no signal is coming in), and “Lock xx” 
(where xx indicates the frame rate of the incoming signal).

VST System Link

Application options
The following options are available in the Application sec-
tion of the Synchronization Setup dialog:

Lock Frames
Using this field you can set how many frames of “correct” 
timecode Cubase LE should receive before attempting to 
“lock” (synchronize) to incoming timecode. If you have an 
external tape transport with a very short start-up time, you 
could try lowering this number to make lock-up even faster 
than it already is.

Drop Out Frames
On an analog tape with timecode, dropouts may occur. If 
a drop-out is very long, Cubase LE may (temporarily) stop. 
In the Dropout Frames field you can set how long a drop-
out (in frames) should be tolerated until Cubase LE de-

The ASIO Audio Device is selected as Timecode Source

Options for in-
coming timecode

Outputs for 
MIDI Clock

Set this to the time-
code position 
where you want the 
project to start.

! When the master device with the timecode is 
stopped, you can use the Cubase LE transport con-
trols as you normally do, when it is not synchronized. 

! For a description of the VST System Link feature 
(with which you can synchronize separate computers 
running Cubase LE or Nuendo for example) see 
“VST System Link” on page 223.
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cides that the tape isn't good enough to synchronize to. If 
you have a very stable timecode source, you may lower 
this number to make Cubase LE stop more swiftly after 
the tape recorder has been stopped.

Inhibit Restart
Some synchronizers will still transmit MIDI Time Code for 
a short period after an external tape machine has been 
stopped. These extra frames of timecode can sometimes 
cause Cubase LE to restart suddenly. Inhibit Restart al-
lows you to control the amount of time in milliseconds that 
Cubase LE will wait to restart (ignoring incoming MTC) 
once it has stopped.

Working with VST System Link
VST System Link is a network system for digital audio that 
allows you to have several computers working together in 
one large system. Unlike conventional networks it does not 
require Ethernet cards, hubs, or CAT-5 cables; instead it 
uses the kind of digital audio hardware and cables you 
probably already possess in your studio.

VST System Link has been designed to be simple to set 
up and operate, yet give enormous flexibility and perfor-
mance gains in use. It is capable of linking computers in a 
“ring” network (the System Link signal is passed from one 
machine to the next, and eventually returns to the first ma-
chine). VST System Link can send its networking signal 
over any type of digital audio cable, including S/PDIF, 
ADAT, TDIF, or AES, as long as each computer in the sys-
tem is equipped with a suitable ASIO compatible audio in-
terface.

Linking up two or more computers gives you vast possibil-
ities:

• Dedicate one computer to running VST instruments while re-
cording audio tracks on another.

• If you need lots of audio tracks, you may simply add tracks on 
another computer.

• You could have one computer serve as a “virtual effect rack”, 
running CPU-intensive send effect plug-ins only.

Since you can use VST System Link to connect different 
VST System Link applications on different platforms, you 
can take advantage of effect plug-ins and VST instru-
ments that are specific to certain programs or platforms.

Preparations

Requirements
The following equipment is required for VST System Link 
operation:

• Two or more computers.
These can be of the same type or use different operating systems – it 
doesn’t matter. For example, you can link an Intel-based PC to an Apple 
Macintosh without problems.

• Each computer must have audio hardware with specific 
ASIO drivers, installed and working.

• The audio hardware must have digital inputs and out-
puts.
Of course, to be able to connect the computers, the digital connections 
must be compatible (i.e. the same digital formats and connection types 
must be available).

• At least one digital audio cable for each computer in the 
network.

• A VST System Link host application installed on each 
computer.
Any VST System Link applications can connect to each other.

Additionally, we recommend that you use a KVM switch-
box:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a 
small network in a limited space, it's a good idea to invest 
in a KVM (Keyboard, Video, Mouse) switchbox. With one 
of these switchers you can use the same keyboard, moni-
tor, and mouse to control each computer in the system, 
and switch between computers very rapidly. KVM switch-
ers are not too expensive, and very easy to setup and op-
erate. It you decide not to go this route, the network will 
function just the same, but you may end up doing a lot of 
jumping from one machine to the other while setting up!

Making connections
Below, we assume that you are connecting two comput-
ers. Should you have more than two computers, it’s still 
best to start with two and add the others one by one once 
the system is working – this makes troubleshooting easier 
if you run into problems. For two computers, you will need 
two digital audio cables, one in each direction:
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1. Connect a digital audio cable from the digital output of 
computer 1 to the digital input of computer 2.

2. Connect the other cable from the digital output of 
computer 2 into the digital input of computer 1.

• If a card has more than one set of inputs and outputs, 
choose whichever one that suits you – for simplicity usu-
ally the first set is best.

Synchronization 
Before you proceed, you need to make sure that the clock 
signals on your ASIO cards are synchronized correctly. 
This is essential when cabling any kind of digital audio 
system, not just VST System Link.

The Clock Mode or Sync Mode is set up in the ASIO con-
trol panel of the audio hardware. In Cubase LE, you pro-
ceed as follows:

1. Pull down the Devices menu and open the Device Set-
up dialog.

2. On the VST Audio System subpage, select your audio 
interface from the “ASIO Driver” pop-up menu.
In the Devices List, the name of the audio interface is displayed below 
the VST Audio System entry.

3. Select your audio interface in the Devices list to the 
left.

4. Click the Control Panel button.
The ASIO control panel appears.

5. Open the ASIO control panel on the other computer 
as well.
If you are using another VST System Link host application on that com-
puter, check its documentation for details on how to open the ASIO con-
trol panel.

6. Now, you need to make sure that one audio card (and 
only one!) is set to be the Clock Master, and all the other 
cards are set to listen for the clock signal coming from the 
Clock Master i.e. they must be Clock Slaves.
The naming and procedure for this differs depending on the audio hard-
ware – consult its documentation if required. If you are using Steinberg 
Nuendo ASIO hardware, all cards default to the “AutoSync” setting – in 
this case you must set one of the cards (and only one) to “Master” in the 
Clock Mode section of the control panel.

• Typically, the ASIO control panel for an audio card con-
tains some indication of whether the card receives a proper 
sync signal or not, and the sample rate of that signal.
This is a good indication that you have connected the cards and set up 
clock sync properly. Check your audio hardware’s documentation for de-
tails.

The only exception to this procedure is if you are using an 
external clock – which could be from a digital mixing desk 
or special Word Clock synchronizer for example. If so, you 
must leave all your ASIO cards in Clock Slave or AutoSync 
mode, and make sure that each of them is listening for the 
signal coming from the synchronizer, usually passed 
through your ADAT cables or Word Clock connectors in a 
daisy chain fashion.

VST System Link and latency
The general definition of latency is the amount of time it 
takes any system to respond to whatever messages are 
sent to it. For example, if your system’s latency is high and 
you play VST instruments in real time, you will get a notice-
able delay between when you press a key and when you 
hear the sound of the VST instrument. Nowadays, most 
ASIO-compatible audio cards are capable of operating 
with very low latencies. Also, all VST applications are de-
signed to compensate for latency during playback, making 
the playback timing tight.

However, the latency time of a VST System Link network 
is the total latency of all the ASIO cards in the system 
added together. Therefore it’s extra important to minimize 
the latency times for each computer in the network.

! All digital audio cables by definition always carry a 
clock signal as well as audio signals, so you don't 
have to use a special Word Clock input and output 
for this (although you may find that you get a slightly 
more stable audio system if you do, especially when 
using multiple computers).

! It’s very important that one and only one card is the 
clock master, otherwise the network cannot function 
correctly. Once you have set this up, all the other 
cards in the network will take their clock signal from 
this card automatically.



226

Synchronization

The latency does not affect the synchronization – it's 
always perfectly in time. But, it can affect the time it takes 
to send and receive MIDI and audio signals, or make the 
system seem sluggish.

To adjust the latency of a system, you adjust the size of the 
buffers in the ASIO control panel – the lower the buffer 
size, the lower the latency. It's best to keep to fairly low la-
tencies (buffer sizes) if your system can handle it – about 
12 ms or less is usually a good idea.

Setting up your software
Now it’s time to set up your programs. The procedures 
below describe how to set things up in Cubase LE; if you 
are using another program on the other computer, please 
refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the 
same sample rate. Select “Project Setup…” from the 
Project menu and make sure the sample rate is the same 
in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications 
and route these to the digital inputs and outputs.
The number and configuration of the busses depends on your audio hard-
ware and on your needs. If you have a system with eight digital i/o channels 
(such as an ADAT connection), you could create several stereo or mono 
busses together with a stereo bus, or any combination you need. The im-
portant thing is that you should have the same configuration in both appli-
cations – if you have four stereo output busses on computer 1, you want 
four stereo input busses on computer 2, etc.

2. Set things up so that computer 1 plays back some au-
dio.
You can for example import an audio file and play this back in Cycle 
mode.

3. In the Inspector or mixer, make sure the playing audio 
channel is routed to one of the digital output busses you 
set up.

4. In computer 2, open the mixer and locate the corre-
sponding digital input bus.
The audio being played back should now “appear” in the program run-
ning on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back 
and computer 1 “listens”.

Now you have verified that the digital connection works as 
it should.

From this point on in this chapter, we refer to the bus-
ses connected to the digital inputs and outputs as “VST 
System Link busses”.

Settings for the audio hardware

When you send VST System Link data between comput-
ers, it is important that the digital information isn’t changed 
in any way between the programs. Therefore, you should 
open the control panel (or additional application) for your 
audio hardware and make sure that the following condi-
tions are met:

• If there are additional “format settings” for the digital 
ports that you use for VST System Link data, make sure 
these are turned off.
For example, if you are using an S/PDIF connection for VST System Link, 
make sure that “Professional format”, Emphasis and Dithering are turned 
off.

• If your audio hardware has a mixer application allowing 
you to adjust the levels of digital inputs and outputs, make 
sure that this mixer is disabled or that the levels for the 
VST System Link channels are set to ± 0dB.

• Similarly, make sure no other forms of DSP (pan, ef-
fects, etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hard-
ware, the Totalmix function allows for extremely complex 
signal routing and mixing in the audio hardware. This can 
in some situations lead to “signal loops” in which case the 
VST System Link won’t work. If you want to make abso-
lutely sure this won’t cause any problems, select the de-
fault or “plain” preset for the Totalmix function.
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Activating VST System Link
Before you proceed you need to make sure that VST Sys-
tem Link is set as Timecode Source in the Synchronization 
dialog and that the desired Sync options are activated, 
see “Application options” on page 223.

After setting up the inputs and outputs, you now need to 
define which input/output should carry the actual VST 
System Link information.

The System Link networking signal is carried on only one 
bit of one channel. This means that if you have an ADAT 
based system which normally carries eight channels of 
24-bit audio, once you activate VST System Link you will 
have seven channels of 24-bit audio and one channel of 
23-bit audio (the least significant bit of this last channel 
will be used for networking). In practice this makes no dis-
cernible difference to the audio quality, since you will still 
have around 138dB headroom on this channel.

To set things up, open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.

2. Select VST System Link in the Devices List to the left.

3. Use the ASIO Input and ASIO Output pop-up menus 
to define which channel should be the networking channel 
(and thus become a 23-bit audio channel, in our example).
Quite often you will be able to leave these pop-ups the way they are. 

4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the net-
work. 

As the computers are made active, you should see the 
small T (Transmit) and R (Receive) lights flashing on each 
active computer, and the name of each computer should 
appear in the list at the bottom of the pane. Each com-
puter is assigned a random number – don't worry about 
this, it's just so the network knows internally which one is 
which.

• You can double-click on the name in bold (which is the 
name of the computer you’re currently working on) and set 
it to whatever other name you wish.
This name will appear in the System Link window of every computer on 
the network.

If you don't see the name of each computer appearing 
once you have made it active, you may have to check your 
settings. 
Go through the procedure above again and make sure that all ASIO 
cards are listening to the digital clock signals correctly, and that each 
computer has the correct inputs and outputs assigned to the System 
Link network.

Putting the network online
After each computer's name you will see whether it is on-
line or not. When a computer is online, it will receive trans-
port and timecode signals, and its sequencer application 
can be started and stopped by remote control. If it is off-
line, it can only be started from its own keyboard – it is ef-
fectively an independent machine, although it is still on the 
network.

Note that any computer can control any and all of the 
others – VST System Link is a peer-to-peer network and 
there is no absolute “master” computer.
However, most users do like to think of one machine as the master (in a 
one person/two computer network, this would be the machine you actu-
ally sit behind most of the time). 
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For now, let's put all computers online:

1. Activate the Online checkbox in the VST System Link 
panel for all computers. 

2. Check that the system is working by pressing Play on 
one computer – all computers should start almost instantly 
and play perfectly in time, with sample-accurate precision.

• The Offset setting to the right allows you to adjust 
whether one machine will play back slightly ahead or be-
hind the rest.
This is normally not needed, but occasionally with some hardware you 
may find that the lock is a few samples out. In that case you can adjust 
the lock with the Offset value. For now, leave it set to 0 – it will most likely 
be what you want.

VST System Link sends and understands all transport 
commands, so you can play, stop, fast forward, rewind 
etc. the entire network from one computer without a prob-
lem – try it! If you jump to a locator point on one machine, 
all other machines will also instantly jump to that locator 
point. 

Using MIDI
As well as supplying transport and sync control, VST Sys-
tem Link also supplies up to 16 MIDI ports, each with 16 
channels. You set this up as follows:

1. Use the MIDI Ins and Outs value boxes to specify the 
number of MIDI ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open 
the Inspector (top section).

3. If you now pull down the Input and Output Routing 
pop-up menus, you will find the specified System Link 
ports added to the list of MIDI Inputs and Outputs.

Note that for instrument tracks you can also select a VST 
System Link input.

The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, 
there is a small possibility that you might run out of band-
width on your VST System Link network. This will manifest 
itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI 
by activating Active ASIO Ports for Data only in the VST 
System Link Setup panel. When this is activated, the VST 
System Link information will be sent on the entire channel 
instead of just one bit, more than enough for all the MIDI 
you could ever hope to use. The downside is that you can 
no longer use this ASIO channel for audio transfer (do not 
connect it to a speaker!), thus leaving you only 7 channels 
of audio in our ADAT cable example. Depending on how 
you work this might be a reasonable compromise.

Hearing the network audio
If you are using an external mixing desk, hearing your audio 
really isn't an issue – just plug the outputs of each com-
puter into the desired channels on the external mixing 
desk, press Play on one of the computers, and you're 
good to go.

! Make sure that all computers have their tempos set 
to the same value, otherwise your synchronization 
will be seriously skewed.
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However, many people prefer to mix internally inside the 
computer and just use a desk for monitoring (or maybe not 
use any external mixer at all). In this case you'll need to se-
lect one computer to be your “main mix computer” and 
send the audio from your other computers into this.

In the following example, we assume you are using two 
computers, with computer 1 as your main mix computer 
and computer 2 running two additional stereo audio 
tracks, an FX channel track with a reverb plug-in and an 
instrument track with stereo outputs.

1. First you want to set things up so that you can listen to 
the audio playback from computer 1.
In other words, you need an unused set of outputs, e.g. an analog stereo 
output, connected to your monitoring equipment.

2. Go to computer 2 and route each of the two audio 
tracks to a separate output bus.
These should be busses connected to the digital outputs – let’s call 
them Bus 1 and 2.

3. Route the FX channel track to another VST System 
Link bus (Bus 3).

4. Route the Instrument track to yet another bus (Bus 4).

5. Go back to computer 1 and check the corresponding 
four VST System Link input busses.
If you start playback on computer 2, the audio should “appear” on the in-
put busses on computer 1. However, to mix these audio sources you 
need actual mixer channels:

6. Add four new stereo audio tracks on computer 1 and 
route these to the output bus you use for listening, e.g. to 
the analog stereo outputs.

7. For each of the audio tracks, select one of the four in-
put busses.
Now, each computer 2 bus is routed to a separate audio channel on 
computer 1.

8. Activate monitoring for the four tracks.

If you now start playback, the audio from computer 2 will 
be sent “live” to the new tracks on computer 1, allowing 
you to hear them together with any tracks you play back 
on computer 1.

For more information about Monitoring, see “About moni-
toring” on page 13.

Adding more tracks

OK, but if you have more audio tracks than you have VST 
System Link busses (physical outputs)? Then you just use 
the computer 2 mixer as a submixer: Route several audio 
channels to the same output bus and adjust the output 
bus level if needed.

Note also that if your audio cards have multiple sets of in-
put and output connections you can link up e.g. multiple 
ADAT cables and send audio via any of the busses on any 
of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the la-
tency issue we mentioned earlier. The VST engine always 
compensates for record latencies, but if you are monitor-
ing through computer 1 you will hear a processing delay 
while you listen to signals coming from your other comput-
ers (not on your recording!). If your audio card in computer 
1 supports ASIO Direct Monitoring you should definitely 
turn this on – you'll find the setting in the VST Audio Sys-
tem Device Setup panel (see “ASIO Direct Monitoring” on 
page 49). Most modern ASIO cards support this function. 
If yours doesn't you may want to change the Offset value 
in the VST System Link Setup panel to compensate for 
any latency issues.

Setting up a larger network
This is not much more difficult than a two computer net-
work. The main thing to remember is that VST System Link 
is a daisy chain system. In other words, the output of com-
puter 1 goes to the input of computer 2, the output of 
computer 2 goes to the input of computer 3, and so on 
around the chain. The output of the last computer in the 
chain must always go back into the input of computer 1, to 
complete the ring.

Once you've done this, the transmission of all the trans-
port, sync, and MIDI information to the whole network is 
handled pretty much automatically. However, where you 
may run into confusion in a large network is in the trans-
mission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your 
ASIO cards you don't need to send audio via the chain at 
all, but can transmit it directly to the master mix computer 
via one or more of its other hardware Inputs. For example, if 
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you have a Nuendo Digiset interface or 9652 card on com-
puter 1 you could use ADAT cable 1 for networking, ADAT 
cable 2 as a direct audio input from computer 2, and ADAT 
cable 3 as a direct audio input from computer 3.

You can also transmit audio via the ring system if you don't 
have enough hardware I/Os for direct audio transmission. 
For example, in a four computer scenario you could send 
audio from computer 2 into a channel in the mixer in com-
puter 3, and from there to a channel in the mixer in com-
puter 4, and from there back to the master mixer in 
computer 1. This can certainly be tricky to set up, so gen-
erally it is recommended that if you want to set up a com-
plex network, you should make sure to use ASIO cards 
with at least three separate digital I/Os. 

Application examples

Creating a virtual effect rack
The effect sends for an audio channel in Cubase LE can 
either be routed to an FX channel track or to any activated 
Group or output bus. This allows you to use a separate 
computer as a “virtual effect rack”, by setting things up in 
the following way:

1. Go to computer 2 (the machine you will use as effect 
rack) and add a new stereo audio track.
You cannot use an FX channel track in this case, since the track must 
have an audio input.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link 
busses as input for the audio track.
You want to use a separate System Link bus, which will only be used for 
this purpose.

4. Route the channel to the desired output bus.
If you are using computer 1 as your main mixing computer, this would be 
one of the VST System Link output busses, connected to computer 1.

5. Activate monitoring for the track.

6. Now, go back to computer 1 and select a track to 
which you want to add some reverb.

7. Bring up the effect sends for the track in the Inspector.

8. Pull down the send routing pop-up menu for one of 
the sends, and select the VST System Link bus assigned 
to the reverb in step 3.

9. Use the send slider to adjust the amount of effect as 
usual.

The signal will be sent to the track on computer 2 and pro-
cessed through its insert effect, without using any proces-
sor power on computer 1.

You can repeat the steps above to add more effects to the 
“virtual effect rack”. The number of effects available this 
way is only limited by the number of ports used in the VST 
System Link connection (and of course by the perfor-
mance of computer 2, but given that it won’t have to han-
dle any recording or playback, you should be able to use 
quite a lot of effects).

Getting extra audio tracks
All computers on a VST System Link network are locked 
with sample-accuracy. Therefore, if you find that the hard 
drive on one computer isn’t fast enough to run as many 
audio tracks as you need, you can record new tracks on 
one of the other computers instead. This would create a 
“virtual RAID system”, with several disks all operating to-
gether. All tracks will remain locked together just as tightly 
as if they were all running on the same machine. This 
means that you effectively have an unlimited track count! 
Need another 100 tracks? Just add another computer.
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Background
Cubase LE plays back video films in a number of formats. 

Under Windows, video playback can be done using one 
of three playback engines: Video for Windows, Direct-
Show or Quicktime. This ensures compatibility with as 
wide a range of video files as possible. The following file 
formats are supported: AVI, Quicktime and MPEG.

Under Mac OS X, Quicktime is always used as playback 
engine. QuickTime supports the following video file for-
mats: AVI, MPEG, QuickTime and DV.

There are two ways to play back video:

• Without any special hardware.
While this will be fine in many situations it does put a limit on the size of 
the video window as well as the quality of the image.

• Using video hardware that, for example, connects to an 
external monitor.
Mac OS X: Using a FireWire port, you can play back video on an external 
monitor using a DV-to-analog converter or a DV camera.
You can play back DV video. QuickTime is used for playback.
Windows: Multi-head graphics cards that support overlay functionality 
can be used to display the video picture on an external monitor. The fol-
lowing manufacturers have working (and tested) solutions available: 
nVIDIA and Matrox.

Before you start
When working on a project involving a video file, there are 
several points to bear in mind:

Have you selected the right player? (Windows 
only)
The player is used not only for playback of the video file, 
but also to provide file information in the Pool and in the 
Import Video dialog. Therefore, to make sure that you have 
chosen the right player for a particular type of video file, 
check the file information displayed in the Import Video 
dialog or the Pool prior to trying to import or playing back 
the file.

When this information reads “0x0 pixel”, “0.000 s” and “0 
Frames”, the video file is either corrupt, or the format is not 
supported by the codecs available to the selected video 
player. You will either have to change the video player, or 
install the required codec.

Editing a video file
Video clips are played back by events just as audio clips 
are. You can use all the basic editing operations on video 
events, just as with audio events. The following operations 
are not possible on the video track:

• Drawing, Gluing, and Scrubbing.
Note that when you activate the Mute button for a video track, the video 
playback will be stopped, but playback of any other Project events will 
continue. See below.

• The video track has no editor and does not make use of 
parts.

• Cubase LE allows you to cut, copy, paste and trim video 
events, i.e. your video track may contain more than one 
video event. However, when using the DirectShow video 
player (Windows only), you may find that only the first event 
on the video track is played back correctly. In such a case 
make sure that the video track contains no more than one 
video event.

• Under Windows, you may find that you are unable to 
edit a video file copied from a CD. This is because files 
copied from CD are write protected by default. Right-click 
the file and deactivate the “Read-Only” option in the File 
Properties dialog.

• When you have a video file in a format not supported by 
Cubase LE, use an external application to convert the file 
to a format that Cubase LE can import.

! Trying to import or play back a file not supported by 
the selected video player leads to unpredictable re-
sults – if no information on the number of frames, the 
length and the pixel resolution is available in the Im-
port Video dialog or the Pool, you cannot import/play 
this file properly with this particular video player.

! You can change the video player in the Device Setup 
dialog. After having done so, make sure to remove 
any previously imported video file from the Pool first, 
and re-import it.
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Operations

About the video playback engine
In Cubase LE for Windows, you select a playback engine 
in the Device Setup–Video Player page:

• Make sure to read the section “Before you start” on 
page 232.

• Generally, you can expect most Windows hardware to 
work with DirectShow.
On a Windows system, the DirectShow and Video for Windows players 
are provided by the operating system, so you don’t have to install any ad-
ditional software.

• Under Windows, QuickTime must be installed on your 
computer for Quicktime playback to be available.
There is a freeware version (a QuickTime installer is included on the Cu-
base LE DVD if required, or you can download it from www.quick-
time.com) and a “pro” version, which offers additional video cutting 
options. The player engine is the same in both versions, so for mere play-
back in Cubase LE there is no need to purchase the “pro” version.

• Under Mac OS X, only the Quicktime playback engine is 
available, supporting the formats AVI, MPEG, QuickTime 
and DV. If your system has a FireWire port, there is also a 
FireWire option – see below.

Importing a video file
Video files are imported in the same manner as audio files.

• By using the File menu (Import–Video File).

• By using drag and drop from the Windows Explorer/
Mac OS Finder or the Pool.
This requires that a video track has been added to the Project and that 
you drop the video file onto this track.

• By importing the file to the Pool first and then dragging 
it into the Project window (see the chapter “The Pool” on 
page 129 for details).

Note:

• You can only have one video track in each project. The Video 
track is added like other tracks in the Project window by using 
the Add Track submenu on the Project menu. If a project does 
not contain a video track when you import a video file via File–
Import–Video file, this is added automatically.

• All video files on the track must be of the same size and com-
pression format.

Video import preferences

In the Preferences dialog (Editing–Video page), there is 
an option that affects the import of video files:

• Generate Thumbnail Cache on Import Video File
When this is activated, a thumbnail cache file will be created automati-
cally when you import a video file. This is handy, as a cache file will also 
be created when you import a video file using drag and drop.

Advantage of thumbnail cache files

To display video thumbnails in the Project window, the 
option “Show Video Thumbnails” has to be activated in 
the Preferences dialog (Event Display–Video page).

When working with video in Cubase LE, video files are 
displayed as events/clips on the video track with thumb-
nails representing the frames in the film. These are calcu-
lated in real time, i.e. they have to be redrawn during 
scrolling or moving. As this consumes quite a lot of pro-
cessor power, reaction sometimes may be sluggish. To 
remedy this, you can generate a thumbnail cache file.

The cache file is used in situations where the processor 
load is very high and the correct redrawing or real-time 
calculation might use system resources necessary for ed-
iting or processing. When the cache file is used and you 
zoom in on the thumbnails, you will see that they are in a 
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lower resolution, i.e. the pictures are not as clean as when 
they are calculated. When the processes that rely heavily 
on the computer CPU are finished, the frames will be au-
tomatically recalculated, i.e. the program automatically 
switches between real-time calculation of the pictures and 
using the cache file.

The generated thumbnail cache file will be stored in the 
same folder as the video file and will get the name of the 
file with the suffix “.videocache”.

Generating thumbnail cache files during video import

A thumbnail cache file will be created automatically before 
the file is inserted in the Project window, if you activated 
“Generate Thumbnail Cache on Import Video File” in the 
Preferences (Editing–Video page). 

A window will be displayed, showing you the progress 
and the estimated time for the process.

The thumbnail cache file is created.

After the cache file is created, the window will be closed 
and the video clip is inserted as usual. When you now 
start video playback and perform processor consuming 
operations, the thumbnail file is used to display the video 
frames in the Project window. When enough processor 
power is available, the “real” calculated thumbnail frames 
are displayed again.

Generating thumbnail cache files from within the Pool

When you have video files without thumbnail cache files 
(e.g. if you did not create a thumbnail cache file during im-
port or if you are working with an older project), you al-
ways have the possibility to generate the thumbnail cache 
file at a later stage. This is done from within the Pool.

Proceed as follows:

1. Open the Pool window and locate the video file you 
want to create a thumbnail cache file for.

2. Right-click on the file to open the context menu and 
select “Generate Thumbnail Cache”, or select “Generate 
Thumbnail Cache” from the Media menu.
Just as when creating the file during import, the status window opens 
(see above).

After the file is created, the window will be closed and the 
thumbnail cache file is used when necessary, i.e. under 
high load.

Playing back a video file
Video files are displayed as events/clips on the video 
track, with thumbnails representing the frames in the film 
(if the option Show Video Thumbnails is activated in the 
Preferences, Event Display–Video page).

A video event on a video track.

In the track list and Inspector, you will find the control 
“Mute Video”. When this is activated, video playback will 
be stopped, but playback of any other events in the 
project will continue (to decrease the processor load).

To view the video on the computer screen (as opposed to 
on an external monitor, see below), proceed as follows:

• If you’re running Mac OS X, open the Device Setup dia-
log from the Devices menu, click “Video Player” in the list 
and make sure “Onscreen Window” is selected in the 
Video Output section of the dialog. 

• Under Windows, either pull down the Devices menu 
and select Video, or use a key command – by default [F8], 
or double-click the video clip.
A video window appears. In Stop mode, this displays the video frame at 
the project cursor position.

! Please note that the cache file will not be automati-
cally updated if a video file is edited. Whenever you 
change a video file (e.g. in a video editing applica-
tion), you need to create a new thumbnail cache file 
manually, as described above. (To refresh the “real” 
thumbnails of an edited video file, resize the video 
track so that they are calculated again.)
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The video will be played back together with any other 
events in the Project window as usual.

Setting the Window size

If you are playing back video in a window on your com-
puter screen, you may want to adjust the size. 

On a Mac, this is done by dragging the borders, just like 
resizing other windows.

Under Windows, proceed as follows:

• Open the Device Setup dialog from the Devices menu, 
click Video Player in the Devices list and use the buttons 
in the Video Properties section to select a size.

Playing back video in full screen mode

When viewing video on the computer screen, you can 
choose to let the video occupy the whole screen during 
playback or in Stop mode:

• Right-click in the video window to switch to full screen. 
Click again to exit full screen.

Playing back video file using graphics cards
(Windows only) 

Multi-head graphics cards that support overlay functional-
ity can be used to display the video picture on an external 
TV or computer monitor in full screen mode. The manufac-
turers nVIDIA and Matrox have working (and tested) solu-
tions available. Check the card’s documentation for 
information on how it handles video output and how to set 
it up for multi-monitor display.

Playing back a video via FireWire (Mac OS X only)

For Apple computers equipped with a FireWire port, you 
can easily connect external video hardware via this, as 
OS X has built-in video support for the most common for-
mats (NTSC/PAL/DVCPRO). FireWire is capable of high 
data-transfer speed and is the most common standard for 
communicating with video-related peripheral equipment.

• To play back a video file via hardware connected to the 
FireWire port, select “FireWire” in the Outputs pop-up of 
the Device Setup–Video Player dialog.
When FireWire is selected as output, a number of format options appear 
on the Format pop-up, allowing you to select between various video for-
mats and resolutions.

Video playback preferences
In the Preferences (Event Display–Video page), there are 
two options for video playback:

• Show Video Thumbnails.
When this is activated, thumbnail frames of the video contents are shown 
in the track.

• Video Cache Size.
This determines how much memory is available for video thumbnails. If 
you have long video clips and/or work with a large zoom factor (so that a 
lot of frames are shown in the thumbnails), you may have to raise this 
value.
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Working with Projects

New Project
The New Project command on the File menu allows you to 
create a new project, either empty or based on a template:

1. Select New Project from the File menu.
A list of templates is displayed. When you install Cubase LE, templates 
for various purposes are included, but you can also create your own (see 
“Save as Template” on page 238).

2. Select a template from the list or select “Empty”.
A file dialog opens, allowing you to specify a folder for the new project.

3. Select an existing project folder or click on Create and 
enter a name for a new one in the dialog that opens.
A new, untitled project is created.

Open
The Open command on the File menu is used for opening 
saved project files.

1. Select “Open...” from the File menu.
A file dialog opens, allowing you to select a project.

2. Click Open.
The project opens in the Project window.

• Several projects can be open at the same time.
The active project is indicated by the blue Activate button in the upper 
left corner of the Project window. To make another project active, click 
its Activate button.

An active project.

• You can also open project files by selecting an entry 
from the “Recent Projects” submenu on the File menu.
This submenu lists the projects you have recently worked with, with the 
most recent one at the top of the list.

• Projects can also automatically be opened when you 
launch Cubase LE (see “Startup Options” on page 239).

About the “Pending Connections” dialogs

If you open a Cubase LE project created on another setup 
(other audio hardware), the program tries to find matching 
audio inputs and outputs for the i/o busses (this is one of 
the reasons why you should use descriptive, generic names 
for your input and output ports – see “Preparations” on 
page 10).

If the program cannot resolve all audio/MIDI inputs and 
outputs used in the project, a Pending Connections dialog 
will open. This will allow you to manually re-route any ports 
specified in the project to ports available in your system.

Close
The Close command on the File menu closes the active 
window. If a Project window is active, selecting Close will 
close the corresponding project.

• If the project contains unsaved changes, you will be 
asked whether you want to save the project before closing 
it.
If you select “Don’t Save” and have recorded or created new audio files 
since saving, you get the choice to delete or keep these.

Save and Save As
The commands Save and Save As allow you to save the 
active project as a project file (file extension “.cpr”). The 
Save command stores the project under its current name 
and location, while Save As allows you to rename and/or 
relocate the file. In case you haven’t yet saved the project 
or it hasn’t been changed since it was last saved, only 
Save As will be available.

A word about file extensions

Under Windows, file types are indicated by three letter file 
name extensions (such as *.cpr for Cubase LE project files). 

Under Mac OS X, it is not necessary to use file name ex-
tensions, since the file types are stored internally in the 
files. However, if you want your Cubase LE projects to be 
compatible with both platforms, you should make sure the 

! Generally, we recommend that you save project files 
in their project folders, to keep the projects as 
manageable as possible.
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option “Use File Extension in File Dialog” is activated in 
the Preferences (General page). When this is activated 
(default), the proper file name extension is automatically 
added when you save a file.

Save New Version
This function is only available as a key command, by de-
fault [Ctrl]+[Alt]+[S] (Windows) or [Command]+[Op-
tion]+[S] (Mac). When you use this function, a new 
version of the project is saved under a new file name. 

The new file will have the same name as the original project, 
but with an incremental number attached. For example, if 
your project is called “My Project”, you will get new versions 
called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with 
edits and arrangements and want to be able to go back to 
a previous version at any time. The newest versions are al-
ways listed on the Recent Projects submenu on the File 
menu for instant access.

Save as Template
This function allows you to save the current project as a 
template. When you create a new project, the available 
templates will be listed, allowing you to base the new 
project on a template.

Proceed as follows:

1. Set up a project.

2. Select “Save As Template...” from the File menu and 
save the project template with a name of your choice.

• Templates can contain clips and events just like regular 
projects.
If this is not what you want, make sure to remove all clips from the Pool 
before you save the project as template.

Templates are always stored in the Templates folder. 

On a Windows system, it is located at \Documents and 
Settings\<username>\Application data\Steinberg\Cu-
base LE 4\templates. On a Mac system, it is located inside 
Users/<username>/Library/Preferences/Cubase LE 4.

Setting up a default template

If you always want the same default project to open when 
you launch Cubase LE, you can save a default template. 
Proceed as follows:

1. Set up a project.

2. Select “Save As Template...” from the File menu and 
save the project template with the name “default”. 

3. Open the Preferences dialog and select the General 
page.

4. Open the “On Startup” pop-up and select the option 
“Open ’Default’ Template”.

The next time you launch Cubase LE, the default template 
is automatically opened. For details on the other Startup 
options, see “Startup Options” on page 239.

Save Project to New Folder
This function is very useful if you want to move or archive 
your project. 

1. Select “Save Project to New Folder”. 
A file dialog opens in which you can choose an existing, empty folder or 
create a new folder to save the project.

2. Click OK to confirm your choice.
The “Save to Folder Options” dialog opens with the following options:

Option Description

Project Name Enter a project name if you want to change it from the de-
fault (the current name of the project).

Minimize Audio 
Files

If this is activated, only the audio file portions that are ac-
tually used in the project will be included. This can signi-
ficantly reduce the size of the project folder (if you are 
using small sections of large files), but it also means you 
cannot use other portions of the audio files if you con-
tinue working with the project in its new folder.

Freeze Edits This will perform a Freeze Edits operation, making all pro-
cessing and applied effects permanent to each clip in the 
Pool, see “Freeze Edits” on page 105.

Remove 
Unused Files

When this is activated, only files in the Pool that are actu-
ally used in the project will be stored in the new folder.
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3. Make the desired settings.

4. Click OK. 
The project is saved in the new folder. The original project is not affected. 
However, now you could e.g. delete the original project without losing 
your project data.

Startup Options

Auto Save

If you activate the Auto Save checkbox in the Preferences 
(General page), Cubase LE will automatically save backup 
copies of all open projects with unsaved changes.

Backup copies of projects are named “<project name>-
xx.bak”, where xx is an incremental number. Unsaved 
projects are backed up in a similar way as “UntitledX-
xx.bak”, with X being the incremental number for unsaved 
projects. All backup files are saved in the project folder. 

• Use the “Auto Save Interval” option to set the time inter-
vals in which a backup copy will be created.

• Use the “Maximum Backup Files” option to specify how 
many backup files will be created with the Auto Save func-
tion.
When the maximum number of backup files is reached, the existing files 
will be overwritten (starting with the oldest file). 

On Startup
The “On Startup” pop-up menu in the Preferences (Gen-
eral page) allows you to specify what should happen each 
time you launch Cubase LE. 

The following options are available:

Cubase LE Open Document Options Dialog

This dialog will open in two cases:

• If you launch Cubase LE with the option “Show Open 
Options Dialog” selected on the “On Startup” pop-up 
menu in the Preferences (General page).

• If you hold down [Ctrl]/[Command] while launching Cu-
base LE.

Option Description

Do Nothing Cubase LE launches without opening a project.

Open Last 
Project

The last saved project is opened on launch.

Open ’Default’ 
Template

The default template is opened, see “Setting up a default 
template” on page 238.

Show Open 
Dialog

The Open dialog opens on launch, allowing you to manu-
ally locate and open the desired project.

Show Template 
Dialog

The Template dialog opens on launch, allowing you to 
create a new project from one of the templates.

Show Open 
Options Dialog

The Open Document Options dialog opens on launch, 
see below. It allows you to make a different choice each 
time you launch Cubase LE.
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The Open Document Options Dialog.

The dialog lists your recently used projects.

• To open a project, select it and click the “Open Selec-
tion” button. 

• To open another project not listed here, click the “Open 
Other...” button. 
A file dialog opens that allows you to look for the desired file on your disk. 

• To create a new project, click the “New Project” button.

Revert
If you select “Revert” from the File menu, you will be asked 
whether you really want to revert to the last saved version 
of the project. If you click “Revert”, all changes you have 
made since saving will be discarded.

If you have recorded or created new audio files since sav-
ing, you will be asked whether you want to delete or keep 
these.

Importing audio
For exporting Audio, see the chapter ““Export Audio 

Mixdown” on page 211”.

Importing audio files
For information on audio file import preferences, please 
see “Audio file import options” on page 26. For informa-
tion on import into the Pool and import options, see “Im-
port Medium...” on page 137.

Importing ReCycle files
ReCycle by Propellerhead Software is a program de-
signed especially for working with sampled loops. By 
“slicing” a loop and making separate samples of each 
beat, ReCycle makes it possible to match the tempo of a 
loop and edit the loop as if it was built of individual 
sounds. Cubase LE can import two file types created by 
ReCycle:

• REX files (export file format of the first versions of ReCycle, 
extension “.rex”).

• REX 2 files (file format of ReCycle 2.0 and later, extension 
“.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to 
where you want the imported file to start.
You probably want to import REX files to tempo based audio tracks, 
since this will allow you to change the tempo later on (having the im-
ported REX file automatically adjust).

2. Select “Audio File…” from the Import submenu on the 
File menu.

3. Select REX files or REX 2 files with the file type pop-
up menu in the file dialog.

4. Locate and select the file and click Open.
The file is imported and automatically adjusted to the current Cubase LE 
tempo. 

Unlike a regular audio file, the imported REX file will con-
sist of several events, one for each “slice” in the loop. The 
events will automatically be placed in an audio part on the 
selected track and positioned so that the original internal 
timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you 
can edit each slice separately by muting, moving and re-
sizing events, adding effects and processing, etc.
You can also adjust the tempo and have the REX file automatically follow 
(provided that its track is tempo based).

You can achieve similar results by using Cubase LE’s 
own loop slicing features, see “Working with hitpoints and 
slices” on page 122.
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Importing compressed audio files
Cubase LE can import several common audio compres-
sion formats. The procedure is the same as when import-
ing any non-compressed audio file, with one important 
thing to note:

• When you import a compressed audio file, Cubase LE 
will create a copy of the file and convert this to Wave for-
mat (Windows) or AIFF format (Mac OS X) before import-
ing it. The original compressed file will not be used in the 
project.

The imported file will be placed in the designated project 
Audio folder.

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is 
the name of a family of standards used for coding audio-
visual information (e. g. movies, video, music) in a digital 
compressed format. 

Cubase LE can read two types of audio MPEG files: 
MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Cur-
rently, mp3 is the most common of these formats, while 
the mp2 format is mostly used in broadcast applications.

Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by 
Microsoft Inc. Due to advanced audio compression algo-
rithms, Windows Media Audio files can be made very 
small, maintaining good audio quality. The files have the 
extension “.wma”.

Exporting and importing MIDI files
Cubase LE can import and export Standard MIDI Files, 
which makes it possible to transfer MIDI material to and 
from virtually any MIDI application on any platform. When 
you import and export MIDI files, you can also specify 
whether certain settings associated with the tracks should 
be included in the files (automation tracks, volume and 
pan settings etc.).

Exporting MIDI files
To export your MIDI tracks as a Standard MIDI File, pull 
down the File menu and select “MIDI File...” from the Ex-
port submenu. A regular file dialog opens, allowing you to 
specify a location and name for the file.

When you have specified a location and a name for the 
file, click “Save”. The Export Options dialog opens, allow-
ing you to specify a number of options for the file – what 
should be included in the file, its type and its resolution 
(see below for descriptions of the options).

The Export Options dialog.

You will also find these settings in the Preferences (MIDI–
MIDI File page). If you set these up once and for all in the 
Preferences, you only need to click OK in the Export Op-
tions dialog to proceed.

The dialog contains the following options:

! The resulting Wave/AIFF file will be several times 
larger than the original compressed file.

Option Description

Export Inspector 
Patch

If this is activated, the MIDI patch settings in the Inspec-
tor – Bank Select and Program Select (used for selecting 
sounds in the connected MIDI instrument) are included 
as MIDI Bank Select and Program Change events in the 
MIDI file.

Export Inspector 
Volume/Pan

If this is activated, Volume and Pan settings made in the 
Inspector are included as MIDI Volume and Pan events in 
the MIDI file.
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The MIDI file will include the Tempo track.

Inspector settings other than those specified in the Ex-
port options are not included in the MIDI file!

Importing MIDI files
To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File...” from the Import submenu on the 
File menu.

2. If there is already an open project, a dialog opens in 
which you can select whether a new project should be 
created for the file or not.
If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that 
opens and click Open.

• If you choose to create a new project, select the project 
folder.
Select an existing project folder or create a new by clicking on Create 
and entering a name in the dialog.

The MIDI file is imported. The result depends on the con-
tents of the MIDI file and the Import Options settings in the 
Preferences (MIDI–MIDI File page). The Import Options 
are as follows:

As mentioned in “Exporting MIDI files” on page 241, the 
result also depends on what type of MIDI file it is – Type 0 
or Type 1:

• If the MIDI file is of Type 0 (all data on a single track), 
only one MIDI track will be created.
This track will be set to MIDI Channel “Any”, allowing all MIDI events to 
play back on their original channels. You can use the Dissolve Part func-
tion on the MIDI menu to distribute the events onto different tracks with 
different MIDI Channels (see “Dissolving parts into separate channels” 
on page 160).

• If the MIDI file is of Type 1 (data on several tracks), a 
number of new MIDI tracks and parts will be created.

In both cases, the Tempo track is adjusted according to 
the Tempo track in the MIDI file.

Export 
Automation

If this is activated, recorded automation (see “Back-
ground” on page 91) is converted to MIDI controller 
events and included in the MIDI file.

Export as 
Type 0

If this is activated, the MIDI file will be of Type 0 (all data 
on a single track, but on different MIDI channels). If you 
don’t activate this option, the MIDI file will be of Type 1 
(data on separate tracks). Which type to choose de-
pends on what you want to do with the MIDI file (in which 
application or sequencer it should be used, etc.).

Export 
Resolution

You can specify a MIDI resolution between 24 – 960 for 
the MIDI file. The resolution is the number of pulses, or 
ticks, per quarter note (PPQ) and determines the preci-
sion with which you will be able to view and edit the MIDI 
data. The higher the resolution, the higher the precision. 
The resolution should be chosen depending on the appli-
cation or sequencer with which the MIDI file should be 
used though, since certain applications and sequencers 
may not be able to handle certain resolutions.

Export Locator 
Range

If this is activated, only the range between the locators 
will be exported. 

Export 
includes Delay

If this is activated, the delay of the MIDI track will be in-
cluded in the MIDI file.

Option Description

Option Description

Extract First 
Patch

If this is activated, the first Program Change and Bank 
Select events for each track are converted to Inspector 
settings for the track.

Extract First
Volume/Pan

If this is activated, the first MIDI Volume and Pan events 
for each track are converted to Inspector settings for the 
track.

Import Controller 
as Automation 
Tracks

If this is activated, MIDI controller events in the MIDI file 
will be converted to automation data for the MIDI tracks.

Import to Left 
Locator

If this is activated, the imported MIDI file will be placed so 
that it starts at the position of the left locator – otherwise 
it will start at the beginning of the project. Note that if you 
choose to have a new project created automatically, the 
MIDI file will always start at the beginning of the project.

Import dropped 
File as single 
Part

If this is activated and you drag and drop a MIDI file into 
the project, the whole file will be placed on a single track.

Ignore Master-
track Events on 
Merge

If this is activated and you import a MIDI file into the cur-
rent project, tempo track data in the MIDI file is ignored. 
The imported MIDI file will play according to the current 
Tempo track in the project.

! It is also possible to import a MIDI file from disk by 
dragging and dropping it from the Windows Explorer 
or the Mac OS Finder into the Cubase LE Project 
window. The Import Options apply as well.
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Background
The user can customize the appearance and functionality 
of Cubase LE in various ways.

User configurable items described in this chapter are:

• Setup dialogs
Several parts of the user interface (toolbars, Transport panel, Inspector, 
info lines and channel settings windows) provide a Setup dialog, where 
the user can configure which items of the respective window area or 
panel are to be shown or hidden and where they should be located.

• Appearance
The general look of the program can be adjusted – see “Appearance” on 
page 245.

• Track and event colors
You can adjust which colors should be used – see “Applying track and 
event colors” on page 245.

This chapter also contains a section describing where 
your preferences and settings are stored (see “Where are 
the settings stored?” on page 248), to help you transfer 
your customized settings to another computer.

The Setup dialogs
The following elements in the program feature Setup dia-
logs and context menus:

• the Transport panel
• the info lines
• the Channel Settings windows
• the toolbars 
• the Inspector

Customizing via the setup context menus
If you right-click the Transport panel, the toolbars, the info 
lines, or the Inspector, the respective setup context menu 
opens. For channel settings windows, these options are 
found in the Customize View submenu on the context 
menu. On this menu, you can activate or deactivate ele-
ments as desired.

The following general options are available in the setup 
context menus:

• “Show All” makes all items visible.

• “Default” resets the interface to the default setting.

• “Setup...” opens the Setup dialog (see below).

If presets are available, they can be selected from the 
lower half of the menu. 

The info line and Inspector setup context menus. In the Inspector setup 
context menu, the available options depend on the track type.

The channel settings setup context menu for a MIDI track. The available 
options depend on the track type.

Customizing via the Setup dialog
If you select “Setup…” from the setup context menus, the 
Setup dialog opens. Here you can:

• choose which elements (“items”) should be visible or hid-
den for the Transport panel, the toolbars or the Inspector.

• configure where the items should be placed.

• save and recall presets, i.e. different configurations.

The Setup dialog, e.g. for the Transport panel.
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The dialog is divided into two columns. The left column 
displays the currently visible items and the right column 
displays the currently hidden items.

• You can change the current show/hide status by select-
ing items in one column and then using the arrow buttons 
in the middle of the dialog to move them to the opposite 
column.
Changes are applied directly.

• By selecting items in the “Visible Items” column and us-
ing the Move Up and Move Down buttons, you can change 
the position of the selected item(s).
Changes are applied directly. To undo all changes and revert back to the 
standard layout, you can select “Default” from the setup context menu.

A “customized” Transport panel.

• If you click the Save button (disk icon) in the Presets 
section, a text field opens, allowing you to name the cur-
rent configuration and to save it as a preset
The saved setting will be displayed in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the 
Presets pop-up in the Setup dialog or directly from the 
setup context menu.

Appearance
In the Preferences dialog you will find a page called Ap-
pearance. The following settings are available:

• Basic Appearance Scheme.
By selecting an option from this pop-up menu you can adjust the general 
look of the program. After selecting an Appearance Scheme and clicking 
Apply or OK, you need to restart the program for the changes to take ef-
fect.

• Brightness/Intensity sliders.
These sliders allow you to fine-tune the brightness and contrast in vari-
ous areas in the program. Changes take effect when you click Apply or 
OK.

Applying track and event colors
You can use color scheming for easier overview of tracks 
and events in the event display of the Project window. Ap-
plying colors is divided into two areas; track and event 
colors.

• A track color is shown and can be edited in the Inspec-
tor, the Track list, and the corresponding channel in the 
Mixer. It is furthermore displayed in all parts and events for 
the track in the event display.
Track colors can be switched on and off globally.

• Event colors are shown for parts and events in the event 
display and are independent from the track colors.

An applied event color “overrides” the track color, if 
both are used.

The palette of the color bar can be customized, see “The 
Event Colors dialog” on page 247.

Track colors

Applying track colors manually

To activate track colors, proceed as follows:

1. Click the Show/Hide Track Colors button at the top of 
the Track list.

This brings up the track color selector in the Inspector, the 
Track list and in the Mixer.

2. To bring up the color palette, click the track color se-
lector.

Click the arrow in the track name title bar or…

…click the color strip in the Track list.
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In the Mixer, click the track color selector below the channel name.

3. Select a color from the color bar.
The chosen track color is now reflected in the Inspector title bar and the 
color strip as well as in the Mixer and any parts or events on the selected 
track.

Applying track colors automatically

In the Preferences (Editing–Project & Mixer page) you can 
find the option “Auto Track Color Mode”.

This offers you several options for automatically assigning 
colors to tracks that are added to the project.

Coloring parts and events
There are two ways to color parts and events in the 
Project window:

Using the color selector

1. Select parts or events.

2. Choose a color from the color selector in the toolbar.

Using the color tool

1. Select the color tool (the paint bucket icon). 

2. Click the small strip below it to bring up the color pal-
ette.

3. Choose a color. 

4. Click on a part/event to assign the color. 

The color is applied to all selected parts/events and over-
rides the track color (if used).

• If you press [Ctrl]/[Command] and click on a part/event 
with the color tool, the color palette is displayed and you 
can choose the desired color for an event.

• If you press [Alt]/[Option], the color tool cursor be-
comes a pipette, which can be used to select a color by 
clicking on a part/event.

Customizing the event background

On the Event Display page in the Preferences, you can 
find the option “Colorize Event Background”.

Option Effect

Use Default 
Event Color

The default color (gray) is assigned. 

Use Previous 
Track Color

Uses the color of the track above the new one (i.e. the 
track that is selected when you add a new track).

Use Previous 
Track Color +1

Uses the color next to the color of the track above the 
new one (+1 refers to the color number in the palette).

Use Last 
Applied Color

The last manually assigned color is used. 

Use Random 
Track Color

Track colors are assigned randomly.
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This option affects the display of events in the project win-
dow.

• When this is activated, the background of the events 
and parts in the event display will be shown in the se-
lected color.

• When this is deactivated, the event “content”, i.e. MIDI 
events, audio waveforms, etc. will be displayed in the se-
lected color and the event background will be displayed in 
gray. 

The Event Colors dialog
You can open the Event Colors dialog in two ways: 

• Double-click the small strip below the color tool. 

• Open the Color pop-up menu on the toolbar and select 
“Select Colors…”.

In the Event Colors dialog, you can fully customize the 
color palette, apart from the default color (gray).

To add new colors to the color palette, proceed as follows:

1. Click the Insert New Color button in the Event Colors 
section to add a new color.
A new color icon and color name are added to the Event Colors section.

2. Click the color field next to the name field to activate 
the new color for editing.

3. In the Standard Colors section, choose a standard 
color. You can modify the selected color by:
• Moving to another point in the color circle.
• Moving the handle in the color meter.
• Manually entering the values for red, green and blue and hue, 

saturation and luminosity.

4. Click the Apply button in the Standard Colors section. 
The color setting is applied to the selected color item. 

You can edit every existing event color accordingly.

• To delete an event color item, select it and click the Re-
move Selected Color button in the Event Colors section.

• To increase or decrease the intensity and the brightness 
of all colors, use the corresponding buttons in the Event 
Colors section.

• To save the current set as default, click the button “This 
set as default set” in the Event Colors section. Accord-
ingly, click the button “Use default set” to the right to ap-
ply the saved default set.

• To return to the standard setting of the palette in Cu-
base LE, click Reset.

Remove 
new color

Increase/decrease in-
tensity for all colors

This Set as 
Default Set

Increase/decrease 
brightness for all colors

Insert
new color

Use Default 
Set
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Where are the settings stored?
As you have seen, there are a large number of ways in 
which you can customize Cubase LE. While some of the 
settings you make are stored in each project, others are 
stored in separate preference files.

If you need to transfer your projects to another computer 
(e.g. in another studio), you can bring all your settings 
along by copying the desired preference files and install-
ing them on the other computer.

It’s a good idea to make a backup copy of your prefer-
ence files once you have set things up the way you want!
This way, if another Cubase LE user wants to use his or her personal set-
tings when working on your computer, you can restore your own prefer-
ences afterwards.

• Under Windows, preference files are stored in the 
folder “\Documents and Settings\<user name>\Applica-
tion Data\Steinberg\Cubase LE 4\”.
On the Start menu, you will find a shortcut to this folder for easy access.

• Under Mac OS X, preference files are stored in the 
folder “Library/Preferences/Cubase LE 4/” under your 
home directory.
The full path would be: “/Users/<user name>/Library/Preferences/
Cubase LE 4/”.

RAMpresets.xml is saved when exiting the program. 

Program functions or configurations not used in the 
project will not be stored.

The table below shows the location and name of each 
preference file:

Setting Stored in

Current edit 
modifier keys

Edit Modifiers.xml

Current key 
commands

Key Commands.xml

Current 
preferences 

Defaults.xml

Color setup saved in the project

Default Color 
setup

Defaults.xml

Crossfade 
presets

\Presets\RAMPresets.xml

Drum maps \DrumMaps as *.drm file

Installed MIDI 
devices

Midi Devices.bin

Key commands 
presets

\Presets\KeyCommands\<Preset Name>.xml

Logical Editor 
presets

\Presets\Logical Edit\<Preset Name>.xml

Mixer (or channel) 
settings

saved in the last active folder as *.vmx file (VST Mixer 
settings)

Mixer view 
preset

saved in project

Patch name 
scripts

\Scripts\Patchnames\ as *.txt file

Port Input/
Output settings

Port Setup.xml

Quantize 
presets

\Presets\RAMPresets.xml

Toolbar presets \Presets\RAMPresets.xml

Transport panel 
presets

\Presets\RAMPresets.xml

Usage profile
log

Usage Profile.xml (only saved if the corresponding 
option in the Preferences is activated)

User templates Under Programs\Steinberg\Cubase LE 4\templates\
<Template Name>.cpr

VST connections 
presets

\Presets\RAMPresets.xml

VST 3 plug-ins 
and instruments

VstPlugInfo.xml

VST 2 plug-ins 
and instruments

Vst2xPlugins.xml

Not loadable 
VST2 plug-ins

Vst2xBlacklist.xml

VST3 presets
(included in the 
program)

In the application folder under 
\VST3 Presets\<company>\<plug-in name>
as *.vstpreset file

VST3 presets 
(user-defined, 
for all programs)

Win: \Common files\VST3 Presets\<company>\
<plug-in name>
Mac: Users/<user name>/Library/Audio/Presets/
<company>/<plug-in name>
as *.vstpreset file

VST3 presets 
(public, for all pro-
grams)

Win: \Documents and Settings\VST3 Pre-
sets\<company>\<plug-in name>
Mac: (Network)/Library/Audio/Presets/<company>/
<plug-in name>
as *.vstpreset file

Zoom presets \Presets\RAMPresets.xml

Setting Stored in
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Background

Introduction
Most of the main menus in Cubase LE have key command 
shortcuts for certain items on the menus. In addition, there 
are numerous other Cubase LE functions that can be per-
formed via key commands. These are all default settings. If 
you want, you can customize existing key commands to 
your liking, and also add commands for menu items and 
functions currently not assigned any.

How are key commands settings saved?

Every time you edit or add any key command assignment, 
this is stored as a global Cubase LE preference – not as 
part of a project. Hence, if you edit or add a key command 
assignment, any subsequent projects that you create or 
open will use these modified settings. However, the de-
fault settings can be restored at any time by selecting “Re-
set All” in the Key Commands dialog.

In addition, you can save key commands settings as a “key 
commands file”, which is stored separately and can be im-
ported into any project. This way you can quickly and easily 
recall customized settings, when moving projects between 
different computers, for example. The settings are saved in 
a file on disk with the windows extension “.xml”.

How to save key commands settings is described in the 
section “About key commands presets” on page 252.

Setting up key commands
The following is a description of how you set up key com-
mands and save them as presets for easy access.

Key commands settings are accessed and edited mainly 
in the Key Commands dialog. You can find some key com-
mand settings in the Preferences dialog as well, also ad-
dressed in this chapter.

Adding or modifying a key command

In the Key Commands dialog you will find all main menu 
items and a large number of other functions, arranged in a 
hierarchical way similar to that of the Windows Explorer 
and Mac OS Finder. The function categories are repre-
sented by a number of folders, each containing various 
menu items and functions. When you open a category 
folder by clicking the plus-sign beside it, the items and 
functions it contains are displayed with the currently as-
signed key commands.

To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to 
the desired category.

3. Click the plus sign to open the category folder and 
display the items it contains.
Note that you can also click the “global” plus and minus signs in the top 
left corner to open and close all category folders at once.

! You can also assign tool modifier keys, i.e. keys that 
change the behavior of various tools when pressed. 
This is done in the Preferences dialog – see “Setting 
up tool modifier keys” on page 253.
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4. In the list, select the item to which you wish to assign a 
key command.
Already assigned key commands are shown in the Keys column as well 
as in the Keys section in the top right corner.

5. Alternatively, you can use the search function in the 
dialog to find the desired item.
For a description of how to use the search function, see “Searching for 
key commands” on page 251.

6. When you have found and selected the desired item, 
click in the “Type in Key” field and enter a new key com-
mand.
You can choose between any single key or a combination of one or sev-
eral keys ([Command], [Option] (Mac), [Ctrl], [Alt] (Win), [Shift]) plus any 
key. Just press the keys you want to use.

7. If the key command you entered is already assigned to 
another item or function, this is displayed below the “Type 
in Key” field.

In case a key command already is assigned to another function, you can 
either ignore this and proceed to assign the key command to the new 
function instead, or you can select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

Note that you can have several different key commands for 
the same function. So adding a key command to a function 
that already has another key command will not replace the 
key command previously defined for the function. If you 
wish to remove an assigned key command, please see 
“Removing a key command” on page 251.

9. Click OK to exit the dialog.

Searching for key commands
If you want to know which key command is assigned to a 
certain function in the program, you can use the Search 
function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog 
and type in the function for which you want to know the key 
command.
This is a standard word search function, so you should type the command 
as it is spelled in the program. Partial words are OK; e.g., to search for all 
quantize related commands, you could type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
The search is conducted and the first matching command is selected 
and displayed in the commands list below. The keys column and the keys 
list show the assigned key commands, if any.

3. To search for more commands containing the word(s) 
you entered, just press the Search button again.

4. When you’re done, click OK to close the dialog.

Removing a key command
To remove a key command, proceed as follows:

1. If the key commands dialog isn’t already open, pull 
down the File menu and select “Key Commands…”.

2. Use the list of categories and commands to select the 
item or function for which you wish to remove a key com-
mand.
The key command for the item is shown in the Keys list and the Keys 
column.

3. Select the key command in the Keys list and click the 
Remove button (the trash icon).
You will get a prompt asking if you want to remove the key command or 
cancel the operation.

4. Click OK to close the dialog.! If the key command you enter is already assigned to 
another function, you will get a prompt asking if you 
want to reassign the command to the new function 
instead, or cancel the operation.

If a selected item or function has a key command 
assigned already, it is displayed here… …and here.
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About key commands presets

Saving key commands presets

As mentioned above, any changes made to the key com-
mands are automatically stored as a Cubase LE prefer-
ence. However, it is also possible to store key commands 
settings separately. This way, you can store any number of 
different key command settings as presets for instant re-
call.

Proceed as follows:

1. Set up the key commands to your liking.
When setting up key commands, remember to click “Assign” to make the 
changes.

2. Click the Save button next to the Presets pop-up 
menu.
A dialog appears, allowing you to type in a name for the preset. 

3. Click OK to save the preset.
Your saved key commands settings will now be available in the Preset 
pop-up menu for your future projects.

Loading key command presets

To load a key command preset, simply select it from the 
Presets pop-up menu.

Note that this operation may replace existing key com-
mands!
The key command settings you load will replace the current key command 
settings for the same functions (if any). 
If you want to be able to revert to your current settings again, make sure to 
save them first, as described above!

Loading saved key commands settings from Cubase SX 1

If you have saved key commands settings with version 1 of 
Cubase, it is possible to use them in Cubase LE, by using 
the “Import Key Command File” function, which lets you 
load and apply saved key commands:

1. Open the Key Commands dialog.

2. Click the “Import Key Command File” button to the 
right of the Presets pop-up menu.
A standard file dialog opens.

3. In the file dialog, use the “Files of type:” pop-up to 
specify if you want to import a key commands file (Win-
dows file extension “.key”).
With version 2 of Cubase, key commands files with the Windows exten-
sion “.xml”. So after you have imported an older file, you might want to 
save it as a preset (see “About key commands presets” on page 252) to 
be able to access it from the Presets pop-up menu in the future.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply 
the imported settings.
The settings in the loaded key commands file now replace the current 
settings.

About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both 
restore the default settings. The following rules apply:

• “Reset” restores the default key command setting for 
the function selected in the Commands list.

• “Reset All” will restore the default key commands for all 
commands.

About the default key commands
As mentioned before, there are numerous default key 
commands. These are listed in the section “The default 
key commands” on page 253.

! Note that the “Reset All” operation will cause any 
changes made to the default key commands to be 
lost! If you want to be able to revert to these settings 
again, make sure to save them first!
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Setting up tool modifier keys
A tool modifier key is a key you can press to get an alter-
nate function when using a tool. For example, clicking and 
dragging an event with the Arrow tool normally moves it – 
holding down a modifier key (by default [Alt]/[Option]) will 
copy it instead.

The default assignments for tool modifier keys can be 
found in the Preferences (Editing–Tool Modifiers page).

Here, you can also edit them:

1. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Cubase LE menu) and se-
lect the Editing–Tool Modifiers page.

2. Select an option in the Categories list, and then locate 
the action for which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category 
“Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the 
Assign button.
The current modifier key(s) for the action is replaced. If the modifier 
key(s) you pressed are already assigned to another tool, you will be 
asked whether you want to overwrite them. If you do, this will leave the 
other tool without any modifier key(s) assigned.

5. When you’re done, click OK to apply the changes and 
close the dialog.

The default key commands
Below, the default key commands are listed according to 
category.

• As described in the section “Key command conventi-
ons” on page 8, modifier keys are written as: 
[Win modifier key]/[Mac modifier key].
For example, “[Ctrl]/[Command]+[N]” in the list below means 
“press [Ctrl] under Windows or [Command] under Mac OS X, 
then press [N]”.

Audio category

Devices category

Edit category

Option Key command

Adjust Fades to Range [A]

Crossfade [X]

Find Selected in Pool [Ctrl]/[Command]+[F]

Option Key command

Mixer [F3]

Video [F8]

VST Connections [F4]

VST Performance [F12]

Option Key command

Autoscroll [F]

Copy [Ctrl]/[Command]+[C]

Cut [Ctrl]/[Command]+[X]

Cut Time [Ctrl]/[Command]+[Shift]+[X]

Delete [Del] or [Backspace]

Delete Time [Shift]+[Backspace]

Duplicate [Ctrl]/[Command]+[D]

Insert Silence [Ctrl]/[Command]+[Shift]+[E]

Left Selection Side to Cursor [E]

Move to Cursor [Ctrl]/[Command]+[L]

Mute [M]

Mute Events [Shift]+[M]

Mute/Unmute Objects [Alt]/[Option]+[M]

Open Default Editor [Ctrl]/[Command]+[E]

Open List Editor [Ctrl]/[Command]+[G]
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Editors category

File category

MIDI category

Navigate category

Nudge category

Open Score Editor [Ctrl]/[Command]+[R]

Open/Close Editor [Return]

Paste [Ctrl]/[Command]+[V]

Paste at Origin [Alt]/[Option]+[V]

Paste Time [Ctrl]/[Command]+[Shift]+[V]

Record Enable [R]

Redo [Ctrl]/[Command]+[Shift]+[Z]

Repeat [Ctrl]/[Command]+[K]

Right Selection Side to Cursor [D]

Select All [Ctrl]/[Command]+[A]

Select None [Ctrl]/[Command]+[Shift]+[A]

Snap On/Off [J]

Solo [S]

Split At Cursor [Alt]/[Option]+[X]

Split Range [Shift]+[X]

Undo [Ctrl]/[Command]+[Z]

Unmute Events [Shift]+[U]

Option Key command

Show/Hide Infoview [Ctrl]/[Command]+[I]

Show/Hide Inspector [Alt]/[Option]+[I]

Option Key command

Close [Ctrl]/[Command]+[W]

New [Ctrl]/[Command]+[N]

Open [Ctrl]/[Command]+[O]

Quit [Ctrl]/[Command]+[Q]

Save [Ctrl]/[Command]+[S]

Save As [Ctrl]/[Command]+[Shift]+[S]

Save New Version [Ctrl]/[Command]+[Alt]/[Option]+[S]

Option Key command

Quantize [Q]

Option Key command

Option Key command

Add Down:
Expand/Undo selection in the 
Project window to the bottom/ 
Move selected event in the 
Key Editor down 1 octave

[Shift]+[Down Arrow]

Add Left:
Expand/Undo selection in the Project 
window/Key Editor to the left

[Shift]+[Left Arrow]

Add Right:
Expand/Undo selection in the Project 
window/Key Editor to the right

[Shift]+[Right Arrow]

Add Up:
Expand/Undo selection in the 
Project window to the top/
Move selected event in the Key 
Editor up one octave

[Shift]+[Up Arrow]

Bottom
Select bottom track in the track list

[End]

Down:
Select next in the Project window/
Move selected event in the Key Edi-
tor one semitone down

[Down Arrow]

Left:
Select next in the Project window/
Key Editor

[Left Arrow]

Right: 
Select next in the Project window/
Key Editor

[Right Arrow]

Top: 
Select top track in the track list

[Home]

Up:
Select next in the Project window/ 
Move selected event in the Key 
Editor one semitone up

[Up Arrow]

Option Key command

End Left [Alt]/[Option]+[Shift]+[Left Arrow]

End Right [Alt]/[Option]+[Shift]+[Right Arrow]

Left [Ctrl]/[Command]+[Left Arrow]

Right [Ctrl]/[Command]+[Right Arrow]

Start Left [Alt]/[Option]+[Left Arrow]

Start Right [Alt]/[Option]+[Right Arrow]
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Key commands

Project category

Tool category

Transport category

Option Key command

Open Markers [Ctrl]/[Command]+[M]

Open Tempo Track [Ctrl]/[Command]+[T]

Open/Close Pool [Ctrl]/[Command]+[P]

Setup [Shift]+[S]

Show/Hide Track Colors [Shift]+[C]

Option Key command

Delete tool [5]

Draw tool [8]

Drumstick tool [0]

Glue tool [4]

Mute tool [7]

Next Tool [F10]

Play tool [9]

Previous Tool [F9]

Range tool [2]

Select tool [1]

Split tool [3]

Zoom tool [6]

Option Key command

AutoPunch In [I]

AutoPunch Out [O]

Cycle Pad [/]

Exchange time formats [.]

Fast Forward [Shift]+Pad [+]

Fast Rewind [Shift]+Pad [-]

Forward Pad [+]

Input Left Locator [Shift]+[L]

Input Position [Shift]+[P]

Input Right Locator [Shift]+[R]

Input Tempo [Shift]+[T]

Insert Marker [Insert] (Win)

Locate Next Event [N]

Locate Next Marker [Shift]+[N]

Locate Previous Event [B]

Locate Previous Marker [Shift]+[B]

Locate Selection [L]

Locators to Selection [P]

Loop Selection [Shift]+[G]

Metronome On [C]

Nudge Down [Ctrl]/[Command]+Pad [-]

Nudge Up [Ctrl]/[Command]+Pad [+]

Panel (Transport panel) [F2]

Play Selection Range [Alt]/[Option]+[Space]

Recall Cycle Marker 1 to 9 [Shift]+Pad [1] to Pad [9]

Record Pad [*]

Retrospective Record [Shift]+Pad [*]

Return to Zero Pad [.] or Pad [,]

Rewind Pad [-]

Set Left Locator [Ctrl]/[Command]+Pad [1]

Set Marker 1 [Ctrl]/[Command]+[1]

Set Marker 2 [Ctrl]/[Command]+[2]

Set Marker 3 to 9 [Ctrl]/[Command]+Pad [3] to [9] or
[Ctrl]/[Command]+ [3] to [9]

Set Right Locator [Ctrl]/[Command]+Pad [2]

Start [Enter]

Start/Stop [Space]

Stop Pad [0]

Sync Online [T]

To Left Locator Pad [1]

To Marker 1 [Shift]+[1]

To Marker 2 [Shift]+[2]

To Marker 3 to 9 Pad [3] to [9] or [Shift]+[3] to [9]

To Right Locator Pad [2]

Option Key command
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Key commands

Zoom category
Option Key command

Zoom Full [Shift]+[F]

Zoom In [H]

Zoom In Tracks [Alt]/[Option]+[Down Arrow]

Zoom Out [G]

Zoom Out Tracks [Alt]/[Option]+[Up Arrow] or
[Ctrl]/[Command]+[Up Arrow]

Zoom to Event [Shift]+[E]

Zoom to Selection [Alt]/[Option]+[S]

Zoom Tracks Exclusive [Z] or [Ctrl]/[Command]+
[Down Arrow]



Index
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Index

A
ACID® loops 119
Activate Next/Previous Part 167
Activate project button 237
Active ASIO Ports for Data only 228
Active Part 167
Active Staff 194
Add Track 25
Adding busses 11
Adjust Fades to Range 59
Advanced Quantize 159
Aftertouch

Deleting 181
Editing 179
Recording 53

AIFF files 213
Alt/Option key 8
Alternative Key Sets 253
Always Send Start Message 220
Any (MIDI channel setting) 52
APP

Introduction to 222
Setting up 221

Appearance 245
Archiving 139
ASIO 2.0 49
ASIO Direct Monitoring 49
ASIO Positioning Protocol

Introduction to 222
Setting up 221

Audio channels
Copying settings 85
Making settings for 83
Mixing down to file 212
Saving settings 88

Audio clips
About 101
Creating new versions 132
Deleting 133
Locating events 134
Managing in Pool 132
Opening in the Sample Editor 137

Audio effects
Automating 95
Selecting VST Presets 143
Using VST System Link 230

Audio events
Blue handles 59
Editing in Sample Editor 107
Fade handles 59
Making selections in 110
Slicing 127
Volume handles 60

Audio files
Converting 140
Deleting permanently 133
Exporting 212
Format for recording 47
Formats 137
Import options 26
Importing into Pool 137
Importing into Project window 26
Locating missing 136
Reconstructing missing 136
Removing missing 136

Audio loops
Determining the tempo 119

Audio parts
About 15
Creating by gluing events 31
Creating from events 27
Drawing 27
Editing in Audio Part Editor 114
Sliding contents 32

Audio Warp
Realtime pitch shifting 121
Settings pop-up 120

Audition icon
Sample Editor 109

Auditioning
Audio Part Editor 116
MIDI editors 171
Project window 27
Sample Editor 109

Auto Fades 64
Auto Monitoring modes 48
Auto Quantize 53
Auto Quantize (Score Editor) 195
Auto Save 239
Auto Select Events under Cursor

MIDI editors 173
Project window 28

Automatic MIDI Record Quantize 53

Automation
About 91
Opening automation tracks 92
Reduction Preference 99
Showing and hiding 92
Write/Read buttons 94

Automation events
About 96
Drawing 97
Editing 97
Removing 98
Selecting 98

Automation follows Events 
(Option) 94

Automation Reduction Level 99
Automation tracks

Assigning parameters to 93
Hiding and showing 94
Muting 94

Autoscroll 38, 171

B
Backup (.bak) files 239
Bars+Beats Linear

MIDI editors 169
Tempo Track Editor 207

Basic Appearance Scheme 245
Bounce (Export Audio) 212
Bounce Selection

Project window 33
Sample Editor 112

Brightness 245
Busses

About 10
Adding 11
Mixing down to file 212
Routing to and from 12
Viewing in the mixer 12

C
Calculate Hitpoints 124
Channel (MIDI) 51
Channel setting

MIDI 52
Channel Settings

Audio tracks 83
Copying 85
MIDI tracks 87
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Channel Settings windows
Customizing 244

Channel view sets 78
Chase 43
Chord Recognition 169
Clean Lengths 196
Cleanup 240
Clef 195
Click 56
Clips, see “Audio clips”
Close 237
Close Gaps 128
Color pop-up menu

MIDI editors 171
Project window 25

Color tool 25
Colorize Event Background 24
Conform Files 140
Constrain Delay Compensation 145
Controller display

About 169
Adding and removing lanes 177
Controller lane presets 178
Editing events 179
Editing velocity 178
Selecting event type 177

Controller Lane Editing - Select Tool
defaults to Pen 178, 180

Controllers
Deleting 181
Editing 179
Recording 53

Convert Files 140
Convert to Real Copy 30
Converting MIDI to CC track

automation 164
Count-in 56
Cpr files 237
Create Audio Images During 

Record 49
Create new controller lane 177
Create slices 127
Crop 37

Crossfades
Creating 62
Editing in dialog 63
Presets 64
Removing 62

Csh files 139
Ctrl/Command key 8
Cursor, see “Project cursor”
Cut Time 36
Cycle

About 42
About recording 46
Recording audio 50
Recording MIDI 53

Cycle markers
About 71
Adding in Marker window 71
Drawing 73
Editing 73
Making selections with 74
Navigating to 73
On Marker track 72

Cycle Record modes 53

D
DC Offset 105
Deactivate Punch In on Stop 55
Default Edit Action 166
Default MIDI editor 166
Default Output Bus 11
Default template 238
Delay compensation

Constraining 145
Delete

Audio files from disk 133
Events in Project window 33
MIDI controllers 162, 181
MIDI drum notes 184
MIDI notes 176

Delete Continuous Controllers 162
Delete Controllers function 162
Delete Doubles function 162
Delete Notes function 162
Delete Overlaps

Mono (MIDI) 163
Poly (MIDI) 163

Delete Overlaps (Audio) 34

Delete Time 36
Device Ports

Selecting for busses 11
Setting up 10

DirectShow 233
Disable Hitpoints 126
Disable Track 42
Display format 20
Display Quantize 195
Display Transpose 196
Dissolve Part

Audio 27
MIDI 160

Divide audio events 128
Drag Delay 29
Draw

In Sample Editor 112
Markers 73
MIDI controllers 179
MIDI notes 172
Parts 27

Drop Out Frames 223
Drum Editor

Creating and editing notes 183
Muting drum sounds 184
Selecting drum maps 187

Drum maps
About 185
Making settings 185
MIDI channel and output 187
Selecting 187
Setup dialog 187

Drum name lists 188
Drum Sound Solo 184
Drumstick tool 183
Duplicate

Events and parts 30
MIDI notes 174

Duplicate track 25
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E
Edit Active Part Only 167
Edit as Drums when Drum Map is

assigned 166
Edit button

Audio channel strips 83
Audio track Inspector 17
MIDI channel strips 87
MIDI track Inspector 148

Editing via MIDI 176
Edits folder 101
Elements (Sample Editor) 107
Enable Record on Selected Track 45
Enable Solo on Selected Track 33
Enable Track 43
Enharmonic Shift 199
Enlarge Selected Track 23
Envelope

Process 102
EQ

Bypassing 85
Setting 84

Eraser tool 33
Events

Color 25
Duplicating 30
Moving 29
Muting 33
Overlapping in audio part 115
Overlapping in Project window 29
Removing 33
Renaming 30
Renaming all on track 25
Resizing 31
Resizing with time stretch 32
Selecting 28
Sliding contents 32
Splitting 31

Events (Snap mode) 38
Events to Part 27
Exclusive Solo 81
Export Audio Mixdown 212
Export MIDI files 241
Export Options (MIDI files) 241
Extract MIDI Automation 164

F
Fade handles 59
Fade In/Out functions 60
Faders 80
Fades

Auto Fades 64
Creating 59
Editing in dialog 60
Presets 61
Processing 60
Removing 60

Fill Loop 30
Filter (MIDI) 55
Filter bar 191
Find missing files 136
Find Selected in Pool 134
FireWire 235
Fixed Lengths 162
Fixed tempo 206
Fixed Velocity 164
Flip Stems 199
Folder parts 68
Folder tracks

About 67
Moving tracks into 67
Muting and soloing 67

Frame rates 219
Freeze Edits 105
Freeze Quantize 159
FX channel tracks

Mixing down to file 212

G
Gain

Process 103
Glue Tube tool

MIDI editors 175
Project window 31
Score Editor 199

Grid (Snap mode) 37
Grid Relative (Snap mode) 37
Group channel tracks

About 15
Routing audio to 86

H
Hitpoint Edit tool 126
Hitpoint Sensitivity 125
Hitpoints

About 123
Auditioning 125
Calculating 124
Disabling 126
Drawing 126
Editing manually 126
Locking 126
Moving 126

Horizontal Zooming Only 22

I
Import

Audio files 26
Medium in Pool 137
MIDI files 241
MPEG files 241
REX 240
Video files 26
WMA files 241

Info line
Drum Editor 182
Key Editor 168
Pool 131
Project window 19
Sample Editor 108
Score Editor 193

Info lines
Customizing 244

Inhibit Restart 224
Initialize Channel 86
I-Note 186
Input (MIDI) 51
Input busses

About 10
Adding 11
Routing to channels 12

Input levels 48
Inputs (Audio) 10
Insert into Project 135
Insert pop-up menu 190
Insert Silence

Project window 37
Sample Editor 111
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Index

Insert Velocities 173
Insert velocity (MIDI Editors) 172
Inspector

Audio tracks 18
Customizing 244
Folder tracks 18
General controls 17
Handling 17
MIDI tracks 147

Instrument tracks
About 141
Creating 142
Editing 143

Intensity (Appearance) 245
Interpolate Audio Images 109
Iterative Quantize 158

J
Jump tempo curve mode 208

K
Keep Last

Audio cycle recording 50
MIDI cycle recording 53

Key (Score Editor) 195
Key command conventions 8
Key commands

About 250
Alternative Key Sets 253
Default 252
Importing 252
List of default commands 253
Loading 252
Modifying 250
Removing 251
Resetting to default 252
Searching for 251

L
Lanes

Audio Part Editor 115
Latency

Monitoring 48
VST System Link 225

Left locator 42
Legato 161
Length Adjustment 54

Length Compression
MIDI Modifier 149

Length Quantize 172
Level faders 80
Line mode

Automation 97
MIDI controllers 179
MIDI velocity 178

Linear Record Mode
Audio 50
MIDI 52

List Editor
Adding events 190
Editing in the list 190
Editing in the value display 192
Filtering events 191
Masking events 191

Locate when clicked in empty 
space 41

Locators 42
Lock Frames 223
Lock Hitpoints 126
Loop icon

Audio Part Editor 116
Pool 136
Sample Editor 109

M
M button 33
Magnetic Area 157
Magnetic Cursor (Snap mode) 38
Magnifying Glass tool 22
Main Mix Bus 11
Markers

About 71
Adding in Marker window 71
Drawing on Marker track 73
Editing on Marker track 73
ID numbers 72
Key commands for 74
Marker track 72
Marker window 71
Moving 72
Removing 71
Snapping to 38

Mask function 191
Merge Clipboard 103

Merge Record Mode
Audio 50
MIDI 52

Metric Bias 125
Metronome

Activating 56
Precount 56
Settings 56

MIDI
Functions vs. MIDI Modifiers 155

MIDI channel
"Any" 52
In drum maps 187
Selecting for tracks 51

MIDI channel setting 52
MIDI Channel Settings 87
MIDI Clock

About 218
Always Send “Start” 220
Transmitting 220

MIDI Clock Follows Project 
Position 220

MIDI connector button 176
MIDI Controller Input to Automation

Tracks (Option) 95
MIDI Device Manager

About 150
MIDI devices

Defining new for patch 
selection 153
Editing patches for 151
Installing 151
Selecting patches for 151

MIDI files 241
MIDI Filter 55
MIDI input (Editing via) 176
MIDI inputs

Renaming 51
Selecting for tracks 51

MIDI Modifiers 148
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MIDI notes
Deleting 176
Drawing 172
Editing velocity 178
Moving 174
Muting 175
Muting in Drum Editor 184
Quantizing 155
Resizing 175
Selecting 173
Splitting and gluing 175
Transpose (Function) 159
Transposing (in editor) 174

MIDI outputs
In drum maps 187
Renaming 51
Selecting for tracks 51

MIDI parts
About 15
Drawing 27
Editing 166
Sliding contents 32

MIDI Record Catch Range 55
MIDI reset 54
MIDI Thru 50
MIDI tracks

Channel Settings window 87
MIDI Modifiers 148
Settings 147

Minimize Files 139
Mix (Cycle Record mode) 53
Mixer

Common panel 80
Group channels 86
Hiding channel types 77
Loading settings 88
Output busses 80
Pan 82
Saving settings 88
Solo and Mute 81
Volume 80

Mixing down to an audio file 212
Modifier keys 8, 253
Monitor button

Audio tracks 48
MIDI tracks 50

Monitoring modes 48

Move Controller 
(Quantize setting) 158

Move to Back/Front 29
Move to Cursor 29
Move to Origin 29
MP3 files

Importing 241
MPEG files

Audio 241
Video 233

Musical Mode
About 119
Activating 119
Activating in Pool 120

Mute
Events in Project window 33
MIDI notes 175
Mixer 81
Tracks 33

Mute tool 33

N
New Project 21
No Overlap 196
Noise Gate 104
Non Quantize setting 158
Normal Record Mode

Audio 50
MIDI 52

Normal Sizing 31
Normalize

Audio process 104
Note Velocity Slider 173
Notes, see also “MIDI notes”
Nudge buttons

MIDI editor toolbar 174
Project window toolbar 29

Numeric keypad 41

O
On Import Audio Files 26
On Processing Shared Clips 101
On Startup setting 239
Online (VST System Link) 227
O-Note 186
Open 237
Open Document Options dialog 239
Option/Alt key 8

Output (MIDI) 51
Output busses

About 10
Adding 11
Mixing down to file 212
Routing channels to 12
Viewing in the mixer 12

Output channels 80
Outputs (Audio) 10
Over Quantize 158
Overlapping events

Audio Part Editor 115
Project window 29

Overwrite (Cycle Record mode) 53

P
Pan Law 82
Parabola mode

Automation 97
MIDI controllers 180
MIDI velocity 179

Part Data mode 24
Parts, see “Audio parts” or 

“MIDI parts”
Paste at Origin 30
Paste Time

MIDI editing 175
Selection ranges 36

Patch Banks 151
Pedals to Note Length 163
Pencil tool 27
Pending Connections 237
Performance meter 89
Phase Reverse 104
Pitch Bend

Deleting 181
Editing 179
Recording 53

Play icon
Audio Part Editor 116
Pool 136

Play tool
Audio Part Editor 116
Project window 27

Plug-ins
Automating 95

Poly Pressure events 181
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Polyphony (Restricting) 163
Pool

About 130
Auditioning 136
Convert Files 140
Handling audio clips 132
Import Medium 137
Locate missing files 136
Record folder 138
Search Filters 135
Status column icons 131

Postroll 55
Pre/Post-CrossFade 102
Precount 56
Preferences

Transferring 248
Prepare Archive 139
Preroll 55
Printing

From the Score Editor 200
Printing Scores 200
Processing

About 101
Settings and functions 102

Project
Activating 237
Creating 21
Opening 237
Saving 237
Saving templates 238
Template 238

Project cursor
Autoscroll 38
Moving 41
Selecting events with 28
Snapping to 38

Project Setup dialog 21
Punch In

Automatic 46
Manual 45

Punch Out 46

Q
Q-points 127
Quantize

About 155
Applying 158
Automatic during recording 53
Ends 159
Freeze 159
Lengths 159
Setting on toolbar 156
Setup dialog 156
Undo 159

Quick Zoom 22
Quicktime 233

R
R button 94
Ramp tempo curve mode 208
Random

MIDI Modifier 149
Random Quantize setting 158
Range

MIDI Modifier 150
Range Selection tool 35
Read button 94
Realtime pitch shifting 121
Reconstruct 136
Record Catch Range 55
Record enable 45
Record file type 47
Record format 47
Record Mode (Linear)

Audio 50
MIDI 52

Recording in MIDI editors 54
Recovering recordings 57
ReCycle files 240
Relative snapping 37
Remove DC Offset 105
Remove missing files 136
Remove Parameter 98
Removing crossfades 62
Removing fades 60
Repeat

Events and parts 30
MIDI notes 174

Replace Record Mode
Audio 50
MIDI 52

Reset 54
Reset Mixer 86
Resolution 47
Resolving 218
Restrict Polyphony 163
Retrospective Record 54
Return To Start Position on Stop 42
Reverse 105
Reverse (MIDI function) 164
Revert 240
REX files 240
Right locator 42
Routing

Audio to and from busses 12
Ruler

About 20

S
S button 33
Sample Editor

About 107
Sample rate 21
Sample size 47
Save 237
Save New Version 238
Save Project to new folder 238
Scissors tool

MIDI editors 175
Project window 31
Score Editor 199

Score
Displaying 194
Printing 200

Scrubbing
Events in Project window 27
Events in Sample Editor 110
Resizing events by 32

Search key commands 251
Select Tool

Show Extra Info 20
Selecting

Events in Project window 28
MIDI notes 173
Mixer channels 84
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Sensivity slider 125
Set Audio Event from Loop 128
Set Pool Record Folder 138
Set Tempo from Event 128
Shared copy 30
Show Controllers 24
Show Data on Small Track 

Heights 24
Show Event Names 24
Show Event Volume Curves 

Always 59
Show Filter View 191
Show Part Borders 167
Show Track Colors 25
Show Video Thumbnails 235
Shuffle 196
Shuffle (Snap mode) 38
Signal levels 48
Silence 105
Sine mode

Automation 97
MIDI editing 180

Sizing Applies Time Stretch 32
Sizing Moves Contents 31
Slices

Auditioning 125
Creating 127
Disabling 126
Locking 126

Snap
MIDI editors 171
Project window 37

Snap point
Setting for clips in Pool 137
Setting in Project window 37
Setting in Sample Editor 110

Snap Record Parts to Bars 54
Snap to Zero Crossing

Audio Editor 117
Preference setting 38
Sample Editor 112

Snap Track Heights 22

Solo
Audio Part Editor 116
Folder tracks 67
MIDI editors 171
Mixer 81
On Selected Track 33
Tracks 33

Solo Defeat 82
Solo Record in MIDI Editors 54
Speaker icon (MIDI editors) 171
Speaker tool

Audio Part Editor 116
Project window 27

Split
Events 31
Range 37

Split (Piano) Staff 195
Split at Cursor

MIDI editors 175
Project window 31

Split Loop
MIDI editors 175
Project window 31

Split MIDI Events 31
Square mode

Automation 97
MIDI editing 180

Staff Mode 195
Staff Settings 194
Start Record at Left Locator 45
Startup options 239
Static Value Line (Automation) 96
Stationary cursor 38
Step Bar 41
Step input 176
Step Input button 176
Stereo Flip 105
Stereo Pan Law 82
Stop after Automatic Punch Out 55
Stretch to Project Tempo 128
Swing 157
Sync indicator 221, 223
Sync Project and Mixer Selection 83

Synchronization
About 217
Audio card settings 222
Connections for 219
Formats 217
Frame rates 219
Indicator
(Transport panel) 221, 223
Options 223
Recording in Sync mode 46
Synchronization Setup dialog 220
Syncing equipment to 
Cubase LE 220
To timecode 221

Syncopation 196
System Exclusive

About 202
Bulk Dumps 202
Editing 203
Recording parameter 
changes 203

T
T button (Score Editor) 193
Templates 238
Tempo

About 206
Audio loops 119
Editing 208
Setting from event 128
Setting in Fixed mode 209

Thin Out Data 164
Time display 41
Time format 20
Time Linear

MIDI editors 169
Tempo Track Editor 207

Time signature 209
Timecode

About 217
Frame rates 219
Synchronizing to 221

Tool modifier keys 253
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Toolbar
Audio Part Editor 114
Drum Editor 182
Key Editor 168
List Editor 189
Pool 131
Project window 19
Sample Editor 107
Score Editor 193

Toolbars
Customizing 244

Track list
About 16

Track types 15
Tracks

Adding 25
Audio channel configuration 47
Changing height of 22
Color 25
Disabling/Enabling 42
Removing 25
Renaming 25
Selecting 25

Transfer projects and settings 248
Transparent events 24
Transport menu

Functions 40
Playback options 43

Transport panel
Customizing 244
Display format 41
Hiding and showing 40
Key commands 41
Overview 40

Transpose
Info line 20
MIDI function 159
MIDI Modifier 148

Triangle mode
Automation 97
MIDI editing 180

Trim buttons 32
Trim tool 170
Tuplet 157

U
Undo

Recording 49
Undo Quantize 159
Update Display 213
Use File Extension in File Dialog 238
Use pop-up menu (Hitpoints) 125

V
Velocity

Editing 178
Editing via MIDI 176
Info line 20
MIDI function 163

Velocity Compression
MIDI Modifier 149

Velocity Shift
MIDI Modifier 149

Video
Generating thumbnail cache
files 234
Import preferences 233
Importing files 233
Playing back 234
Playing back via FireWire 235
Preparations (Windows) 232
Setting up 233

Video Cache Size 235
Video for Windows 233
Video playback engine 233
Video track

Showing thumbnails 235
Volume (Info line) 81
Volume handle 60
VST Channel Settings 83
VST Connections 11
VST Instruments

Activating 142
Automating 145
Saving VST Presets 144
Using VST Presets 143

VST Performance window 89
VST Ports 10

VST System Link
About 223
Activating 227
Connections 224
Latency 225
MIDI 228
Putting computers online 227
Requirements 224
Setting up sync 225
Settings 226

W
W button 94
Warp settings 120
Wave files 214
Wave Image Style 24
Waveform zooming 22
Windows Media Audio files 214

Importing 241
WMA files

Importing 241
Word Clock

About 218
Selecting for sync 222
Setting up 219

Write button 94

Z
Zero Crossings 38
Zoom

About 22
Presets 23
Sample Editor 109
Track height 22
Waveforms 22

Zoom N Tracks 23
Zoom Tool Standard Mode 22
Zoom while Locating in Time

Scale 22
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